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Using the Module Reference Guide (MRG)
If you are unfamiliar with module reference guides (MRGs), please review the content below so 
that you can more quickly and efficiently locate the information you need.

The MRG is a PDF document containing all available instructions for a module. The content in this 
MRG is considered module-specific. You may be referred to another MRG if a referenced function 
is not specific to this module.

Each MRG typically includes the following chapters:
• Exposure - Provides introductory information and license requirements.
• Usage - Provides procedures for user-facing functionality.
• Configuration - Provides procedures for configuration and system administration.
• Installation - Provides system requirements and installation procedures.

You can open any chapter or section in the MRG by clicking its entry in the Table of Contents.

It is considered a best practice to read through an entire procedure before attempting to complete 
any of its steps. Pay close attention to notes, tips, and cautions, which can help you better 
understand the entire process and discover any prerequisites you may not have completed.

The MRGs use notes, tips, and cautions to draw your attention to additional information.

Note: A note provides supplemental information or highlights behavior you might not expect.

Tip: A tip describes extra, non-crucial information, such as a shortcut, reminder, or use for a 
feature you might not think of.

Caution: Cautions are designed to help protect the system from data loss or severe issues that 
may arise when an instruction is not followed properly.

Cross-references are links to related information or additional instructions you may need to 
complete a task. Click a cross-reference to navigate to the referenced section. To return to the 
page you were viewing before following a cross-reference, press Alt + Left Arrow until the desired 
page is displayed.

Searching: The following search instructions pertain to viewing an MRG in Adobe Reader or Adobe 
Acrobat. Some information may not apply to other PDF readers.

• Basic search: Press Ctrl + F. Enter the word or phrase you are looking for in the search 
box and press Enter to locate each instance.

• Advanced search: Press Ctrl + Shift + F to find all instances of a phrase in an MRG or 
folder. In the Search dialog box, enter the word or phrase you are looking for, and then 
select one of the following options:
• In the current document - Searches the document you are viewing.
• All PDF Documents in - Searches a selected folder or directory. If you are unsure of 

which MRG to search, try searching the folder where your MRGs are located to 
display all results for the word or phrase.
©2018 Hyland Software, Inc. iv



Unity Client
Table of Contents
Using the Module Reference Guide (MRG) ........................................................................................ iv

EXPOSURE

Overview ....................................................................................................................................................1
Exclusive Features ............................................................................................................................................... 1

Applications ...............................................................................................................................................1

Licensing .....................................................................................................................................................1

Definitions .................................................................................................................................................2
Annotations .......................................................................................................................................................... 2
AutoFill Keyword Set ............................................................................................................................................ 2
AutoFill Keyword Set Instance............................................................................................................................. 3
Cascading Data Sets............................................................................................................................................ 3
Cross-Reference................................................................................................................................................... 3

HTML-Based Documents ............................................................................................................................. 3
Custom Queries.................................................................................................................................................... 4
Document ............................................................................................................................................................. 4
Document Handle................................................................................................................................................. 4
Document Type .................................................................................................................................................... 4
Document Type Group ......................................................................................................................................... 4
Envelope................................................................................................................................................................ 5
External Text Search Definition ........................................................................................................................... 5
File Cabinet .......................................................................................................................................................... 5
Dynamic Folder..................................................................................................................................................... 6
Static Folder.......................................................................................................................................................... 6
Image Documents ................................................................................................................................................ 7
Internal Text Search Definition ............................................................................................................................ 7
Keyword Data Sets ............................................................................................................................................... 7
Keyword Types and Keyword Values.................................................................................................................. 7

Keyword Types ............................................................................................................................................. 7
Keyword Values ............................................................................................................................................ 8

Keyword Type Groups.......................................................................................................................................... 8
Multi-Instance Keyword Type Groups ......................................................................................................... 9

Keyword Type Masking........................................................................................................................................ 9
Note....................................................................................................................................................................... 9
OLE Documents..................................................................................................................................................10
Overlay ................................................................................................................................................................11
Staples ................................................................................................................................................................11
Text Documents .................................................................................................................................................12
User .....................................................................................................................................................................12
User Group..........................................................................................................................................................12
OnBase 18
©2018 Hyland Software, Inc.

v



Unity Client
Table of Contents
USAGE

General Functionality ........................................................................................................................... 13
Opening the Unity Client ....................................................................................................................................13
Logging On..........................................................................................................................................................13
Change Password ..............................................................................................................................................15
The Unity Client Window....................................................................................................................................16
Home Tab ...........................................................................................................................................................17

Home Layout ..............................................................................................................................................18
Web Sites .............................................................................................................................................19
RSS Ticker ............................................................................................................................................20

File Menu ............................................................................................................................................................21
Accessing Keyboard Shortcuts .........................................................................................................................23
Favorites .............................................................................................................................................................23

Using Your Home Page ..............................................................................................................................24
Setting Your Home Page .....................................................................................................................24
Resetting Your Home Page .................................................................................................................25

Using Your Favorites ..................................................................................................................................25
Adding a Favorite ........................................................................................................................................26
Opening a Favorite .....................................................................................................................................26
Managing Your Favorites ...........................................................................................................................27

Renaming Favorites .............................................................................................................................27
Deleting Favorites ................................................................................................................................27

Personal Page ....................................................................................................................................................28
Using Your Personal Page .........................................................................................................................28
Administrative Tiles ....................................................................................................................................30

Editing Administrator Suggested Tiles ...............................................................................................30
Adding Items to Your Personal Page ........................................................................................................30

Adding Layouts to Your Personal Page .............................................................................................31
Adding Custom Queries to Your Personal Page ................................................................................31
Adding Documents to Your Personal Page .......................................................................................32
Adding Import Tiles with Specified Document Types to Your Personal Page ................................32
Adding WorkView Filters and Objects to Your Personal Page .........................................................33

Opening A Layout or an Item from the Personal Page ............................................................................34
Managing and Configuring Personal Page Tiles ......................................................................................34

Custom Query Results Tiles ................................................................................................................35
Removing Personal Page Tiles ..................................................................................................................35

Panes ..................................................................................................................................................................35
Open in New Window .........................................................................................................................................36
Data Lists ............................................................................................................................................................36

Selecting Multiple Items ............................................................................................................................36
Reordering and Stacking Columns ............................................................................................................37
Grouping ......................................................................................................................................................38
Sorting .........................................................................................................................................................40
Filtering .......................................................................................................................................................40
OnBase 18
©2018 Hyland Software, Inc.

vi



Unity Client
Table of Contents
Operators .............................................................................................................................................41
Drop-Down Select Lists .......................................................................................................................42

Custom Filter Selection .................................................................................................................44

User Options ........................................................................................................................................... 46
Overview .............................................................................................................................................................46
General ................................................................................................................................................................48
Document ...........................................................................................................................................................50
Document Import ...............................................................................................................................................53
Local Data...........................................................................................................................................................54
Printing................................................................................................................................................................54
Retrieval Date Options .......................................................................................................................................55
Service Mode ......................................................................................................................................................56

Document Retrieval .............................................................................................................................. 58
Document Retrieval without Specifying Search Parameters ..........................................................................59
Retrieval Using Custom Queries........................................................................................................................60

Conducting a Custom Query ......................................................................................................................61
Conducting Multiple Custom Queries .......................................................................................................66
Viewing Folder Custom Query Results ......................................................................................................67
Filtering Custom Query Results .................................................................................................................68

Document Retrieval by Keyword Value.............................................................................................................71
Document Search Results List ..........................................................................................................................75

Viewing Documents ...................................................................................................................................76
Thumbnail Viewer ................................................................................................................................77

Document Retrieval by Document Date............................................................................................................77
Date Range Parameters and Corresponding Results ..............................................................................82

Document Retrieval Using Note Search............................................................................................................82
Document Retrieval Using External Text Search..............................................................................................85
Viewing Recent Query History ...........................................................................................................................88
Document Retrieval by Document Handle........................................................................................................89
Keyword Types Relationship Examples in Document Retrieval ......................................................................90

Cascading Data Set ....................................................................................................................................90
Multi-Instance Keyword Type Group .........................................................................................................90

Working with Documents .................................................................................................................... 95
Document Viewer ...............................................................................................................................................95
Document Tab ....................................................................................................................................................99

The Notes Gallery .....................................................................................................................................102
Notes ..................................................................................................................................................102
Annotations ........................................................................................................................................103
Redacting Documents Using Redaction Annotations .....................................................................105

Creating a Redaction ...................................................................................................................106
Viewing Redactions .....................................................................................................................107

Redacting Documents Using Bitmap Redactions ...........................................................................107
Navigating in the Bitmap Redaction Tab....................................................................................108
Applying a Redaction Bitmap......................................................................................................108
OnBase 18
©2018 Hyland Software, Inc.

vii



Unity Client
Table of Contents
Deleting a Redaction Bitmap.......................................................................................................109
Working with Notes in the Document Viewer.................................................................................................109

Viewing Notes ...........................................................................................................................................110
Showing and Hiding Notes ......................................................................................................................110
Moving Notes ............................................................................................................................................110
Deleting Notes ..........................................................................................................................................111
Setting Note Privacy Options ...................................................................................................................111

Working with Notes in the Task Pane.............................................................................................................111
Viewing and Editing Notes .......................................................................................................................112
Deleting a Note .........................................................................................................................................113
Setting Note Privacy Options ...................................................................................................................114

Viewer Options .................................................................................................................................................115
Google Services Integration Viewer ........................................................................................................115
Microsoft Office Online Integration Viewer ............................................................................................116
View in Native Format ..............................................................................................................................117

Staples ..............................................................................................................................................................117
Stapling Open Documents from the Information Bar ............................................................................118
Stapling Documents from a Document Search Results List .................................................................118
Viewing Stapled Documents ....................................................................................................................119
Moving Staples .........................................................................................................................................119
Editing Staple Notes .................................................................................................................................119
Deleting Staples ........................................................................................................................................120

Image Tab.........................................................................................................................................................120
Document Thumbnails.....................................................................................................................................124
Text Tab ............................................................................................................................................................125

Internal Text Search .................................................................................................................................128
Generating Text Search Reports .......................................................................................................128
Limiting Searches Using Internal Text Search Settings ..................................................................129

Overlays ............................................................................................................................................................132
Apply an Overlay to a Document .............................................................................................................133
Remove an Overlay from a Document ....................................................................................................133

Media Tab .........................................................................................................................................................133
Retrieving Cross-Referenced Documents.......................................................................................................134

From a Document Search Results List ....................................................................................................136
From Image or Text-Based Documents ..................................................................................................136
From E-Forms, HTML Documents, or OLE Documents ..........................................................................136

Access Document History ...............................................................................................................................136
Document History ............................................................................................................................................137
Access Document Properties..........................................................................................................................137
Document Properties .......................................................................................................................................138
Generating a CSV File ......................................................................................................................................140
Saving Documents to Files ..............................................................................................................................142
Deleting Documents.........................................................................................................................................147
Creating a Document .......................................................................................................................................148

Creating a New Document from an Existing Document ........................................................................148
OnBase 18
©2018 Hyland Software, Inc.

viii



Unity Client
Table of Contents
Executing a Unity Script ...................................................................................................................................151

Working with Keywords .................................................................................................................... 153
Access the Keyword Values of a Document ..................................................................................................153
Add / Modify Keywords ...................................................................................................................................155
Read-Only Keywords ........................................................................................................................................158
Mixed Case Keywords......................................................................................................................................160

Searching on Mixed Case Keyword Values ............................................................................................160
With Case Sensitive Searching Applied ...........................................................................................160
Without Case Sensitive Searching Applied ......................................................................................160

Indexing Mixed Case Keyword Values ....................................................................................................160
Masked Keywords............................................................................................................................................160
AutoFill Keyword Set Instance.........................................................................................................................161

Using AutoFill Keyword Sets When Indexing or Re-Indexing .................................................................161
Indexing with AutoFill Keyword Sets ................................................................................................161
Re-Indexing with AutoFill Keyword Sets ...........................................................................................162

Using a Reverse AutoFill Keyword Set Lookup...............................................................................................163
Use Keywords for Document Retrieval ...........................................................................................................167

Keyword Types that Contain Relationships ............................................................................................167
Cascading Data Sets .........................................................................................................................167
Multi-Instance Keyword Type Groups ..............................................................................................167

Common Keyword Types for Document Type Groups and Multiple Document Types .......................168
Add Another Value to a Keyword .............................................................................................................169

Multi-Instance Keyword Type Groups ..............................................................................................169
Keywords with Drop-Down Select Lists ..................................................................................................169

Keyword Operators and Extended Search Features ......................................................................................169
Relational (Comparative) Operators ...............................................................................................................170
Logical Boolean Operators ..............................................................................................................................170
Wildcard Characters.........................................................................................................................................171
Adding Multiple Values to a Keyword Type ...................................................................................................172

Re-Indexing ........................................................................................................................................... 173
Re-Indexing Documents...................................................................................................................................173

Keywords with Drop-Down Select Lists ..................................................................................................176
Re-Indexing Document Revisions ............................................................................................................177

Considerations for Re-Indexing Documents and Adding or Modifying Keyword Values ............................177

Separating Image and PDF Documents .......................................................................................... 181
The Separation Workspace .............................................................................................................................182

Document Display Mode ..........................................................................................................................183
Page Display Mode ...................................................................................................................................184
Tree Display Mode ....................................................................................................................................185
Adjusting Thumbnails in the Separation Workspace .............................................................................185
Selecting Documents in the Separation Workspace ..............................................................................186

Selecting Documents in Document Display Mode ..........................................................................187
Selecting Documents in Page Display Mode ...................................................................................187

Reordering Documents in the Separation Workspace ...........................................................................188
OnBase 18
©2018 Hyland Software, Inc.

ix



Unity Client
Table of Contents
Using the Page Holder .............................................................................................................................189
Working with Locked and Read-Only Documents in the Separation Workspace .................................190
Saving Documents ...................................................................................................................................190

Viewing and Editing Page Details in Document Separation ..........................................................................191
Creating and Editing Documents in the Separation Workspace ...................................................................192

Adding New Pages to the Separation Workspace .................................................................................193
Adding Pages by Browsing ...............................................................................................................193
Adding Pages by Acquiring ...............................................................................................................194

Clicking and Dragging Pages in the Separation Workspace .................................................................194
Clicking and Dragging Pages in Document Display Mode ..............................................................195
Clicking and Dragging Pages in Page Display Mode ......................................................................196

Joining Documents in the Separation Workspace .................................................................................196
Merge Documents .............................................................................................................................197
Join Pages .........................................................................................................................................197
Append After Page ............................................................................................................................198

Splitting Documents in the Separation Workspace ................................................................................199
Split .....................................................................................................................................................200

Using the Break into Documents Option ....................................................................................200
Copying Pages and Documents in the Separation Workspace .............................................................201

Copy Document .................................................................................................................................202
Copy Pages to New Document .........................................................................................................202
Copy Pages in Place ..........................................................................................................................202

Deleting Documents or Pages in the Separation Workspace ................................................................202
Undoing and Redoing Actions in the Separation Workspace ................................................................203

Importing a New Document in the Separation Workspace ...........................................................................205
Adding or Modifying Keywords on a Source Document in the Separation Workspace...............................207
Working with Comments on Revisable Documents in the Separation Workspace .....................................209

Working with Comments in Document Display Mode ...........................................................................209
Working with Comments in Page Display Mode ....................................................................................211

Keyboard Shortcuts for the Separation Workspace.......................................................................................211

Folders ................................................................................................................................................... 214
Folder Definition ...............................................................................................................................................214

Folder Hierarchy .......................................................................................................................................215
Folder Contents ........................................................................................................................................215

Static Folder......................................................................................................................................................215
Dynamic Folder.................................................................................................................................................216
Auto-Foldering ..................................................................................................................................................216
Opening File Cabinets and Folders .................................................................................................................216

Opening Multiple Folders Windows .........................................................................................................218
Moving Up a Level from a Folder Tab .....................................................................................................219
Scrolling Through Folder Tabs ................................................................................................................219
Accessing Folder Search by Clicking a Folder .......................................................................................220
Working with Folder Pop-up Lists ............................................................................................................221

Retrieving Related Folders...............................................................................................................................222
Searching for Folders.......................................................................................................................................223
OnBase 18
©2018 Hyland Software, Inc.

x



Unity Client
Table of Contents
Show Folder Locations .............................................................................................................................226
Keyword Considerations for Show Folder Locations ......................................................................227

Applying Folder Filters .....................................................................................................................................227
Applying a Folder Template.............................................................................................................................228
Adding, Uploading, and Removing Documents ..............................................................................................229

Adding Documents to Dynamic Folders .................................................................................................229
Adding Documents to Static Folders ......................................................................................................230

If You Cannot Add a Document to a Folder .....................................................................................230
Uploading and Indexing Documents Using Folders ...............................................................................230
Removing Documents from Folders .......................................................................................................232

Adding and Deleting Folders ...........................................................................................................................232
Adding a Folder .........................................................................................................................................233
Deleting a Folder .......................................................................................................................................234

Changing Folder Keyword Values ...................................................................................................................234
Modifying Keyword Values on a Folder, Child Folders, and Documents ..............................................236

Modifying Multi-Instance Keyword Type Groups ............................................................................238
Example 1: Content uses the same Multi-Instance Keyword Type Group as its folder ..........239
Example 2: Content uses a Multi-Instance Keyword Type Group that contains a Keyword Type 
used by its folder .........................................................................................................................240
Example 3: Content uses a Keyword Type that is contained in a Multi-Instance Keyword Type 
Group used by its folder ..............................................................................................................240

Working with Folder Notes ..............................................................................................................................241
Folder Notes Requirements .....................................................................................................................241
Viewing and Sorting Folder Notes and Bookmarks ...............................................................................242
Adding a Folder Note or Bookmark .........................................................................................................243
Viewing a Bookmarked Document ..........................................................................................................245
Editing an Existing Note or Bookmark ....................................................................................................246
Deleting a Note or Bookmark ...................................................................................................................247

Folder Properties..............................................................................................................................................248
Viewing the History of a Folder .......................................................................................................................249

Sending and Receiving Mail .............................................................................................................. 250
Send To | Internal User.....................................................................................................................................250

Sending OnBase Documents to Other OnBase Users ............................................................................250
Checking Internal Mail ..............................................................................................................................255

Viewing Internal Mail .........................................................................................................................258
Emailing Documents and Links to Documents ..............................................................................................260

Attachment Display Considerations ........................................................................................................267
Sending Folders as Unity Pop Links and Unity Pop Files ..............................................................................267
Using the OnBase Mail Message Dialog Box .................................................................................................268

Checking Names and Addresses ............................................................................................................269
Viewing Unity Pop Files and Links ..................................................................................................................270

Using Envelopes ................................................................................................................................... 272
Envelope............................................................................................................................................................272
Creating and Deleting Envelopes ....................................................................................................................273

Creating a New Envelope .........................................................................................................................273
OnBase 18
©2018 Hyland Software, Inc.

xi



Unity Client
Table of Contents
Deleting an Envelope ................................................................................................................................274
Sharing an Envelope .................................................................................................................................275

Adding or Removing Documents from Envelopes .........................................................................................278
Adding Documents to Envelopes ............................................................................................................278
Removing Documents from Envelopes ...................................................................................................279

Opening Existing Envelopes ............................................................................................................................280

Importing Documents ......................................................................................................................... 281
Importing Documents by Browsing.................................................................................................................282
Importing Documents by Acquiring ................................................................................................................283
Importing Documents from Google Drive.......................................................................................................284

Importing Documents from Third-Party Google Applications ...............................................................286
Importing Documents by Dragging and Dropping..........................................................................................287

Completing the Import Process........................................................................................................ 288
Multi-Page TIFF Images ....................................................................................................................294

Appending Pages to an Existing Document ...................................................................................................294

Printing .................................................................................................................................................. 298
Printing Documents .........................................................................................................................................298
File Format not Supported for Printing ...........................................................................................................303

Reports .................................................................................................................................................. 304
Creating List Reports .......................................................................................................................................304

Document Search Results Lists and Batch Queues ...............................................................................305

CLIENT ADMINISTRATION

Introduction .......................................................................................................................................... 307

Managing Locks ................................................................................................................................... 308
Document Locks ..............................................................................................................................................309

Keyword Locking ......................................................................................................................................310
Disk Group Locks .............................................................................................................................................310
Process Locks ..................................................................................................................................................310

User Administration ........................................................................................................................... 311
Required Administrative Rights.......................................................................................................................311
User Administration Overview .........................................................................................................................312
Users Tab..........................................................................................................................................................313
Creating Users ..................................................................................................................................................314
Editing Users.....................................................................................................................................................316
Resetting User Passwords ..............................................................................................................................316
Locking and Unlocking Users ..........................................................................................................................317
Deleting Users ..................................................................................................................................................318
Changing User Group Assignments................................................................................................................318
Assigning Security Keywords to Users ...........................................................................................................320

User Option Policy Administration ................................................................................................. 322
Adding a User Option Policy ............................................................................................................................324
OnBase 18
©2018 Hyland Software, Inc.

xii



Unity Client
Table of Contents
Viewing the Resultant Set of User Options.....................................................................................................332
Changing a User Option Policy ........................................................................................................................336

Changing the Name and Description of a User Option Policy ...............................................................336
Changing the Configured User Options of a User Option Policy ...........................................................338
Changing the Assigned User Group of a User Option Policy .................................................................342
Changing the Priority of a User Option Policy ........................................................................................343

Deleting a User Option Policy ..........................................................................................................................346

Personal Page Tile Group Administration ..................................................................................... 346
Creating a Tile Group .......................................................................................................................................347
Renaming a Tile Group.....................................................................................................................................347
Deleting a Tile Group........................................................................................................................................348
Assigning a Tile Group to a User Group..........................................................................................................349
Adding Tiles to Tile Groups .............................................................................................................................351

Adding Documents, Folders, and Individual Items to Tile Groups ........................................................351
Adding a Layout to Tile Groups ...............................................................................................................352
Adding Custom Query Results to Tile Groups ........................................................................................352
Adding Import Tiles with Specified Document Types to Tile Groups ...................................................354

Managing and Configuring Tiles in Tile Groups.............................................................................................355
Custom Query Results Tiles .....................................................................................................................356

Removing Tiles from a Tile Group...................................................................................................................356

Troubleshooting Layout ..................................................................................................................... 358
Troubleshooting Messages.............................................................................................................................358
Creating Bug Reports .......................................................................................................................................358
Using the Request Profile Diagram .................................................................................................................359

CONFIGURATION

Custom Query Configuration ........................................................................................................... 361
Grouping Columns ...........................................................................................................................................361
Filtering Columns .............................................................................................................................................362

Document Retrieval ............................................................................................................................ 364
Document Retrieval Threshold ........................................................................................................................364

DocumentQueryWarningThreshold .........................................................................................................364
DocumentQueryLimit ...............................................................................................................................364

Configuring Google Services ............................................................................................................. 365
Creating a Google API Project in the Google Developers Console ...............................................................365
Enabling Google Services ................................................................................................................................366
Configuring Gmail ............................................................................................................................................367

Microsoft Office Web Application Server Integration ............................................................... 368

The Unity Client Configuration File ................................................................................................ 368
AD FS Configuration.........................................................................................................................................368
Hyland.Canvas.Client .......................................................................................................................................368

Trusted Certificates ..................................................................................................................................370
OnBase 18
©2018 Hyland Software, Inc.

xiii



Unity Client
Table of Contents
ServiceLocations..............................................................................................................................................370
appSettings.......................................................................................................................................................372
Hyland.Canvas..................................................................................................................................................374

DisplayLanguage ......................................................................................................................................374
Culture .......................................................................................................................................................375
Application ................................................................................................................................................375
DefaultHomeLayout .................................................................................................................................376
UserGroupTimeoutMode .........................................................................................................................376

Hyland.Canvas.Automation.Services..............................................................................................................377
Application Enabler ..........................................................................................................................................377

HTTPS Automation ..................................................................................................................................382
Workflow...........................................................................................................................................................382

Configuring Unity Pop ........................................................................................................................ 383
Configuring Unity Pop Links ............................................................................................................................383
Configuring Unity Pop Files .............................................................................................................................384

INSTALLATION

Requirements ....................................................................................................................................... 385
Unity Client Supported Operating Systems ....................................................................................................385
Unity Client Hardware Requirements ..............................................................................................................385
HTTPS Automation Requirements..................................................................................................................386
Microsoft .NET Framework Requirements .....................................................................................................386
Microsoft Visual C++ Requirements ...............................................................................................................387
Databases Supported ......................................................................................................................................387

Microsoft SQL Server ...............................................................................................................................387
Oracle ........................................................................................................................................................388
SAP SQL Anywhere ..................................................................................................................................388

Database/File Servers......................................................................................................................................389
Hyland Software - Microsoft Service Pack Statement...................................................................................389
Third-Party Software Compatibility .................................................................................................................389
About Virtual Environments.............................................................................................................................389
64-Bit Support Statement ................................................................................................................................390
Windows User Account Control Statement ....................................................................................................390

Modifying Configuration Files .................................................................................................................391
Licensing...........................................................................................................................................................391
Digital Input Device Compatibility ...................................................................................................................391
Third-Party Software Requirements................................................................................................................391

Upgrade Considerations .................................................................................................................... 391
General User Interface Redesign.....................................................................................................................392
Server Machine Considerations ......................................................................................................................392
End-User Workstation Considerations............................................................................................................392
ClickOnce Deployment Considerations ..........................................................................................................392
General Deployment Considerations ..............................................................................................................393
OnBase 18
©2018 Hyland Software, Inc.

xiv



Unity Client
Table of Contents
Installation Overview ......................................................................................................................... 393
Installer Prerequisites ......................................................................................................................................395
Installer User Permissions...............................................................................................................................395
Installer .NET Framework Requirements........................................................................................................395

Installation Using the MSI Installer ................................................................................................. 396
Running the Installer ........................................................................................................................................396
Change, Repair, or Remove an Installation .....................................................................................................407
Running the Installer from the Command Line ..............................................................................................407

Feature Names .........................................................................................................................................408
Properties ..................................................................................................................................................408

Post-Installation ...............................................................................................................................................412
AD FS Configuration .................................................................................................................................412
HTTPS Automation ..................................................................................................................................412

Installation Using ClickOnce ............................................................................................................ 412
ClickOnce Deployment.....................................................................................................................................412
Web Server Installation Steps .........................................................................................................................417
From a Shared Folder Installation Steps ........................................................................................................420
Manually Created Share Steps ........................................................................................................................424
Unity Features...................................................................................................................................................428
Service Location and Deployment Configuration...........................................................................................429
Before Signing the Deployment.......................................................................................................................435

AD FS Configuration .................................................................................................................................435
HTTPS Automation ..................................................................................................................................435

Deployment Signing .........................................................................................................................................436
Updating or Adding a Deployment Instance...................................................................................................439

Web Server Add or Update Steps ............................................................................................................442
From a Shared Folder Add or Update Steps ...........................................................................................445
Service Location and Deployment Configuration ...................................................................................449

Automatically Launching a Deployed Application at System Startup ..........................................................452
Removing a Deployed Application ..................................................................................................................452

Removing a Deployed Application Instance from Client Workstations ................................................453
Removing a Deployed Application Instance from the Deployment Server ...........................................453
Completely Removing a Deployed Application .......................................................................................454

Manual Installation ............................................................................................................................. 455

Running Multiple Instances of the Unity Client ........................................................................... 456

Backup/Recovery ................................................................................................................................ 456
Window Settings ..............................................................................................................................................456

Frequently Asked Questions ............................................................................................................ 456

Troubleshooting .................................................................................................................................. 457
Cannot Start Application..................................................................................................................................457
Display...............................................................................................................................................................457
External Email ...................................................................................................................................................457

The Body of Notifications is Blank ..........................................................................................................457
OnBase 18
©2018 Hyland Software, Inc.

xv



Unity Client
Table of Contents
Exception Has Been Thrown by the Target of an Invocation ................................................................458
One or More of the Selected Documents Could Not Be Sent ................................................................458
Unity Pop File Is Not Valid for the System ..............................................................................................458
You Do Not Have Privileges to View This Document .............................................................................458
Open or Save an EML Document .............................................................................................................458
Page Could Not Be Displayed ..................................................................................................................459

Logging On........................................................................................................................................................459
Initialization Error .....................................................................................................................................459

Scanning ...........................................................................................................................................................459
Working with Documents.................................................................................................................................460

Created in a Newer Version of Word .......................................................................................................460
There Was an Error Opening This File .....................................................................................................460
Excel Ribbon Is Reset to the Home Tab ..................................................................................................460
Opening a Modal Dialog Box ...................................................................................................................461
Unable to Use Microsoft Excel Outside of the Unity Client ....................................................................461
Attempt to Access Invalid Address .........................................................................................................461
Exception Has Been Thrown by the Target of an Invocation ................................................................461
Characters Appear Cut Off in Text Documents ......................................................................................461
Unity Client Becomes Unresponsive When Scrolling .............................................................................462

Notes, Redactions, Burned Markups, and Deficiencies on Documents with Overlays ................................462

Contacting Support ............................................................................................................................. 463

SYSTEM ASSESSMENT TOOL

Using the System Assessment Tool ................................................................................................. 465

BEST PRACTICES

DocPop and Unity Pop ....................................................................................................................... 467

Network Connectivity ........................................................................................................................ 467

Document Retrieval ............................................................................................................................ 468
Dates .................................................................................................................................................................468
Drop-Down Lists ...............................................................................................................................................468
Wildcards ..........................................................................................................................................................468

Importing ............................................................................................................................................... 468
Text Documents ...............................................................................................................................................468

Indexing ................................................................................................................................................. 469
Multi-Instance Keyword Type Groups.............................................................................................................469

QUICK REFERENCE GUIDE
OnBase 18
©2018 Hyland Software, Inc.

xvi



On
©2
EXPOSURE
Overview
The OnBase Unity Client is a connected, next-generation document management system that 
offers the familiar look-and-feel of Microsoft® Office® 2013. You can use the Unity Client to 
easily upload, organize, and retrieve documents.

Exclusive Features
The OnBase Unity Client contains features that are not found in other OnBase clients. These 
features include:

• Ribbons
• Task panes
• A configurable homepage
• A configurable Favorites list
• List grouping and sorting
• Import preview
• An integrated audio and video viewer

Applications
The OnBase Unity Client is the OnBase integration platform of the future. It:

• Simplifies OnBase access, promoting ease-of-use by presenting OnBase features 
and functions where users expect to find them.

• Increases adoption and minimizes training and support costs by leveraging user-
familiarity with Microsoft Office 2013 products.

• Improves worker productivity by providing a personalized, task-centric interface with 
integrated functionality.

• Saves deployment time, effort, and costs through rapid rollout and upgrades using 
Microsoft’s ClickOnce technology.

Licensing
A Unity Client Server license is required to use the OnBase Unity Client. A valid Concurrent 
Client, Workstation Client, or Named User Client license is also required.

Check your current licensing status by selecting Utils | Product Licenses in the OnBase 
Configuration module.
Base 18
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Definitions

Annotations
Annotations are similar to OnBase notes. An annotation can be used to call attention to items 
in a document, it can contain a message, and it may be represented by an icon. However, 
annotations also allow you to call attention to a portion of the document with special markings, 
such as arrows, highlights, and ellipses.

Note: If you are viewing a document that has been locked by Records Management, in the 
ActiveX environment, the Annotations toolbar is selectable, but does not perform any 
functions. In the HTML environment, the Annotations toolbar is locked and cannot be used.

Characteristics such as color and title are predefined when the note is configured for use. 
Several types of annotations can be created:

• Arrows typically point to a specific item.
• Ellipses typically circle an area of interest.
• Overlapping Text allows user-defined text to be displayed over the document.
• Highlights place a translucent color over the area of interest.

Redaction annotations can be used to produce an entirely new image document, in which the 
annotation is permanently applied to the document.

Note: The Arrow, Ellipse, and Overlapped Text note types are not available for use on all 
documents. Availability depends on the file format of the document.

AutoFill Keyword Set
AutoFill Keyword Sets are used to automate and standardize data entry. The following apply to 
AutoFill keyword sets:

• An AutoFill Keyword Set is a configuration of Keyword Types that includes a Primary 
Keyword Type and one or more Secondary Keyword Types.

• If an AutoFill Keyword Set is assigned to a Document Type, each set of Keyword 
Values (the Primary Keyword Value and its corresponding Secondary Keyword 
Values) can be considered an instance.

• A value entered into the Primary Keyword Type field during indexing of a document 
triggers the population of the remaining Secondary Keyword Types.

When applied to Document Types, AutoFill Keyword Sets increase the speed and accuracy of 
indexing, especially when indexing large volumes of documents.
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AutoFill Keyword Set Instance
An AutoFill Keyword Set instance is a Primary Keyword Value and its corresponding Secondary 
Keyword Values on a document.

• A document may contain one or more instances, depending upon its configuration.
• Many instances can compose the total AutoFill Keyword Set.

Cascading Data Sets
A Cascading Data Set is a set of Keyword Types where the values available in a drop-down list 
for one Keyword Type vary depending on the value selected from the drop-down list for the 
previous Keyword Type on the document or folder. 

These Keyword Types are arranged to show this parent/child relationship. For example, if State, 
County, and City are listed as Keyword Types and displayed in that order, then the available 
County values depend on the selected State, and the available City values depend on the 
selected County.

Changing a parent Keyword Value does not update the child values that depend on it. For 
example, if you change the State after selecting the County, then the County retains its original 
value and is not automatically updated to reflect the new State.

Note: OnBase cannot validate Keyword lengths for externally filled Keyword data sets, but 
externally filled Keyword data sets must still respect the configured Keyword lengths of the 
Keyword Types in OnBase.

Cross-Reference
A cross-reference is a relationship between a Document Type and one or more other Document 
Type(s). This allows you to view related documents by double-clicking on a word or a document 
region (an account number, for example).

Cross-referencing aids research by making all related documents readily available. For 
example, a vendor invoice could be configured to allow you to double-click the invoice to 
retrieve the corresponding purchase order. The purchase order could then in turn be cross-
referenced with a corresponding requisition form.

HTML-Based Documents
HTML-based documents can be configured with buttons that will initiate a cross-reference or a 
Custom Query.
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Custom Queries
Custom Queries allow you to quickly access your most frequently retrieved documents by 
conducting pre-defined searches.

Document
A document is a piece of information that your organization has chosen to store electronically 
in the system. Letters, contracts, scanned images of contracts, photographs, and email 
messages are all examples of documents.

Documents can be retrieved based on Keyword Values that are associated with the document. 
Storing documents in the system eliminates the need for paper documents. Documents can be 
revised, viewed, annotated, and tracked within the system.

Document Handle
A document handle is a unique number that identifies a document. The document handle is 
assigned to a document when it enters the system.

Document Type
Each document that is brought into the system is assigned to a Document Type. Document 
Types group together documents with similar characteristics. For example, a Document Type 
of AP - PACKING SLIPS might be used to define image files of packing slips. Document Types 
allow you to work with groups of documents rather than individual documents. For example, 
you can limit your document searches to only those documents of a certain Document Type.

Document Type Group
A Document Type Group represents a logical grouping of Document Types in the database.

Document Type Groups allow the system to organize, search for, and locate a document more 
efficiently.

Document Type Groups also provide a means of applying customized archival and security 
characteristics to a group of Document Types. For example, certain User Groups can be 
restricted from accessing a group of Document Types by configuring specific user group 
characteristics. Other characteristics can be configured to restrict the method of retrieval 
available to the Document Type, for example, from the connected database or a third-party 
system.

Document Type Groups contain Document Types that have common characteristics. For 
example, the Document Types of Health Records and Insurance Documents could be grouped 
together under the Document Type Group of Patient Information.
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Envelope
You can place any documents you want into an envelope, regardless of whether they have 
anything in common. When an envelope is opened, it displays a list of documents that have 
been placed in it.

Envelopes provide you with a way to group documents together for easy access. Only the 
envelope’s creator can view that envelope. Envelopes are an alternate way to retrieve 
documents; the documents remain accessible through standard document retrieval methods.

• Because the entry in an envelope is actually a pointer to the document stored in its 
Document Type Group, removing a document from an envelope will not delete the 
document from OnBase.

• Adding documents to envelopes does not duplicate the document in OnBase.
• There is no limit to the amount or type of documents that can be placed in one 

envelope.
• You can add a document to more than one envelope.

External Text Search Definition
The External Text Search function allows you to search for text across text-based documents 
of a selected Document Type. Text-based documents include, but are not limited to, all 
documents with the following formats: 

• Text Report Format
• Dynamic Document
• XML
• AFP
• PCL

See also: Internal Text Search Definition on page 13

File Cabinet 
A file cabinet is the highest organizational unit in a folder hierarchy. The file cabinet helps 
organize folders for easy retrieval. You can place OnBase folders into different cabinets just as 
you would physically with paper folders.
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Dynamic Folder
Dynamic folders allow users to automatically store documents in folders based on Keyword 
Values.

• A dynamic folder contains all documents that match specified Keyword Value criteria 
and Document Types. Whenever the folder is opened, its contents are updated 
automatically.

• Documents that are automatically pulled into a dynamic folder are not physically 
moved. The folder just provides another way for users to easily access the 
document.

• For documents to be added manually to a folder from within OnBase, the Folder Type 
must be static or both static and dynamic.
If a folder is both static and dynamic, documents containing Keyword Values not 
matching the folder Keyword Values can be added manually. If a folder is dynamic 
only, documents cannot be manually placed in or removed from the folder from 
within OnBase.

• You can drag documents from outside of OnBase into a folder.
Documents imported using this method can be automatically indexed with the 
dynamic folder’s Keyword Values, provided that the folder’s Keyword Types also 
exist on the Document Type. You can change these values in the Import Document 
dialog box, but if you change a Keyword Value the folder uses to dynamically store 
the document, then the document will not be dynamically stored in the folder. If the 
folder can contain static contents, then the document will be statically stored in the 
folder.

Static Folder
Static folders allow users to manually add and remove documents as needed for a custom 
organizational hierarchy.

• You can add OnBase documents to a static folder using the OnBase Client, Web 
Client, and Unity Client.

• Adding a document to a folder does not physically move the document. Rather, the 
folder provides another way for users to easily access the document.

• You can drag documents from outside of OnBase into a folder using the OnBase 
Client.
Documents imported using this method can be automatically indexed with the static 
folder’s Keyword Values, provided that the folder’s Keyword Types also exist on the 
Document Type.

• Documents residing in a static folder do not have to share the same Document Type 
or Keyword Values.
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Image Documents
Image documents, such as checks, x-rays, or pictures of real estate can come from several 
native file formats, such as .tiff, .jpg, or .bmp. Once they are imported into the system, they are 
stored in their native file format. If the file does not have a native file format when imported, it 
will be stored as the chosen File Type.

Internal Text Search Definition
The Internal Text Search function allows you to locate search text in an open text-based 
document, including PCL and other plain text documents or ASCII file formats.

See also: External Text Search Definition on page 11.

Keyword Data Sets
Keyword Data Sets are used to limit the values that appear in a Keyword Type drop-down select 
list. When a Keyword Data Set has been configured, users will be able to select values 
contained in the Keyword Data Set when indexing documents with that Keyword Type. This 
helps users maintain consistency when indexing documents.

Note: OnBase cannot validate Keyword lengths for externally filled Keyword data sets, but 
externally filled Keyword data sets must still respect the configured Keyword lengths of the 
Keyword Types in OnBase.

Keyword Types and Keyword Values
Keyword Types and Keyword Values provide the ability to assign descriptions to documents. 
Effective indexing and classification of Document Types is essential for efficient document 
management and retrieval.

The system administrator assigns all Keyword Types to documents in your system.

Keyword Types
Every Document Type can be configured to have associated Keyword Types. For example, a 
Check Images Document Type may have Keyword Types such as Account #, Check Serial #, 
and Amount assigned to it.

A Keyword Type may be used for many different types of documents. For example, you can use 
a Keyword Type Amount for almost any Document Type for which you need to store an amount.
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The system administrator sets up Keyword Types for each Document Type.

Note: Some Keywords Types are only available to the user upon indexing, re-indexing, Custom 
Queries, or Workflow. See your system administrator for details regarding Keyword Display 
Options.

Note: System Keyword Types supplied by OnBase cannot be deleted.

Keyword Values
When a document is indexed, its Keyword Types are assigned Keyword Values. A Keyword 
Value is the specific value that helps to identify documents in the system.

• Some Keyword Types require their values to be a specific format, such as a date, a 
number, or a currency value.

Note: Currency keyword values are limited to 15 characters in length.

• Some Keyword Types will have default values assigned to them, so when you import 
a document into the system, the default value is displayed in the Keyword Type field.

• Some Keyword Values display automatically on an open document.

Note: Depending on your system’s configuration, you may be able to change the currency 
format for Keyword Types that use specific currency formats. If a Keyword Type uses specific 
currency formatting, a currency button is displayed to the right of the Keyword Type field. Click 
the button to display a list of available currency formats.

Note: Depending on your system’s configuration, certain Keyword Types may be masked or 
appear as read-only at the Document Type level.

Note: Depending on your system’s configuration, certain Keyword Types may be subject to 
value validation rules.

Keyword Type Groups
A Keyword Type Group is a collection of Keyword Types assigned as a whole to a Document 
Type or Folder Type.

Each Keyword Type in the Keyword Type Group can have only one instance (unlike Keywords 
that are not part of a Keyword Type Group, which can contain multiple instances with different 
values). To allow multiple instances of the Keyword Types contained within a Keyword Type 
Group, the Keyword Type Group must be a Multi-Instance Keyword Type Group. Multi-Instance 
Keyword Type Groups can contain multiple instances of a Keyword Type Group, much like there 
can be multiple instances of a standard Keyword. Each instance of a Multi-Instance Keyword 
Type Group contains its own instances of the Keyword Types contained within the group, which 
can have different values between Keyword Type Groups.
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For information about using Keyword Type Groups on folders, see the section on working with 
folder keywords.

See your system administrator for information regarding your system setup related to Keyword 
Types.

Multi-Instance Keyword Type Groups
A Multi-Instance Keyword Type Group can be duplicated on a document so that one or more 
Keyword Type Groups can be created for the document.

A Multi-Instance Keyword Type Group respects the relationships among Keyword Types within 
a Keyword Type Group. This is especially important when documents are indexed with more 
than one record of information.

Multi-Instance Keyword Type Groups are displayed in an expanded state when OnBase is in an 
indexing mode. Multi-Instance Keyword Type Groups are also displayed in an expanded state 
when creating a new folder in the OnBase Client. Other instances can be configured to display 
the Keyword Values in the Keyword Type Groups either expanded or collapsed.

Keyword Type Masking
Keyword Type masking sets a specific format for a Keyword Type which affects the way you 
work with Keyword Values in OnBase.

Keyword Type masking serves two purposes. The first is to set a specific format for a Keyword 
Type, allowing for more efficient indexing and retrieval. Once a mask is defined for a Keyword 
Type, OnBase will validate that the Keyword Value entered matches the mask for that Keyword 
Type. If the Keyword Value does not match the mask for that Keyword Type, OnBase will 
display an error message stating that the value is invalid.

Keyword Type masking can also be used for security purposes when displaying certain 
alphanumeric Keyword Types. When this kind of Keyword Type mask is configured, a portion of 
the alphanumeric Keyword Type, or the entire alphanumeric Keyword Type, is hidden by the 
configured mask. For example, a social security number Keyword Type is configured so all but 
the last four digits of each social security number are masked by the * character. In this 
example, a user viewing a social security number in OnBase would see *******6789 instead of 
the actual Keyword Value stored in OnBase, 123-45-6789.

Note
A note is an explanation or instruction that can be attached to text or image documents. Notes 
are used to draw attention to content, clarify or explain items, or identify the current state of 
the document.
OnBase 18
©2018 Hyland Software, Inc.

9



Unity Client
Exposure
You can place a note on a text or image document. Notes remain associated with the page on 
which they were created, unless they were otherwise configured. For example, if the note was 
created on page 1 of a two-page document, the note icon appears only on page 1.

Caution: If an image document, or page is dragged-and-dropped into another image document, 
then all notes associated with the first document/page are lost. However, if an image 
document is appended to an existing image document during indexing via matching Keyword 
Values, then any notes on that document/page are retained once it is appended to the existing 
document.

Notes are displayed on all renditions of a document.

Note: A note has a maximum character length of 250 characters. If a note appears truncated, it 
is because the note has been configured to use variable text. The variable text is causing the 
note to exceed the maximum character length of 250 characters. If you are experiencing 
truncated notes, contact your system administrator.

OLE Documents
OLE is short for Object Linking and Embedding, a standard that allows documents created with 
one application to be linked or embedded in another application. OLE documents, such as 
Microsoft Word documents, retain their original format and links to the applications that 
created them.

When you open an OLE document in OnBase, the document is displayed in a viewer based on 
the document’s source application. If the Open in Alternate Viewer button is available, you can 
view documents using the Office Business Application. Note that if you are viewing an older 
document (.doc instead of .docx), the document is read-only.

The document’s right-click options are specific to the source application. OnBase options can 
be accessed by right-clicking the document in a Document Search Results list.

For open OLE documents, you can access OnBase options by right-clicking the document’s 
information bar.
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When you have modified a revisable OLE document, upon saving in the source application, a 
dialog box is displayed asking whether you want to save the changes as a revision of the 
existing document, or create a new document.

Select the desired option, or click Cancel to exit the dialog box.

Overlay
An Overlay is an image document that can be displayed, printed, or faxed over a text or image 
document. For example, text documents containing purchase order information might use an 
image of a purchase order form as an overlay.

Staples
Documents can be attached to each other using staples. In most cases, staples are used to 
associate documents that have an established logical relationship. For example, documents 
related to a single customer may be stapled together or an invoice and its associated purchase 
order may be stapled together. Logical relationships between documents can be established by 
the user but are not required by OnBase to staple documents.

When documents are stapled, a Staple icon is placed on each document. Staple icons can be 
used to directly open associated documents. Since Staples only create a link between 
documents, the stapled documents remain separate.

Staple icons can also be used to open the Staple’s note window, which displays creation 
information and allows the addition of customized text.

Tip: The Staple window can also be viewed in the Notes list on the Document Information 
Panel of an open document.

When using Staples, consider the following:
• The Staple icon and Staple window are placed on the primary document, and a Back 

Staple icon and Back Staple window are placed on secondary documents.
• For documents consisting of multiple revisions, Staple icons appear on all revisions. 

When viewing a stapled document from any revision of an open document, the latest 
available revision of the stapled document is displayed.

• When viewing a stapled document from its associated document, the stapled 
document is opened to the page on which the Staple was placed.
OnBase 18
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• When a Staple on a document is deleted, the corresponding Staple on the stapled 
document is not deleted. The corresponding Staple on the stapled document must be 
deleted separately.

• When printing a document, Staple icons will not be printed when selecting Note Icon/
Annotation on Document in the Print Settings.

Text Documents
Text-based documents have special features available for selecting or searching text. 
Examples of text-based documents in the system are ASCII files, PCL documents, text 
renditions of image documents, text-based documents such as checking statements that have 
been imported into the system, and system reports or verification reports created during 
processing.

All text documents in the system are read-only, thus the contents of the text documents 
themselves can never be modified or deleted. The associated attributes however, such as 
Keyword Values, notes, file types or Document Types, can be modified by a user with the 
appropriate rights. Users with Delete document rights can delete the whole text document, not 
delete its contents.

Text documents have specific buttons, which are different from the buttons and options 
available to image documents.

User
Each person using the system is known as a user. When a user logs onto the system, he or she 
supplies a unique user name and a password.

This allows greater flexibility for system operation. For example, each user can configure his or 
her workstation settings with personal preferences.

User Group
A system User Group is similar in concept to a user group on your network. User Groups are 
granted rights to access system functionality.

Access to various resources, such as scan queues and Document Types are controlled by User 
Group rights. A user can be a member of multiple User Groups, in which case the user has 
access to the sum of all functionality granted for each group.

User Groups provide easier administration because new users inherit the access rights of the 
group to which they are assigned.
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General Functionality
The following sections describe general functionality available in the OnBase Unity Client. For 
specific functionality regarding other license-based modules, see their respective help files.

Opening the Unity Client

The Unity Client can be opened by double-clicking the Unity Client executable or a desktop 
shortcut to it.

Depending on your deployment, you can access it by entering the URL path to the deployment 
application or by clicking the shortcut to it, if one has been created. When the module is 
deployed and activated, you are prompted for your logon credentials. After the application has 
been deployed the first time, it can also be accessed from the Windows Start | All Programs | 
Hyland menu.

When the Unity Client is installed by deploying the installation package to your machine using 
the URL or UNC path provided to you:

1. Launch the deployment package by opening the URL or UNC path to the 
UnityClient<package>.application file, where <package> is the name of your specific 
deployment package.

2. If the Publisher cannot be verified dialog box is displayed, confirm that the Name is 
Hyland Unity Client and the From matches the path and file name you were provided.

3. Click Install.
4. The Unity Client is installed. After installation, the logon dialog box is displayed.

Note: When the installation package is modified by your system administrator, you are 
prompted to install a new version of the Unity Client.

Logging On
Base 18
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After you launch the module, the login dialog box is displayed.

1. Enter the required information:

2. Depending on your configuration and the module being used, the Remember me on this 
computer check box may be displayed. Selecting this check box stores your login 
credentials. The OnBase user name and password you provide will be used for 
subsequent login attempts.

Note: If you store your login credentials using the Remember me on this computer check box, 
clicking the Application button and selecting Log Out clears these stored credentials. You will 
be required to provide your OnBase user name and password the next time you log on.

3. Click Login to log on, or click Cancel to close the dialog without logging on.
4. If the Application Server that you are connecting to is initializing, an initializing message 

is displayed until the Application Server is ready:
5. If any System Notifications are available, they are displayed after login. The Effective 

Date is shown above each message. Click OK when you are finished reading the 
notifications.

After logging on to OnBase, these same login credentials may be reused when opening 
subsequent Unity-based modules. This allows you to move between modules without needing 
to login. When the same login credentials are being reused, the OnBase login dialog box is 
displayed while you are automatically logged on.

Note: Login credentials are only reused when Unity-based modules share the same service 
path and data source configuration.

Field Description

Select the data source to connect to from the drop-down list.

Note: This field is displayed only when multiple data sources are available.

Type your OnBase user name.

Type your OnBase password.
OnBase 18
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Change Password
Depending on how your system is configured, you may be prompted to change your OnBase 
login password when logging on. You also may have the ability to change your password after 
logging on.

1. Type your current password in the Old Password field. 
All keystrokes display as dots to maintain security.

2. Type your new password in the New Password field. 
3. Re-type your new password in the Verify New Password field. 
4. Click OK to save. Click Cancel to exit without changing your password.
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The Unity Client Window

The OnBase Unity Client window has three primary regions: Layout, Ribbon, and Task Pane. The 
following screen shot displays each region.

The letters displayed in the screen shot above correspond to the letters in the following table, 
where each region of the screen is explained in detail.

Region Description

A | Tabs You can use tabs to navigate between different layouts in the Unity Client. Tabs 
are displayed at the top of the Unity Client window. 
OnBase 18
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Windows within the Unity Client can be resized and repositioned as needed. Your adjustments 
are persisted across OnBase sessions.

Home Tab
The Home tab is displayed after logging on to OnBase:

This tab provides access to common OnBase operations, such as Document Retrieval and 
Custom Queries. Depending on your licensing, the Home tab may also contain buttons to 
access other OnBase modules such as Workflow.

B | Ribbon The contextual ribbon displays available user actions based on the currently 
displayed layout. A ribbon is displayed by clicking the corresponding tab. Each 
ribbon is divided into ribbon groups.
In the above screen shot, the Home tab is displayed. This tab is available after 
logging on. The Home tab is divided into ribbon groups. Ribbon groups are 
categories of user actions.

Note: You can minimize the ribbon by right-clicking the ribbon and selecting 
Minimize the Ribbon. After minimizing the ribbon, you can maximize it by 
right-clicking and selecting this same option. Your selection is persisted across 
OnBase sessions.

Note: Some items on the ribbon may display a notification icon. This is to 
indicate that there are attachments or new items associated with the action on 
which it is displayed.

C | Layout Each screen in the OnBase Unity Client is a layout. Default layouts are included 
with the OnBase Unity Client.

D | Task Pane The task pane is displayed dynamically, based on a user action. For example, 
clicking the Keywords button displays the Add/Modify Keywords pane. 
Typically, the task pane is used to display some information that can be 
referenced briefly and then closed. It is also used for tasks such as adding 
documents to an envelope, displaying a document’s keywords, notes, and 
cross-references, or managing Favorites and query history.

Region Description
OnBase 18
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When the Home tab is selected, the layout that you have configured as your Home Page is 
displayed. The default layout that is displayed is the Home layout. This layout is described in 
the following section.

Home Layout
Depending on your configuration, the Home layout may be displayed after logging on.

You can return to the Home layout at any time by clicking Home on the Home tab. If you 
configured a different layout to be your Home layout, you can return to the Home layout by 
clicking Home on the Home tab and selecting Reset Home Page.

The Home layout is divided into three panes, described in the following sections.
OnBase 18
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Web Sites
The Web Sites pane contains a list of web sites. When you select a web site from the list, it is 
displayed in the corresponding pane. Web sites can be opened in a new browser window by 
right-clicking and selecting Open in New Window.

To add or remove web sites from this list, click the gear icon in the Web Sites pane:

Click Add New to add a new web site to the list. The full website URL is required (including 
http:// or https://). For example, http://www.example.com.

Select an existing site and click Remove to remove a web site from the list.
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RSS Ticker
The RSS Ticker pane displays information retrieved from the RSS or Atom feeds to which you 
are subscribed. When you select an item from the list, it is displayed in the corresponding pane:

You can use the following buttons in the RSS Ticker pane:

To add or remove web sites from this list, click the following icon in the RSS Ticker pane:

Type the address of a new RSS or Atom feed in the text field and click Add to add a new RSS or 
Atom feed. Select an existing RSS or Atom feed and click Remove to remove an RSS or Atom 
feed.

Button Description

Click to move forward in your RSS or Atom feeds.

Click to pause the RSS Ticker. Click the following button to resume:

Click to move backward in your RSS or Atom feeds.
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To modify the frequency with which your RSS or Atom feeds are updated, select an update 
frequency (in minutes) from the Update Frequency (Minutes) drop-down list.

To modify the number of RSS or Atom feed items that are displayed, select a number from the 
Number of Feed Items drop-down list.

File Menu

The File menu is used to open previously used layouts and access administrative functionality. 
Depending on your configuration and rights, the File menu may contain:

Button Description

Open In New Window Click to open the current layout in a new window.

Troubleshooting Click to select from the following:
• Troubleshooting - Click to view the Troubleshooting layout.
• Request Profile Diagram - Click to show the Request Profile 

Diagram layout.

Note: See the Troubleshooting Within the Unity Client topic in the 
Unity Client help files for more information.

User Options Click to configure user options in the User Options dialog box.

Administration This menu displays rights-based, permissions-based, and license-
based administration and configuration modules.

• User Administration - Click to perform user administration from 
the User Administration layout.

Note: See the User Administration topic in the Unity Client help files 
for more information.

• Manage Locks - Click to manage document, Disk Group, or 
process locks using the Manage Locks dialog box.

Note: See the Managing Locks topic in the Unity Client help files for 
more information.

Change Password Click to change your OnBase password.

Note: See the Change Password topic in the Unity Client help files 
for more information.

Recent Activities Select one of your recent activities from the list to return to that 
layout.
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Note: The ADMINISTRATOR user, MANAGER user, and users that are part of a User Group with 
the Usergroup Security or User Configuration Configuration Right also have access to the 
OnBase Community button. Click this button to open the Hyland Community web site in your 
web browser.

Help Click to select from the following:
• Help - Click to open the Unity Client help files.
• About OnBase - Click to open the About screen. Here you can 

find the version of OnBase you are running and the associated 
Copyright information. 
From this screen, you can also view Connection Information 
such as FriendlyName, Data Source, and the App Server URL.

Log Out Click to log off and log back in as a different user.
If you stored your log on credentials using the Remember me on 
this computer check box, clicking this button clears these stored 
credentials. You will be required to enter your OnBase user name and 
password the next time you log on.

Exit OnBase / Close 
Window

The appearance of the Exit OnBase or Close Window buttons 
depends on whether or not Service Mode is enabled.
While in Service Mode, click Close Window to close the Unity Client 
window.

Note: Closing the main client window while in Service Mode 
closes the embedded document viewer. You will be prompted to 
save any changes before closing.

While in Service Mode, click Exit OnBase to log off and exit the 
OnBase Unity Client.

Re-launch Client The Re-launch Client button is only available in Service Mode.
Click Re-launch Client to restart the client. The client is closed, 
updates are applied, and the client is then reopened. 

Button Description
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Accessing Keyboard Shortcuts
Keyboard shortcuts allow you to quickly change layouts and perform actions without using your 
mouse. To discover an action’s shortcut, use the Alt key. For example, the following steps 
describe how to learn shortcuts for tasks available from the Home tab.

1. On the Home tab, press Alt. Shortcut keys are displayed for the ribbon tabs and File 
menu:

2. Press F to access the File menu and display its shortcut keys.

Favorites
The Favorites group is used to open and configure your home layout and favorites:

The following buttons are available:

Button Description

Home Click to go to your Home layout.
For more information, see Using Your Home Page on page 24.
When you click the bottom part of this button, the following options are available:

• Make this layout my Home Page - Click to make the currently displayed layout 
your Home layout. 

• Reset Home Page - Click to reset the layout that is displayed as your Home 
layout to the default.
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Using Your Home Page
The Unity Client Home Page is the layout that is automatically shown upon opening the Unity 
Client. The Home Page can be changed to suit your needs.

To access your Home layout, click the Home button:

Setting Your Home Page
Most layouts, including designated WorkView Applications, can be made your Home layout. 
Your Home Page selection is saved in the database.

To set your Home Page:

1. Navigate to the desired layout.
2. With the layout active and displayed, click the Home tab.
3. Click the bottom portion of the Home button.

Personal 
Page

Click to go to your Personal Page. 
For more information, see Personal Page on page 28.
When you click the bottom part of this button, the following option is available:

• Add this layout to my Personal Page. - Click to add a Unity Client layout to 
your Personal Page.

Favorites Click to display Favorite layouts and the following options:
• Manage my favorites - Click to open the Manage my favorites task pane.
• Add this layout to my favorites - Click to add the current layout to your 

favorites.
• Layouts already added as favorites

For more information on Favorites, see Using Your Favorites on page 25.

Button Description
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4. Select Make this layout my Home Page.

The layout will now be displayed when opening the Unity Client or when the Home 
button is clicked.

Resetting Your Home Page
Your Home Page can be reset to the default layout set by your system administrator. To reset 
your home page:

1. Click the bottom portion of the Home button.
2. Select Reset Home Page.

Using Your Favorites
Favorites give you the ability to save frequently used layouts in an easily-accessible area in the 
ribbon menu. Clicking the Favorites button displays your favorite layouts in alphabetical order. 
This button persists across all layouts that use the ribbon menu.
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Adding a Favorite
To add a layout to your Favorites:

1. Navigate to the desired layout. Ensure that the layout you wish to favorite is in the 
current window.

2. Click Favorites | Add this layout to my favorites. Your selected favorites are saved in 
the database.

Note: If a layout has already been added to your Favorites, the Add this layout to my favorites 
button will be changed to say This layout is already in my favorites.

Opening a Favorite
Favorite layouts can be opened to two locations: in the current window or in a new window.

To open a Favorite in the current window, click anywhere on the layout name:

To open a Favorite in a new window, click the Open in New Window button:
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Managing Your Favorites
Clicking the Manage my favorites option opens the Manage my favorites task pane:

This task pane lists the layouts that have previously been defined as favorites. These layouts 
are displayed in alphabetical order. When a favorite layout is selected, the Delete and Rename 
buttons are available.

Renaming Favorites
Upon adding a layout to your Favorites, a default name is given to the layout. This name can be 
changed to better suit your needs. To rename a Favorite:

1. Click Favorites | Manage my favorites.
2. Select a Favorite and click Rename.
3. The name is now editable:

Change the name of the Favorite layout as needed.
4. Press Enter to save the new name.

Deleting Favorites
Layouts can be removed from your Favorites by deleting them. To delete a favorite:

1. Click Favorites | Manage my favorites.
2. Select a Favorite and click Delete.
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3. Click Yes when asked if you would like to remove the Favorite:

Personal Page

Using Your Personal Page
Your Personal Page gives you the ability to access shortcuts and frequently used features from 
one single page:

Note: The Personal Page Configuration privilege is needed to add, edit, and delete items on 
the Personal Page. For additional information, contact your system administrator.
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OnBase features that you have added to your Personal Page are represented as tiles. Numeric 
values in the bottom right corner represent the number of items in the tile. For example, in the 
above screen shot, the Browse Folders and File Cabinets tile contains 5 forms. Tiles are also 
represented by different colors, which are customizable.

• You can move tiles by clicking and dragging them.
• Some tiles can be refreshed by clicking the Refresh icon on the tile:

• To rename an existing tile, right-click it and select Rename Tile. Enter a new name 
for the tile and click OK.

• To change a tile’s color, right-click it and select Pick Color. A box containing color 
options is displayed. Click to select the color of your choice. The tile will now display 
your selected color.

To search tiles, type a term in the Search Tiles field. Tiles that contain terms matching your 
search criteria remain in focus with matching terms displayed. Tiles that do not contain terms 
matching your search criteria are faded out and only tile contents that match your search 
criteria are visible:

To clear search criteria, click Clear.
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Administrative Tiles
Tiles may be assigned to you by administrators. Required tiles will be displayed in their own 
section at the top of your Personal Page. The tiles that you add or modify yourself are 
displayed in the My Tiles group. Changes made by administrators to the enforced tiles will be 
shown in your Personal Page upon refreshing the layout.

Editing Administrator Suggested Tiles
Administrator Suggested Tiles can be edited or deleted like any other tile on the Personal Page.

Changing the name, title, description, and color of the tile will retain the connection to the 
original Administrator Suggested Tile. When the administrator updates the tile, the tile on your 
Personal Page will be updated accordingly. However, if you change the configuration of a tile 
(such as when you change the search criteria for a Custom Query Results tile) or delete the tile, 
the connection to the original Administrator Suggested Tile is broken. When an administrator 
updates that tile, you will receive a new tile with the new configuration and, if it hasn’t been 
deleted, the tile you originally edited will remain on your Personal Page.

Changes you make to Administrator Suggested Tiles on your Personal Page do not impact 
other users.

Adding Items to Your Personal Page
The following can be added to your Personal Page:

• OnBase Layouts
• Documents
• Folders
• Custom Queries
• Custom Query Results
• Document Knowledge Transfer Reading Groups
• Document Tracking folders and folder lists
• E-Forms/Unity Forms
• Full Text Search (Full-Text Indexing Server for Autonomy IDOL)
• Workflow queues (including load balanced queues)
• Workflow Combined Inboxes
• Internal Mailbox (with a list of unread messages)
• Individual Document Templates
• WorkView Applications, Filters, and Objects
• Import Tiles with specified Document Types
• Dashboards and Dashboard items

Generally, individual items and folders can be added to the Personal Page by right-clicking the 
item you wish to add and selecting the Add To Personal Page option. 
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See the following sections for information on adding different types of items to your Personal 
Page.

Note: Non-document Workflow queues cannot be added to your Personal Page.

Note: Document Knowledge Transfer Reading Group tiles will only show up to 50 documents. 
Tiles may show fewer than 50 documents depending on filter settings. To view all documents, 
click the Document Knowledge Transfer Reading Group tile header.

Note: Administrative layouts, which are available from the File menu, are not supported for 
addition to your Personal Page.

Note: Items that have been deleted are not automatically removed from your Personal Page. To 
manually remove Personal Page tiles, see Removing Personal Page Tiles on page 35.

Adding Layouts to Your Personal Page
To add a Layout to your Personal Page:

1. With the layout you wish to add to your Personal Page displayed, navigate to the Home 
tab and click the bottom part of the Personal Page button located in the Favorites 
group.

2. Click Add this layout to my Personal Page.

Adding Custom Queries to Your Personal Page
To add a Custom Query Results tile to your Personal Page, select Add To Personal Page from 
the tabbed results page drop-down menu:
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Adding Documents to Your Personal Page
To add an open Document to your Personal Page:

1. Click the Send To button in the Actions group on the Document tab.

2. From the menu, select My Personal Page.
3. Documents in a hit list can be added to the Personal Page by right-clicking and selecting

Adding Import Tiles with Specified Document Types to Your Personal Page
To add an Import layout tile with a Document Type to your Personal Page:

1. In the Create ribbon group, click the Import button.

2. The Import layout is displayed. Select a Document Type in the Import pane.

3. After a Document Type has been selected, navigate to the Home tab.
4. From the Favorite ribbon group, click the bottom portion of the Personal Page button.

5. Select Add this layout to my Personal Page.
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6. The tile is added to your Personal Page. The name of the tile reflects the Document 
Type specified.

Note: To add an Import tile without a specified Document Type, add the layout to your Personal 
Page before selecting a Document Type.

Adding WorkView Filters and Objects to Your Personal Page
WorkView filters and objects can be added to the Personal Page. The same filter or object can 
be added to the Personal Page multiple times. Depending on layout view, there are multiple 
ways to add filters or objects to your Personal Page.

Note: WorkView filter tiles will only show 50 results.

To add a WorkView filter to your Personal Page:

With the filter you would like to add to the Personal Page open, click Add to Personal Page in 
the Favorites ribbon menu group. 

The bottom part of the button also allows you to add the filter to your Personal Page by clicking 
Add Filter to Personal Page. Filters can also be added to the Personal page by right-clicking 
within the filter and selecting Add to Personal Page | Add Filter to Personal Page.

If any objects are selected, the Add Object to Personal Page portion of the Add to Personal 
Page button is available. Multiple objects can be added at once. Objects can also be added 
from the filter view by selecting the desired object(s) and selecting Add to Personal Page | Add 
Object to Personal Page from the right click menu. 

Note: If more than five objects are selected for addition to the Personal Page, you will be asked 
to confirm the action.
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To add an open WorkView object to your Personal Page: 

1. In an open object, click the Add to button in the Actions ribbon menu group.

2. Select Add to Personal Page.
3. The tile is added to your Personal Page.

Opening A Layout or an Item from the Personal Page
To open a layout, you may either click the tile, or area of the tile. The feature is displayed in a 
new window.

To open an item in a tile, click the item in the list. The item is displayed in a new window.

Note: Clicking the title on a list tile opens the layout associated with the tile, not the items 
contained in that tile.

Managing and Configuring Personal Page Tiles
To configure settings for a Personal Page Tile:

1. Click the Configure button on the tile you want to configure:

2. The General Options dialog box is displayed. The following configurable options are 
available:

When you are finished configuring the tile, click Save to save your changes. Click 
Cancel to cancel.

Option Tab Option Description

General Title Modify the title that is displayed on the tile.

Description Modify the description that is displayed on the tile.

Color Modify the color of the tile displayed on the Personal 
Page.
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The following sections describe additional options that can be configured for some Personal 
Page tiles:

• Custom Query Results Tiles on page 35

Custom Query Results Tiles
The following additional items can be configured on the Custom Query Results tile 
configuration screen:

Removing Personal Page Tiles
You can remove tiles from your Personal Page if you no longer want the tile, if you no longer 
have sufficient rights to the configured object, or if the configured object no longer exists. To 
remove a tile from your Personal Page, right-click it and select Delete Tile. Click Yes to remove 
the tile. Click No to cancel and keep the tile.

Panes
Some layouts in OnBase consists of one or more panes. An example of a pane is shown below:

Option Tab Description

Custom Query This screen allows you to modify the form field values that are used when 
returning the Custom Query result displayed on the tile. You can add, modify, 
or remove search terms.

Note: You can include additional instances of a Keyword Type, or use 
Wildcard or Boolean operators to narrow the search.

Note: To modify the form field values of an HTML Form Custom Query tile, a 
new tile with the updated form field values must be created.

When you are finished modifying form field values, click Search to run the 
Custom Query and validate the results. Click OK to confirm the results and 
return to your Personal Page.
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To minimize a pane, click the minimize button:

To maximize a pane that has been minimized, click the maximize button:

Open in New Window
Multiple layouts can be open at the same time by opening additional layouts in new windows. 
To open the current layout in a new window, select File | Open in New Window.

The layout is displayed in a new window:

Note: The Home tab is not displayed in any new windows that you open. It is retained in the 
original window.

Data Lists
Many layouts within the Unity Client contain lists to display data. Data lists can be customized 
to display information in ways that allow you to complete tasks more efficiently. Multiple items 
in data lists can be selected at the same time, data list columns can be reordered and stacked, 
and data list items can be grouped, sorted, and filtered.

Modifications to data lists are automatically saved to the OnBase database and persisted 
across sessions. To remove data list modifications and return to the default display, right-click 
in the data list and select Clear Customizations.

Selecting Multiple Items
Many data lists within the Unity Client support selecting multiple data list items using the 
following keyboard shortcuts:

Keyboard Shortcut Description

Ctrl Hold and click to select multiple items in a list.

Ctrl + A Press to select all items in a list.
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To select multiple consecutive items in a list, click an item and drag up or down.

Reordering and Stacking Columns
Data list columns within the Unity Client can be reordered or stacked.

To reorder columns:

1. Click on a column header and drag it to its new location:

2. Release the mouse button. The column header is displayed in its new location:

Ctrl + Shift + End Press to select all items below the selected item in a list, including the 
selected item.

Ctrl + Shift + Home Press to select all items above the selected item in a list, including the 
selected item.

Keyboard Shortcut Description
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To stack columns:

1. Click on a column header and drag it onto the header of the column with which you want 
to stack it:

2. Release the mouse button. The columns’ contents are stacked:

Grouping
Data lists within the Unity Client support multi-level grouping. Grouping is done client-side and 
does not incur a round trip to the database.
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To group a data list:

1. Click the bar above the column headers:

2. The group by area is displayed:
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3. Select a column header and drag it into the group by area to group the data list by that 
column:

4. Continue selecting column headers and dragging them into the group by area to group 
the data list further.

Sorting
Data lists within the Unity Client can be sorted in ascending or descending order by column. 
Sorting is done client-side and does not incur a round trip to the database.

To sort a data list by values in a column in ascending order, click on the column header. To sort 
the data list by the values in descending order, click the column header again.

Filtering
Data lists within the Unity Client can be filtered using operators and drop-down select list 
options and by creating custom filters.

The following Unity Client layouts support filtering:
• Custom Queries
• Document History
• Document Retrieval
• Mailbox
• Users

Note: If you apply filtering to a Search Results list, the search results are updated to indicate 
the number of matching documents in the following format: [number of matching documents] 
Document(s) matched of [number of documents returned by the original query] found.

When working with filters, the following right-click options are available:

Option Description

Clear Customizations Select to remove column filtering and return to the default display.

Toggle Column Filters Select to show or hide column filtering options in the layout.
When you hide filtering options, applied column filters are removed.
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Operators
Column filter operators are used to define how to apply a filter to a data list with regard to the 
value specified in the column’s filter drop-down select list.

Operators are available by clicking the operator button:

Depending on the type of value the column contains, the following operators may be available:

Clear All Column Filters Select to clear all applied column filters.

Operator Description

Equals Values equal to the value specified in the corresponding drop-down 
select list are displayed.

Not equals Values not equal to the value specified in the corresponding drop-down 
select list are displayed.

Less than Values less than the value specified in the corresponding drop-down 
select list are displayed.

Less than or equal to Values less than or equal to the value specified in the corresponding 
drop-down select list are displayed.

Greater than Values greater than the value specified in the corresponding drop-down 
select list are displayed.

Greater than or equal 
to

Values greater than or equal to the value specified in the corresponding 
drop-down select list are displayed.

Contains Any values containing the value specified in the corresponding drop-
down select list are displayed.

Does Not Contain Any values containing the value specified in the corresponding drop-
down select list are not displayed.

Top The top number of values specified in the corresponding drop-down 
select list are displayed.
For example, when Top is selected and 2 is entered in the ID column 
drop-down select list in the Users layout, the two most recently created 
users are displayed.

Option Description
OnBase 18
©2018 Hyland Software, Inc.

41



Unity Client
Usage
Drop-Down Select Lists
In conjunction with column filter operators, column filter drop-down select lists are used to 
select or enter a value that defines how to apply a filter to a data list.

Bottom The bottom number of values specified in the corresponding drop-down 
select list are displayed.
For example, when Bottom is selected and 2 is entered in the ID column 
drop-down select list in the Users layout, the two users created first 
(ADMINISTRATOR and MANAGER) are displayed.

Top percentile Values in the top percentile of the value specified in the corresponding 
drop-down select list are displayed.

Bottom percentile Values in the bottom percentile of the value specified in the 
corresponding drop-down select list are displayed.

Like (wildcards) Values like (including wildcards) the value specified in the 
corresponding drop-down select list are displayed.

Not like (wildcards) Values that are not like the value (including wildcards) specified in the 
corresponding drop-down select list are displayed.

Match (regular 
expression)

Values that match (including regular expression) the value specified in 
the corresponding drop-down select list are displayed.
For example, typing A*M in the Name column in the Users layout 
displays the MANAGER and ADMINISTRATOR user names, because both 
user names contain the letters A and M.

Does not match 
(regular expression)

Values that do not match (including regular expression) the value 
specified in the corresponding drop-down select list are displayed.

Starts with Values that start with the value specified in the corresponding drop-
down select list are displayed.

Does not start with Values that do not start with the value specified in the corresponding 
drop-down select list are displayed.

Ends with Values that end with the value specified in the corresponding drop-down 
select list are displayed.

Does not end with Values that do not end with the value specified in the corresponding 
drop-down select list are displayed.

In This option is intended for use with Reporting Dashboards. For more 
information, see the Reporting Dashboards module reference guide.

Not In This option is intended for use with Reporting Dashboards. For more 
information, see the Reporting Dashboards module reference guide.

Operator Description
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To select an option from a column’s drop-down select list, click the drop-down arrow:

To enter a value in the drop-down select list, click to the left of the drop-down arrow and enter 
the value. The data list is filtered as you type.

The following options are available for selection from all drop-down select lists:

Each column’s drop-down select list also contains all the unique values in the data list for that 
column. For example, in a Document Search Results list, the drop-down select list for the Type 
column lists the Document Types of the documents found during the search:

In addition to unique values in the data list, drop-down select lists may contain comparative or 
general options to filter by non-specific values. For example, the drop-down select list of 
columns containing numerical or date values may include comparative options, such as Above 
Average and Bottom 10. When a data list is filtered by these options, the only list items 
displayed are those whose value in the filtered column meets the criteria when compared with 
the values in that column for all items in the data list, regardless of filtering applied to other 
columns.

Note: When comparative filter options are selected for columns with date values, Top refers to 
the most recent date and Bottom refers to the oldest date.

Option Description

(Custom) The Custom Filter Selection dialog box is opened, and a custom filter can be 
created.
For more information, see Custom Filter Selection on page 44.

(Blanks) Blank values for the column are displayed.

(NonBlanks) Any non-blank values for the column are displayed.
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For columns containing date values, the drop-down select list filter options may also contain 
relative and general options. For example, options such as Yesterday and Next Month are 
relative to the current date. Options such as Quarter 1 and January are not relative to the 
current date and will display list items that meet the criteria in any year.

All filtering applied to a data list column can be cleared by clicking the following button:

Custom Filter Selection
The Custom Filter Selection dialog box is used to create a custom filter.

To create a custom filter for a data list column:

1. Select (Custom) from the drop-down select list. The Custom Filter Selection dialog box 
is displayed:

2. Click Add Condition. A row is added to the conditions list.
3. Select an operator from the Operator drop-down select list.
4. In the Operand field, enter a value or select a value from the drop-down select list.
5. Repeat steps 2 through 4 to add additional conditions.

To remove a condition, select the row and click Remove Condition(s).
6. To group multiple conditions, select the rows and perform one of the following:

• Click ‘And’ Group to use ‘And’ as the logical operator for the group.
• Click ‘Or’ Group to use ‘Or’ as the logical operator for the group.

To ungroup conditions, select the rows and click Ungroup.
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7. If necessary, change the logical operator for a row or group using one of the following 
methods:
• Click the following area of the row or group:

• Select the row or group and click Toggle.

8. Click OK to close the Custom Filter Selection dialog box and apply the custom filter to 
the data list.
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User Options

Overview
In the User Options dialog box, you can customize the appearance and system functionality for 
each user. Since settings are assigned per user, they remain in effect at any workstation.

To access the User Options dialog box, click the File menu and select User Options.

The User Options dialog box displays with the General tab selected by default.

You can save user-specific settings on each of the following tabs:
• General: defines Unity Client display features and general behavior.
• Document: defines document display options.
• Document Import: defines document upload options.
• Local Data: allows you to manage local data options.
• Printing: defines printing options.
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• Retrieval Date Options: sets the default date for retrieving documents.
• Service Mode: defines Service Mode options. This tab is only displayed when the 

Unity Client is configured to run in Service Mode.

Note: Some User Options may be enforced by an Administrator with a User Option Policy. 
Options that can not be changed will display the following message when hovered over: 
Disabled by Group Policy - This option has been disabled by your system administrator. 
Contact your system administrator if you have any questions or concerns regarding the 
enforced User Option.

Note: Additional tabs may be available if you are licensed for additional functionalities that use 
the User Options interface. Information on these User Options is contained in the respective 
module documentation.

To apply User Options, select the desired options in each tab. Selection controls for options 
vary (check boxes, text fields in which you can insert a number or date range, etc.). After you 
have selected the appropriate options, click Save to save your changes and to close the User 
Options dialog box. See the sections below for information about each User Option.
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General
General options control OnBase display features and general behavior. The following options 
are configured on the General tab:

General Option Description

Confirm Exit/Logoff You are prompted for confirmation upon exit.

Enable Animations Animations are enabled during your current Unity Client session. 
Animations are most noticeable when viewing Keywords, Notes, and 
Cross- References in the task pane, or when rotating a document.
Disabling animations allows for a smoother visual experience.

Note: In a Remote Desktop environment, this option is disabled and 
cannot be enabled.

Enable Pop-up 
Notifications

Enables the display of pop-up status notifications.

Refresh Internal Mail The Internal Mail Mailbox is refreshed at the rate specified in the 
Internal Mail Refresh Rate field.

Note: After selecting Refresh Internal Mail, you must log out of 
OnBase and log back in for the change to take effect.

Internal Mail Refresh 
Rate

Enter the rate in seconds at which to check for unread and new mail 
messages and automatically refresh the Internal Mail Mailbox.
This field is only available when Refresh Internal Mail is selected.
The Internal Mail Refresh Rate field can be set to 0, or any number 
greater than or equal to 60.

Note: When the Internal Mail Refresh Rate is set to 0, the Unity Client 
will only check for unread internal mail messages immediately after 
logging in.

Note: After changing the refresh rate, you must log out of OnBase and 
log back in for the change to take effect.

Enable default 
directory for Send To 
File operations

Enable the selection of a default directory in which to save documents 
when using Send To | File. The default directory is specified in the 
Directory field.
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Directory Enter a directory or select a directory by clicking Browse to specify a 
default directory in which to save documents when using Send To | File.
This field is only available when Enable default directory for Send To 
File operations is selected.

Search Option Description

Automatically display 
document viewer with 
search results

The Document Viewer pane in the Document Search Results list is 
automatically displayed.

Allow case-sensitive 
sorting and grouping 
of search results

Enabling this option allows items in the Document Search Results list to 
be sorted according to alphanumeric case. By default, case is ignored.

General Option Description
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Document
Document options control settings for documents retrieved in the Unity Client. The following 
options are available on the Document tab:

Document Option Description

Automatically open if 
search returns a single 
result.

When a Document Retrieval or Custom Query search results list 
contains a single document, the document is automatically displayed.
If the Automatically display document viewer with search results 
user option is also selected or the Document Viewer pane is displayed, 
the document is displayed in the Document Viewer pane.
If the Automatically display document viewer with search results 
user option is not selected, the document is displayed in a new window.

Automatically Display 
the Notes Task Pane 
when viewing 
documents.

When a document is viewed, the Notes Task Pane is automatically 
displayed. The Notes Task Pane is displayed even if no notes are 
associated with the document.

Note: This option is not respected when viewing documents through 
the Document Knowledge Transfer module.

Close standalone 
viewer when viewing 
.MSG documents

When an .MSG document is viewed, the standalone viewer is closed.

Open email 
documents as images

Email documents will open as images in the Document Viewer. When 
this option is not selected, email documents will automatically open 
externally in their native application.

Note: Email documents opened in the Document Viewer can be opened 
externally in their native application by selecting View in Native 
Format from the Viewer Options ribbon group.

Note: Email attachments are not included.
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Open Microsoft Office 
documents using the 
Office Business 
Application module

Microsoft Office documents will open in the Office Business 
Application for 2007, Office Business Application for 2010, or Office 
Business Application for 2013 module.

Note: This option is only available if you are licensed for the Office 
Business Application for 2007, Office Business Application for 2010, or 
Office Business Application for 2013 modules.

Note: If you are running the 64-bit version of Microsoft Office, this user 
option is automatically selected, and cannot be disabled. Office 
documents will always open in the licensed Office Business Application 
module.

Note: This option is not respected when viewing Microsoft Office 
documents through the Document Knowledge Transfer module. When 
viewing Microsoft Office documents through the Document Knowledge 
Transfer module, documents are always displayed in the Unity Client 
Document Viewer.

Note: This option is not respected when importing a document as a 
revision.

Disable the Google 
Viewer when viewing 
Microsoft Office 
documents

Microsoft Office documents will not be opened using the Google 
Services Integration Viewer. Instead, they will open using the OLE 
viewer, or using the WOPI viewer if it is enabled.
When this option is not selected, Microsoft Office documents will open 
in the Google Services Integration Viewer if it is enabled.

Note: This option is not available in the RCM Unity Client.

Document Option Description
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Image Option Description

Hide Notes By default, notes icons are not displayed in the Document Viewer.

Hide Annotations By default, annotations are not displayed in the Document Viewer.

Hide Thumbnails By default, thumbnails are not displayed in the Document Viewer.

Hide Blank Pages By default, pages of image documents hidden by Blank Page Suppression 
are not displayed in certain viewers.
If the page number of a suppressed page is selected, that page is still 
shown as normal. When navigated away from, the page will not be hidden 
again until the pages are refreshed.
The following items should be noted with Hide Blank Pages:

• The page count includes hidden pages.
• This option applies to documents scanned into OnBase 

through a batch scan process.
• This option does not apply in Document Separation or the 

editing layout, when working with signatures, when printing, 
when emailing, or when saving documents to file.

• This option is only available if the database has been 
configured for Blank Page Suppression. Contact your system 
administrator for more information.

Auto-Save Flip and 
Rotation

Any flip or rotation you apply to an image document is automatically 
saved.

Reset Image Scale 
on Page Change

When navigating between pages, the image scale is reset to default 
settings.

Image Scale Description

Fit To Width Image documents are scaled so that their width is the same as the width of 
the Document Viewer.

Fit To Window Image documents are scaled so that the entire image is displayed in the 
Document Viewer.

Actual Size Image documents are displayed in their actual size.

Auto Display 
Keyword Option

Description

Show Always The Keywords window is displayed when viewing documents containing 
keywords that are configured to automatically display.
OnBase 18
©2018 Hyland Software, Inc.

52



Unity Client
Usage
Document Import
Document import options affect how you upload documents. The following options are 
available on the Document Import tab:

Show Collapsed The Keywords window is displayed minimized when viewing containing 
keywords that are configured to automatically display.

Hide The Keywords window is not displayed when viewing containing keywords 
that are configured to automatically display.

Auto Display 
Keyword Option

Description

Document Import Option Description

Clear Document Keywords 
After Import

Keyword Values are cleared from the Keywords pane in the 
Import layout after you upload a document.

Open Document After Import When uploading a document, the Open Document After 
Import check box is selected by default.

Note: After selecting this option, you must log out of OnBase 
and log back in for it to be in effect.

Delete Files After Import This option enables by default the Delete Files After Import 
option in the Options pane on the Import layout. This will 
delete the document from its original location after it is 
uploaded.

Expand Options Panel By 
Default

Select to have the Options pane on the Import layout 
expanded by default.

Preview Option Description

Enable Automatic Preview of 
Imported Files

A preview of the file will be immediately displayed in the 
Import layout.
When this check box is cleared, a Preview is currently 
disabled message is displayed in the Import layout’s Preview 
pane after you upload a document. Click the corresponding 
hyperlink to view the preview of the file.
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Local Data
The local bitmap cache can be cleared from within the User Options dialog.The following 
option is available in the Local Data tab:

Printing
Printing options affect how you print documents. The following option is available on the 
Printing tab:

Image Cache Option Description

Clear Local Image Cache Click to clear the local image cache used to store icons and 
images retrieved from the Application Server.

Printing Option Description

Use native browser 
printing behavior

Printing an Electronic Form (E-Form) or HTML document from the 
Document Viewer will print the document using Internet Explorer instead 
of OnBase. Any print formatting styles within the HTML document is 
preserved.

Note: This option only applies to printing done directly from the 
Document Viewer (for example, by selecting Send To | Print). When 
printing from a Document Search Results list, OnBase will always be used 
to print the document, regardless of whether this option is selected.

Note: Unity Forms always display the browser’s Print dialog regardless 
of this setting.

Default Page Range 
Option

Description

Print All Pages Select to set the default print range to Print All Pages.

Print Current Page Select to set the default print range to Print Current Page.
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Retrieval Date Options
Retrieval date options allow you to set a default date to be used by the system for retrieving 
documents using the Document Retrieval and Custom Queries layouts. Setting the default date 
saves time when you frequently search for documents using a specific date or date range.

The following options are available on the Retrieval Date tab:

When you select an option, the date or date range is shown in the Example Dates field.

Single Date Option Description

None No default date is used.

Last Weekday The previous weekday is used as a default. Friday is considered the 
last day of the week.

Last Business Day The previous business day is used as a default. Saturday is considered 
the last business day of the week.

Yesterday Yesterday’s date is used as the default date.

Today Today’s date is used as the default date.

First of the Month First day of the current month is used as the default date.

Last of the Month Last day of the previous month is used as the default date.

Specific Day The specified day is used as the default date.

Date Range Option Description

Last Month The date range of the prior month is used as the default date range.

Current Month The date range of the current month is used as the default date range.

Current Week The date range of the current week is used as the default date range.

Month to Date The date range extends from the first day of the current month to the 
current date.

Year to Date The date range extends from the first day of the year to the current 
date.

Last Number of Days The date range is determined by the number of days specified.

Last Number of Weeks The date range is determined by the number of weeks specified.

Last Number of Months The date range is determined by the number of months specified.
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Service Mode
Service Mode options affect how the Unity Client functions in Service Mode. Information on the 
following Unity Client features is displayed on the Service Mode tab:

The location of the Unity Client executable that registered each feature is displayed, along with 
the version and build of OnBase.

To force registration of these features, which means that they will use the current Unity Client 
executable if they are not already doing so, click Set Registration.

Unity Client Registration Description

UnityPop Allows for the handling of Unity Pop files.

Unity Automation Allows for automation of the Unity Client by external 
applications.

Run At Windows Startup Allows the Unity Client to run when Windows starts.
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Document Retrieval
You can retrieve documents in a variety of ways from within the Unity Client. Retrieval options 
can be accessed from the Documents ribbon group in the Home tab.

Retrieval options include:
• Custom Queries - See Retrieval Using Custom Queries on page 60 for more 

information.
• Retrieval without specifying search parameters - See Document Retrieval without 

Specifying Search Parameters on page 59 for more information.
• Retrieval by Keyword Value - See Document Retrieval by Keyword Value on page 71 

for more information.
• Retrieval by Document Date - See Document Retrieval by Document Date on page 77 

for more information.
• Retrieval by Note Search - See Document Retrieval Using Note Search on page 82 for 

more information.
• Retrieval using External Text Search - See Document Retrieval Using External Text 

Search on page 85 for more information.
• File Cabinets - See Folders on page 214 for more information.
• Envelopes - See Using Envelopes on page 272 for more information.
• Query History - See Viewing Recent Query History on page 88 for more information.
• Document Handle - See Document Retrieval by Document Handle on page 89 for 

more information.
OnBase 18
©2018 Hyland Software, Inc.

58



Unity Client
Usage
Document Retrieval without Specifying Search 
Parameters

If configured, documents can be retrieved from the Document Retrieval pane without specifying 
search parameters.

Note: You may not be able to perform searches without providing some search parameters, 
depending on your configuration. Contact your system administrator for additional information.

1. In the Home tab, click Retrieval.
2. The Document Retrieval layout is opened. Ensure that the Document Retrieval pane is 

expanded:
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3. From the first drop-down list in the Document Types and Groups pane, select the 
Document Type Group containing the type(s) of document(s) you want to retrieve, or 
select <All> if you plan to retrieve documents from more than one Document Type 
Group. You can also select a Document Type Group by typing the name of the Document 
Type Group.

4. From the Document Types list, select the Document Type(s) to be included in your 
search:

You can also select a Document Type by typing the name of the Document Type.
To select multiple Document Types, press Shift or Ctrl as you click.

Note: Some Document Type Groups do not require you to select a Document Type in retrieval. 
To determine whether a Document Type Group is Group Search Enabled, select that Document 
Type Group from the drop-down list. If the Document Type Group is Group Search Enabled, the 
Find button is available when the Document Type Group is selected.

5. Press the Enter key or click Find:

Retrieval Using Custom Queries
Custom Queries are queries that have been configured for you by your system administrator, so 
that you can quickly and easily select the kinds of documents and folders that you most 
frequently work with.
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Whenever you conduct a Custom Query, its specifications are automatically recorded in a 
temporary query history, which is maintained for the duration of your current session. At any 
later time in the same session, you can conduct the same query by clicking Query History on 
the Home tab, and then selecting the Custom Query from the list in the resulting Query History 
pane.

Conducting a Custom Query
1. On the Home tab, click Custom Queries.
2. The Custom Queries panel displays all available Custom Queries:

3. If you want to narrow the list of Custom Queries displayed for selection, in the Find field, 
enter text that is contained in the name of the Custom Query you wish to conduct.

4. Select a Custom Query.
OnBase 18
©2018 Hyland Software, Inc.

61



Unity Client
Usage
5. The Custom Query form is displayed:

6. Some or all of the fields may be filled in automatically.
7. Complete as much of the form as necessary, by selecting, inserting, or editing the 

appropriate values. If there are instructions at the top of the Custom Query form, be 
sure to follow them.
If you enter only a From date, all documents from that date forward will be found
If you enter only a To date, all documents from that date backward will be found
If you enter a From and a To date, all documents within the date range will be found

Note: You can include additional instances of a Keyword Type, or use Wildcard or Boolean 
operators to narrow the search.

Depending on the configuration of the Custom Query, you may have access to external 
text search options using the Find Text in Documents pane. 
See Document Retrieval Using External Text Search on page 85 for more information on 
the options in this pane.
If necessary, click the Clear button or the clear button configured on the Custom Query 
to clear all fields.
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8. Press the Enter key, click the Search button, or click the search button configured on the 
Custom Query itself.
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9. Documents that meet the search criteria are displayed, along with the name of the 
Custom Query and the number of documents that meet the search criteria:

Note: If you used the external text search options in the Find Text in Documents pane, search 
results are displayed in an External Text Search Results window.

Your system may be configured to automatically display one of the selected documents 
in the Document Viewer.
Depending on a Custom Query’s configuration, documents that meet the search criteria 
may be automatically grouped by one of the display columns:

Note: If a Keyword Type that is used as a display column has more than one value for a 
document, the document is listed for each Keyword Value.
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The tab contains various buttons. Click the drop-down button on the tab to display additional 
options.

The tab contains the following buttons:

Button Description

Open in New Window Click to open the Custom Query results in a new window.

Refresh Click to refresh the Custom Query results.

Note: When Custom Query results are opened in a new window, Refresh is 
available on the Document tab ribbon.

Add to Personal Page Click to add the current Custom Query results to your Personal Page. After 
clicking this button, you can add a description for the tile before it is added 
to your Personal Page.

Add to Tile Groups Click to add the current Custom Query results to a Tile Group. After clicking 
this button, you can add a description for the tile before it is added to the Tile 
Group of your choice.

Note: This button is disabled if you are not configured to create or 
administer Tile Groups.

Send Query as Link Click to send the current Custom Query results to an external user. After 
clicking this button, your e-mail client will open a blank e-mail that contains, 
depending on your configuration, a Unity Pop link or Unity Pop file to the 
Custom Query results.

Note: This button is disabled if you are not configured to send Unity Pop 
links or files.

Caution: Custom Query results sent as Unity Pop links or files include 
keywords as un-encoded plain text. Before you send a Custom Query in 
this way, consider who the recipient is and what keywords are included 
(i.e. social security numbers).

Note: For more information on sending and receiving Unity Pop links and 
files, see Emailing Documents and Links to Documents on page 260.
OnBase 18
©2018 Hyland Software, Inc.

65



Unity Client
Usage
Depending on your configuration, the Filter tab may be displayed in the Custom Queries 
pane. For more information on the Filter tab, see Filtering Custom Query Results on 
page 68.

Conducting Multiple Custom Queries
When you conduct multiple Custom Queries, results for each Custom Query are retained on 
their respective tabs for future use:

Note: Results are retained for the duration of your OnBase session.

Close All Tabs Click to close all Custom Query results tabs. These results will no longer be 
available.

Button Description
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If you navigate away from the Custom Queries layout, or select a different Custom Query from 
the list of available Custom Queries, you can return to the list of results by clicking Go To 
Results:

Viewing Folder Custom Query Results
Folder Type Custom Queries work like other Custom Queries, except they retrieve folders rather 
than documents.

When a Custom Query is used for folder retrieval, the results list displays all folders satisfying 
the search criteria. A folder may be listed multiple times if it has more than one value for a 
Keyword Type that is used as a display column.

The right-click options available for folder search results allow you to perform folder-related 
tasks, such as viewing folder Keyword Values or displaying Folder History. To open a folder in 
the File Cabinets layout, double-click it from the list. If only one folder is returned, the File 
Cabinets layout opens the folder automatically.
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Filtering Custom Query Results
Depending on a Custom Query’s configuration, you may be able to filter Custom Query results 
using the Filter tab in the Custom Queries pane:

When the Filter tab is selected, the Custom Queries pane displays any of the filters that are 
configured for the Custom Query:
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The following filter types are available:

When you apply filters to a Custom Query, the number of documents that meet the search 
criteria is updated.

The order in which filters are displayed in the Custom Queries pane is determined by your 
system administrator.

Filter Type Example Description

Instance This filter is displayed as a list of values with the number 
of instances of that value. As you select and clear values, 
the Custom Query results list updates accordingly.
Select or clear multiple values by holding the Ctrl or Shift 
keys and clicking. Select all values by pressing Ctrl + A.

Text This filter is displayed as a text box. As you type in the 
text box, the Custom Query results list is updated 
accordingly.
When a text filter is configured for an alphanumeric 
Keyword Type, such as Vendor Name, a wildcard is 
automatically applied to the end of the value specified in 
the text box.
When a text filter is configured for a non-alphanumeric 
Keyword Type, such as a number or date, multiple values 
can be entered in the text box. Separate multiple values 
with a comma or semicolon. Ranges of values can be 
entered by using a hyphen. To find all values greater than 
the value entered in the text box, add a + after the value.

Note: When specifying a date or a range of dates, you 
must specify a month, day, and year in a date format 
supported by OnBase.

Pinch This filter is displayed as a slider, with two thumbs 
beneath a sparkline.The sparkline indicates the density of 
data over the range of values. Pinch the thumbs in this 
filter towards each other to narrow down the Custom 
Query results.

Note: If two or less results are returned by the Custom 
Query, pinch filters are displayed as instance filters.
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Use the Reset button to remove any applied filters and return to the original Custom Query 
results list.

Note: Filters in the Custom Queries pane are not updated when you apply a filter to a Custom 
Query results list. For example, a Custom Query includes an instance filter for Invoice # and a 
pinch filter for Invoice Amount. Invoice #1110 in your system is in the amount of $200.00. 
When you use the pinch filter to narrow down a Custom Query results list to invoices between 
$400.00 and $600.00, Invoice #1110 will still be displayed in the Invoice # instance filter.
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Document Retrieval by Keyword Value

Note: The options available to you will depend upon your User Groups and Rights and the 
configuration of the Document Types and Groups. See your system administrator for details.

1. In the Home tab, click Retrieval.
2. The Document Retrieval layout is opened. Ensure that the Document Retrieval pane is 

expanded:
o

Note: Some Document Types are configured to require Keyword Values to be entered in order 
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to create and/or retrieve documents. Required Keyword Values are displayed in red for these 
operations, which may include the following: Document Retrieval, upload, and adding/
modifying Keyword Values.

Note: User rights are needed to access the Document Retrieval layout and to view documents. 
Contact your system administrator for additional information.

3. From the first drop-down list in the Document Types and Groups pane, select the 
Document Type Group containing the type(s) of document(s) you want to retrieve, or 
select <All> if you plan to retrieve documents from more than one Document Type 
Group. You can also select a Document Type Group by typing the name of the Document 
Type Group.

4. From the Document Types list, select the Document Type(s) to be included in your 
search:

You can also select a Document Type by typing the name of the Document Type.
To select multiple Document Types, press Shift or Ctrl as you click.

Note: Some Document Type Groups do not require you to select a Document Type in retrieval. 
To determine whether a Document Type Group is Group Search Enabled, select that Document 
Type Group from the drop-down list. If the Document Type Group is Group Search Enabled, the 
Find button is available when the Document Type Group is selected.
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5. When a Document Type is selected, the Keyword Types with which it is associated are 
displayed. All documents assigned to a Document Type have the same Keyword Types, 
but unique Keyword Values. If multiple Document Types are selected, the only 
applicable Keyword Types are those that are common to all the selected Document 
Types.
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6. Type Keyword Values or select Keyword Values from the drop-down list, if available. You 
can use the Tab key to move to the next Keyword Value field.
When the cursor is in the Keyword Type’s field, you can press F5 to open the drop-down 
list, if one exists. You can use the up and down arrow keys to select from the Keyword 
Values displayed in the drop-down list. When you have selected the appropriate 
Keyword Value, press Enter.
If you type a partial value before pressing F5 or opening the drop-down list, the drop-
down list will begin with those values that match the partial value.
If two or more consecutive Keyword Types contain drop-down lists and are ordered in 
such a way as to show a hierarchical parent/child relationship, the Keyword Types may 
be part of a Cascading Data Set. Selecting a Keyword Value from the parent drop-down 
list filters the available Keyword Values from the subsequent child drop-down list.

Note: You are only able to view the first 100 entries in a drop-down list. To reduce the values 
displayed in a drop-down list, type several characters into the field before expanding the drop-
down list.

Note: Some searches require you to enter at least one Keyword Value. Search requirements are 
determined by your system administrator.

7. When you have entered all search criteria, press the Enter key or click Find:

8. All documents that match the search criteria are displayed in a Search Results list. If 
you used a text search as a method of retrieval, OnBase provides the number of times 
the search criteria appears in the document, as well as the page(s) on which the items 
were found.

Note: OnBase maintains a record of the search criteria used in each search in Query History, 
so that you can repeat it exactly during a given session.

When retrieving documents by Keyword Value, the following keyboard shortcuts are available:

Keyboard Shortcut Description

F3 Change the operator for the selected Keyword Type.

F4 Change the connector for the selected Keyword Type.

F5 Show the drop-down select list for the selected Keyword 
Type.

F6 Add another value for a Keyword Type.

Ctrl + O Collapse or expand any Multi-Instance Keyword Type 
Groups.
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Document Search Results List
The Document Search Results list is a list of all documents that meet the search criteria in any 
of the following:

• Document Type
• Document Date
• Keyword
• Note
• Folder
• Envelope
• Custom Query

Each item in a Documents Search Results list identifies the Auto-Name string assigned to the 
document. How documents are named varies between Document Types. The following 
example illustrates the appearance of a Documents Search Results list.
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Viewing Documents
When the Document Viewer pane is expanded, you can view a document by selecting it from 
the Documents Search Results list:

You can select multiple documents from a Documents Search Results list and right-click to 
access options.

Note: If you have multiple documents selected, but do not have consistent privileges for the 
corresponding Document Types, only the options you can apply to all selected documents are 
available. Unavailable options are grayed out.
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Thumbnail Viewer
The Thumbnail Viewer displays the selected documents as a thumbnail image of their first 
page.

Note: Depending on Document Type, some documents may be displayed as No Image 
Available.

To view selected documents in the Thumbnail Viewer, right-click the selected documents and 
select Open in Thumbnail Viewer.

Document Retrieval by Document Date
When retrieving documents, you can limit your search to documents with a specific Document 
Date or within a certain date range. You can limit results by date when performing searches by 
Keyword Value, external text searches, and note searches. A Document Date is assigned to all 
documents upon import.

Note: User rights are needed to access the Document Retrieval layout and to view documents. 
Contact your system administrator for additional information.

See Document Properties on page 138 for clarification on Document Date vs. Date Stored.

1. In the Home tab, click Retrieval.
2. The Document Retrieval layout is opened. Ensure that the Document Retrieval pane is 

expanded:
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3. From the first drop-down list in the Document Types and Groups pane, select the 
Document Type Group containing the type(s) of document(s) you want to retrieve, or 
select <All> if you plan to retrieve documents from more than one Document Type 
Group. You can also select a Document Type Group by typing the name of the Document 
Type Group.
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4. In the Keywords and Date Range pane, enter date(s) in the From and/or To fields:

Note: The character used to separate the parts of the date should be appropriate to your 
locale. OnBase recognizes slashes (/), commas (,), and periods (.) as date separators.

You can also specify values by:
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• Click the drop-down arrow next to the From or To field:

a. A calendar is displayed:

b. Select a day.
c. The From or To fields automatically populate according to your selection.
• Clicking the Custom Date Range button:

a. The Custom Date Range window is displayed:
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Calendar selections are available from the drop-down list at the top of the Custom 
Date Range window. Day Selection is selected by default. Additional options include:

b. In the calendar, select a day, or click and drag to select multiple days.
c. This date range is displayed below the calendar.
d. To apply the date range, click Apply Date Range.

Custom Date Range Description

Month Selection Select to show months in the calendar:

Year Selection Select to show years in the calendar:
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e. The From or To fields automatically populate according to your selection.

Date Range Parameters and Corresponding Results

Document Retrieval Using Note Search
You can search documents for notes. You can limit your search by Document Type, Keyword 
Value, Note Type, note text, note creation date, and the note creator.

Note: User rights are needed to access the Document Retrieval layout and to view documents. 
Contact your system administrator for additional information.

1. In the Home tab, click Retrieval.
2. The Document Retrieval layout is opened. Ensure that the Document Retrieval pane is 

expanded:

Date Range Parameter Corresponding Result

From left blank, To left blank Retrieves all documents with document dates from 1/1/
1753 through the current date.

From left blank, To valid date Retrieves all documents with document dates from 1/1/
1753 through the date in the To field.

From valid date, To left blank Retrieves all documents with document dates from the 
date in the From field through the current date.

From valid date, To valid date Retrieves all documents with document dates from the 
date in the From field through the date in the To field. 
Note that a valid date can be any date from 1/1/1753 to 
any date in the future. The only stipulation is that the 
From date cannot be greater than the To date.

From valid date = To valid date Retrieves all documents with the specified document 
date.
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3. Select the Document Type Group(s) and/or Document Type(s) to search.
4. Click the Note Search hyperlink.
5. The Note Search window is displayed:
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6. Type the note text to search for in the Find What field, or use the drop-down list to 
select from previous note searches.

7. To add additional search parameters, expand the Options pane:

8. If desired, enter a date range using the From and To fields in the Note Creation Date 
Range search parameter. Entering dates into these fields will limit your search to notes 
created within that range. You can use the corresponding calendars to select a date.
If no range is specified, OnBase searches for notes created on any date within the 
selected Document Type(s).

9. If desired, use the Note Owner field to specify the OnBase user who created the note 
you are searching for. 
If no user is specified, OnBase searches for notes created by any user within the 
selected Document Type(s).

10. If desired, use the Note Type field to specify the type of note you are searching for.
If no Note Type is specified, OnBase searches for notes of any type within the selected 
Document Type(s).
If necessary, you can clear search parameters by clicking Clear Search:

11. Click outside the Note Search window, or click Close:

12. The Note Search window closes and the Note Search field displays in the Document 
Retrieval pane:
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13. If you specified note text to search for in the Note Search window’s Find What field, the 
Note Search field contains this text enclosed by quotation marks. If you specified 
additional search criteria in the Note Search window, the Note Search field contains 
+Parameters.
You can edit the note search by clicking the Note Search hyperlink.
You can remove the note search by clicking the following button:

14. Press the Enter key or click Find:

15. When the search is finished, OnBase displays all matching documents in a Document 
Search Results list.

16. Open a document. The document is displayed in the Document Viewer.

Document Retrieval Using External Text Search
If you have sufficient privileges, you can search for specific text in a text-based document 
assigned to a Document Type or Document Type Group.

Note: User rights are needed to access the Document Retrieval layout and to view documents. 
Contact your system administrator for additional information.

1. In the Home tab, click Retrieval.
2. The Document Retrieval layout is opened. Ensure that the Document Retrieval pane is 

expanded:
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3. Select the Document Type Group(s) and/or Document Type(s) to search.
4. Click the Text Search hyperlink.
5. The Text Search window is displayed:
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6. In the Find What field, type the text string you want to search for. The string must 
contain at least two characters, and at least one character in the string must be a letter 
or a number. Use the drop-down list to select from previous text searches.

7. To add additional search parameters, expand the Options pane:

8. Select a Type Radio Button:
• Text - Searches for alphanumeric text.
• Number - Searches for numeric values and allows the use of the following operators 

to limit the search: =, >, <, >=, and =<. You can use and, or, and to as operators to 
search for a range of values. For example, type 2009 and 2010 to find documents 
containing both 2009 and 2010.
If you are searching for an exact number that is part of an alphanumeric text string, 
then the number will not be found. For example, if you search for 001 and the actual 
text is ABC001, then the value will not be found.

• Formatted Number - Searches for numeric values that use formatting characters. For 
example, to search for all Social Security Numbers greater than 800-00-0000, type > 
800-00-0000 in the Search String field. You can use this option with following 
operators to limit your search: =, >, <, >=, and =<. The and, or, and to operators can be 
used to search for a range of values. For example, type 800-00-000 to 900-00-0000 
to find documents containing values within this range.

Note: When you search for formatted numbers greater or less than the entered search string, 
formatted numbers followed by periods are not included in the search results. For example, if 
the formatted number is the last word in a sentence, then it will be omitted as a result.

Note: External text searching for currency is not supported.

9. Select one of the following check boxes if necessary:
• Select Find First to search for the first instance of the text.
• Select Use Wildcards to include wild card characters in your text string search 

criteria.
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• Select Case Sensitive to return only matches that have the same capitalization as 
the text string search criteria.

• Select Whole Word Match to return matches for an exact word.
• Select Column Search to search for a text string within specified columns. In the 

From field, type the character position of the column to start the search in (the left 
most column to be searched). The column of characters at the far left of the 
document is 1, the next column to the right is 2, and so on. In the To field, type the 
character position of the column to end the search in (the right most column to be 
searched). The number in the To field must be greater than or equal to the number in 
the From field.

If necessary, you can clear search parameters by clicking Clear Text Constraints:

10. Click outside the Text Search window, or click Close:

11. The Text Search window closes and the Text Search field displays in the Document 
Retrieval pane:

12. The Text Search field contains the Type of search selected in the Text Search window, 
followed by the entry in the Find What field.
You can edit the text search by clicking the Text Search hyperlink.
You can remove the text constraints by clicking the following button:

13. Press the Enter key or click Find:

14. When the search is finished, OnBase displays all matching documents in an External 
Text Search Results window.

15. Open a document. The document is displayed in the Document Viewer. The page of the 
document containing the text string you searched for is displayed.

Viewing Recent Query History
The query history displays a list of Document Retrieval and Custom Query searches performed 
during the current OnBase session.
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To view the query history:

1. On the Home tab, in Documents, click Query History.
2. The Query History pane is displayed.
3. To repeat a previous search, click an item from the list.
4. The search results list is displayed in a new window.

Document Retrieval by Document Handle
If you have the Retrieve by Document Handle / File Name product right, you can retrieve 
documents by their Document Handles. A Document Handle is a unique number assigned to 
each document.

1. On the Home tab, in the Documents ribbon group, click Document Handle:

2. The Retrieve by Document Handle dialog box is displayed:

3. Enter numeric search criteria and click OK.
• Enter a range of numbers in the From and To fields to retrieve all documents within 

that range, or
• Enter a number in the From field to retrieve the document assigned that Document 

Handle.
OnBase retrieves all documents that you have rights to view and that meet your search 
criteria. These results include documents that have been deleted, but not purged.
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Keyword Types Relationship Examples in Document 
Retrieval

Cascading Data Set
A Document Type contains a Cascading Data Set that includes the State, County, and City 
Keyword Types. State is the parent, or root, Keyword Type in the Cascading Data Set. County is 
a child to State, and City is a child to County. These Keyword Types appear in the order of their 
parent/child relationship in the Document Retrieval window:

When retrieving documents, you must select values for Keyword Types in the order of their 
parent/child relationship. In this example, the drop-down list for the County Keyword Type is 
empty until a State value has been selected. The drop-down list for the City Keyword Type is 
empty until a County value has been selected. This is because the three Keyword Types are 
related to one another, and meant to be used in conjunction with one another.

Note: Child Keyword Values are not automatically corrected after modifying the parent 
Keyword Value. Using the above example, a user selects a State, County, and City Keyword 
Value. The user then modifies the State Keyword Value. The selected County and City Keyword 
Values are not child Keyword Values of the new State Keyword Value. The selected County and 
City Keyword Values are not cleared from the Keywords panel.

Multi-Instance Keyword Type Group
A Document Type called AP - Purchase Order contains a Multi-Instance Keyword Type Group 
called Item that includes the Keyword Types Item Number, Item Description, Quantity, Amount 
and Total Amount. A Multi-Instance Keyword Type Group was configured for the Document 
Type, because a purchase order is likely to contain more than one item, each requiring a 
separate group of Keyword Values.
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If you were to search for the Keyword Value 0023426 for the Item Number Keyword Type and 
the Keyword Value 3/4 IN. NAILS - 100 for the Item Description Keyword Type, a document 
retrieval would only retrieve documents that contained both Keyword Values either in the same 
instance of a Keyword Type Group or as standard Keyword Values values (i.e., values that are 
not part of a Keyword Type Group). It would not retrieve documents that only contained the 
values collectively across different Keyword Type Groups.
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For example, the following documents contain the same Keyword Values but were indexed 
differently:

• Document A was configured with the Item Multi-Instance Keyword Type Group and 
was indexed with two Keyword Type Group instances.

• Document B was configured with loose Keyword Types and was indexed with 
multiple values for Item Number, Item Description, Amount and Total Amount.
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A single document retrieval for both Item Number Keyword Value 0023426 and Item 
Description Keyword Value 3/4 IN. NAILS - 100 would not find Document A, since the Keyword 
Values 0023426 and 3/4 IN. NAILS - 100 are not part of the same Keyword Type Group 
instance. It would find Document B, since those values are not tied to any Keyword Type Group.
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Working with Documents
This chapter provides a general overview of working with documents.

When working with documents in OnBase, it is important to understand that documents may 
behave slightly differently depending upon their file format. A file format identifies the type of 
file.

The two most common file formats are image documents and text documents. Other file 
formats include XML, video formats, or OLE documents, such as those created with Microsoft 
Office applications. See your system administrator for specific questions regarding your 
system’s file types and their default behavior.

Note: Some file formats ask for your permission before opening. These documents may 
contain scripts or executables. Opening these documents within Unity Client executes the 
script or executable. Take caution when opening unfamiliar documents.

Document Viewer
When you open a document, it is displayed in the Document Viewer. The document’s Auto-
Name string, page count, note count (if applicable), and revision number (if applicable) are 
displayed in the information bar above the document.

Item Description

A Auto-Name String

B Stapler

C Page Count
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If the document being viewed is a Text, HTML, or HTML Unicode file format, Text Encoding is 
available. Select an option from the drop-down menu to change the text encoding, and select 
Save Encoding to save the change.

If the document is read-only and cannot be modified, the following icon is displayed above the 
document:

Hover over this icon to display information about why the document is read-only. For more 
information, see Document Locks on page 309.

Note: If the Document Type is configured with the Rendition / Revision Control Setting Display 
Message when Document is Locked enabled, you are prompted when opening the document.

Depending on the Document Type and your rights, you might see different ribbon tabs, ribbon 
groups, icons and other graphics that indicate the presence of notes or annotations.

If you have an alternate viewer configured, such as the Google Services Integration viewer or 
the Microsoft Office Online Server WOPI viewer, you may be presented with a button to switch 
viewers.

Note: With alternate viewers, OLE and RTF documents are viewed as PDFs, regardless of file 
type. File type is not changed, despite being rendered as PDFs for viewing purposes within the 
Unity Client.

D Note Count

E Revision Number

F Document

Item Description
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If changes are made to a document and the document is navigated away from without being 
saved, you will be prompted to save, discard, or cancel your changes.

Note: Some documents created in third-party applications (for example, Microsoft Outlook 
MSG files) may open externally in their native applications. Other types of documents created 
in third-party applications (for example, Microsoft Office files) may open within the Document 
Viewer, using an embedded viewer based on the third-party application. See the third-party 
application’s help files for information on these types of documents and their options.

Note: Not all Microsoft Office application functionality is available for Microsoft Office 
documents opened in the embedded Document Viewer. For access to full Microsoft Office 
application functionality, these documents must be opened using the Office Business 
Application module.

Note: The Unity Client Document Viewer does not support viewing XML documents imported 
as Microsoft Office file types. For more information, contact your system administrator.

Note: When opening a Zipped HTML Archive for the first time, a message is displayed stating 
that the document is being prepared. After the zipped file has been prepared, the progress of 
the archive download is shown. Click Cancel to cancel the unzipping process. Enable Dynamic 
Document Content must be selected in the settings for the Document Type.

Caution: When working with a Microsoft Excel file in the Unity Client, you will not be prompted 
to save if only one cell has been modified. The document is not marked as modified until you 
navigate to another cell. Care should be taken to ensure your changes have been saved. This is 
a known issue.

When viewing documents, the following keyboard shortcuts are available:

Keyboard Shortcut Description

Ctrl + H Opens the Document History dialog.

Ctrl + P Opens the Print pane.

Ctrl + K Opens the Add/Modify Keywords pane.

Ctrl + W Opens the Cross-References pane.

Ctrl + U Toggles the thumbnail display.

Ctrl + O Toggles text overlay when working with image documents.
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When viewing a multi-page image document, navigation through and between pages can be 
performed using the following methods:

• Scroll the mouse wheel up or down.
• Press Page Up or Page Down.
• Press the up or down arrow keys.

Ctrl + Mouse Wheel Up
or
Ctrl and +

While holding down the Ctrl button, scroll the mouse wheel up 
to zoom in on the current document. Or press the + key while 
holding down the Ctrl button to zoom in.

Note: The Ctrl and + shortcut is not usable when working 
within a text document. Use the Ctrl + Mouse Wheel Up 
shortcut to zoom in on text documents.

Ctrl + Mouse Wheel Down
or
Ctrl and -

While holding down the Ctrl button, scroll the mouse wheel 
down to zoom out on the current document. Or press the - key 
while holding down the Ctrl button to zoom out.

Note: The Ctrl and - shortcut is not usable when working 
within a text document. Use the Ctrl + Mouse Wheel Down 
shortcut to zoom in on text documents.

Ctrl + Page Up 
or
F11

Go to the previous page in a multi-page document.

Ctrl + Page Down
or
F12

Go to the next page in a multi-page document.

Ctrl + Home Go to the first page in a multi-page document.

Ctrl + End Go to the last page in a multi-page document.

Ctrl + Shift + Page Up Go to the previous document in the Document Search Results 
list.

Ctrl + Shift + Page Down Go to the next document in the Document Search Results list.

Ctrl + G Opens the Go to Page dialog box.

Ctrl + Right Arrow Rotates the currently selected pages 90 degrees clockwise.

Ctrl + Left Arrow Rotates the currently selected pages 90 degrees 
counterclockwise.

Ctrl + Down Arrow Rotates the currently selected pages 180 degrees.

Keyboard Shortcut Description
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Document Tab
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The Document tab allows you to manage documents more efficiently. If you have sufficient 
privileges, you may have access to any of the following ribbon groups and/or buttons:

Information Description

Keywords displays the Add/Modify Keywords pane in the task pane. 
See Access the Keyword Values of a Document on page 153 for more 
information.

Tip: When the Add/Modify Keywords pane is displayed, you can easily view 
the document’s notes and cross-references by selecting the corresponding 
tab.

Cross-References displays the Cross-References pane in the task pane. 
See Retrieving Cross-Referenced Documents on page 134 for more 
information.

Tip: When the Cross-References pane is displayed, you can easily view the 
document’s keywords and notes by selecting the corresponding tab.

Revisions displays the Revisions and Renditions dialog box.
If a Document Type is configured to allow multiple renditions of a document 
and you have rights to view renditions, the Revisions and Renditions dialog 
box displays any renditions. A rendition is a copy of an original document that 
is saved in a different file format. An example of a rendition is a searchable 
text document created from an image document.
Double-click a rendition in the Revisions and Renditions dialog box to view 
it.
You can also open the Revisions and Renditions dialog box by right-clicking 
a document selected in a Document Search Results list or an open text or 
image document and selecting Revisions/Renditions.

Note: If you are licensed for EDM Services, the Revisions and Renditions 
dialog box also includes information on revisions. For information on using 
revisions, see the EDM Services documentation.

History displays the Document History dialog box. 
See Document History on page 137 for more information.

Properties displays the Document Properties dialog box. 
See Document Properties on page 138 for more information.
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Actions Description

Send To displays the following options:
• Mail Recipient (As Attachment) sends the document or a link to the 

document to a user via external mail. 
See Emailing Documents and Links to Documents on page 260 for more 
information.

• Internal User sends the document to a user via internal mail. 
See Send To | Internal User on page 250 for more information.

• Copy Hyperlink copies to the clipboard a hyperlink to the document.
• My Personal Page sends the document to a tile on your Personal Page. 

See Personal Page on page 28 for more information.
• Tile Groups adds the document to the selected Tile Group.
• Envelope displays the Envelope pane in the task pane. 

See Using Envelopes on page 272 for more information.
• Create New Document displays the Create New Document dialog box. 

See Creating a Document on page 148 for more information.
• File displays the File pane in the task pane. 

See Saving Documents to Files on page 142 for more information.
• Document Separation sends the document to the Document Separation 

workspace.

Note: This option is not available during indexing.

See Separating Image and PDF Documents on page 181 for more 
information.

Print displays the Print dialog box. 
See Printing Documents on page 298 for more information.

Re-Index displays the Re-Index pane in the task pane. 
See Re-Indexing Documents on page 173 for more information.

Delete removes the document from OnBase. 
See Deleting Documents on page 147 for more information.
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The Notes Gallery
If you have sufficient privileges, you can view notes and create notes and annotations on 
documents using the Notes gallery.

View Notes List displays the Notes pane in the task pane.

Your five most frequently used note types will be displayed at the front of the list.

Tip: When the Notes pane is displayed, you can easily view the document’s keywords and 
cross-references by selecting the corresponding tab.

Scroll through the available notes and annotations using the following buttons:

To display all available notes and annotations, click the following button:

Tip: To display the name of a note in the Notes gallery, rest the mouse cursor over the desired 
note. This is helpful when the full name of the note is not displayed due to length restrictions.

Delete Note deletes the selected note or annotation.

Privacy Options sets the note privacy options for the selected note. For more information, see 
Setting Note Privacy Options on page 114.

Note: Notes and annotations placed on text documents snap to the nearest character when 
moved or resized. Due to this functionality, notes and annotations may slightly shift after 
creation to snap to the nearest row and column position.

Notes

Note: Notes are limited to 250 characters.
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Notes are available from the Notes gallery when a document is opened in the OnBase viewer or 
selected in the Document Search Results list.

1. On the Document tab, in Notes, select the type of note.
2. If you are adding a note to an open text or image document, click on the document to 

place the note. The note is displayed and expanded on the document. Type text in the 
note’s text field as necessary.
If you are adding a note to a document in the Document Search Results list, or an open 
OLE document or E-Form, the Notes pane is displayed. If necessary, type text for the 
note. Click Close.

3. To delete a note, perform one of the following:
• Select the note and click Delete Note in the Notes gallery.
• Right-click the note in the Notes pane and select Delete Note.

Note: To toggle whether all notes are shown or not, right-click and select Show / Hide Notes in 
Viewer.

Annotations
Annotations are available from the Notes gallery when a document is opened in the OnBase 
Viewer. Annotations are not available from the Notes gallery when a document is selected in 
the Document Search Results list. This is because annotations have to be drawn on 
documents.

Note: Annotations cannot be placed on HTML or OLE documents.

1. From an open document, select the type of annotation from the Notes gallery.
2. Define the location and size of the annotation by clicking and dragging the cursor over 

the document. Release the mouse button when finished to display the annotation.

Note: Ensure that the annotation is large enough to be visible. Annotations are required to be a 
certain size before they can be created and saved.

To create multiple annotations of the same type without returning to the Notes gallery, 
hold down the Ctrl key while clicking and dragging. Release the Ctrl key or right-click to 
exit the Note creation mode. This functionality only applies to annotations that do not 
prompt you to add text upon creation. For more information, see your system 
administrator.

Note: Depending on your system configuration, some icon stamps may only require you to click 
the appropriate location on the document, instead of clicking and dragging. See the Creating 
Note instructions that are displayed at the top of the document when applying a note to 
determine whether this applies. Icon stamps that behave this way cannot be repeatedly applied 
by holding the Ctrl key and clicking.
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3. Depending on the annotation’s configuration, you may be prompted to add text to the 
annotation:

a. Type text for the annotation.
b. When you have finished typing text, click the following to close the window:

c. The annotation now includes the following button:

This button is only available the first time the annotation is selected. If necessary, 
click this button to edit the annotation’s text. If this button is not available, you can 
edit the annotation’s text from the Notes pane.
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4. Depending on your system’s configuration, you may be able to resize or move 
annotations after placing them on a document. Annotations that can be resized or 
moved appear like the following annotation:

Note: To toggle whether all annotations are shown or not, right-click and select Show / Hide 
Annotations in Viewer.

Redacting Documents Using Redaction Annotations
A redaction is a special kind of annotation used to hide confidential information on an image 
document. A redaction is a permanent black or white rectangle that obscures an area of the 
document.

Redactions can be created and saved on image documents whose Document Types are 
configured to allow redactions. See your system administrator to verify whether a Document 
Type has been configured for redactions.
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A redaction cannot be deleted (or undone) once it has been saved. When a redaction is saved, 
the redacted document is stored either as a new document in another Document Type or as a 
revision of the current document. How the redacted document is stored depends on your 
system’s configuration.

Creating a Redaction
You can apply and save redactions to a document if all of the following conditions are met:

• You have sufficient privileges to modify the document.
• The document’s file type is image.
• The document’s Document Type is configured to allow redactions.

1. On the Document tab, click the Notes Gallery.
2. Select a redaction annotation.
3. Using your mouse, define the location and size of the redaction by clicking and dragging 

the pointer over the area you want to redact. Repeat for each area you want to redact.
4. Right-click the image and select Redactions | Create New Redaction.
5. The Redaction Options dialog box is displayed:

6. Select the Delete Redaction Notes after Creating check box if OnBase should delete 
redaction notes from the document after creating the new redaction.

7. Select the Convert Redacted Image to Black and White check box if OnBase should 
convert color images to black and white after performing the redaction.

8. Click Create Redaction.

Note: If configured, you may be asked to provide a comment before saving the document with 
redactions.

9. OnBase displays a message indicating that the redacted document has been created.
If OnBase indicates that the redaction could not be saved, the Document Type may not 
be configured for redactions.

Note: Redactions cannot be saved on an Image Rendered PDF.
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10. The redacted document is displayed. Depending on your system’s settings, this 
redacted document is either saved to another Document Type, saved as a revision of 
the current document, or the existing document is replaced by the redacted document. 
Depending on your system’s settings, the original document may also be deleted.

Caution: If you are using EDM Services, clicking Save on the Markups tab will also save any 
redactions you have added to the document.

Viewing Redactions
If your system is configured to save redacted documents to another Document Type, you can 
view existing redactions for the original document from a Document Search Results list or the 
open document:

1. Right-click the original document.
2. Select Redactions | View Existing Redactions.
3. The View Existing Redactions dialog box is displayed:

4. Double-click a document to open it.

Redacting Documents Using Bitmap Redactions
In addition to standard redactions, images can also be redacted using a bitmap image 
(Redaction Bitmap), which is burned permanently into the image document. Redacted images 
can be used to create tamper-proof markings, such as a signature, or a check mark on a drug 
test result form.

If the Document Type has been configured for Redaction Bitmaps, you can apply and manage 
Redaction Bitmaps with the Redaction Bitmaps button in the Modify ribbon menu group.

Note: Before entering or exiting Redaction Bitmaps mode, you may be prompted to discard 
unsaved changes to the document.
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Navigating in the Bitmap Redaction Tab
In the Redaction Bitmap tab, use the Previous and Next buttons to browse through the 
Redaction Bitmaps on a document. 

Use the Hand Tool to pan or scroll the document in any direction.

Use the Select All button to select all Redaction Bitmaps on the document.

Applying a Redaction Bitmap
To add a Redaction Bitmap to an open document:

1. Click Redaction Bitmaps in the Modify group of the ribbon menu.
2. The Redaction Bitmaps tab is opened. Click the Redaction Bitmaps drop-down.

3. Select a Redaction Bitmap to place it on the document.

4. Add and adjust additional Redaction Bitmaps, if necessary.
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5. When Redaction Bitmaps have been positioned correctly, click the Save button to save 
all Redaction Bitmap changes on the document.

Caution: Ensure you are satisfied with the bitmap before performing this step. Performing this 
action makes the bitmap a permanent part of the document, and it can no longer be moved or 
deleted.

Caution: If a note, redaction, burned markup, or deficiency is not in the location you expect, do 
not save or sign the document until the location has been corrected by your system 
administrator. When the document is saved or signed, the pending redaction, burned markup, 
or deficiency is permanently placed in the shifted location. The shifting of notes that do not 
permanently alter the document can be corrected at any time by your system administrator.

Note: Creating a redacted image from a redaction bitmap differs from creating a redacted 
image using a redaction annotation. When you create a redacted image using a redaction 
annotation, a rendition is created. This means you can view the original document, as well as 
the redacted rendition. Depending on your system’s configuration, when you create a redacted 
image using a redaction bitmap, the redaction is burned directly into the original document and 
a rendition is not created. For additional information, see your system administrator.

Deleting a Redaction Bitmap
You can delete the selected Redaction Bitmap from a document as long as it has not been 
saved to the document. To delete a Redaction Bitmap, select the Redaction Bitmap you would 
like to delete and click Delete:

Working with Notes in the Document Viewer
Users with the appropriate privileges can view and interact with notes on a document using the 
Document Viewer.
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Viewing Notes
Depending on your configuration, existing notes applied to a document are displayed on the 
document.

Notes are displayed on documents as an icon:

To view the properties and contents of a note, hover over the note icon or double-click it to 
open it:

Note: Any time or date in the note Auto-Name string (top line of the note header) respects the 
Windows Region and Language settings of the user creating the note at the time the note is 
created. The time and date in the third line of the note header respects the Windows Region 
and Language settings of the user currently viewing the note.

Showing and Hiding Notes
Depending on your configuration, notes and annotations may be shown or hidden on 
documents by default. To show or hide notes and annotations on the document, right-click on 
the document and select one of the following:

• Show / Hide Notes and Annotations in Viewer
• Show / Hide Notes in Viewer
• Show / Hide Annotations in Viewer

Moving Notes
To move a note, click and drag the note icon on the document. Release the mouse button when 
you have moved the note to its new position. The new position is saved automatically.

Note: You cannot move notes outside of the document.
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Some Note Types may be configured to always maintain the position where they were created. 
If you move a note, its new position is saved only if the Note Type is set up to be moveable. 
Your system administrator determines whether a Note Type should be moveable when the Note 
Type is configured.

Deleting Notes
To delete a note, right-click the note icon or the note and select Delete Note. Click Yes to 
confirm that you want to delete the note.

Setting Note Privacy Options
To set privacy options on a note, right-click the note icon or the note and select Privacy 
Options. Proceed to step 5 in Setting Note Privacy Options on page 114.

Working with Notes in the Task Pane
Ensure you have appropriate privileges for viewing, modifying, or deleting notes. Note the 
following:

• If you have the Create privilege for a Note Type but do not have the View privilege for 
that Note Type, you can create a note of that Note Type on a document. However, 
once the document is closed, you are no longer able to view the note you created.

• If you have the Create privilege for a Note Type but do not have the Modify privilege 
for that Note Type, you can modify the note’s text and position only during the same 
viewing session in which you created the note. Once the document is closed, the 
note’s text becomes read-only. You can reposition the note while viewing the 
document, but the note will return to its original position once the document is 
closed.

Notes may contain messages that can be displayed and edited. If you have appropriate 
privileges, you can delete notes.

Note: Notes can be added using the Document tab’s Notes gallery.
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Viewing and Editing Notes
To view and edit notes:

1. Perform one of the following:
• Click View Notes List on the Document tab.
• Right-click on the information bar of the document and select View Notes List.
• Click the note count displayed on the information bar of the document.

The Notes pane is displayed on the Document Information Panel:

2. To search for specific text contained in the document’s notes, enter text in the Find 
field. The Notes pane automatically displays any notes matching your search criteria. 
To clear search criteria, click the X in the Find field.
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3. To sort the document’s notes, click the following button:

The following sort options are available:

4. Select the note to edit.
5. Edit the contents of the note.

Right-click for the following text-editing options:

6. Click anywhere outside of the note text-editing area to save your changes.

Note: Changes to notes are saved automatically when you click outside of the note text-editing 
area. If the document is closed while the cursor is still in the text-editing area of a note, 
changes to the note may not be saved.

7. Click the red X to close the Document Information Panel.

Deleting a Note
To delete a note:

1. Click View Notes List on the Document tab, right-click and select View Notes List, or 
click the note count displayed above the document.

2. The Notes pane is displayed.

Sort Option Description

None The document’s notes are not sorted.

Created By (Ascending) The document’s notes are sorted by the name of the user that 
created the note, in ascending order.

Created By (Descending) The document’s notes are sorted by the name of the user that 
created the note, in descending order.

Created Date (Ascending) The document’s notes are sorted by the date and time that the 
note was created, in ascending order.

Created Date (Descending) The document’s notes are sorted by the date and time that the 
note was created, in descending order.

Option Shortcut Description

Cut Ctrl + X Click to remove selected text and place it on the clipboard.

Copy Ctrl + C Click to retain selected text and place it on the clipboard.

Paste Ctrl + V Click to insert the text from the clipboard at the location of the cursor.
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3. Select the note to delete.
4. Click the Delete Note button in the Notes gallery, or right-click the note and select 

Delete Note.
5. Click Yes when prompted to confirm.
6. Click Close to close the Notes pane.

Setting Note Privacy Options
Depending on your system’s configuration, you may be able to set privacy options for notes 
that you have created. Privacy options are used to determine whether or not other users can 
view or change a note that you have created.

To set note privacy options:

1. Click View Notes List on the Document tab, right-click and select View Notes List, or 
click the note count displayed above the document.

2. The Notes pane is displayed.
3. Select the note.
4. On the Document tab, in Notes, click Privacy Options, or right-click the note and select 

Privacy Options.
5. The Note Type Privacy Options window is displayed:
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6. Select any of the following options:

Note: Users with administrative rights will always be able to view, update, and delete your 
notes.

7. Click OK.

Viewer Options

Google Services Integration Viewer
When working with documents uploaded through Google Services Integration, documents are 
previewed as PDFs. The Google Services Integration viewer previews documents in a Read Only 
state, and a lock is not placed on the document unless you switch to an alternate viewer. An 
additional button is available on the Document tab when working with these documents.

The Open in Alternate Viewer button is available in the Viewer Options ribbon menu group:

If you do not want to view documents as PDFs in the Google Services viewer, documents can 
instead be opened in Office or in the embedded Unity Client viewer.

To open documents in Office:

1. Click the Open in Alternate Viewer button.
2. Select Open in Office. The document will open in its native Office application.

Note: The Open in Office option is only available when viewing OLE documents. This option is 
only available if the Unity Client is integrated with a Microsoft Office Online Server.

Note Type Privacy Options Descriptions

Disallow View Prohibits all other users from viewing the note.

Note: If this option is selected, other users can still 
successfully search for text in the note, though they will not be 
able to view the note.

Disallow Update Prohibits all other users from editing the note.

Disallow Delete Prohibits all other users from deleting the note.
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To open documents in the Embedded Viewer:

1. Click the Open in Alternate Viewer button.
2. Select Open Embedded Viewer. The document will open in the Unity Client Embedded 

Viewer.

Microsoft Office Online Integration Viewer
When working with OLE (Office) documents in the Unity Client, the Microsoft Office Online 
Integration may be used. When the Unity Client is integrated with a Microsoft Office Online 
Server, Office documents are viewed in an alternate viewer: the Web Application Open Platform 
Interface (WOPI) viewer. An additional button is available on the Document tab when working 
with these documents.

Note: Office documents flagged as read-only cannot be previewed during upload in the WOPI 
viewer.

Note: If the Office Business Application for 2007, 2010, or 2013 is installed and the WOPI 
viewer is configured, the WOPI viewer takes precedence and the documents will be viewed in 
the WOPI viewer instead of the native Office application.

The Open in Alternate Viewer button is available in the Viewer Options ribbon menu group:

Note: The Open in Alternate Viewer option is only available when viewing OLE documents. 
This option is only available if the Unity Client is integrated with an Office Online Server.

If you do not want to view OLE documents in the WOPI viewer, documents can instead be 
opened in Office or in the embedded Unity Client viewer.

To open documents in Office:

1. Click the Open in Alternate Viewer button.
2. Select Open in Office. The document will open in its native Office application.

To open documents in the Embedded Viewer:

1. Click the Open in Alternate Viewer button.
2. Select Open Embedded Viewer. The document will open in the Unity Client Embedded 

Viewer.
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View in Native Format
When an email document is viewed as an image in the Document Viewer, it can be opened 
externally in its native application by selecting View in Native Format.

Note: The View in Native Format option is only available when viewing .EML and .MSG 
documents. The user option Open email documents as images must be selected. For more 
information, see Document on page 50.

Staples
Documents can be attached to each other using staples. In most cases, staples are used to 
associate documents that have an established logical relationship. For example, documents 
related to a single customer may be stapled together or an invoice and its associated purchase 
order may be stapled together. Logical relationships between documents can be established by 
the user but are not required by OnBase to staple documents.

When documents are stapled, a Staple icon is placed on each document. Staple icons can be 
used to directly open associated documents. Since Staples only create a link between 
documents, the stapled documents remain separate.

Staple icons can also be used to open the Staple’s note window, which displays creation 
information and allows the addition of customized text.

Tip: The Staple window can also be viewed in the Notes list on the Document Information 
Panel of an open document.

When using Staples, consider the following:
• The Staple icon and Staple window are placed on the primary document, and a Back 

Staple icon and Back Staple window are placed on secondary documents.
• For documents consisting of multiple revisions, Staple icons appear on all revisions. 

When viewing a stapled document from any revision of an open document, the latest 
available revision of the stapled document is displayed.

• When viewing a stapled document from its associated document, the stapled 
document is opened to the page on which the Staple was placed.

• When a Staple on a document is deleted, the corresponding Staple on the stapled 
document is not deleted. The corresponding Staple on the stapled document must be 
deleted separately.

• When printing a document, Staple icons will not be printed when selecting Note Icon/
Annotation on Document in the Print Settings.
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Stapling Open Documents from the Information Bar
If you have sufficient rights, you can staple two open documents together. To staple two open 
documents together from the information bar:

1. Open two documents in separate windows.
2. Click and drag the stapler icon from the information bar of the secondary document to 

the information bar of the primary document:

3. A Staple icon is displayed on the primary document:

A Back Staple icon is displayed on the secondary document:

Stapling Documents from a Document Search Results List
If you have sufficient rights, you can staple a secondary document in the Document Search 
Results list to an open primary document. To staple documents together from the Document 
Search Results list:

1. Open the primary document to which other documents will be stapled.

Note: Dragging from the Document Search Results list to the embedded internal Document 
Viewer is not supported.

2. Select the secondary document(s) in the Document Search Results list.
3. Click and drag the selected document(s) to the information bar of the primary 

document.
4. A Staple icon is displayed on the primary document:

5. Open the secondary document(s). A Back Staple icon is displayed on the secondary 
document(s):
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Viewing Stapled Documents
When viewing stapled documents, consider the following:

• Stapled documents are opened to the page on which the staple was placed.
• When viewing a stapled document from any revision of an open document, the latest 

available revision of the stapled document is displayed.
• If the stapled document has been deleted, an error message is displayed.

To view a stapled document:

1. From an open document, click the Staple icon. The Staple window is displayed:

2. To view the document stapled to the open document, right-click on the open document 
and select View Stapled Document or click the View Stapled Document button from the 
Staple window:

Moving Staples
To move the Staple icon on a document, click and drag the icon to the new location. The new 
location of the Staple icon is automatically saved.

Editing Staple Notes
To edit Staple note text on an open document:

1. Click the Staple icon on the document. The Staple window is displayed:
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2. In the text-editing area of the Staple note, edit the text as needed.
3. Click anywhere outside of the text-editing area to save changes.

Note: Changes to Staple note text are saved automatically when you click outside of the text-
editing area. If the document is closed while the cursor is still in the text-editing area of a 
Staple note, changes to the Staple note may not be saved.

Deleting Staples
To delete a staple on an open document:

1. Right-click on the Staple icon or Staple window and select Delete Note.
2. On the confirmation dialog box, click Yes. The Staple is deleted.

Note: When a Staple on a document is deleted, the corresponding Staple on the stapled 
document is not deleted. The corresponding Staple on the stapled document must be deleted 
separately.

Image Tab

The Image tab allows you to view documents more efficiently and edit documents. You can use 
the buttons to resize and reorient the document.
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Navigation Description

Selection Zoom allows you to zoom in on the selected region of the document. 
When this button is selected, click on the document and drag the mouse select a 
region. Release the mouse button to zoom in on the selected region.

Hand Tool allows you to pan, or scroll, the document in any direction. When this 
button is selected, click on the document and drag the mouse to move the 
document.

Note: To pan quickly, hold down the Alt key while moving the mouse.

Previous Document displays the previous document in the Document Search 
Results list.

Next Document displays the next document in the Document Search Results 
list.

Previous Page displays the preceding page of a multi-page document.

Note: You can also press Ctrl + Page Up to display the preceding page of a 
multi-page document. If the document is being displayed in the Document 
Viewer pane, click the document prior pressing Ctrl + Page Up.

Next Page displays the following page of a multi-page document.

Note: You can also press Ctrl + Page Down to display the following page of a 
multi-page document. If the document is being displayed in the Document 
Viewer pane, click the document prior pressing Ctrl + Page Down.

First Page displays the first page of the document.

Last Page displays the last page of the document.

Go To Page allows you to go to a specific page in the document.
After clicking this button, type a page number and click OK.
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Toggle Thumbnails displays or hides thumbnails.

Scale Description

Zoom In magnifies the view of a document, reducing the portion that is 
visible. Every zoom increases magnification by one third. 

Zoom Out reduces the magnification of a document, increasing the 
portion that is visible. Every zoom reduces magnification by one third.

Sizing options allow you to select a standard sizing option. Select a 
specific percentage of reduction or magnification (25%, 50%, 75%, 100%, or 
200%), Fit To Width, or Fit To Window. You can also type a custom scale.
Also displays the current magnification percentage whenever the Zoom In 
or the Zoom Out options are used.

Note: Fit To Width is selected by default.

Actual Size displays the document in its actual size (as it is stored in 
OnBase).

Fit To Width resizes the document page so that its width is the same as 
the width of the document display area.

Fit To Window resizes the document page so that the entire image is 
displayed in the window.

Navigation Description
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Transform Description

Rotate Left rotates the selected pages 90 degrees counterclockwise.

Note: To rotate all pages in a document at the same time, click Ctrl + 
A to highlight all pages before clicking Rotate Left.

Rotate Right rotates the selected pages 90 degrees clockwise.

Note: To rotate all pages in a document at the same time, click Ctrl + 
A to highlight all pages before clicking Rotate Right.

Rotate 180 rotates the selected pages 180 degrees.

Note: To rotate all pages in a document at the same time, click Ctrl + 
A to highlight all pages before clicking Rotate 180.

Flip Horizontally flips the selected pages horizontally around the 
vertical axis.

Note: To flip all pages in a document at the same time, click Ctrl + A 
to highlight all pages before clicking Flip Horizontally.

Flip Vertically flips the selected pages vertically around the 
horizontal axis.

Note: To flip all pages in a document at the same time, click Ctrl + A 
to highlight all pages before clicking Flip Vertically.

Save Flip & Rotation saves any flips or rotations.

Note: When the Auto-Save Flip and Rotation user option is enabled, 
this button is not available.

Modify Description

Edit Pages allows you to edit the current document using the Document 
Separation window.
For more information, see Separating Image and PDF Documents on page 
181.
This button is not available under the following conditions:

• This button is not available during indexing.
• This button is not available if there are unsaved changes to the 

document.
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Document Thumbnails
Document thumbnails are miniature representations of the document pages, which provide a 
method of document navigation. When you open a document, thumbnails are displayed along 
the right edge of the Document Viewer, in a vertical column:

You can navigate to a different page in the open document by clicking on the thumbnail for that 
page.

Toggle Overlay turns the overlay on and off, if an overlay is present.

Redaction Bitmaps opens the Redaction Bitmaps tab. For more 
information, see Navigating in the Bitmap Redaction Tab on page 3.

Modify Description
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Text Tab

The Text tab allows you to view text documents more efficiently. You can use the buttons to 
resize and reorient the document. You can also search for text.

Search Description

Find in Document is used to search for text in text 
documents.
For more information, see Internal Text Search on page 128.

Generate Report is used to generate a report of text search 
results.
For more information, see Internal Text Search on page 128.

Settings is used to configure settings when searching for 
text in text documents.
For more information, see Internal Text Search on page 128.
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Navigation Description

Selection Zoom allows you to zoom in on the selected region of the document. 
When this button is selected, click on the document and drag the mouse select a 
region. Release the mouse button to zoom in on the selected region.

Hand Tool allows you to pan, or scroll, the document in any direction. When this 
button is selected, click on the document and drag the mouse to move the 
document.

Note: To pan quickly, hold down the Alt key while moving the mouse.

Previous Document displays the previous document in the Document Search 
Results list.

Next Document displays the next document in the Document Search Results 
list.

Previous Page displays the preceding page of a multi-page document.

Note: You can also press Ctrl + Page Up to display the preceding page of a 
multi-page document. If the document is being displayed in the Document 
Viewer pane, click the document prior pressing Ctrl + Page Up.

Next Page displays the following page of a multi-page document.

Note: You can also press Ctrl + Page Down to display the following page of a 
multi-page document. If the document is being displayed in the Document 
Viewer pane, click the document prior pressing Ctrl + Page Down.

First Page displays the first page of the document.

Last Page displays the last page of the document.

Go To Page allows you to go to a specific page in the document.
After clicking this button, type a page number and click OK.
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Toggle Thumbnails displays or hides thumbnails.

Scale Description

Zoom In magnifies the view of a document, reducing the portion that is 
visible. Every zoom increases magnification by one third. 

Zoom Out reduces the magnification of a document, increasing the 
portion that is visible. Every zoom reduces magnification by one third.

Sizing options allow you to select a standard sizing option. Select a 
specific percentage of reduction or magnification (25%, 50%, 75%, 100%, or 
200%), Fit To Width, or Fit To Window. You can also type a custom scale.
Also displays the current magnification percentage whenever the Zoom In 
or the Zoom Out options are used.

Note: Fit To Width is selected by default.

Actual Size displays the document in its actual size (as it is stored in 
OnBase).

Fit To Width resizes the document page so that its width is the same as 
the width of the document display area.

Fit To Window resizes the document page so that the entire image is 
displayed in the window.

Transforms Description

Toggle Overlay turns the overlay on and off, if an overlay is present.

Navigation Description
OnBase 18
©2018 Hyland Software, Inc.

127



Unity Client
Usage
Internal Text Search

Use the Find in Document field on the Text tab to search for specific text strings within the 
document.

Note: If an overlay is turned on, you cannot perform an internal text search on the document.

To perform an internal text search:

1. Click in the Find in Document field and type the characters to search for. Internal text 
searches are case-insensitive, so searches for Account will also find account, and 
searches for account will also find Account.

2. If necessary, click Settings to limit your internal text search. 
See Limiting Searches Using Internal Text Search Settings on page 129 for more 
information.

3. Press the Enter key.
4. The number of occurrences of the specified string of text is displayed below the Find in 

Document field as Result 1 of #, where # is the total number of occurrences.
5. The first occurrence of the specified string of text is displayed within a highlight bar.
6. Click Find Next to search for the next following occurrence of the specified string within 

the current text document.

7. Click Find Previous to search for the previous occurrence of the specified string within 
the current text document.

Generating Text Search Reports
Internal text searches can be run to generate a report of text search results. Text search 
reports that are generated are archived to OnBase as a document in the SYS Search Reports 
Document Type. The full line in which the text result is found is included in the generated 
report.
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To generate a text search report:

1. Click Generate Report. The Generate Text Report dialog box is displayed:

2. In the Search Term field, enter the characters for which to search. This field is limited to 
200 characters.

3. In the Report Description field, enter a description for the text search report. The 
specified value is used to populate the Description Keyword Value for the generated 
report document. This field is limited to 49 characters.

4. Enter a value from 0 to 100 to specify the number of lines prior to each text search 
result in the document that will be included in the generated report document.

5. Enter a value from 0 to 100 to specify the number of lines following each text search 
result in the document that will be included in the generated report document.

6. Click OK. The text search is run.
7. Once the text search is complete, the generated search report is archived and displayed.

Limiting Searches Using Internal Text Search Settings
Searching an entire document for a specific text string can be time-consuming, especially if the 
document is very long. If you have an idea of where the text string occurs in the document, you 
can use text search options to limit your search. For example, if you know that the phrase you 
are looking for occurs only within a specific set of columns, you can limit the search to those 
columns. Depending on how the document was imported, you may also be able to search 
predefined blocks of text using column indexes.
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To limit a search using internal text search settings:

1. Click Settings.
2. The Settings drop-down list is displayed:

3. Select from the following:

Settings Description

Text Select to search for alphanumeric text.

Number Select to search for numeric values. This option also allows the use of the 
following operators to limit the search: =, >, <, >=, and =<. You can use 
and, or, and to as operators to search for a range of values. For example, 
type 2010 and 2011 to find documents containing both 2010 and 2011.
If you are searching for an exact number that is part of an alphanumeric 
text string, then the number will not be found. For example, if you search 
for 001 and the actual text is ABC001, then the value will not be found.

Formatted Number Select to search for numeric values that use formatting characters. For 
example, to search for all Social Security Numbers greater than 800-00-
0000, type > 800-00-0000 in the Search String field. You can use this 
option with following operators to limit your search: =, >, <, >=, and =<. 
The and, or, and to operators can be used to search for a range of values. 
For example, type 800-00-000 to 900-00-0000 to find documents 
containing values within this range.

Note: When you search for formatted numbers greater or less than the 
entered search string, formatted numbers followed by periods are not 
included in the search results. For example, if the formatted number is the 
last word in a sentence, then it will be omitted as a result.

Use Wildcards Select to include wild card characters in your text string search criteria.

Case Sensitive Select to return only matches that have the same capitalization as the text 
string search criteria.
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4. Press the Enter key.
5. The search is executed with your selected options.

Whole Word Match Select to return matches for an exact word.

Column Searching Use Column Searching - Select to search within specified columns.
Column Indexing - Select the column index for the block of text that you 
want to search. This setting is only available for documents with column 
indexes.
After selecting either option, select Columns... to specify columns in the 
Column Configuration window:

In the From field, type or select the character position of the column to 
start the search in (the left most column to be searched). The column of 
characters at the far left of the document is 1, the next column to the right 
is 2, and so on.
In the To field, type or select the character position of the column to end 
the search in (the right most column to be searched). The number in the 
To field must be greater than or equal to the number in the From field.

Settings Description
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Overlays
This example shows a document displayed with an overlay.

This example shows the same document displayed without an overlay.

If a text document has been set up with a corresponding overlay, the Toggle Overlay button is 
available. This indicates that you can apply the overlay to the document or remove the overlay.
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Apply an Overlay to a Document
Open a text document that uses an overlay and select Toggle Overlay on the Text tab to apply 
its overlay:

Remove an Overlay from a Document
To remove the overlay from the window, click Toggle Overlay on the Text tab.

Media Tab
The Media tab is displayed after opening an audio or video file in OnBase:

You can use the slider to re-wind or fast-forward.
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You can also use the following Controls:

Retrieving Cross-Referenced Documents
If cross-references have been set up by your System Administrator, related documents can be 
automatically retrieved from an open document or the Document Search Results list.

You retrieve cross-references in different ways depending on the type of document that is open 
(image, text, or electronic form). In most cases, your system administrator will instruct you on 
how to properly retrieve cross-referenced documents.

Playback Description

Click to stop the file that is playing.

Click to pause the file that is playing.

Click to play the file.

Navigation Description

Previous Document displays the previous document in the Document Search 
Results list.

Next Document displays the next document in the Document Search Results list.
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The Cross-References pane displays cross-references for the selected document if there are 
any available:
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Double-click the cross-reference to display the document. The document displays in a window 
titled Document Related to [Auto-Name string of the original document].

Note: Some Document Types do not support cross-references. See your system administrator 
for additional information.

Note: If there is more than one value for the referenced keyword, all documents matching 
cross-reference criteria are retrieved.

From a Document Search Results List
Select a document and click Cross-References on the Document tab.

From Image or Text-Based Documents
From an open document:

• Double-click on the cross-reference or region preset by your system administrator; or
• Click Cross-References on the Document tab.

From E-Forms, HTML Documents, or OLE Documents
From an E-Form, HTML document, or OLE document, click Cross-References on the Document 
tab.

Access Document History
View a document’s history by accessing the Document History dialog box, which contains a 
variety of information regarding the history of the document.

To view a document’s history:
• From a Document Search Results list, select the document, right-click, and select 

History or click History on the Document tab.
• From an open text, image, or PDF document, right-click and select History or click 

History on the Document tab.
• From an open HTML document, click History on the Document tab.

Note: Your User Group must have the Document History product right in order to access 
Document History. For additional information, see your system administrator.
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Document History
The Document History dialog box contains the following information about actions that were 
performed on the document:

Note: Depending on your system’s configuration, you may have access to the Workflow 
Queues or Workflow Transactions tabs. For more information on these tabs, see the Workflow 
documentation.

Note: Page rotation is calculated clockwise from the point of origin. For example, Rotate270 is 
displayed in the Document History dialog if a page is rotated once to the left. Rotating the page 
once to the right would be shown in the Document History as Rotate90.

Access Document Properties
The Document Properties dialog box contains a variety of information regarding the document.

To view a document’s properties:
• From a Document Search Results list, select the document, right-click, and select 

Properties.
• From an open text, image, or PDF document, right-click and select Properties or click 

Properties on the Document tab.
• From an open HTML document, click Properties on the Document tab.

Note: Your User Group must have the Document Properties privilege in order to access 
Document Properties. For additional information, see your system administrator.

Column Description

Log Date The date that the action was logged.

Log Time The time that the action was logged.

User name The user who performed the action.

Action The action that was performed.

Message A message, using the document’s Auto-Name string, describing the action that 
was performed.
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Document Properties
You can display the Properties of all documents in the system, as long as you have the proper 
privileges.

Property Description

Document Handle The document number assigned to the document when it was 
brought into the system. This is the only place in the system where 
the internal document handle for a document is displayed. The 
document handle can be used to retrieve a specific document and 
to troubleshoot problems with the document.

Document Name The Auto-Name string of the document.
This is displayed at the top of the Document Properties dialog 
box.

Batch # The number of the batch in which the document was brought into 
the system. A batch number is displayed if the document was 
brought into the system through a process such as COLD.

Document Date The date used by the system to refer to the document. This date is 
used during searches limited by date. The document date is 
assigned to a document during import.

Note: If the Import layout has been open overnight, the system 
date and Document Date may reflect the previous day’s date. If this 
has occurred, close and re-open the Import layout so that the 
correct Document Date is stored.

Date Stored The date on which the document was imported into the system. If 
an invoice from December 28, 1996 was brought into the system on 
March 11, 1997, December 28, 1996 is the document date and 
March 11, 1997 is the date stored. This date is used for internal 
tracking. You cannot search for documents based on the date 
stored.

Document Type Number The internal number associated with documents of this Document 
Type.

Document Type The name of the Document Type to which the document belongs.

Document Status Displays the document's position in the system. If the document is 
retrievable, a status of 0 is displayed. If the document is in the 
system, but not yet available for retrieval, a status of 1 is displayed. 
If the document has been deleted, a status of 16 is displayed.
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Document Type Revision Displays which revision of the Document Type the document is 
using. Different Document Type revisions can have different 
configurations.

Revision # If the document is revisable, the Revision field displays the latest 
revision number of the document. For non-revisable documents, 
this field is always set to 1.

Created By The name of the user who processed the document into the 
system.

Security Value For internal use only.

Page The internal page number for a document. Page numbers start at 0, 
and are indicative of the number of files used to display the 
document. Text documents typically have only one page, while 
image documents typically have several. Virtual E-Forms have no 
pages, so on a Virtual E-Form this field would display the tag 
<Virtual E-Form> instead of a page number.
This information is available by clicking More Information.

Disk Group The number associated with the Disk Group in which the document 
is stored.
This information is available by clicking More Information.

Volume The volume number in the Disk Group in which the file is stored. 
This information is available by clicking More Information.

# of Pages and # of Lines The characteristics of the document within the file. These values 
are useful for text documents. Non-text documents display the 
number of pages as 1 and the number of lines as 0.
This information is available by clicking More Information.

File Format The number associated with a configured file format. This number 
determines how a document is displayed and printed.
This information is available by clicking More Information.

Offset and Size Describes the physical storage of the document within the file. The 
Item Offset is the byte offset into the file for the starting point of 
this particular document. The Item Size is the number of bytes in 
the file that make up this document.
This information is available by clicking More Information.

Path Lists a partial path to the document. The beginning of the path 
depends on the location configured for the document’s Disk Group.
This information is available by clicking More Information.

Property Description
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Note: Dates and times use the Windows regional settings for formatting.

Generating a CSV File

Note: When generating a CSV file with one or more documents containing a Multi-Instance 
Keyword Type Group, keywords from the Multi-Instance Keyword Group will not be included.

Note: To generate a CSV file, a user must have the View Keywords and Create List Report 
privileges.

Note: CSV files cannot be generated from Full Text Search result lists.

Note: In the generated CSV file, ’ is inserted at the beginning of values that begin with =, -, @, or 
+.

To export the results of a search in a .csv file, follow these steps:

1. From a Document Search Results list right-click and select Generate CSV File. The 
Generate CSV File window is displayed.
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2. Configure your file as desired. The following table describes each available option.

3. In the Save to File field, enter the name and location that will be used to save the CSV 
file. You can select Browse to navigate to the correct location.

4. Click Launch Associated Application if you would like to view the CSV file after you 
click Generate. The file will be opened by your default CSV application.

Option Description

Selected Items Select this radio button to generate the CSV file using only the 
documents you have selected in the search results list.

All Select this radio button to generate the CSV file using all of the 
documents in the search results list.

Document Name Select this box to include the Document Name in the CSV file.

Document Date Select this box to include the Document Date in the CSV file.

Archive Date Select this box to include the date the document was stored in OnBase 
in the CSV file.

Document Type Select this box to include the Document Type in the CSV file.

Document Handle Select this box to include the Document Handle in the CSV file.

DocPop URL Select this box to include the DocPop URL in the CSV file.

Note: Depending on your system’s configuration, you may be unable 
to select this option. See your system administrator if you have 
questions.

Keywords Select the Keyword Types you want to include in the CSV file.
None: Select this option to include no Keyword Types.
Common: Select this option to include only Keyword Types that are 
found in all of the documents included in the CSV file.
All: Select this option to include all Keyword Types in all the document 
included in the CSV file.

Note: Depending on your system’s configuration, you may be unable 
to view certain Keyword Types. These Keyword Types will not be 
included in the CSV file.
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5. Click Generate. The CSV file has been created at the specified location.
Or click Cancel to cancel the process and return to the search results list.

Note: The Generate button is not available until a file location is specified.

Caution: If the CSV file already exists and is currently open, you will be unable to generate the 
new CSV file. You must close the existing CSV file before you can overwrite it with your newly 
generated file.

Saving Documents to Files
If you have the appropriate user rights, you can save the document that you are viewing to a file 
that you can access on your computer system or through a network connection.

The ways in which you can save a document to a file are based on whether the document is 
open, as well as file type of the document:

• From a Document Search Results list, or an open text or image document:
• Right-click and select Send To | File, or
• Click the Send To button on the Document tab and select File.

Tip: You can select multiple documents to save by holding down the Ctrl key while clicking.

• From an open E-Form, HTML document, or OLE document, click the Send To button 
on the Document tab and select File.

Note: Rotating an image without saving the rotation before sending it to file will not save the 
newest rotation.

Certain special characters are not supported in file names. If these characters appear in the 
document’s Auto-Name string, they are replaced with a space or substituted with other 
characters that are supported. The following special characters are replaced with a space: @ # 
$ % ^ & = { } [ ] : " ; ’ < >. Character substitutions are as follows:

Auto-Name Character Substitution

* +

? !

/ -

\ -

| !
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To save a document to a file:

1. Right-click and select Send To | File, or click the Send To button on the Document tab 
and select File.

2. The Send To File pane is displayed:
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3. Select one of the following options from the File Format of Attachment drop-down 
select list:

File Format of 
Attachment

Description

Default/TIFF Format Saves the document as a TIFF file.
Available for documents with any of the following file formats:

• Image file format
• PCL
• PCL with overlay
• Text report format
• Text report format with overlay

Unencrypted PDF Saves the document as a PDF file.
Available for documents with any of the following file formats:

• Image file format
• PCL
• PCL with overlay
• Text report format
• Text report format with overlay

Encrypted PDF Saves the document as an encrypted PDF file. Upon choosing this 
Content Type, you will be prompted to enter a password, which will 
need to be entered upon opening the file.
Available for documents with any of the following file formats:

• Image file format
• PCL
• PCL with overlay
• Text report format
• Text report format with overlay

Native Format Saves the document in the format in which it is stored in OnBase (e.g., 
OLE documents such as Word documents and PDFs, uncompressed 
text documents, most image documents).
Overlays are not applied.

Note: When saving a Unity Form using Native Format, attachment 
controls, images, drawing controls, and signature controls are not 
supported and do not function in this context. Choosing Default/TIFF 
Format will display these controls.

Note: This option is unavailable for multi-page image documents.
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Note: An Image Rendered PDF document can be saved in its native format as long as no 
modifications have been made to the document. Once the document has been modified (e.g., 
an image markup has been applied, or pages have been moved or deleted), the document can 
no longer be saved in its native format.

If you are saving an encrypted PDF, you are required to type an encryption password in 
the Password field, which is displayed below the File Format of Attachment field in the 
Send to File pane. This password is case-sensitive and can include alphanumeric or 
special characters. It cannot contain Unicode characters.

Caution: If you lose or forget the encryption password, it cannot be recovered.

4. Select one of the following from the Settings drop-down select list:

5. If you are saving a document containing notes or annotations, the Note Options drop-
down list is available. Select either of the following:

Text Format Saves the document as a .txt file.
Available for documents with compressed text file formats. This 
includes documents imported with COLD or documents with the .ctx 
file type.

Settings Description

Send All Pages All pages in the selected document will be saved.

Send Custom Range The page(s) specified in the Pages field will be saved. Enter page 
numbers and/or page ranges, separated by commas. For example: 1,3,5-
12.

Note: This option is unavailable when File Format of Attachment is set 
to Native Format.

Option Description

Annotation and/
or Note Icon On 
Document

The document is saved with any annotations and note icons displayed on the 
document. If you move a note before saving the document, the note is 
displayed in its last saved location. Note locations are saved when a 
document is closed.

File Format of 
Attachment

Description
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6. To change the file name the document is saved as, click the Browse button:

Enter a new name for the file and click Save.
7. To change the location where the document should be saved, click the Browse button:

The Browse For Folder dialog box is displayed. Browse to a new location and click OK, 
or click Make New Folder to create a new folder in the current directory.

8. When sending multiple image or text documents, the Apply Settings to Subsequent 
Documents check box is available.
When it is selected, the File Format of Attachment selection is applied to all 
subsequent documents. The Settings drop-down list and Pages field are not available. 
The Note Options drop-down list is only available if the first selected document 
contains notes.
When it is not selected, you are required to repeats steps 3 through 5 for each 
document. Navigate through the documents using the Next Document button:

Note Text On 
Document

The document is saved with the title and text of any notes in that note’s 
location on the document, along with the name of the user that created the 
note and the date and time it was created. If this option is selected with 
Annotation and/or Note Icon On Document, the text is displayed below the 
icon. If you move a note before saving the document, the note is displayed in 
its last saved location. Note locations are saved when a document is closed.

Option Description
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9. Click Save. A confirmation is displayed in the Send To File pane:

10. The document is saved to the selected location using the chosen document name as 
the file name.

Deleting Documents
You can delete documents from the Document tab, or by using the right-click option from a 
Document Search Results list, open image or text document, or folder.

To delete a document from the Document tab:

1. Ensure that the document is displayed.
2. Select the Document tab.
3. Click Delete.
4. Confirm the deletion when prompted.

To delete a document from a Document Search Results list, or to delete an open image or text 
document:

1. Select the document(s) you want to delete.
2. Right-click and select Delete Document.
3. Confirm the deletion when prompted.
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To delete a document from a folder:

1. Select the document(s) you want to delete from the Folder Documents pane.
2. Right-click and select Delete Document.
3. Confirm the deletion when prompted.

Creating a Document
In most cases, new documents are created by importing them. In addition to importing 
documents, you can create new documents from an existing document or from a thumbnail. 
The newly created document will be of the same file type as the original document.

The new document created can become a revision of an existing selected document or an 
entirely new document.

Note: A revisable document will not have its initial revision created until it has been indexed. 
Prior to indexing, all changes to the document will not create a new revision.

Note: A revision of a document can not be created while the document is locked.

Creating a New Document from an Existing Document

Note: An image document that has unsaved modifications cannot be used to create a new 
document with the Send To | Create New Document feature. Save all modifications before 
attempting to create a new document from an image.

1. To create a new image document from an existing one:
• From the Documents Search Results list, right-click on a document and select Send 

To | Create New Document.

Note: The Create New Document and Copy to Clipboard / Save As privileges are needed to use 
the Send To | Create New Document Feature in the Document Retrieval layout.

• From an open document, right-click and select Send To | Create New Document.
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• From an open document, select a document’s thumbnail page image, or select 
multiple pages by holding down the Ctrl (specific pages) or Shift (page range) keys. 
You can also press Ctrl + A to select all pages. After selecting pages, right-click and 
select Send To | Create New Document.

 The Create New Document dialog box is displayed.

Note: Unity Forms and Image Forms are not supported by the Send To | Create New Document 
feature.

2. Select the Document Type Group for the new document.
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3. Select the Document Type for the new document.

Note: If you select a different Document Type during document creation, entered Keyword 
Values are cleared. Default values for common Keyword Types are either updated or cleared 
when selecting a different Document Type, depending on whether the selected Document Type 
has default values for those Keyword Types.

4. In the Create from pages field, specify the page(s) to include in the new document. If 
you selected specific thumbnail page images, the Create from pages field automatically 
reflects this selection.
• To specify a range of pages, type the start page-end page (e.g., pages 4-6).
• To specify multiple pages that are not within a range, use commas to separate the 

pages (e.g, pages 1, 3, 5-12).

Note: If the original document is a text document or a single page, this field will not be 
displayed.

5. To delete the selected pages from your original document, select Delete copied pages 
from original document.

Note: The option Delete copied pages can not be selected when the Create from pages range 
includes all pages of the original document.

6. If you want the new document to be created as a revision of the existing document, 
select Create as revision of original document.

Note: If you selected Delete copied pages from original document in the previous step, the 
Create as revision of original document option will not be available.

7. To add the new document to Workflow, select Initiate Workflow.

Note: This check box is only available when licensed for Workflow and the Document Type is 
part of an existing Life Cycle.

8. To assign a date to the new document, select a date from the Document Date drop-
down calendar. Often, this is the date the document was created or received.

9. Keyword Values are inherited from the original document. If necessary, click Clear 
Keywords and re-index the new document if necessary.

10. Click OK to create the new document. The new document is automatically displayed.
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Executing a Unity Script
When the Tasks tab is available, you can execute a Unity Script over any open document or a 
group of documents selected from the document retrieval list:

Clicking Execute Task displays a drop-down list of scripts to execute on the document(s).

Caution: Executing a Unity Script which affects an open document will refresh the document 
viewer and keyword panel for that document and remove any unsaved changes. Ensure that 
you have saved any necessary changes before executing a Unity Script.

Note: The Unity Automation API license is required to execute Unity Scripts.

To change the order of script tasks in the Execute Task drop-down list, click the lower right 
corner of the Script Tasks ribbon group, or select Configure Items... from this drop-down list. 
In the Organize Tasks dialog box, select script tasks and re-position them using the 
corresponding arrows. To add a button to the Script Tasks ribbon group for a script task, select 
the corresponding check box next to the script task:
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Working with Keywords

Note: Some Document Types are configured to require Keyword Values to be entered in order 
to create and/or retrieve documents. Required Keyword Values are displayed in red for these 
operations, which may include the following: Document Retrieval, Import, and Add/Modify 
Keywords.

Access the Keyword Values of a Document
Some documents have one or more Keyword Values displayed automatically in the Keywords 
window when you open the document:

You can move the Keywords window, or minimize it by clicking:

You can also close the Keywords window by clicking:

To copy a Keyword Type or Keyword Value to the Windows clipboard, select it and press Ctrl + 
C, or right-click and choose Copy.

You can also view Keyword Values that are not auto-displayed. Depending on your system’s 
configuration, these Keyword Values may be masked or read-only.

To access a document's Keyword Values, perform one of the following:
• From a Document Search Results list or an open image or text document, right-click 

and select Keywords, or click Keywords on the Document tab.
• From an open OLE or HTML document, click Keywords on the Document tab.
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The Keywords pane is displayed:

From the Add/Modify Keywords pane, you can view or edit a document’s Document Date or 
Keyword Values, depending on your rights and the Document Type. Some Document Types are 
configured to not allow keyword editing, which renders a document’s Keyword Values read-
only.

Note: When the Keywords pane is displayed, other users cannot edit that document’s Keyword 
Values. The document is locked until the Keywords pane is closed.

Tip: For Keyword Values that exceed the width of the Keywords pane, hover over the Keyword 
Value to display its entire value.
OnBase 18
©2018 Hyland Software, Inc.

154



Unity Client
Usage
Add / Modify Keywords
Use the Keywords pane to view or modify the document Keyword Values currently associated 
with the document. The Keyword Value is blank if no Keyword Value is currently assigned.

You can use the Keywords pane to remove, add, or change a Keyword Value:
• To remove a Keyword Value from a document, delete the contents in the Keyword 

Type field.
• To change the value, edit the Keyword Value currently residing in the Keyword Type 

field.
• To add another value for a Keyword Type, place the cursor in the Keyword Type field 

and press F6 or double-click the Keyword Type name. An additional field is displayed 
for the Keyword Type. Fill in the additional Keyword Value.

Note: If you add another value of a Keyword Type within a Multi-Instance Keyword Type Group, 
another instance of the entire Multi-Instance Keyword Type Group will be added, not just the 
Keyword Type. This is because all Keyword Types within the Multi-Instance Keyword Type 
Group are part of a record. When you choose to duplicate the Keyword Type, you must 
duplicate the entire record. It is recommended that all Keyword Type values are indexed when a 
Multi-Instance Keyword Type Group is duplicated, even if only one Keyword Value is different 
between the original Keyword Type Group and additional instances.

A calendar button is available next to date-based Keyword Types, allowing you to select a date 
from a calendar. A drop-down arrow may be available for some alphanumeric Keyword Types, 
allowing you to select a Keyword Value from the drop-down list.
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When you modify a Keyword Value, the modified Keyword Value turns blue:

You can use the Tab key to move to the next Keyword Value field.

When viewing keywords, the following keyboard shortcuts are available:

Keyboard Shortcut Description

F5 Show the drop-down select list for the selected Keyword 
Type.

F6 Add another value for a Keyword Type.

Ctrl + O Collapse or expand any Multi-Instance Keyword Type 
Groups.
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Click Save Keywords to save any additions or modifications in the Keywords pane. The 
Keywords pane is refreshed to display the most recent changes.

Caution: In some instances, changing Keyword Values will affect the appearance of your 
document. Change Keyword Values carefully.

Note: If this document is checked out by another user, keywords cannot be modified.

Note: A document cannot be saved with an invalid Document Date. The Document Date field 
will turn red to indicate an invalid date entry.

Note: You cannot change Keyword Values on E-Forms that have been signed. When a form is 
signed, the Keywords pane becomes read-only and the Re-Index option is disabled for the 
form.
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Read-Only Keywords
Sometimes you can view, but not modify some or all of the Keyword Values on a document. 
This can be for any of the following reasons:

• Keywords can be configured to appear as read-only to certain User Groups. If this is 
the case, the Keywords pane will resemble the following:
In the following example, the PO # Keyword Value is configured as read-only at the 
Document Type level. The user is unable to modify this Keyword Value. The user is 
able to modify the other Keyword Values.
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• The User Group that you belong to does not have the Modify Keywords privilege. The 
Keywords pane displays in read-only mode:

• When you elect to view keywords on a document, OnBase displays a message that 
someone has the document checked out or locked, and the Keywords pane is in read-
only mode. Depending on your system configuration, this happens if a document is 
checked out by another user, or if it is persistently checked out.

Note: When you open the Add/Modify Keywords pane, the document is locked for your use so 
you can modify Keyword Values and save the changes. The document is unlocked when the 
pane is closed. When another user attempts to open the Keywords pane for a document that is 
locked, the user can view the Keyword Values, but not modify them.
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Mixed Case Keywords
Keyword Types configured for an Alphanumeric Data Type must be assigned a Character Case 
setting. There are two Character Case options that may be assigned to a Keyword Type: 
Uppercase Values and Mixed Case Values with an option for Case Sensitive Searching.

Keyword Types configured for Uppercase Values store the Keyword Value in uppercase letters, 
regardless of how the Keyword Value was entered upon indexing. Keyword Types configured 
for Mixed Case Values store the Keyword Value upon indexing exactly how it was entered, 
using both upper and lower case characters.

See your system administrator for details on Keyword Types that may be configured for Mixed 
Case Values.

Searching on Mixed Case Keyword Values

With Case Sensitive Searching Applied
Whether you are searching for documents through Document Retrieval, cross-references, etc., 
you must be aware of the case that was entered when the document was indexed. For example, 
“JOHN ADAMS” and “John Adams” are separate values and will not produce the same results if 
the Keyword Value is not entered correctly.

Without Case Sensitive Searching Applied
If a Keyword Type does not have Case Sensitive Searching applied to it, then the value you 
enter on a document will not depend on the case used when indexed. For example, the Keyword 
Value when indexed is “John Adams”. However, when searching you may type in “JOHN 
ADAMS” and retrieve the document. In this instance, “John Adams” and “JOHN ADAMS” are not 
separate values, however, the Keyword Value will display as it was originally indexed.

See your system administrator for details on Keyword Types that may be configured for Case 
Sensitive Searching.

Indexing Mixed Case Keyword Values
When indexing or re-indexing a document, two Keyword Values with the same value, but a 
different case may not be stored on the same document.

For example, the values “JOHN ADAMS” and “John Adams” cannot be indexed under the same 
Keyword Type on the same document.

Masked Keywords
Masked Keyword Types must have values entered in a specific format, called a mask format. 
Fields for masked Keyword Types prohibit you from typing values that do not satisfy the mask 
format.
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For example, a masked Keyword Type for Social Security Numbers may contain dashes as 
static characters and allow users to enter only nine numeric characters. The dashes are 
entered automatically as the subsequent characters are typed.

Depending on your system’s configuration, a mask may also be applied to certain Keyword 
Values upon retrieval.

The mask format is displayed after placing your cursor in the Keyword Type field, as shown in 
the following example:

AutoFill Keyword Set Instance
An AutoFill Keyword Set instance is a Primary Keyword Value and its corresponding Secondary 
Keyword Values on a document.

• A document may contain one or more instances, depending upon its configuration.
• Many instances can compose the total AutoFill Keyword Set.

Using AutoFill Keyword Sets When Indexing or Re-Indexing
An AutoFill Keyword Set is a collection of Keyword Values dependent upon a Primary Keyword 
Value. If an AutoFill Keyword Set is assigned to a Document Type, a value entered into the 
Primary Keyword Type field during indexing of a document triggers the population of the 
remaining Keyword Types with values from the AutoFill Keyword Set.

Indexing with AutoFill Keyword Sets
1. From the Import layout, enter the first Keyword Value. Press the Tab key on the 

keyboard or click outside of the Primary Keyword Type field. The remaining values for 
the remaining Keyword Types in the AutoFill Keyword Set will populate in their 
respective fields. If you entered a Primary Keyword Value that has more than one 
AutoFill Keyword Set associated with it, you are prompted to select which AutoFill 
Keyword Set to use. Continue to Step 2. Otherwise, skip to Step 6.

2. If you are prompted to select which AutoFill Keyword Set to use, the Primary Keyword 
Value has more than one AutoFill Keyword Set associated with it. For example, both the 
Plaintiff and the Defendant may share the same Case#, so there may be two separate 
sets of values for a Case# Primary Keyword Value.
• Depending on how your system is configured, you may be allowed to choose one or 

more of the AutoFill Keyword Sets.
• If you are permitted to select only one set, the values of your selected set are 

displayed in the indexing fields.
• If you are permitted to select multiple AutoFill Keyword Sets, the document is 

indexed with values from both AutoFill Keyword Sets.
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3. Select the AutoFill Keyword Set(s) from the list and click OK.
4. Keyword Values are displayed according to the order in which their associated Keyword 

Types are configured to display on the Document Type. Depending on the AutoFill 
Keyword Set’s configuration, these values may be read-only.
For example, if a loan document associated with a loan taken out jointly by two 
customers is associated with one Keyword Value for Account #, Last Name, and 
Address, but two different Keyword Values for First Name, then an additional instance 
of the First Name Keyword Type is added after the first and both Keyword Values for 
First Name are displayed. Only one instance of a Keyword Value common to both sets is 
displayed.

5. You can verify if the Keyword Set Configuration permits multiple sets by checking the 
Settings. In the Configuration Module, select Keyword | AutoFill Keyword Sets, select 
the AutoFill Keyword Set you want to verify and click Settings.

Note: Your User Group must have rights to that AutoFill Keyword Set to have access to it in the 
AutoFill Keyword Sets Configuration dialog box.

The Allow Multiple Keyword Set Selection will be checked if the AutoFill Keyword Set is 
configured to allow for more than one set of AutoFill Keyword set values for one 
Primary Keyword Value. This setting can be changed once the AutoFill Keyword Set has 
been created.

6. When all fields are populated, click Import.

Note: If you change the Primary Keyword Value and press Tab, all Secondary Keyword Values 
are updated to reflect the new Primary Keyword Value. If you create another Primary Keyword 
Type field and enter a second Primary Keyword Value, OnBase adds another set of values 
associated with the second Primary Keyword Value while retaining the values associated with 
the first Primary Keyword Value.

Note: Every workstation that will be accessing External AutoFill Keyword Sets must have an 
ODBC connection that has the same name as the one configured in the Configuration module. 
See your system administrator for details. In the case of Web Server, only the Web Server itself 
must have the ODBC connection, not the client workstations.

Re-Indexing with AutoFill Keyword Sets
1. From an open document or from a Document Search Results list, right-click and select 

Re-Index or click Re-Index on the Document tab.
2. Using the drop-down, select the Document Type to which the document is to be re-

indexed.

Caution: AutoFill Keyword Sets may unexpectedly re-populate Secondary Keyword Values 
when re-indexing to a Document Type associated with the same Keyword Type Group (KTG) or 
Multi-Instance Keyword Type Group (MIKTG) as the current Document Type. For more 
information, see Considerations for Re-Indexing Documents and Adding or Modifying Keyword 
Values on page 177.
OnBase 18
©2018 Hyland Software, Inc.

162



Unity Client
Usage
3. To select a date with a calendar, hover over the right edge of the Document Date field 
and click the down arrow.

4. If necessary, modify the Keyword Values on the document:
Changing the Primary Keyword Value to another Primary associated with the AutoFill 
Keyword Set: If this occurs, all Secondary Keyword Values are updated to reflect the 
values associated with the new Primary Keyword Value.
To avoid undesired Keyword Value changes, click on any field in the dialog box before 
clicking the Re-Index button. This will trigger the AutoFill Keyword Set and allows the 
user to review any changes made to the Secondary Keyword Values before re-indexing 
the document.
If more than one AutoFill Keyword Set is associated with the same Primary Keyword 
Value: Multiple AutoFill Keyword Sets are displayed in a selection box after the Primary 
Keyword Value is entered. Depending on how your system is configured, you may be 
able to select one AutoFill Keyword Set or you may be able to select multiple AutoFill 
Keyword Sets.
If you are only permitted to select one AutoFill Keyword Set, the Keyword Values 
associated with the AutoFill Keyword Set populate the Keyword Type fields.
If you are permitted to select more than one AutoFill Keyword Set, the document is 
indexed with Keyword Values from all AutoFill Keyword Sets. Only one instance of a 
Keyword Value common to both sets is displayed. Additional instances of Keyword 
Types are added to hold Keyword Values not common to both AutoFill Keyword Sets.

5. Add Keyword Values to any Keyword Types that are not associated with the previous 
Document Type but are associated with the new Document Type.

6. Click Re-Index.
Once the document has been re-indexed, it no longer exists in the database as the 
original document, and can only be retrieved using the new Document Type and any new 
Keyword Values.

Using a Reverse AutoFill Keyword Set Lookup
A Reverse AutoFill Keyword Set Lookup allows you to search for and select an AutoFill Keyword 
Set instance while indexing a document. Once selected, the AutoFill Keyword Set is used to 
populate Keyword Type values on the document.

Note: Depending on your configuration, for existing Keyword Type values on a document, 
selecting an AutoFill Keyword Set from a Reverse AutoFill Keyword Set Lookup will either add 
additional instances of Keyword Types or replace existing Keyword Type values. For more 
information, contact your system administrator.

To use a Reverse AutoFill Keyword Set Lookup to find an AutoFill Keyword Set:

1. From the interface you are using to index the document, select a Document Type that 
has a Reverse AutoFill Keyword Set configured.

Note: Reverse AutoFill Keyword Sets are configured in the Configuration module. For more 
information, contact your system administrator.
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2. Click the Lookup magnifying glass icon displayed in the Keywords section.
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3. Select the desired lookup if more than one lookup is available.

The Lookup dialog box is displayed.

Note: For example purposes, this documentation refers to the Lookup dialog box, but the 
actual title of the dialog box is configured by your OnBase administrator.
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4. In the Search dialog box, enter any known Keyword Values in the Keywords pane and 
click Find.
AutoFill Keyword Sets that match the search criteria are displayed in the Results pane.

5. Select the appropriate AutoFill Keyword Set and click Select.

Note: For example purposes, this documentation refers to the Select button, but the actual 
name of the button is configured by your OnBase Administrator.

The Lookup dialog box is closed and the Keywords section of the indexing context is 
updated with the Keyword Values from the selected AutoFill Keyword Set.
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Use Keywords for Document Retrieval
Once you have selected a Document Type, its Keyword Type fields appear in the Keywords 
section. If a Keyword Type requires you to enter a value to search by, the Keyword Type is 
displayed in red.

Keyword Types that Contain Relationships
Some Keyword Types have been configured to provide smart searching capabilities for 
retaining relationships in retrieval.

Cascading Data Sets
If two or more of the Document Type’s available Keyword Types contain drop-down lists and 
are ordered in such a way as to show a hierarchical parent/child relationship, the Keyword 
Types may be part of a Cascading Data Set.

Multi-Instance Keyword Type Groups
If the Document Type's available Keyword Types are displayed in a collapsed state, the 
Keyword Types are part of a Multi-Instance Keyword Type Group:

Multi-Instance Keyword Type Groups can display in a collapsed state with only the name of the 
Multi-Instance Keyword Type Group showing, or they can display with the Keyword Values in 
the Keyword Type Group expanded.
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If the Multi-Instance Keyword Type Group is displayed in a collapsed state, click the down 
arrow next to the first Keyword Type to show the entire group:

Common Keyword Types for Document Type Groups and 
Multiple Document Types
If you select a Document Type Group or multiple Document Types, Keyword Types common to 
all Document Types in the group display in the Keywords section.

For example, if you select two Document Types, one with Keyword Types of Customer Name 
and Account #, and the other with Customer Name and Address, only the Customer Name 
Keyword Type field appears in the Keywords section.

Enter Keyword Values for which to search. If you do not enter Keyword Values, the system 
returns documents regardless of the Keyword Values associated with the documents. In most 
cases, advanced Keyword Operators can be used to further define your search.

Note: If multiple Document Types are selected that use different Cascading Data Sets, OnBase 
ignores Cascading Data Sets and their associated Keyword Values are not available. If the 
Keyword Type in the Cascading Data Set was configured to use a Keyword Data Set, Keyword 
Values from this Keyword Data Set will be available. If the Keyword Type in the Cascading Data 
Set was not configured to use a Keyword Data Set, no Keyword Values will be available.
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Add Another Value to a Keyword
You can double-click the Keyword Type name to add another instance of the Keyword Type, or 
place the cursor inside the Keyword Value field and press F6.

Note: You cannot add additional instances of Keyword Types that are part of a Cascading Data 
Set.

Multi-Instance Keyword Type Groups
If you double-click on the name of a Multi-Instance Keyword Type Group, another instance of 
the entire Multi-Instance Keyword Type Group will be added.

Keywords with Drop-Down Select Lists
The fields for some Keyword Types may contain a drop-down select list:

Select any value from this list as criteria for document retrieval.

When the cursor is in the Keyword Type’s field, you can press F5 to open the drop-down list if 
one exists. You can use the up and down arrow keys to select from the Keyword Values 
displayed in the drop-down list. When you have selected the appropriate Keyword Value, press 
Enter.

If you type a partial value before pressing F5 or opening the drop-down list, the drop-down list 
will begin with those values that match the partial value.

Your system administrator determines if a drop-down list appears for a Keyword Type, and 
what values will be in the list.

Note: You are only able to view the first 100 entries in a drop-down list. To reduce the values 
displayed in a drop-down list, type several characters into the field before expanding the drop-
down list.

If two or more consecutive Keyword Types contain drop-down lists and are ordered in such a 
way as to show a hierarchical parent/child relationship, the Keyword Types may be part of a 
Cascading Data Set.

Keyword Operators and Extended Search Features
Extended search features allow you to narrow or expand your document search when retrieving 
documents.
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Relational (Comparative) Operators
Relational (comparative) operators allow you to retrieve documents based on a range of 
Keyword Values, as well as exact Keyword Value matches. Select the Document Type Group 
and Document Type of the document you want to search for. Click the relational operator 
button to the left of the Keyword Type field to toggle through the available operators.

Blank Keyword Values on a document are not compared to the Keyword Values provided during 
document retrieval. If you use the <> operator to omit all documents indexed with a specified 
value, the search will not return documents that were indexed with a blank value. Some 
documents indexed with Keyword Type Groups may be returned, depending on the Keyword 
Type Group’s configuration.

The following operators may be available to search for:

Note: Available operators vary depending on the Keyword Type. For example, only the =, <>, and 
" operators are available for alphanumeric Keyword Types.

Logical Boolean Operators
If you have two or more fields for the same Keyword Type, each of these fields is separated 
from the next by one of the following logical operators: And, Or, or To. The current logical 
operator appears to the right of the first of the two Keyword Type fields.

You can create an additional Keyword Type field by double-clicking its name or pressing F6 
while your cursor is positioned in the data entry field of the Keyword Type you wish to add. This 
automatically inserts a logical operator button to the right of the original Keyword Type field.

Operator Description

= An exact Keyword Value match.

<> Keyword Values that are not equal to the specified value.

> Keyword Values that are greater than the specified value.

>= Keyword Values that are greater than or equal to the specified value.

< Keyword Values that are less than the specified value.

<= Keyword Values that are less than or equal to the specified value.

" The string literal operator (double quote) used with alphanumeric Keyword Types. 
Selecting this button will match the literal string. If a wildcard is used in the string, 
the search will look for the exact match, including the wildcard treated as a 
standard character.
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To change the logical operator in use, click the logical operator button, which scrolls through 
the available options:

Note: When you use the Or operator and one document has both Keyword Values, OnBase 
retrieves two separate records for that document. For example, you perform a search for the 
Keyword Values Sarah Adams Or John Adams. If the same document has both values 
associated with it, then OnBase displays a record for each occurrence of the Keyword Value 
(one record for Sarah Adams, one record for John Adams).

If you have more than two Keyword Values for the same Keyword Type, then the logical 
operators are processed in order of occurrence.

Wildcard Characters
A wildcard character can be used to match Keyword Values where one or more characters are 
unknown. Wildcards can only be used to match alphanumeric Keyword Values.

Note: Depending on your system’s configuration, some alphanumeric Keyword Types may not 
allow wildcard characters to be used, or searches that include wildcards may return 
unexpected results.

Type one of the following wildcard characters directly into the Keyword Type field to search for 
text strings containing one or more unspecified characters:

Operator Description

And Searches for documents containing the Keyword Values preceding and following 
the logical operator.

Or Searches for documents containing either the value preceding the logical operator 
or the value following the logical operator.

To Searches for all values that are between the two values (i.e., that are greater than or 
equal to the first value and less than or equal to the second value). This operator is 
unavailable for alphanumeric Keyword Types.

Wildcard Description

* The * wildcard character can be used to replace one or several 
characters of a text string. For example, the text string Smit* will find 
all instances of both Smith and Smithsonian.

? The ? wildcard character can be used to replace a single character in 
the text string. For example, the text string SM?TH will find all 
instances of both Smith and Smyth. 
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Adding Multiple Values to a Keyword Type 
You can add additional values to a Keyword Type when retrieving documents or indexing:

• Double-click the Keyword Type name, or
• Place the cursor inside the Keyword Value field and press F6

Multiple values of a Keyword Type are saved with documents only if Keyword Type values are 
populated (in other words, the additional Keyword Type field cannot be left blank). Once you 
delete the value from an additional instance of a Keyword Type and click Save, the additional 
instance is removed.

You cannot add multiple values to Keyword Types in a Single-Instance Keyword Type Group or 
a Cascading Data Set. You can add multiple values to Keyword Types in a Multi-Instance 
Keyword Type Group.

See your system administrator if you have questions about the configuration of Keyword Types 
on the Document Type.

Note: When documents are indexed with multiple instances of the same Keyword Type, 
multiple results for the same document can be returned in a Document Search Results list. This 
occurs because of the way that OnBase searches for multiple Keyword Values.
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Re-Indexing
Re-indexing provides the ability to change Keyword Values, Document Date, and Document 
Type.

Note: Some Document Types are configured to require Keyword Values to be entered in order 
to create and/or retrieve documents. Required Keyword Values are displayed in red for these 
operations, which may include the following: Document Retrieval, Import, and Add/Modify 
Keywords.

Re-Indexing Documents
Each document stored in OnBase has an associated Document Type, Document Date, and 
optional Keyword Types. This information is usually entered when a document is first imported 
into OnBase upon indexing.

You can change this associated information using the Re-Index feature.

Note: Ensure you understand the effects of re-indexing documents before proceeding. 
For more information, see Considerations for Re-Indexing Documents and Adding or Modifying 
Keyword Values on page 177.

1. Save any changes that you have made to a document before re-indexing.

Note: If you open a document in the Document Viewer and select Re-Index, a lock is applied, 
and the document cannot be re-indexed from the Document Search Results list.

2. From an open document or from a selected document in a Document Search Results 
list, right-click and select Re-Index or click Re-Index on the Document tab.

Tip: In a Document Search Results list, you can select multiple documents and re-index them in 
the order in which they were selected.

3. The Re-Index pane is displayed.

Note: If the original Document Type contains a Multi-Instance Keyword Type Group, the 
Document Type to which you want to re-index must contain the same Multi-Instance Keyword 
Type Group.

Note: The Document Type of a Unity Form file type document or an Image Form file type 
document cannot be changed during re-indexing.
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4. Select a Document Type from the Document Type drop-down select list. All Document 
Types that you have rights to create are displayed.

Tip: You can select a new Document Type by typing the name of the Document Type.

To filter this list, you can first select a Document Type Group from the Document Type 
Group drop-down select list.

Tip: You can select a Document Type Group by typing the name of the Document Type Group.

Note: The original Document Type is displayed in the Document Type drop-down select list, 
even if it is not in the selected Document Type Group.

If the destination Document Type is configured to use Default Keyword Values, these 
Keyword Values are assigned to the document when the destination Document Type is 
selected from the Document Type drop-down select list.
If you are licensed for EDM Services, the destination Document Type is configured with 
the Prompt for revision setting, and a document with matching keywords exists, the 
Document Revisions dialog box is displayed when the destination Document Type is 
selected from the Document Type drop-down select list. For more information, see the 
EDM Services module reference guide. 

Note: If you select a different Document Type at any point during the re-indexing process, 
Keyword Values for common Keyword Types are retained. For example, if there is a value for 
the City Keyword Type, and you switch to a different Document Type that also contains the City 
Keyword Type, the original City Keyword Value is retained. This also applies to Keyword Types 
configured to use Default Keyword Values on the initial Document Type. These values are not 
replaced, even if the new Document Type uses a different set of Default Keyword Values.

Caution: If you are re-indexing a document associated with a Keyword Type Group (KTG) or 
Multi-Instance Keyword Type Group (MIKTG) filled by an AutoFill Keyword Set to another 
Document Type associated with the same KTG or MIKTG filled by an AutoFill Keyword Set, the 
AutoFill Keyword Set may unexpectedly re-populate secondary Keyword Values once the 
Document Type is changed. 
For more information, see Considerations for Re-Indexing Documents and Adding or Modifying 
Keyword Values on page 177.

Caution: When switching between Document Types that share a MIKTG, and there are different 
values for each Document Type, the Default Values of the new Document Type are appended. If 
you switch back to the original Document Type, the Default Values of the initial Document Type 
are not appended unless they have been changed. If you delete all values from the MIKTG 
before switching Document Types, the second Document Type’s Default Values are used.
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5. Change the File Type, if needed.
• Select another file format available from the File Type drop-down select list.
• You can easily change the file format by re-indexing the document instead of re-

scanning or re-importing it to OnBase with the corrected file format.
• File formats available for Re-Indexing depend on your system setup and the file 

format itself (certain file formats are only available through document processes or 
system functions.)

Caution: Contact your system administrator before selecting the Image Rendered PDF file 
format, as selecting this file format without the proper system specifications can cause 
unexpected behavior.

6. Change the Document Date, if needed. If a document date is not specified when the 
document is processed into OnBase, the Document Date is the same as the Date 
Stored.
To select a date with a calendar, hover over the right edge of the Document Date field 
and click the down arrow.

7. Change Keyword Values as desired. When you modify a Keyword Value, the modified 
Keyword Value turns blue. You can use the Tab key to move to the next Keyword Value 
field. Note the following:
• Some Keyword Types may be configured to be uppercase only, while others may be 

configured to appear in mixed or lowercase.
• Depending on your system’s configuration, certain Keyword Types may appear as 

read-only in the Re-Index Document dialog box to certain users. These Keyword 
Types may also be masked.

• OnBase will not retain two sets of duplicate Keyword Values. For example, a 
Document Type contains two instances of the Keyword Type First Name, and one 
value is John and the other value is Sarah. If you change the value of Sarah to John, 
upon clicking Re-Index, OnBase will only retain one instance of John. If two Multi-
Instance Keyword Type Groups share identical values, only one of those Multi-
Instance Keyword Type Groups is retained.

Caution: After changing Keyword Values, click on a field in the Re-Index pane before you click 
the Re-Index button. This will trigger any AutoFill Keyword Sets that may have been affected by 
the Keyword Value change. If you changed the primary Keyword Value in the AutoFill Keyword 
Set, press the Tab key to trigger the AutoFill Keyword Set. If the primary Keyword Value is 
associated with multiple AutoFill Keyword Sets, you are prompted to select an AutoFill Keyword 
Set. You may select an AutoFill Keyword Set by double-clicking. See your system administrator 
for information regarding your system's AutoFill Keyword Set configuration. Click Close to 
cancel changes if you get undesired results.

Note: If the document is still required after re-indexing, it is recommended that the document is 
closed and reopened. Doing so ensures that the privileges associated with the new Document 
Type are respected.
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8. To add a new Keyword Type field of the same Keyword Type to the document, place the 
mouse cursor inside the Keyword Type field that you want to duplicate and press F6. 
This adds a new Keyword Type field. Enter the new Keyword Value.
If the Keyword Type that you double-click belongs to a Keyword Type group, then it can 
only be duplicated if the group is a Multi-Instance Keyword Type Group. The entire group 
is duplicated, not just the selected Keyword Type.

9. Press Clear Keywords if you want to clear all existing Keyword Values and re-enter new 
values.

10. If you are re-indexing an image or PDF file, the Split button is displayed. Click it to open 
the Document Separation window, where the document can be edited and separated 
into multiple documents.

11. Click Re-Index to save your changes and re-index the document. Click Close to cancel 
changes.

Note: Review changes carefully before saving. Once re-indexed, documents can be retrieved 
using only the new Keyword Values.

Note: You can also change Keyword Values by right-clicking the document, selecting 
Keywords, and entering new Keyword Values in the appropriate fields. Re-indexing allows you 
to change the Document Type in addition to Keyword Values.

Note: If the Re-Index pane has not finished loading, the Re-Index button will be unavailable.

Keywords with Drop-Down Select Lists
Some Keyword Type fields have drop-down lists from which you can select Keyword Values. 
Select a Keyword Value from a drop-down list using any of the following methods:

• Click the drop-down button and scroll to the value you want to select.
• Place the cursor in the Keyword Type fields with the drop-down and press F5 or the 

drop-down button to display available Keyword Values. Select a Keyword Value. You 
can use the up and down arrow keys to select from the Keyword Values displayed in 
the drop-down list. When you have selected the appropriate Keyword Value, press 
Enter.

• Filter values available from the drop-down select list by entering a word and/or 
character(s) that are part of the Keyword Value. When you press F5 or the drop-down 
button, the list displays only values that match the entered characters. Scroll to your 
selection.

Note: The F5 function is only available for Keyword Types that are configured to use a drop-
down menu.

If two or more consecutive Keyword Types contain drop-down lists and are ordered in such a 
way as to show a hierarchical parent/child relationship, the Keyword Types may be part of a 
Cascading Data Set. Selecting a Keyword Value from the parent drop-down list filters the 
available Keyword Values from the subsequent child drop-down list.
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Re-Indexing Document Revisions
You can re-index a document revision that is not the latest revision. For example, if a document 
has three revisions with the third being the most recent, you can re-index the first revision. 

The revision process is the same as Re-Indexing Documents on page 173, only you would 
access documents from the Document Results Search List using the Revisions/Rendition 
option from the right-click menu. When the Revisions/Renditions dialog box is displayed, 
select the oldest revision and re-index as needed. All options are available during a regular re-
indexing, including the ability to change the file type.

Considerations for Re-Indexing Documents and Adding 
or Modifying Keyword Values

Ensure you understand the effects of re-indexing documents and adding or modifying Keyword 
Values before proceeding with either task. Documents are re-indexed in the Re-Index pane. 
Keyword Values are added or modified in the Add/Modify Keywords pane.

Note: You cannot re-index a document or add or modify Keyword Values if the document has 
been locked by another user. See your system administrator for information regarding 
Document Lock Administration.

• Automatically Change Secondary Keyword Values of an AutoFill Keyword Set 
If an AutoFill Keyword Set is associated with the Document Type and you modify the 
Primary Keyword Value, all Secondary Keyword Values are automatically updated to 
reflect Keyword Values in the AutoFill Keyword Set when clicking Re-Index.

Note: You cannot re-index documents in the Add/Modify Keywords pane.

• Keyword Values in Multi-Instance Keyword Type Groups 
If the original Document Type contains a Multi-Instance Keyword Type Group, the 
Document Type to which you want to re-index must contain the same Multi-Instance 
Keyword Type Group in order to preserve the integrity of the data relationship.

• Re-indexing from a standard Keyword Type that has multiple Keyword Type Values to 
a Multi-Instance Keyword Type Group is not supported. It is not supported because it 
is not known which instance of the Multi-Instance Keyword Type Group to associate 
with each Keyword Type Value. If you must re-index from standard Keyword Types to 
a Multi-Instance Keyword Type Group, you must manually enter all of the Keyword 
Type Values appropriately in the Multi-Instance Keyword Type Group instances.
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• AutoFilled Keyword Values in Keyword Type Groups or Multi-Instance Keyword 
Type Groups 
Re-indexing a document to another Document Type associated with the same 
Keyword Type Groups or Multi-Instance Keyword Type Groups causes any associated 
AutoFill Keyword Sets to re-populate the Keyword Values in the Keyword Type Group 
or Multi-Instance Keyword Group.
If Secondary Keyword Type Values contained in a Keyword Type Group or Multi-
Instance Keyword Type Group initially populated by an AutoFill Keyword Set are 
changed at any time before the new Document Type is selected, some or all of the 
modified Keyword Values are overwritten if an AutoFill Keyword Set is configured to 
populate any of those values in the Keyword Type Group or Multi-Instance Keyword 
Type Group on the new Document Type. The overwritten Keyword Values become 
permanent once re-indexing is complete.
If the user closes the Re-Index pane before clicking the Re-Index button, or if the 
Secondary Keyword Values are changed in the Re-Index pane after the new 
Document Type is selected, the user-modified values are saved.

Note: Changing the Primary Keyword Type Value prior to changing the Document Type will 
prevent the AutoFill Keyword Set from re-populating Secondary Keyword Type Values after a 
new Document Type is chosen, because the AutoFill Keyword Set is not triggered by the 
modified Primary Keyword Value, unless the modified Primary Keyword Value is also a Primary 
Keyword Value in an AutoFill Keyword Set associated with the new Document Type. Then, the 
modified Primary Keyword Value would cause the existing Secondary Keyword Values to be 
replaced by the associated Secondary Keyword Values.

Note: This only affects Keyword Type Groups or Multi-Instance Keyword Type Groups. 
Individual AutoFilled Keyword Types will retain any modified, individual, AutoFilled Keyword 
Values when a document is re-indexed, even if values from Keyword Type Groups or Multi-
Instance Keyword Type Groups are overwritten on the same document.

• Require Changes to Child Values in a Cascading Data Set 
A Cascading Data Set is an indexing feature that defines parent/child relationships 
between drop-down Keyword Values available on a document or folder. Changing a 
parent Keyword Value in a Cascading Data Set will not update the child Keyword 
Values that depend on it. For example, suppose a document is indexed with a 
selected State and County, where the County Keyword Value is a child to the selected 
State Keyword Value. If you change the State Keyword Value, then the County will 
retain its original value and will not be updated to reflect the new State.

• Trigger Auto-Foldering 
If you re-index a document that is configured for auto-foldering, it will trigger an auto-
foldering process.

• Alter the contents of Dynamic folders 
Because Dynamic Folders contain documents according to their Keyword Value, re-
indexing a document or adding or modifying Keyword Values may dynamically move 
the document from its current folder to another folder.
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• Affect the appearance of your document 
The appearance of an XML file format document may change if you add or modify 
the Keyword Values or re-index the document. Your system administrator determines 
whether the document’s appearance is dependent on Keyword Values.

• Affect Workflow 
Keyword Values can affect Load Balancing and certain Workflow actions, such as 
Set Related Document’s Keyword Equal to This Document’s Keyword. See the 
Workflow module reference guide or help files for details.

Note: Re-indexing a document or adding or modifying Keyword Values may trigger different 
results depending upon the Workflow action.

• Notes and Annotations 
When re-indexing a revisable document with notes or annotations, the notes or 
annotations are not transferred to the next revision. The notes or annotations are 
only retained on the original document.

When re-indexing documents, the following keyboard shortcuts are available:

Keyboard Shortcut Action

Esc Closes the Re-Index pane.
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Separating Image and PDF Documents
PDFs and documents assigned the default Image File Format or a custom file type based off of 
an image file type can be separated into multiple new documents using the Document 
Separation layout. In addition to separating documents, you may drag pages between 
documents, copy pages within documents, or append documents together in the Document 
Separation window.

Note: To use PDF documents in the Document Separation layout, your workstation must be 
licensed for PDF Framework. For additional information, contact your system administrator.

Note: Sending password-protected PDF documents to the Document Separation layout is not 
supported.

Note: Image Rendered PDF documents sent to the Document Separation layout are read-only. 
The document or its pages may be copied to create a new document of a different file type. For 
more information about read-only documents, see Working with Locked and Read-Only 
Documents in the Separation Workspace on page 190.

In the above diagram, the area labeled A is the ribbon menu. The area labeled B is the 
Separation Workspace (seen here in Document Display Mode). The area labeled C is the Page 
Holder.

Note: In order to use ad hoc Document Separation, the user group must have the Advanced 
Document Splitter client based product privilege and the Separate User Group privilege. For 
additional information, contact your system administrator.
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The original documents brought into Document Separation are called source documents. In 
Document Display Mode, source documents display the icon of the Document Type.

Source documents can be added to the ad hoc Document Separation window through the 
following methods:

• Navigating to the Image tab on an open document and clicking the Edit Pages 
button.

Note: Clicking Edit Pages opens the document in a Document Separation window separate 
from previously opened Document Separation windows. Additional documents sent to 
Document Separation are not added to a Document Separation window opened by clicking Edit 
Pages, and they must be manually dragged and dropped from a Document Search Results list.

• Right-clicking an open document or document(s) in a document retrieval hit list and 
selecting Send To | Document Separation.

• Clicking Send To | Document Separation from the ribbon menu of an open 
document.

• Dragging and dropping from a document retrieval hit list into a previously-opened 
Document Separation window.

Only one instance of a document may be added to the Document Separation window at a time. 
If a duplicate document is dragged and dropped into the Document Separation window, a 
warning is displayed and the document is not added.

Note: If a document is configured to be revisable, only the latest revision of the document can 
be split. Earlier revisions are displayed in the Document Separation window as read-only. 
Depending on your system configuration, revisions are created in Document Separation when a 
document is modified.

Note: If open, the Re-Index pane or the Add/Modify Keywords panel will be closed when the 
document is sent to the ad hoc Document Separation window.

See the following topics to learn about the available features in the Document Separation 
window:

• The Separation Workspace on page 182
• Viewing and Editing Page Details in Document Separation on page 191
• Creating and Editing Documents in the Separation Workspace on page 192
• Importing a New Document in the Separation Workspace on page 205

The Separation Workspace
Documents are separated, appended, reordered, and indexed in the Separation Workspace 
within Document Separation. The Workspace can be used with two display modes: Document 
Display Mode and Page Display Mode.
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To switch between display modes, click the Group by Document button in the ribbon:

For more information on the two display modes, see the sections below.

Document Display Mode
Document Display Mode is enabled when the Group by Document button in the toolbar is 
selected:

In Document Display Mode, each document is displayed in a row of the Separation Workspace. 
Rows are labeled in the Document Header with the name of the document and the page count:

To expand a row of the Separation Workspace in order to see additional pages that belong to 
the document being worked with, place your mouse pointer over the row’s border, and click and 
drag:

Note: Expanded documents may return to default size if scrolled out of view.
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To collapse a specific document completely, click the Collapse Row button in the Document 
Header:

To expand a collapsed document, click the Expand Row button in the Document Header:

You may also use the Expand / Collapse button in the View ribbon group to expand and 
collapse documents in Document Display Mode:

Note: This button is not available in Page Display Mode.

You may also maximize the main Client window and resize it to fit across multiple monitors. 
Collapse the Page Holder to view more page thumbnails horizontally.

Page Display Mode
Page Display Mode is enabled when the Group by Document button in the toolbar is not 
selected:

Page Display Mode displays all document pages at once in the Separation Workspace.

The first page of each document is bordered in green. Subsequent pages display no border:
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Select a page in the Separation Workspace by left-clicking. Select multiple pages by holding 
Ctrl and left-clicking. Selected pages are highlighted in light blue. The active page is bordered 
in dark blue: 

Navigate between documents and pages quickly in Page Display Mode by using the arrow keys 
on the keyboard.

You may also maximize the main Client window and resize it to fit across multiple monitors. 
Collapse the Page Holder to view more page thumbnails horizontally.

Tree Display Mode
Tree Display Mode is only available within batch Document Separation. For more information 
on Tree Display Mode, see the Document Imaging module reference guide.

Adjusting Thumbnails in the Separation Workspace

The thumbnails viewed in this workspace can be adjusted to fit your needs. You can adjust the 
size of the thumbnails and enable or disable thumbnail zooming. 

Thumbnails can be automatically zoomed when you hover over the thumbnail image with your 
mouse. When you move the mouse away from the thumbnail image, the enlarged view will 
shrink back to normal thumbnail size. This temporary enlargement of thumbnails allows you to 
quickly distinguish between pages without having to leave the layout. 

To adjust the thumbnails:

1. Click the Thumbnails Settings button:
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2. Select the size of the thumbnail in the Thumbnail Settings options dialog box:

Choices include:
• Small (200 x 200 pixels)
• Medium (300 x 300 pixels)
• Large (400 x 400 pixels). 
• Custom - Set your own custom size for thumbnails by selecting Custom and inputting 

your own dimensions. Width (pixels) and Height (pixels) on Custom thumbnail sizes 
can range from 100 to 1000 pixels.

Note: Values entered into the Custom fields are saved even if you select a different Thumbnail 
Size.

3. Select Zoomed Thumbnails if you would like to enable thumbnail zooming.
4. If you selected Zoomed Thumbnails in Step 3, you may also adjust the Zooming Delay 

by inputting the desired delay (in seconds).
Zooming Delay is the amount of time you must hover over a thumbnail before it is 
enlarged.

5. Click Save to save changes and close the dialog box, or click Cancel to close the dialog 
box without saving changes.

Note: Thumbnail settings are saved and persist across OnBase sessions.

Note: Changes made to thumbnails apply to both the Separation Workspace and the Page 
Holder. 

Selecting Documents in the Separation Workspace
Selecting entire documents in the Separation Workspace differs slightly between display 
modes. Selection of pages and documents persists across display modes.
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In all display modes, click Select All Documents to select all documents in the Separation 
Workspace:

Note: If the Select All Documents option has been selected and a new document is added to 
Document Separation, the Select All Documents button will become unselected. The newly 
added document is not selected in the Separation Workspace. Selecting the Select All 
Documents button again will select all documents, including the newly added document.

When selecting pages, hold Ctrl to select a page without deselecting previously selected 
pages.

If a page is selected and the Shift key is held while selecting another page, all pages between 
the two selected pages will be selected.

Selecting Documents in Document Display Mode
To select the entire document in Document Display Mode, click the Document Header.

The check box next to the name of the document in the Document Header will also select the 
entire document. 

If the document is already selected, clicking the check box will deselect the document.

If, when using Document Headers, you would like to add a document to the selection without 
deselecting the previously selected document(s), hold Ctrl as you select the new document.

To select multiple page ranges in multiple documents, hold Ctrl + Shift as you select pages.

Selecting Documents in Page Display Mode
To select an entire document in Page Display Mode, click the check box on the first page of the 
document:
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If the document is already selected, clicking the check box will deselect the document.

Note: Left-clicking on a page will select the page only. Selected pages are highlighted in 
yellow. If you attempt to select a single page within a document that is already selected via the 
check box, the document will become deselected.

Reordering Documents in the Separation Workspace

Note: Documents cannot be reordered when working in Page Display Mode.

To reorder documents, click the Document Header of the document you would like to move and 
drag the document to an empty space in the Separation Workspace. A red bar appears between 
documents to show where the selected document will be placed when the mouse button is 
released, as shown in the Document Display Mode example below:
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Using the Page Holder
Document Display Mode and Page Display Mode in the Document Separation layout both offer 
a Page Holder to the right of the workspace area:

Pages can be dragged and dropped into the Page Holder for later use. Pages in the Page Holder 
can be organized by dragging them.

To remove a page from the Page Holder, click and drag the page into a document in the 
Separation Workspace or click and drag it to an empty space within the Separation Workspace 
to create a new document. Multiple pages can be dragged at once.

If you change your mind and decide that you would like pages in the Page Holder to return to 
their original documents, you can click the Page Holder Actions button:

Clicking this button reveals the following Page Holder Options: 
• Return Selected Held Pages - Clicking Return Selected Held Pages will return 

highlighted pages within the Page Holder to their original documents.
• Return All Held Pages - Clicking Return All Held Pages will return all pages within 

the Page Holder to their original documents.

To collapse the Page Holder, click the arrow displayed on the left border of the Page Holder. 
When collapsed, click the arrow again to expand the Page Holder.

Note: The Page Holder automatically collapses if the Add/Modify Keywords panel is displayed.
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Working with Locked and Read-Only Documents in the 
Separation Workspace
Locked and read-only source documents can be brought into the ad hoc Document Separation 
window, but these locked documents can not be edited in the same fashion as unlocked 
documents are. Pages dragged out of a locked document will be copied to their destination. 
The original source document will remain intact and unchanged within the Document 
Separation layout. Pages cannot be dragged into a locked document.

If attempting to append an unlocked document to a locked document by performing a 
Partition/Append task on the last page of the locked document, the unlocked document’s 
pages will not be moved into the locked document.

In Document Display Mode, locked documents are labeled with a lock icon in the Document 
Header:

Hovering over this icon will display who holds the lock on this document.

In Page Display Mode, pages of locked documents are bordered in black and display a lock icon 
in the corner:

Saving Documents
Click the Save and Close All button in the Apply ribbon group to save all documents in the 
Document Separation layout to OnBase and close the Document Separation layout. 

Note: If no changes have been made to documents or keyword values since opening the 
Document Separation layout or since you last saved, this button will be disabled.

Do not save until all desired modifications have been made to a particular document (if 
selecting Save Selected) or to all documents in the Separation Workspace (if selecting Save 
and Close All). The document(s) will be removed from the Document Separation layout and 
imported into OnBase after saving. All modifications including copying pages, clicking and 
dragging pages, appending, splitting, and re-indexing documents are saved at this time.
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Source document modifications, such as deleting pages, deleting the entire document, re-
ordering pages, flipping, rotating, and re-indexing are saved along with documents created in 
Document Separation.

Click the bottom portion of this button to reveal the Save Selected option. Clicking Save 
Selected will save and close only new documents created in Document Separation that have 
been selected in the Separation Workspace.

Note:  Source documents cannot be saved using Save Selected.

If attempting to exit the Separation Workspace without saving, you will be prompted to save 
any unsaved changes.

Tip: If you want to make source document modifications, such as re-ordering pages, but keep 
the original copy intact, copy the source document (Copy Document) immediately after 
opening the Document Separation layout. Treat the copy of the source document as you would 
the source document. When you are finished modifying the copy of the source document, click 
Save and Close All to keep the original document intact and save any modifications to the copy 
of the source document.

Note: If the user has the delete privileges, removing all pages from the source document(s) 
and clicking Save and Close All will result in the document(s) being deleted from OnBase. If the 
user does not have delete privileges, the last page will be copied. The copy will remain in the 
source document so that it cannot be deleted.

Depending on how the Document Type is configured, you may be prompted to enter a comment 
after clicking Save and Close All.

Note: All buttons in the ribbon menu are disabled while saving. Documents being saved are 
unselected and cannot be interacted with while saving.

Viewing and Editing Page Details in Document 
Separation

Double-clicking the thumbnail image will open a full size version of the page in a Detailed View. 
In this view, you may perform the following actions using the buttons in the ribbon menu: 

Option Button Description

Zoom In Zooms in on the page currently open in Detailed View. 
The keyboard shortcut for this action is Ctrl + Mouse Wheel 
Up.

Zoom Out  Zooms out on the page currently open in Detailed View. 
The keyboard shortcut for this action is Ctrl + Mouse Wheel 
Down.
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Modifications made in Detailed View are applied to the document in the Separation Workspace. 
When you are finished viewing and editing the page, close the Detailed View.

Saving a document in the Workspace saves the changes made in the Detailed View.

You may also use the Modify options found in the ribbon of the Separation Workspace to edit 
selected pages without entering Detailed View.

Creating and Editing Documents in the Separation 
Workspace

In addition to editing page details, you can edit documents themselves by adding or removing 
pages. New documents can also be created using these same processes. There are several 
ways to create a new document or edit source documents in the Separation Workspace:

• Adding pages through browsing and acquiring
• Clicking and dragging pages
• Joining documents
• Splitting documents
• Copying the document or individual pages within the document
• Deleting pages or documents completely

Caution: Removing all pages from a new document created in the Separation Workspace will 
delete the document.

Rotate Left Rotates the page 90 degrees counterclockwise.
The keyboard shortcut for this action is Ctrl + Left Arrow.

Rotate Right Rotates the page 90 degrees clockwise.
The keyboard shortcut for this action is Ctrl + Right Arrow. 

Flip 
Horizontally

Flips the page horizontally.

Note: PDF documents cannot be flipped.

Flip 
Vertically

Flips the page vertically.

Note: PDF documents cannot be flipped.

Option Button Description
OnBase 18
©2018 Hyland Software, Inc.

192



Unity Client
Usage
When creating and editing documents in the Separation Workspace, consider the following:
• When splitting a locked document, copies of the selected pages are used to create a 

new document, but the original selected pages remain in the locked document. 
• If you do not have privileges to delete documents, moving all pages from a source 

document into another document creates a copy of the source document’s last page. 
The source document’s last page remains in the source document.

• If the source document belongs to a batch, the new document is added to the same 
batch.

Adding New Pages to the Separation Workspace

Pages can be added either as new documents or to existing documents from within Document 
Separation. Pages can be added by browsing to the appropriate image file on your computer, or 
by acquiring image files through a device such as a scanner or camera.

Page acquisition options are displayed in the Page ribbon group:

Adding Pages by Browsing

Note: PDF Documents cannot be selected when adding pages by browsing.

Browse imports page(s) from a drive accessible from your workstation.

To add pages by browsing:

1. Select the document to which you would like to add pages.
2. Click Browse.

3. The standard Windows Open File dialog box is displayed.
4. Locate the page(s) to import. Pages must be image files.
5. Select the desired page(s).
6. Click Open to add the selected documents as pages.
OnBase 18
©2018 Hyland Software, Inc.

193



Unity Client
Usage
Adding Pages by Acquiring

Acquire scans in the page(s) using a scanner, or imports the image(s) from a scanner, digital 
camera, or other supported digital storage device. 

To add pages using the Acquire option:

1. Select the document to which you would like to add pages.
2. Click Acquire.

Note: The Acquire button is enabled when a device is connected to your workstation.

Note: If more than one device is connected to your workstation, you are prompted to select an 
imaging device.

If you select a scanner:

1. The device’s scanning interface is displayed.
2. Select the desired scan settings, such as image resolution and page size.

Tip: Depending on your scanning interface, you can receive help by clicking the Help button, or 
clicking the Windows Help button in the upper-right corner and then clicking the setting.

3. Click Scan to add the scanned images as pages.
If you select a camera:

1. The Windows Image Acquisition (WIA) Get Pictures interface is displayed.

Note: If the camera is not detected, ensure that the Windows Imaging Service is enabled and 
started. For information on the Windows Imaging Service, consult the Windows help files.

2. Select the images to import.
3. Click Get Pictures to add the images as pages.

Clicking and Dragging Pages in the Separation Workspace
Documents can be created and edited by clicking and dragging pages. This operation behaves 
differently depending on which display mode you are using. In Document Display Mode, it is 
possible to both create and edit documents when clicking and dragging pages. In both Page 
Display Mode and Tree Display Mode, it is only possible to edit existing documents when 
clicking and dragging pages.

If pages are selected to be dragged from multiple different documents, they will be moved into 
the destination in the order in which they appear in the Separation Workspace.
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Note: Pages dragged out of a locked document will be copied to their destination. The original 
source document will remain intact and unchanged within the ad hoc Document Separation 
window. Pages cannot be dragged into a locked document.

Note: If the user has delete privileges, dragging all pages from the source document(s) and clicking 
Save and Close All will result in the document(s) being deleted from OnBase. If the user does not 
have delete privileges, the last page will be copied. The copy will remain in the source document so 
that it can not be deleted.

Clicking and Dragging Pages in Document Display Mode
Documents can be created and edited by clicking and dragging in Document Display Mode.

To create a new document, click and drag the page(s) from the original document(s) to an 
empty space in the Separation Workspace. The possible new insertion point is represented by a 
red line in the Separation Workspace:

The new document must be indexed after you have finished making changes. 

Click and drag the pages, then hold Ctrl to copy the pages to the new location instead of 
dragging the pages away from the existing documents.

Note: A document that is created by clicking and dragging will inherit the indexing information 
from the source document that it was taken from. If the document is created using pages from 
multiple documents, no indexing information will be inherited.
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To edit an existing document, click and drag the page(s) from one document to another. A red 
line will appear at the point of insertion:

Edited source documents must be saved by clicking Save and Close All.

Clicking and Dragging Pages in Page Display Mode
To edit a document by clicking and dragging in Page Display Mode:

1. Click and drag the page(s) from one document to the right of the desired leading page. 
A red line will appear at the point of insertion. For example, in this image, Page 5 is 
being dragged to be added to the right of Page 1:

2. If the destination suits your needs, release the mouse button and the page(s) will be 
added to the point of insertion.

3. Edited source documents must be saved by clicking Save and Close All. 

If a page is dropped to the left of the first page of a new document, it will be inserted as the 
new first page of that document.

Joining Documents in the Separation Workspace
Documents can be edited by joining pages to them. There are three methods of joining.

When you click the Join button in the Modify ribbon group, the three join options are presented:
• Merge Documents 
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• Join Pages 
• Append After Page (also available as the paperclip icon in the Separation 

Workspace)

This section covers each Join option.

Merge Documents
Clicking Join | Merge Documents will combine two or more selected documents into one 
document. Pages will be added to the topmost selected document in the Separation 
Workspace in the order that the documents appear in the Separation Workspace.

For example, if a Merge Documents operation was performed to the selected documents in the 
below image, pages from Check 1301 would be added after the page in Check 1101. The pages 
in Check 1411 would be added after the pages for Check 1101 and Check 1301:

Join Pages
Clicking Join | Join Pages will combine selected pages from many different documents. This 
operation will move all selected pages in the Separation Workspace to the right of the first 
page selected. Pages will be joined in the order in which the pages were selected.

Note: This option is not available in Document Display Mode.
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If a page is selected from a locked document and a Join Pages operation is performed, the 
page from the locked document will be copied and joined to the right of the page from the 
unlocked document. If the locked page is selected first, the pages from the unlocked 
documents will be added to the right of a copy of the locked page.

Append After Page
Click Join | Append After Page to append the next document in the Separation Workspace to 
the selected final page of a document. The Append After Page option is only available when the 
last page of a document (other than the last document) is selected. 

For example, if an Append After Page operation was performed to the documents in the below 
image, all pages in Check 1301 would be added after the pages in Check 1411:
OnBase 18
©2018 Hyland Software, Inc.

198



Unity Client
Usage
Appending can also be performed by using the paperclip icon. To use the paperclip icon, place 
your mouse pointer to the right of the last page of the document to which you wish to append 
the next document in the Separation Workspace. A dotted line with a paperclip icon will appear:

Clicking this paperclip will append the next document in the Separation Workspace to the 
document in which you clicked.

Splitting Documents in the Separation Workspace
Documents can be created and edited by splitting them. Splitting separates the pages of a 
document to create one or more new documents. There are two splitting options.

When you click the bottom portion of the Split button in the Modify ribbon group, the two 
splitting options are presented:

• Split (also available as the scissors icon in the Separation Workspace)
• Break into Documents 

Use Split when making one document into two documents. Split allows you to select the exact 
page on which you would like to separate the documents. Use Break into Documents when 
separating a single document into many documents. Break into Documents might be used if 
you scanned many documents of a common length at once and it was brought into OnBase as 
one large document. This section covers each Split option.
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Split
To create a new document in the Separation Workspace by using the Split option:

1. Select the page in the document that will become the first page of the new document.

Note: The first page of the document cannot be selected.

2. Click Split:

3. The new document will appear below the document from which it was split in the 
Separation Workspace.

In addition to using the Split button in the ribbon, you can also use the scissors icon to 
separate documents. To use the scissors icon, place your mouse pointer between pages in a 
document so that a dotted-line and scissors icon appears between the pages:

Click this dotted-line to split the document. Pages after the dotted-line will become a new 
document. This new document will appear below the document from which it was split in the 
Separation Workspace.

Using the Break into Documents Option
New documents can be created by clicking Split | Break into Documents. When you click Split | 
Break into Documents, four options are available:

• Every Page 
• Every Other Page 
• Every Three Pages 
• Custom 

Each of these options designates where a break will occur in a selected document. For 
example, clicking Every Page will cause every page in a document to become its own new 
document. Clicking Every Other Page will separate the document after every other page and 
Every Three Pages will separate the document after every third page.
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Clicking Custom allows you to select a custom interval for splitting documents. This can be set 
in the Break into Documents dialog box:

To open the Break into Documents dialog box and input a custom interval:

1. Click Split | Break into Documents | Custom. The Break into Documents dialog box is 
opened.

2. Input the number of pages after which you would like to break the documents. The 
number must be greater than or equal to 1 and must also be less than the number of 
pages in the document. For example, if a document has four pages, you could input 1, 2, 
or 3. If a document has six pages, you could input any number from 1 to 5. 

3. Click OK to break documents into the custom interval.

Copying Pages and Documents in the Separation Workspace
Documents can be created and edited within the Separation Workspace by copying. Entire 
existing documents or select pages can be copied. 

When you click the bottom portion of the Copy button in the Modify ribbon group, three options 
are presented:

• Copy Document 
• Copy Pages to a New Document 
• Copy Pages in Place 

Clicking the main portion of the Copy button will perform a Copy Document operation.

A document that is created by clicking Copy Document or Copy Pages to New Document will 
inherit the indexing information from the source document that it was copied from. If the new 
document is created using pages from multiple documents, no indexing information will be 
inherited.
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Copy Document
Click the Copy Document button to copy the entire selected document. The top portion of the 
Copy button also performs this operation:

Note: If no documents are selected or if only individual pages are selected, the top portion of 
the Copy button will be unavailable. 

The new document is displayed in the Separation Workspace below the source document.

Note: A document that is created by clicking Copy Document will inherit the indexing 
information from the source document that it was copied from.

Copy Pages to New Document
Click Copy Pages to New Document to copy individual selected pages to a new document. 
Pages can come from one or more documents.

The new document is displayed at the bottom of the Separation Workspace.

Note: A document that is created by clicking Copy Pages to New Document will inherit the 
indexing information from the source document that it was copied from. If the new document is 
created using pages from multiple documents, no indexing information will be inherited.

Copy Pages in Place
Click Copy Pages in Place to copy selected pages within the same document. The duplicate 
page will appear to the right of the existing page.

Multiple pages from different documents can be copied in place at once.

Deleting Documents or Pages in the Separation Workspace
To delete content in the Separation Workspace, you can mark selected documents for deletion 
or enter Delete Mode.

To mark pages and documents for deletion select the page(s) and document(s) to be deleted 
and then click the Delete Selected button in the Delete ribbon group:
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Pages marked for deletion will display a red X:

After clicking Delete Selected, you may select additional pages and documents to be marked. 
Click Delete Selected again to mark these additional pages. 

If you select a document already marked for deletion and a document not yet marked and then 
click Delete Selected, the unmarked document will be marked while the marked document will 
go unchanged - the previously marked document will not be unmarked by this action. To 
unmark documents, select only marked documents and click Delete Selected.

To enable Delete Mode, click the Delete Mode button in the Delete ribbon group:

A banner will be displayed to indicate that Delete Mode is enabled.

Left-click pages you would like to mark for deletion. A red X is displayed on all pages that will 
be deleted.

To retain the page(s) that were marked for deletion, click the page(s) again while in Delete 
Mode.

Select Browse or Acquire to import new documents. Select a document, and select Browse or 
Acquire to import additional pages.

In Document Display Mode, select the key icon in the Document Header to modify Keywords. 
For revisable documents, select the comment icon in the Document Header to create or modify 
comments.

Note: All other actions are disabled while in Delete Mode.

In both Delete techniques, the marked pages and documents will be deleted after saving.

Undoing and Redoing Actions in the Separation Workspace
Specific actions performed in the Separation Workspace can be undone. Undone actions can 
then be redone. 

The following actions can be undone:
• Append 
• Merge Selected Documents 
• Merge Selected Pages 
• Split 
• Break into Documents 
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• Copy Documents 
• Copy Selected Pages 
• Drop to Create a New Document 
• Mark Page(s) for Deletion 
• Rotate 
• Flip 
• Browse 
• Acquire 

To undo an action, click the Undo button:

To undo all qualifying actions performed, click Undo | Undo All.

To redo the most recently undone action, click the Redo button:

Note: The Redo button only becomes available after an action has been undone.
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Importing a New Document in the Separation Workspace
After you have finished creating a new document, the document must be saved and uploaded 
to OnBase. Before saving and uploading, a document must be indexed. To index and save a 
document created in the Separation Workspace:

1. Select the desired document and click the Keywords button in the ribbon menu:

Document and Keyword Type fields are displayed in the Import pane. These fields are 
used to index the newly-created documents that are created in the Separation 
Workspace.

Note: Depending on your system’s configuration, one or more Keyword Values may be 
displayed as read-only and/or a masked value.

Note: The Keyword panel may display automatically if there is a document with invalid 
keywords in the Separation Workspace.
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Item Description

Document Type Group This drop-down list is used to select the Document Type Group of the 
currently selected document.

Document Type This drop-down list is used to select the Document Type of the 
currently selected document.

File Type This drop-down list is used to select the File Type of the currently 
selected document. 
Choices include Image File Format or PDF.

Note: The File Type of the document will initially be set to the default 
File Type of the Document Type that is chosen.
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Indexing information from the original document automatically populates these fields 
for new documents created from the original document. If necessary, this data can be 
modified or removed.

Note: Keyword Values are only applied to the newly created document(s) if the Keyword Type 
is associated with the new document’s Document Type.

2. To save Keyword modifications to the document and remove it from the Separation 
Workspace, click Save and Remove. If you would like to return to the Separation 
Workspace without removing the document, click Close.

Note: Clicking Save and Remove in the Separation Workspace does not change the document 
status. To mark a document as indexed, you still must index it outside the Separation 
Workspace.

Depending on how the Document Type is configured, you may be prompted to enter a 
comment after clicking Save and Remove.

Adding or Modifying Keywords on a Source Document in 
the Separation Workspace

Note: The Modify Keyword privilege is required to add or edit keywords in Document 
Separation. For more information, contact your system administrator.

Note: The Keyword panel may display automatically if there is a document with invalid 
keywords in the Separation Workspace.

Document Date This field is used to determine the Document Date of the currently 
selected document.
Click the arrow at the right end of this field to display a calendar from 
which the date can be selected.

Keywords The Keyword Type fields are displayed once a Document Type has 
been selected from the Document Type drop-down list. Use the 
keyboard or the mouse to enter data into these fields.

Item Description
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Keywords on source documents can be added or modified from the Document Separation 
window. To add or modify keywords on source documents:

1. Select the desired document and click the Keywords in the View ribbon group:

Document and Keyword Type fields are displayed in the Add/Modify Keywords pane. 
These fields are used to re-index the original document(s).

Note: Depending on your system’s configuration, one or more Keyword Values may be 
displayed as read-only and/or a masked value.

2. Add or edit keywords as needed. Modified fields are highlighted in blue. For more 
information on editing keywords within an Add/Modify Keywords pane, see Add / 
Modify Keywords on page 1.
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3. To re-index the source document with the modified or newly-added keywords, click the 
Close button. The Add/Modify Keywords panel is hidden and documents will be re-
indexed when saved.

Working with Comments on Revisable Documents in the 
Separation Workspace

If a document that allows revisions is brought into the Separation Workspace, you may be able 
to enter comments on it if the Document Type is configured to allow or require comments when 
edited and saved. Comments can be entered in both Document Display Mode and Page Display 
Mode. This section outlines adding and editing comments in these display modes.

Working with Comments in Document Display Mode
Revisions viewed in Document Display Mode will display one of three comment bubble icons 
that depict the comment status:

If there is no comment bubble, the document is not configured to allow comments on revisions.

To enter comments or edit previously entered comments in Document Display Mode:

1. Click the comment bubble icon in the Document Header:

Clicking a blue comment icon will allow you to view or edit unsaved comments 
previously entered in the Separation Workspace.

Icon Comment Status Description

Comment Required Comments must be entered before saving. 

Comment Allowed Comments may be entered before saving, but are not 
required.

Comment Entered Comments have been entered.
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2. Enter the desired comment in the comment text box or edit the existing comment:

3. Click anywhere in the Document Separation layout to exit the comment text box. 
If the comment icon was previously red (indicating that a comment is required) or white 
(indicating that a comment is allowed), the icon will become blue (indicating that a 
comment has been entered).

If a document that requires a comment is saved before a comment has been entered, a dialog 
box displaying the text Please enter a comment for [Document Name] is opened:

 

The document cannot be saved until a comment has been entered and you have clicked OK.

Note: Depending on your configuration, if a document that allows revisions is split in the 
Separation Workspace, you may be prompted to add a comment for the original document and/
or the newly created document.
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Working with Comments in Page Display Mode
Revisions viewed in Page Display Mode will not display an indication that a comment is 
required, allowed, or entered. However, when saving a document that requires comments, a 
dialog box displaying the text Please enter a comment for [Document Name] is opened:

Enter the necessary text and click OK.

To view the comment bubble icons, switch to Document Display Mode.

Note: Depending on your configuration, if a document that allows revisions is split in the 
Separation Workspace, you may be prompted to add a comment for the original document and/
or the newly created document.

Keyboard Shortcuts for the Separation Workspace
When working in the Separation Workspace, the following keyboard shortcuts are available:

Shortcut Action

Delete Deletes selected pages.

Esc Exits the Document Separation layout without saving changes.

Ctrl + S Saves selected documents.

Ctrl + H Flips selected pages horizontally.

Ctrl + . Rotates selected pages right.

Ctrl + , Rotates selected pages left.

Ctrl + J Joins selected documents.

Note: This operation is only used in Page Display Mode.

Alt and + Copies selected document.
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Ctrl and + Copies selected pages in new document.

Note: This operation is not used in Tree Display Mode.

Ctrl and Shift and + Copies selected pages in place.

Note: This operation is not used in Tree Display Mode.

Ctrl + C Copies individual pages to the clipboard.

Ctrl + X Cuts individual pages. 

Note: When pasted elsewhere, these pages will be removed from 
the original document.

Ctrl + V Pastes individual pages.

Note: When pasting pages from a document that is read-only, the 
pages in the clipboard will be pasted into a new document.

Note: This operation is not used in Tree Display Mode.

Shift + Click Selects all pages between two selected pages. Shift must be held 
while clicking.

Ctrl + Click Selects or deselects a page without deselecting other pages or 
documents.

Ctrl + Drag Copies the page being dragged and dropped instead of moving the 
page to the new insertion point.

Note: This operation is not used in Tree Display Mode.

Ctrl + Shift Selects multiple page ranges in multiple documents. These 
buttons must be held while clicking.

Note: This operation is only used in Document Display Mode.

Ctrl + Delete Enters Delete Mode.

Alt + Home Scrolls to the first selected page of a document, if not already in 
view.

Note: This operation is not used in Tree Display Mode.

Shortcut Action
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Up Arrow Scrolls up in the Separation Workspace.

Note: This operation is only used in Document Display Mode.Page Up

Down Arrow Scrolls down in the Separation Workspace.

Note: This operation is only used in Document Display Mode.Page Down

Ctrl + Mouse Wheel Up Zooms in on the page open in Detailed View.

Ctrl + Mouse Wheel Down Zooms out on the page open in Detailed View.

Ctrl + Left Arrow Rotates the page open in Detailed View 90 degrees 
counterclockwise.

Ctrl + Right Arrow Rotates the page open in Detailed View 90 degrees clockwise.

Shortcut Action
OnBase 18
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Folders

OnBase folders allow users to view and organize documents electronically, as they would with 
a folder of paper documents, but with the added benefits and security of OnBase. Users can 
access related documents in a way that is familiar, logical, and easy to use. Folder structures 
can be automatically created and populated based on business needs without user interaction.

OnBase folders allow users to store a document once and retrieve it from a familiar folder 
interface that can be configured to a department’s or user’s need. Because each document can 
reside in multiple folders, departments that prefer different folder structures can access the 
same document in different locations. Because there is only one actual document, changes to 
the document are reflected in all locations, even when the document resides in many folders.

Both folder creation and population can be automated to ensure that the folder structure is 
maintained and file sorting is accurate. This automation protects against accidental folder 
creation or documents being misfiled.

Folders can be sent to other OnBase users by clicking Send To | Mail Recipient (As Link) if 
Unity Pop Files or Unity Pop links are configured. Recipients must have permissions to view the 
Folder Type and must also be a part of a user group that has access to the File Cabinet.

Folder Definition
Folders provide an additional interface for grouping documents for easy retrieval. This 
interface consists of file cabinets that contain folders.

• Each folder is based on a Folder Type. Folder Types determine a folder’s setup, which 
includes the documents it can contain, whether documents are pulled into the folder 
automatically, and the folder’s Keyword information.

• Folders are assigned Keyword Types by your system administrator. You can search 
for folders by Keyword Value.

• A folder can contain documents from multiple Document Types.
• A document can reside in multiple folders. Because the document resides in OnBase, 

it retains all permissions, properties, Keyword Values, document handle, and right-
click menus (among other features).

• Folders can be configured to automatically store documents based on Keyword 
Values as they enter OnBase.

• Depending on your privileges and how Folder Types are configured, you can create 
and delete folders and change their Keyword Values.
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Folder Hierarchy
A folder’s position in the folder tree is defined by its parent-child relationships. A folder that 
contains other folders is a parent folder. The folders residing within a parent are called child 
folders. Child folders can also be parent folders to the folders they contain.

In the illustration above, a folder named HR - Employees is the parent to the Employee Record 
for ANDREW LINCOLN folder, which is the parent to the Employee Documents folder. The 
Employee Documents folder is the child to Employee Record for ANDREW LINCOLN, and 
Employee Record for ANDREW LINCOLN is the child to HR - Employees. Notice Employee 
Record for ANDREW LINCOLN is both a parent and a child folder, depending on the context.

Folder Contents
Folders are classified based on their contents, which can be static, dynamic, or both. A static 
folder’s contents must be manually added or removed from the folder. A dynamic folder’s 
contents are automatically added based on common Keyword Values assigned to the folder. 
File cabinets can contain a combination of both static and dynamic folders. To determine 
whether a folder is static, dynamic, or both, check the status bar at the top of the folder 
window. For more information about static and dynamic folders, see their definitions later in 
this section.

Static Folder
Static folders allow users to manually add and remove documents as needed for a custom 
organizational hierarchy.

• You can add OnBase documents to a static folder using the OnBase Client, Web 
Client, and Unity Client.

• Adding a document to a folder does not physically move the document. Rather, the 
folder provides another way for users to easily access the document.

• You can drag documents from outside of OnBase into a folder using the OnBase 
Client.
Documents imported using this method can be automatically indexed with the static 
folder’s Keyword Values, provided that the folder’s Keyword Types also exist on the 
Document Type.

• Documents residing in a static folder do not have to share the same Document Type 
or Keyword Values.
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Dynamic Folder
Dynamic folders allow users to automatically store documents in folders based on Keyword 
Values.

• A dynamic folder contains all documents that match specified Keyword Value criteria 
and Document Types. Whenever the folder is opened, its contents are updated 
automatically.

• Documents that are automatically pulled into a dynamic folder are not physically 
moved. The folder just provides another way for users to easily access the 
document.

• For documents to be added manually to a folder from within OnBase, the Folder Type 
must be static or both static and dynamic.
If a folder is both static and dynamic, documents containing Keyword Values not 
matching the folder Keyword Values can be added manually. If a folder is dynamic 
only, documents cannot be manually placed in or removed from the folder from 
within OnBase.

• You can drag documents from outside of OnBase into a folder.
Documents imported using this method can be automatically indexed with the 
dynamic folder’s Keyword Values, provided that the folder’s Keyword Types also 
exist on the Document Type. You can change these values in the Import Document 
dialog box, but if you change a Keyword Value the folder uses to dynamically store 
the document, then the document will not be dynamically stored in the folder. If the 
folder can contain static contents, then the document will be statically stored in the 
folder.

Auto-Foldering
Auto-foldering can automatically create OnBase folders when documents are imported or 
created in Document Types that are set up for auto-foldering. Re-indexing, modifying Keyword 
Values, and updating AutoFill Keyword Set information will also create auto-folders if the 
Document Type is properly configured.

Auto-foldering should be used for folder creation whenever possible, because it removes the 
need to manually create folders and reduces the potential for human error. Auto-foldering also 
helps ensure that folder structures are consistent and logical.

If a folder is dynamic or static and dynamic, then all documents that meet the folder’s dynamic 
criteria are pulled into the folder.

Opening File Cabinets and Folders
File cabinets contain folders, which contain documents that are placed in the folder from the 
OnBase Unity Client interface, or that are automatically pulled into the folder according to 
Keyword Type values (dynamic folders).
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In the Unity Client, you can view documents in folders, and in some cases, you can delete 
documents in folders. Folders are accessed in the Unity Client from the Home ribbon.

Your system administrator configures the file cabinets and Folder Types that folders are based 
on. You may not have access to file cabinets and folders, depending on your system's 
configuration. You must have appropriate rights to view, modify, add documents to, or remove 
documents from folders.

To access folders from the Unity Client:

1. Click File Cabinets in the Home ribbon.
2. The Browse Folders and File Cabinets layout displays all available file cabinets and 

folders:

Tip: To resize folder panes, place your cursor over the border between two panes, and then 
click and drag the border to the new height or width.

3. To view the contents of file cabinets and folders, click the triangle to the left of the file 
cabinet or folder, or select the folder.

4. Folders are displayed in the Folder Tree pane.

Note: Depending on the Folder Type configuration, the Documents pane may list all static 
documents residing in the selected folder’s child folders. Static documents are those that have 
been manually added to a folder. See your system administrator for information about your 
folder system’s configuration.
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5. Select a folder to open it.
To collapse all opened child folders under a parent folder, right-click the parent folder 
and select Clear List. This is different than clicking the triangle next to an opened 
parent folder, which only hides an expanded folder list.
• The Child Folders pane lists all child folders of the selected folder. This pane is 

collapsed by default.
• The Related Folders pane lists all related folders of the selected folder. This pane is 

collapsed by default if there are no available related folders the user can access.
• The Documents pane lists all documents in the selected folder.
• The first document in the selected folder may be displayed in the document viewer, 

depending on your system’s settings.
• If the folder is configured to display its child folders as tabs, the first child folder is 

opened.

Tip: To refresh contents of a Folder layout pane, right-click within the pane and select Refresh. 
Refreshing the Folder Tree pane will also refresh the Documents pane.

A pop-up list or search dialog box may be displayed, prompting you to specify the child 
folder to open. This behavior varies depending on the folder’s configuration. See the 
following topics for more information:
• Accessing Folder Search by Clicking a Folder on page 220
• Working with Folder Pop-up Lists on page 221

6. To open a folder from the Child Folders or Related Folders pane, use one of the 
following methods:
• Double-click on the folder.
• If child folders are displayed as tabs (in the right pane), click the tab to open the 

folder.
7. To open a document, select it from the Documents pane.

Opening Multiple Folders Windows
You can open multiple Folders windows from the OnBase Unity Client. This feature lets you 
work in multiple folders concurrently and compare different folders side-by-side. To open 
another Folders window, select Open In New Window from the Unity Client’s File menu.
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Moving Up a Level from a Folder Tab
If both the current folder and its parent folder are displayed as tabs, then you cannot select the 
parent folder by clicking it in the folder tree.

To select the parent folder, click the up-level tab located above the child folder tabs.

You can select the parent folder also by collapsing it in the folder tree.

Scrolling Through Folder Tabs
If a folder contains too many child folder tabs to display on the screen, you can scroll through 
available tabs using the scroll buttons at the bottom of the tabs pane.
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Accessing Folder Search by Clicking a Folder
Some Folder Types are configured to display the Find Folder dialog box when a folder of that 
Folder Type is selected. The Find Folder dialog box allows you to search for child folders of the 
selected folder. Once you retrieve a folder, the folder is inserted into the Folder Tree pane for 
the current session only.

For more information about folder searching, see Searching for Folders on page 223.

To close the dialog box without searching, click anywhere outside of it, or press ESC.
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Working with Folder Pop-up Lists
Upon selecting a folder or file cabinet, you may see a pop-up list displaying child folders of the 
selected folder.

To close the pop-up list, click anywhere outside of it, or press ESC.

1. To filter the folder list, type characters in the filter bar above the list. 
For example, to find records for a customer whose name begins with W, you could type 
Records for W.
The filter bar may be prepopulated with the static characters in the child folders’ Auto-
Names, depending on the selected Folder Type. This feature is useful when all child 
folder Auto-Names start with the same prefix or description. Characters that can vary in 
the folders’ Auto-Names, such as the folder date, are not prepopulated.

Note: If no folders are displayed, begin typing the name of the folder you need. The text above 
the filter bar indicates the number of characters required (excluding prepopulated static 
characters) before folders are displayed. After you’ve typed the number of characters required, 
OnBase displays all folders matching your criteria. The minimum number of characters 
required is configured by your system administrator.

2. Double-click a folder to open it. The folder is added to the Folder Tree pane.
3. Repeat these steps for each child folder you need to view. Each subsequent folder is 

added to the Folder Tree pane, making it easy to work back and forth between them.
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Retrieving Related Folders
If configured, related folders allow you to quickly access related information stored in different 
branches of the folder tree. Related folders and their availability vary per system. See your 
system administrator for information about your system’s folder configuration.

1. Select a folder in the Folder Tree or Child Folders pane.
2. Any related folders are listed in the Related Folders pane.
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Searching for Folders
You can search for folders using the Find Folders pane, which is displayed when you initiate a 
folder search from the Folders window or when you open a folder that is set up for child folder 
searching.

Tip: Depending on your system configuration, you may be able to search for certain Folder 
Types using Custom Queries. For more information, see Retrieval Using Custom Queries on 
page 60.

To initiate a folder search:

1. Right-click in the Child Folders, Related Folders, or Folder Tree pane and select Find 
Folder, or click the Find button from the Folder ribbon:
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2. The Find Folders pane is displayed.

3. From the Folder Type drop-down select list, select a Folder Type. The Find Folder pane 
displays any Keyword Types assigned to the selected Folder Type.

4. Enter Keyword Values as necessary. If a Folder Type requires a Keyword Value to be 
provided (not left blank), the required Keyword Type is displayed in red.

Note: You can use all Keyword functionality when searching folders, including adding 
additional instances of a Keyword Type or Keyword Type Group, or using Wildcard or Boolean 
operators to narrow the search. For more information, see the related Help topics.
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5. Click Find or press Enter to find all folders matching the criteria. Folders are displayed 
in the Results list:

If only one folder is returned, that folder is opened and displayed in the Folder Tree 
pane.

Note: A folder search may return the same folder multiple times if the folder is indexed with 
multiple instances of a Keyword Type Group and each instance contains the same value for the 
Keyword Type you searched on.

6. Double-click a folder to display its documents in the Documents pane.
Depending on the Folder Type, the first document may be displayed in the Document 
Viewer.
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7. If desired, click Clear Keywords to clear all entered values and start a new folder 
search.

8. Click Close to close the Find Folder pane.

Show Folder Locations

Use the Show Folder Locations option to view the folders where a document resides.

From a Document Search Results list or an open document, right-click and select Show Folder 
Locations. 

• If the document resides in only one folder, then the folder is opened in the File 
Cabinets layout.

• If the document resides in multiple folders, then the folders are listed in the following 
dialog box. To open a folder, either double-click it, or select it and click OK. 

• If no container folders can be found, then No documents found is displayed.
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Keyword Considerations for Show Folder Locations
The Show Folder Locations command uses the document’s Keyword Values to dynamically 
associate the folder to the document. Missing values will affect whether the correct folders are 
returned. In the following examples, suppose that two Keyword Types are used to dynamically 
link a document to a folder.

• If one value is left blank on the document, but not on the folder, the command returns 
the folder, even though the document doesn’t reside in it.

• If one value is left blank on the folder, but not on the document, the command does 
not return the folder, even though the document dynamically resides in it.

• If a folder is indexed with multiple instances of a Keyword Type Group, the Show 
Folder Locations command will retrieve the folder only from documents indexed with 
values that are in the same instance of a Keyword Type Group on the folder.
This behavior occurs only if Keyword Types in the folder’s Keyword Type Group are 
used to dynamically link the document to the folder, and if the Keyword Types are not 
in a Keyword Type Group on the document.

Applying Folder Filters

Note: Users without rights to certain filters will not see those filters displayed.

You can filter and sort documents in a folder using folder filters. Folder filters let you perform 
the following tasks:

• Organize and sort documents by Keyword Value, name, or date. Filters display 
information about each document in columns that you can use for sorting.

• Display only documents that have a specific Keyword Value. Filters that use forms let 
you filter the documents by submitting Keyword Values on the form.

• Display only documents within a subset of Document Types. For example, you may 
have a dynamic folder with multiple Document Types assigned to it, but you need 
quick access only to specific Document Types on a regular basis.

Filters are similar to another function of folders called folder templates. Both can display a 
subset of documents within a folder, but templates and filters perform different tasks. When 
choosing between a filter or template, consider what you want to accomplish. Whereas folder 
templates help ensure that a folder has a complete set of documents, folder filters let you 
quickly see information about documents organized in sortable columns.
OnBase 18
©2018 Hyland Software, Inc.

227



Unity Client
Usage
A folder template and a folder filter cannot be applied to a folder simultaneously. If you apply a 
filter to a folder with a template applied, the template is removed before the filter is applied. If 
you apply a template to a folder with a filter applied, the filter is removed before the template is 
applied.

Some folders may have a default filter applied when the folder is opened. When a filter is 
applied, the Documents pane is divided into columns with headers at the top of the pane. To 
determine which filter is applied, click the Filter button in the Folder Ribbon. The applied filter 
has a check mark next to its name. To remove the filter, select <No Filter>. Removing the filter 
may be necessary to display all the documents in a folder.To apply a folder filter:

1. With the Folder tab selected, click the Filter button from the Folder ribbon.

Note:  The Filter button is only available if you have configured Folder Filters.

2. Select a filter.
3. If a form is displayed in a separate window, type the Keyword Values to filter the folder 

by, and submit the form.

Note: The maximum number of documents that can be returned in a folder filter query is 2,000.

4. To sort the filtered list of documents, click the header above the column you want to 
sort by.
For example, if one column contains the Document Date, click the header to sort 
documents in ascending chronological order; click the header again to sort documents 
in descending chronological order.

Applying a Folder Template
Folder templates help you navigate a folder’s contents by doing the following:

• Filtering the view of folder contents when you open the folder. A template can be 
configured to display documents in a certain order by Document Type, or to display 
only documents of a certain Document Type by default.

• Providing a visual indicator of documents missing from the folder. For example, if a 
Patient Information folder is supposed to contain the patient’s Driver’s License, a 
folder template may display an error message if the Driver’s License Document Type 
is missing from the folder.

• Identifying whether documents are missing certain Keyword Values, which may have 
been unavailable when the documents were indexed.

• Sorting documents so they are displayed in a consistent sequence.
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To apply or remove a template:

1. With the Folder tab selected, click the Template button from the Folder ribbon.

2. Select a template. If the folder has a template applied and you want to remove it, select 
<<No Template>> to display all the contents of the folder. Contents are displayed 
according to the configured Document Type order of the folder.

Note: Depending on the template configuration, all contents of the folder may be displayed 
when a template is applied. If this is the case, template documents are displayed first, followed 
by documents that do not meet the template criteria.

The Documents pane displays any applicable documents or information.

Note: A folder template and a folder filter cannot be applied to a folder simultaneously. If you 
apply a filter to a folder with a template applied, the template is removed before the filter is 
applied. If you apply a template to a folder with a filter applied, the filter is removed before the 
template is applied.

Adding, Uploading, and Removing Documents
The following topics describe how documents are added to, uploaded to, and removed from 
folders.

• Adding Documents to Dynamic Folders on page 229
• Adding Documents to Static Folders on page 230
• Uploading and Indexing Documents Using Folders on page 230
• Removing Documents from Folders on page 232

Adding Documents to Dynamic Folders
You cannot add a document to a dynamic folder by dragging the document A dynamic folder 
contains Document Type and Keyword value criteria that OnBase will use to find Documents.

When you open a dynamic folder, documents that match the criteria populate the folder 
automatically. Each time the folder is opened, the query will be run again, finding any new 
documents that match the criteria for the folder.
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Adding Documents to Static Folders
If you have sufficient privileges, you can add documents residing in OnBase to a static folder by 
dragging the documents to the File Cabinets layout. A single document can reside in multiple 
folders, because folders contain pointers to documents rather than actual copies.

1. Ensure that the File Cabinets layout is open in a separate window.
2. From an open document or from a list with one or more documents selected, press and 

hold the left mouse button to hook the document(s).
3. Drag the document(s) to the Folder Tree or Documents pane and release the mouse 

button. The Documents pane displays the added document(s).

Note: You may not be able to manually add documents to all folders. You cannot manually add 
documents to dynamic folders because their contents are dynamically determined based on 
Keyword Values. See your system administrator if you have questions about static and 
dynamic Folder Types.

If OnBase will not let you add the document to a folder, see the following section, If You 
Cannot Add a Document to a Folder.

If You Cannot Add a Document to a Folder
You may be unable to add a document to a folder under any of the following conditions:

• You have insufficient privileges to add documents to the folder.
• The folder’s Folder Type is dynamic. Dynamic folders are populated automatically 

based on document Keyword values. Documents cannot be added to dynamic folders 
manually unless the folder is both static and dynamic.

• The folder’s Folder Type is set up to only contain other folders.
• The document already resides in the folder. A document cannot be added twice to 

the same folder.
• The folder is locked by another OnBase user, process, or module. For example, if a 

user is modifying the folder’s Keyword values in the OnBase Client, then you cannot 
add a document to the folder.

Uploading and Indexing Documents Using Folders
Depending on your privileges, you can upload documents to OnBase using existing dynamic or 
static folders. When you upload a document to OnBase using a folder, the document is added 
to the folder.
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Uploading a document to OnBase using a folder can be useful, for instance, when a template is 
applied to a dynamic folder and one or more placeholders are displayed for documents that 
have not yet been added to the folder. If the document exists and resides outside of OnBase, 
you can simultaneously upload it to OnBase and add it to the folder using the folder’s indexing 
information.

To upload a document to OnBase using a folder:

1. Open the appropriate folder.
2. Right-click the folder and select Keywords to check the Keyword Values assigned to the 

folder. Enter Keyword Values for the folder, if necessary.
3. Ensure the correct folder is selected in the Folder Tree pane.
4. Do one of the following:

• Select a file to upload from outside of OnBase. This includes Outlook emails or email 
attachments. Drag and drop the file to the folder in the Folder Tree pane or to the 
Documents pane.

• Right-click within the Documents pane.

Tip: When uploading to a dynamic folder, select and right-click the document or template 
placeholder in the Documents pane that represents the Document Type of the document you 
would like to upload. That Document Type is then automatically selected when the Import 
layout is displayed.

Select Import.
5. The Import layout is displayed.
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6. Select the appropriate Document Type and any other selections.
• If the folder is dynamic, only Document Types assigned to the Folder Type are 

available.
• If no Document Types are available, then you do not have privileges to any Document 

Type assigned to this Folder Type. In this situation, you cannot upload the document 
into OnBase.

Note: For more information on uploading documents, see Importing Documents on page 281.

7. Any Keyword Types shared with the folder are populated with the folder’s corresponding 
Keyword Values.
If the folder contains the Primary Keyword Value of an AutoFill Keyword Set that is 
assigned to the Document Type, its Secondary Keyword Values are not populated until 
you press the Tab key from within the Primary Keyword Type field.

8. Click Import. The document is uploaded to OnBase and added to the folder.

Note: To drag and drop multiple files into the Import queue, you must be licensed for EDM 
Services. Files dragged and dropped in this manner will be queued in the Import layout in the 
order in which they were selected in Windows Explorer. This order is influenced by which file 
you click and hold to drag the group of files. For example, if files 1, 2, 3, 4, and 5 were selected 
in Windows Explorer and you clicked on file 3 to drag them into the Import layout, the files 
would be organized in the Import queue as follows: 3, 4, 5, 1, 2.

Removing Documents from Folders
If you have sufficient rights, you can remove static documents from static folders. Select the 
document from the Documents pane, right-click, and select Remove From Folder.

Note: You cannot remove a Certificate of Destruction from a folder. For more information on 
Certificates of Destruction, see the Records Management module reference guide.

If a document is removed from a folder, it will not be removed from OnBase, just that folder.

You cannot manually remove documents from a folder that is dynamic. Dynamic folders 
automatically pull in documents based upon Keyword Value criteria. You also cannot manually 
remove documents that reside dynamically in a folder that is both static and dynamic.

Adding and Deleting Folders
These topics describe how to add and delete folders:

• Adding a Folder on page 233
• Deleting a Folder on page 234

Note: You must have appropriate User Groups and Rights for folders.
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Adding a Folder
1. In the Folder Tree pane, select the folder (or file cabinet) into which you want to place 

the new folder.
2. Right-click and select New Folder. The New Folder pane is displayed:

3. Select a Folder Type for the new folder. Folder Types define the following folder 
characteristics:
• Static or dynamic properties (how documents are filed)
• Assigned Keyword Types (used for searching and organization)
If no folders are available for you to create, then the message No folder types available 
is displayed under the drop-down.

4. Index the new folder.
• If a Folder Type requires a Keyword Value to be filled in (not left blank) the Required 

Keyword Type is displayed in red. You must supply a Keyword Value to create and 
save the new folder. 
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• If the folder uses a Multi-Instance Keyword Type Group, you can add another 
instance of the Keyword Type Group by double-clicking the Keyword Type Group’s 
name.

5. Change the Folder Date if desired.
6. Click Create. The new folder is added to the Child Folders pane.

Deleting a Folder
You can delete folders by using a right-click option. Deleting a folder does not remove its 
documents from OnBase. The documents remain available through other Document Retrieval 
methods.

Your ability to delete a folder depends on your privileges to the folder and the child folders it 
may contain. If you attempt to delete a folder that contains a child folder, and you do not have 
privileges to delete that child folder, then you cannot delete the parent folder or the restricted 
child folder(s). Child folders you have privileges to delete are deleted.

If your solution uses the Records Management module, you cannot delete managed folders or 
folders that contain managed folders using this method. If you attempt to delete a folder that 
contains both managed and unmanaged folders, the unmanaged folders you have privileges to 
delete will be deleted. 

Note: Managed folders require a Records Management license.

Note: Deleted folders can only be restored from Folder Maintenance in the OnBase Client by 
your system administrator.

To delete a folder from the Browse Folders and File Cabinets layout:

1. From the Child Folders, Related Folders, or Folder Tree pane, select the folder you want 
to delete.

2. Right-click and select Delete.
3. You are prompted to confirm that you want to delete the selected folder and all of its 

child folders. Click Yes. The selected folder is removed.

Changing Folder Keyword Values
If you have the appropriate user rights, you can change the Keyword Values assigned to a 
folder.

Note: Depending on the Folder Type of the folder (Static or Dynamic), changing its Keyword 
Values may change the contents of the folder, removing existing documents and adding new 
documents to the folder. Ensure you understand the ramifications of changing Dynamic Folder 
Type Keyword Values before proceeding. See your system administrator for additional 
information.
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1. From the Folder Tree pane, select the folder.
2. Right-click and select Keywords.

3. The Folder Keywords pane displays the Keyword Types and values for the selected 
folder along with the Folder Type, folder auto-name (based upon the Keyword Values), 
and the Folder Date, which by default is the folder creation date.

• Depending on your system configuration, one or more of the values may be masked 
or read-only. Keyword Values may be read-only because another user or process is 
working with them, or because you lack privileges to modify them.

• If the folder uses a Multi-Instance Keyword Type Group, you can add another 
instance of the Keyword Type Group by double-clicking the Keyword Type Group’s 
name or by clicking in a Keyword Type field and pressing F6.

For information about working with Keyword Types, see Working with Keywords on page 
153.

4. Edit the Keyword Values.
5. When finished, click Save Keywords. The Keyword Values are changed.
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Modifying Keyword Values on a Folder, Child Folders, and 
Documents
Throughout a business process, the Keyword Values associated with a folder or folder tree may 
change. To modify Keyword Values on all folders and documents in a folder tree, use the Folder 
Contents | Keywords right-click options.

You can modify only one Keyword Value at a time, which prevents folder contents from 
inheriting values for all of the folder's Keyword Types. If the folder uses Multi-Instance Keyword 
Type Groups, all values in a group can be modified simultaneously. For information about 
modifying Keyword Values in Multi-Instance Keyword Type Groups, see page 238.

Note: As a best practice, use the Folder Contents | Keywords options only when the folder and 
its contents use the same Keyword Types.

If you have insufficient privileges to modify Keyword Values on all of a folder’s contents, values 
are modified only on child folders or documents you have privileges to modify. If you lack rights 
to modify Keyword Values on a folder, then no values are modified on the folder’s contents.
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To modify Keyword Values on a folder and its contents,

1. From the Folders layout, select the folder whose Keyword Values you want to modify.
2. Right-click and select one of the following options from the Folder Contents | Keywords 

menu:

The Modify Folder Keywords dialog box is displayed:

Option Description

Folders and Documents Modifies the Keyword Values on the selected folder and any 
documents residing directly within that folder. Keyword Values on the 
folder’s child folders and their documents are not modified.

Folders and Child 
Folders

Modifies the Keyword Values on the selected folder and its child 
folders. Keyword Values on documents residing within the folder or its 
child folders are not modified.

Folders, Child Folders, 
and Documents

Modifies the Keyword Values on the selected folder, its child folders, 
and any documents residing within the folder or its child folders.
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3. Select the Keyword Type to modify from the Keyword Type drop-down select list.
If the Keyword Type is in a Multi-Instance Keyword Type Group, you can modify values 
on all Keyword Types in the group.

Caution: Ensure you understand how modifying Multi-Instance Keyword Type Groups will 
affect Keyword values on folder contents. For more information, see Modifying Multi-Instance 
Keyword Type Groups on page 238.

4. Type the new value for the folder and the contents you selected in step 2. The selected 
contents will have the same number of instances of the Keyword Type and the same 
values for each instance.
• If you add another instance of the Keyword Type (by pressing F6), the new instance 

and its Keyword Value is added to the folder and selected contents. If you remove an 
instance of a Keyword Value, the Keyword Value is removed from the folder and 
selected contents.

• If the selected Keyword Type is part of a Cascading Data Set, changing the Keyword 
Value will not update the child values that depend on it. For example, if you change 
the State value, then the City Keyword Type will retain its current value on the folder 
and its contents. Be sure to update any child values on folders and documents as 
needed.

5. Do one of the following:
• Click Save to save the modified Keyword Values and close the Modify Folder 

Keywords dialog box.
• Click Apply to save the modified Keyword Values and keep the Modify Folder 

Keywords dialog box open to modify additional Keyword Values.
• Click Cancel to cancel any changes that have not been applied.

Modifying Multi-Instance Keyword Type Groups
If the folder or its contents use a Multi-Instance Keyword Type Group, ensure you understand 
how Multi-Instance Keyword Type Groups are affected before using the Folder Contents | 
Keywords options.

The following examples describe how the Folder Contents | Keywords options are applied 
when folders or contents use Multi-Instance Keyword Type Groups. The tables display 
examples of folder and content Keyword Values before and after the Keyword Values are 
modified. These examples use ID and Color as Keyword Types.
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Example 1: Content uses the same Multi-Instance Keyword Type Group as its folder
When modifying a Keyword Value in a Multi-Instance Keyword Type Group used by a folder and 
its content, the Keyword Values on the folder are duplicated exactly on the content. The content 
inherits the same number of instances and the same values for the Multi-Instance Keyword 
Type Group as on the folder. Below, the values of the keywords ID and Color used by the folder 
are modified, so the values of the keywords ID and Color used by the content are modified.

Caution: When a folder has fewer instances of a Multi-Instance Keyword Type Group than its 
content, the content is modified to only use the instances of the Multi-Instance Keyword Type 
Group used by the folder.

Below, the values of the keywords ID and Color used by the folder are modified, so the 
instances of the keywords ID and Color used by the content are replaced by the instance of the 
keywords ID and Color used by the folder.

Folder Keywords Content Keywords

Before Modification ID: 111
Color: Red

ID: 222
Color: Blue

After Modification ID: 444
Color: Green

ID: 444
Color: Green

Folder Keywords Content Keywords

Before Modification ID: 111
Color: Red

ID: 222
Color: Blue

ID: 333
Color: Yellow

After Modification ID: 444
Color: Green

ID: 444
Color: Green
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Example 2: Content uses a Multi-Instance Keyword Type Group that contains a Keyword Type 
used by its folder
When modifying a Keyword Value used by the folder that is in a Multi-Instance Keyword Type 
Group used by the content, each instance of that Keyword Value in the Multi-Instance Keyword 
Type Group used by the content is modified. Below, the value of the keyword ID used by the 
folder is modified, so the value of each instance of the keyword ID used by the content is also 
modified.

Example 3: Content uses a Keyword Type that is contained in a Multi-Instance Keyword Type 
Group used by its folder
When modifying a Keyword Value in a Multi-Instance Keyword Type Group used by the folder, 
the Keyword Value used by the content is not modified. Below, the value of the keyword ID in 
the Multi-Instance Keyword Type Group used by the folder is modified, but the value of the 
keyword ID used by the content is not modified.

Folder Keywords Content Keywords

Before Modification ID: 111 ID: 222
Color: Blue

ID: 333
Color: Yellow

After Modification ID: 444 ID: 444
Color: Blue

ID: 444
Color: Yellow

Folder Keywords Content Keywords

Before Modification ID: 111
Color: Red

ID: 222

After Modification ID: 444
Color: Green

ID: 222
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Working with Folder Notes

Folder notes help you efficiently navigate folders and find specific information about their 
contents. Like notes on paper folders, folder notes in OnBase can provide additional 
information about a folder’s contents, or they can act as bookmarks to let you quickly find a 
document. Different note colors can help you find important or related notes. By providing the 
information you need at a glance, folder notes can save you time otherwise spent searching 
through every document in a folder.

For example, suppose you have case file that contains multiple subfolders. In OnBase, the case 
file folders can be set up as containers for folder notes, allowing you to comment on and add 
bookmarks to any document in any folder in the case file. Other users with permissions to view 
these notes can immediately see them upon opening the case file.

Before you begin, read the following topic, Folder Notes Requirements. Then, proceed to the 
following topics:

• Viewing and Sorting Folder Notes and Bookmarks on page 242
• Adding a Folder Note or Bookmark on page 243
• Viewing a Bookmarked Document on page 245
• Editing an Existing Note or Bookmark on page 246
• Deleting a Note or Bookmark on page 247

Folder Notes Requirements
Not all folders allow notes. To allow notes, a folder must either:

• Be based on a Folder Type configured as a parent for folder notes. These parent 
folders define the branch of the folder tree where notes are allowed.

• Reside within a parent folder for folder notes.

To work with folder notes, you must have sufficient privileges. If you do not have Folder Note 
Type privileges, then you cannot create, view, edit, or remove folder notes.
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Viewing and Sorting Folder Notes and Bookmarks
The following steps describe how to view notes and bookmarks on folders within the current 
branch of the folder tree. If folder notes are unavailable from the folder you are viewing, ensure 
the Folder Notes Requirements on page 241 are met.

1. Open the folder containing notes or bookmarks.
2. Click Notes from the ribbon’s Folder tab to display the Notes and Bookmarks pane. This 

pane displays all notes residing on any folder in the current branch of the folder tree.

Note: Two parent folders for folder notes can exist within the same branch of the folder tree. In 
this scenario, the higher-level parent folder does not display notes residing on folders within 
the lower-level parent. The lower-level parent folder acts as an isolated container for the notes 
residing on it and its child folders. This configuration allows multiple sets of notes to exist 
within a single folder structure. For information about how your folder solution is configured, 
contact your system administrator.

To search for specific text contained in the folder’s notes, enter text in the Find field. The Notes 
and Bookmarks pane automatically displays any notes matching your search criteria. To clear 
search criteria, click the X in the Find field. Wildcards do not function in this field.
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To sort the folder’s notes, click the following button:

The following sort options are available:

Adding a Folder Note or Bookmark
The following steps describe how to add a note or bookmark to the folder you are currently 
viewing. Notes allow you to comment on folder contents; bookmarks allow you to quickly jump 
to a specific page on a specific document in the folder tree.

1. Navigate to the folder where you want to add the note.
2. If you are adding a bookmark, navigate to the document and page that you want to 

bookmark.

Sort Option Action When Selected

Created By (Ascending) The folder’s notes are sorted by the name of the user that 
created the note, in ascending order.

Created By (Descending) The folder’s notes are sorted by the name of the user that 
created the note, in descending order.

Created Date (Ascending) The folder’s notes are sorted by the date and time that the note 
was created, in ascending order.

Created Date (Descending) The folder’s notes are sorted by the date and time that the note 
was created, in descending order.

Modified Date (Ascending) The folder’s notes are sorted by the date and time that the note 
was last modified, in ascending order.

Modified Date (Descending) The folder’s notes are sorted by the date and time that the note 
was last modified, in descending order.

Note Type (Ascending) The folder’s notes are sorted by the Note Type, in ascending 
order.

Note Type (Descending) The folder’s notes are sorted by the Note Type, in descending 
order.
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3. Click New Note from the ribbon’s Folder tab to display available Folder Note Types.

4. Select the type of note you want to add. If you are bookmarking a document, select the 
Note Type set up for bookmarking. The Add Note dialog box is displayed.

Note: If you select a bookmark Note Type, but no document is displayed in the viewer, then you 
are prompted to create a note without a bookmark. Choose Yes to proceed, or choose No to 
cancel note creation.

5. Type the note text in the field provided. 
When adding a bookmark, the Auto-Name string of the bookmarked document and the 
page number on which you are placing the bookmark are displayed in the field by 
default. This text can be removed or edited as needed.

6. Click OK. The new note is added to the top of the Notes and Bookmarks pane. To 
access this pane, see Viewing and Sorting Folder Notes and Bookmarks on page 242.
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Viewing a Bookmarked Document
To quickly retrieve a bookmarked document, click the Go to Page button from the bookmark in 
the Notes and Bookmarks pane. This button is available only on bookmarks; it is not available 
on standard folder notes.

You can also navigate to a bookmarked document by selecting the bookmark and clicking the 
Go To Bookmark button from the Folder ribbon.

Note: If an error is displayed, the document may have been removed from the folder or deleted 
from OnBase, or you may lack privileges to the document.
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Editing an Existing Note or Bookmark
To edit a note, click in the text field under the note’s name and timestamp. Then, type to edit 
the text as needed. Click on an area outside the note. The note text is saved.

If the text field does not have a border, as shown in the following example, then you lack 
sufficient privileges to edit the note.
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Deleting a Note or Bookmark
The following steps describe how to delete a note or bookmark from a folder.

1. Select the note in the Notes and Bookmarks pane. 

2. Do one of the following:
• Right-click on the note (anywhere except the note’s text field), and select Delete 

Note.
• Click the Delete Note button on the Folder tab in the ribbon. 

3. Click Yes when prompted.
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Folder Properties
The Folder Properties window provides information about a selected folder, including its 
content type, creation date, folder date, date range, and creator. Folder properties are available 
only to users with sufficient privileges.

1. Select the folder from the File Cabinets layout.
2. Right-click and select Properties. The folder’s properties are displayed.

Properties are described in the following table. For more information about your folder 
configuration, contact your system administrator.

Property Description

Folder Name The folder’s Auto-Name.

Folder Number The internal number assigned to the folder when it was created.

Batch The number of the batch that imported the document that created the 
folder. Batches of documents are imported through OnBase’s processing 
modules, such as COLD/ERM.
If the folder was not created through a batch, this number is 0.
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Note: File cabinet properties display only the properties of the file cabinet, not the properties of 
the folders it contains.

Viewing the History of a Folder
A folder’s history provides information about actions that have been performed on the folder.

1. Select the folder from the File Cabinets layout.
2. Right-click and select History. The Folder History window displays actions that have 

been performed on the folder, including when the action was logged and who performed 
the action.

Note: Your User Group must have the Folder History product right in order to access Folder 
History. For additional information, see your system administrator.

Folder Type Name The name of the Folder Type on which the folder is based.

Folder Type Number The internal number of the Folder Type.

Usage The usage type of the Folder Type.

Contents The content type of the Folder Type. The content type determines whether 
the folder contains documents and how any documents are stored. 
Possible values include Folders Only, Static, Dynamic, Static/Dynamic, 
Static/Child Contents, and Dynamic Group.
Static/Child Contents is displayed for folders that display the static 
contents of child folders.

Folder Date The date assigned to the folder when it was created. The folder date can 
be modified to suit your business needs.

Date Created The date the folder was created. This value cannot be modified.

Created By The name of the user who created the folder or who ran the process that 
created the folder.

Date Range The date range assigned to the Folder Type.
Possible values include None, Daily, Weekly, Monthly, Quarterly, 
Biannually, and Yearly.

Folder Start Date The start date of the folder’s date range. This property has no value if the 
Folder Type has no date range.

Folder End Date The end date of the folder’s date range. This property has no value if the 
Folder Type has no date range.

Property Description
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Sending and Receiving Mail
If you have appropriate privileges, you can send internal mail to communicate with other 
OnBase users and to send them OnBase documents and folders. You can read messages from 
other users from your OnBase inbox. If you need to send documents to non-OnBase users, you 
can use external mail to send OnBase documents or links to documents to an email address.

• To send documents and messages to another OnBase user, see Send To | Internal 
User on page 250.

• To check your OnBase inbox, see Checking Internal Mail on page 255.
• To email documents or links to documents externally, see Emailing Documents and 

Links to Documents on page 260.

Send To | Internal User
Internal Mail is useful for sending a message to another OnBase user. When you attach 
documents to an internal email message, the system attaches a pointer to the actual document 
within OnBase. Because both the email message and attachments are part of OnBase, 
documents retain all their system attributes (for example, permissions, keywords, etc.). Internal 
Mail messaging also provides the ability for multiple users to view a particular document.

Note: You must have the Internal Mail privilege assigned in order to use Internal Mail.

Depending on your configuration, you may be notified about new Internal Mail messages when 
you log on to OnBase, or when a user sends you new mail, by a You have # unread message(s) 
notification:

Sending OnBase Documents to Other OnBase Users
1. From the Document Search Results list:

• Select one or more documents and click Send To | Internal User on the Document 
tab.

• Select one or more documents, right-click, and select Send To | Internal User.
From an open document:
• Click Send To | Internal User on the Document tab.
From an open image or text document:
• Click Send To | Internal User on the Document tab.
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• Right-click and select Send To | Internal User.

Note: You can only send documents that you have rights to send as mail. If you send a 
document to a user that does not have rights to view the document, the document is not 
attached to the email that this user receives.

2. A new message is displayed:

The Attachments field displays the attached document(s). Double-click a document to 
view it directly from the message.

3. You can add recipients manually or from the address book.
4. To add recipients manually:

a. Type the name of a user or user group in the To: field, separating multiple recipients 
with a semicolon. Enclose user groups with angle brackets (<>). For example, <User 
Group>.

b. On the Message tab, in Names, click Check Names to check the user or user group 
names that you have typed.
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c. If no matches or multiple matches were found, the following screen is displayed:

d. Select the recipient to use and click OK.
5. To add recipients from the address book:

a. On the Message tab, in Names, click Address Book, or select the To drop-down list:
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b. The address book is displayed:

Users and user groups are listed in Available Recipients. User groups are enclosed 
with angle brackets (<>).

c. Select a user or user group, or multiple users/user groups by holding down the Ctrl or 
Shift keys while clicking.

d. Click Add Selected Items to add the selected user(s)/user group(s) to the Selected 
Recipients list.

Click Add All Items to add all user(s)/user group(s) to the Selected Recipients list.
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e. To remove users/user groups from the Selected Recipients list, select them from the 
Selected Recipients list and click Remove Selected Items.

To remove all users/user groups from the Selected Recipients list, click Remove All 
Items.

6. The To: field displays the selected user(s)/user group(s):

7. Type a Subject of up to 100 characters.
8. On the Message tab, in Tracking, select Read Receipt Requested to request a read 

receipt.
9. Type a message of up to 250 characters.

Note: Each space is treated as a single character, each new line counts as two characters. 
When replying and forwarding, the right angle brackets (>) in the message field count as a 
single character and the Fw: counts as four characters in the subject field.

10. Click Send.
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Checking Internal Mail
1. On the Home tab, in Internal Mail, click Mailbox:

2. The Mailbox layout is displayed:

3. Messages are grouped based on the date they were received:

Group Description

Today These messages were received today.

Yesterday These messages were received yesterday.

Earlier This 
Month

These messages were received earlier in the month.

Last Month These messages were received last month.

Older These messages were received prior to last month.
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4. The following columns display message properties:

Column Description

Icon Displays whether the message has been read.
Messages that have not been read are denoted by the following icon:

Messages that have been read are denoted by the following icon:

Messages that have not been read and have an attachment are denoted by the 
following icon:

Messages that have been read and have an attachment are denoted by the 
following icon:

From Displays the OnBase user that sent the message.

Subject Displays the message subject.

Date Displays the date the message was sent.
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5. The following buttons are available on the Mailbox tab and the Mailbox layout’s right-
click menu:

Actions Description

Open opens the selected message. You can also double-click a message to open it.
See Viewing Internal Mail on page 258 for more information.

New creates a new message.

Delete deletes the selected message(s). Click Yes to confirm that you want to 
delete the message.

Respond Description

Reply lets you reply to the OnBase user who sent you the selected message.

Reply with Attachments lets you reply to the OnBase user who sent you the 
selected message while retaining any attachments.

Forward lets you forward the selected message and attachment(s) to other OnBase 
users.
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Viewing Internal Mail
Internal mail messages are displayed in a separate window:

Options Description

Mark as Read marks the selected message as read

Refresh Messages refreshes the list of messages.
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To view an attached document, click the document’s Auto-Name string in the Attachments 
field:

Attachments are displayed in a separate window.

The following buttons are available on the Message tab:

Respond Description

Reply lets you reply to the OnBase user who sent you the message.

Reply with Attachments lets you reply to the OnBase user who sent you the 
message while retaining any attachments.

Forward lets you forward the message and attachment(s) to other OnBase users.

Actions Description

Delete deletes the message. Click Yes to confirm that you want to delete the 
message.
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Emailing Documents and Links to Documents

Note: Emailing a document or a link to a document requires that you have a functional 
Microsoft Outlook, IBM Notes, or Novell GroupWise email client or Gmail account. You cannot 
email documents or links to documents in the Unity Client with any other email client.

Note: If using Microsoft Outlook as your email client, Outlook must be running as the same 
account type as the Unity Client. For example, if Outlook is running in administrator mode 
(accessed by right-clicking the executable file and selecting Run as administrator), the Unity 
Client must also be running in administrator mode.

Note: When Microsoft Outlook and Novell GroupWise are installed on the same machine, using 
GroupWise as the Default Mail Client for the Unity Client may result in unexpected behavior and 
is not supported.

Single documents, a list of multiple documents, folders, Custom Query results, E-Form and 
Unity Form Creation pages can all be sent as Unity Pop links or Unity Pop Files. Unity Pop Links 
and Unity Pop Files are available, depending on your configuration, as Mail Recipient (as Link). 
If you are configured to use DocPop, clicking Mail Recipient (as Link) will allow you to send a 
single document or a list of multiple documents.

You must have user rights to email a document or a link to a document. User rights are 
managed by your system administrator.

Certain special characters are not supported in file names. If these characters appear in the 
document’s Auto-Name string, they are replaced with a space or substituted with other 
characters that are supported. The following special characters are replaced with a space: @ # 
$ % ^ & = { } [ ] : " ; ’ < >. Character substitutions are as follows:

To email a document:

1. From the Document Search Results list:
• Select one or more documents and click Send To on the Document tab.

Auto-Name Character Substitution

* +

? !

/ -

\ -

| !
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• Select one or more documents, right-click, and select Send To.
From an open image or text document:
• Click Send To on the Document tab.
• Right-click and select Send To.

2. Select Mail Recipient (as Attachment) to email the document(s) as an attachment.
Select Mail Recipient (as Link) to email a link to the document(s).
OnBase 18
©2018 Hyland Software, Inc.

261



Unity Client
Usage
3. If you selected Mail Recipient (as Link), OnBase displays a blank email message 
containing a link to each selected document.
If OnBase has been configured to use DocPop or Unity Pop URI links, a single link to all 
documents is generated. A hit list of all documents selected will be opened when the 
link is clicked. Proceed to step 11.
If you selected Mail Recipient (as Attachment), and the document is not an image or 
text document, you may be prompted to select an email template in the Send to Mail 
pane. If the Email Template drop-down list is displayed, proceed to step 6. If the Email 
Template drop-down list is not displayed, proceed to step 10.
If you selected Mail Recipient (as Attachment), and the document is an image or text 
document, or you selected multiple documents including an image or text document, 
the Send to Mail pane is displayed:

Note: If you selected multiple documents, including documents that are not image or text 
documents, the documents will automatically be sent in their native format. Depending on your 
configuration, you may be able to select an email template in the Send to Mail pane. If the 
Email Template drop-down list is displayed, proceed to step 6. If the Email Template drop-
down list is not displayed, proceed to step 10.
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If you are using Gmail as your external mail client, the Send to Mail pane may prompt 
you to log into Google or, if you are already logged in, will display a profile icon.

Tip: Hover over the profile icon to see which Google user is logged in.

Note: If a Google account is already logged in and you would like to switch users, you can click 
the profile icon and select Log out from Google to log the Google account out of OnBase. You 
will also need to log out of Google from your web browser to log out fully. 
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4. Select one of the following from the File Format of Attachment drop-down select list:

If you are sending an encrypted PDF, you are required to type an encryption password in 
the Password field, which is displayed below the File Format of Attachment field in the 
Send to Mail pane. This password is case-sensitive and can include alphanumeric or 
special characters. It cannot contain Unicode characters.

Caution: If you lose or forget the encryption password, it cannot be recovered.

File Format of 
Attachment

Description

Default/TIFF Format Sends the document as a TIFF file.
Available for documents with any of the following file formats:

• Image file format
• PCL
• PCL with overlay
• Text report format
• Text report format with overlay

Unencrypted PDF Sends the document as a PDF file.
Available for documents with any of the following file formats:

• Image file format
• PCL
• PCL with overlay
• Text report format
• Text report format with overlay

Native Format Sends the document in the format in which it is stored in OnBase (e.g., 
OLE documents such as Word documents and PDFs, uncompressed 
text documents, most image documents).
Overlays are not applied.

Note: This Content Type is only available if the selected documents 
can be successfully mailed in their native format.

Note: This option is unavailable for multi-page image documents.

Text Format Saves the document as a .txt file.
Available for documents with compressed text file formats. This 
includes documents imported with COLD or documents with the with 
the .ctx file type.
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5. Select one of the following from the Settings drop-down select list:

6. Depending on your configuration, the Email Template drop-down list may be displayed 
in the Send to Mail pane. The template you select will change the default text in the 
subject and body of your email message.

Note: If the template you select contains a Keyword Type that does not exist on the document, 
that Keyword Value is replaced with a blank space.

7. If you are sending a document containing notes or annotations, the Note Options drop-
down list is available. Select either of the following:

Settings Description

Send All Pages All pages in the selected document will be sent.

Send Custom Range The page(s) specified in the Pages field will be sent. Enter page numbers 
and/or page ranges, separated by commas. For example: 1,3,5-12.

Note: This option is unavailable when File Format of Attachment is set 
to Native Format.

Option Description

Annotation and/
or Note Icon On 
Document

The document is emailed with any annotations and note icons displayed on 
the document. If you move a note before emailing the document, the note is 
displayed in its last saved location. Note locations are saved when a 
document is closed.

Note Text On 
Document

The document is emailed with the title and text of any notes in that note’s 
location on the document, along with the name of the user that created the 
note and the date and time it was created. If this option is selected with 
Annotation and/or Note Icon On Document, the text is displayed below the 
icon. If you move a note before emailing the document, the note is displayed 
in its last saved location. Note locations are saved when a document is 
closed.
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8. When sending multiple image or text documents, the Apply Settings to Subsequent 
Documents check box is available:

When it is selected, the File Format of Attachment selection is applied to all 
subsequent documents. The Settings drop-down list and Pages field are not available. 
The Note Options drop-down list is only available if the first selected document 
contains notes.
When it is not selected, you are required to repeats steps 4 through 7 for each 
document. Navigate through the documents using the Next Document button:

Note: You are only able to select an email template for the first document.

9. Click Send:

Note: If Gmail is configured as your external mail client, you may be prompted to accept Unity 
Client Checkout Account Permissions after clicking Send.

10. OnBase displays an email message with the selected document(s)/page(s) attached. If 
you selected an email template in step 6, the email message includes text from that 
template. If you did not select an email template, the email message is blank.
Depending on your system’s configuration, the file name for the attachment may be 
based on the document’s Auto-Name string, or it may be an automatically generated 
attachment ID.
If an attachment’s name is not unique, for example, because you are sending two files 
with the same Auto-Name string, then OnBase makes the name unique by appending _ 
(underscore) followed by a number.

Note: If you are sending multiple OnBase documents or Unity Pop files with IBM Notes, a ZIP 
file containing all documents or files is attached to the email message.

11. Enter the recipient(s) of the message.
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12. Type the body of the message.
13. Send the message.

Attachment Display Considerations
If the document you are sending has an overlay, the overlay is displayed on the attachment only 
if the overlay is displayed by default when you open the document in OnBase.

If you are sending an XML document, the XML stylesheet is applied to the document and it will 
be converted to HTML.

If you are sending an E-Form, the E-Form is sent as HTML.

If you are sending a Lotus Notes document with a stylesheet, the stylesheet is applied to the 
document and it will be converted to HTML. Lotus Notes documents without configured 
stylesheets are sent in their native format.

Sending Folders as Unity Pop Links and Unity Pop Files
In addition to documents, folders may also be sent to users by clicking Send To | Mail 
Recipient (as Link) if OnBase is configured to use Unity Pop Links or Unity Pop Files. 

Recipients of the sent folder must have the user group privilege to view the File Cabinet and 
must also have permission to view the Folder Type.
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Using the OnBase Mail Message Dialog Box

The OnBase Mail Message dialog box is only displayed when using Novell GroupWise.

Note: SMTP is not supported in the Unity Client or Web Client.

To display the Bcc field, select View | BCC.

The Format menu displays message formats available for your Native Mail System. To make 
the selected format the default format for future messages, select Set as default.

The buttons in the Mail Message toolbar are described in the following table.

Tip: To change the way the toolbar is displayed, click View and select Large Toolbar to display 
large toolbar buttons or Small Toolbar to display small toolbar buttons.

Button Description

Send - Click to send the mail message.
This feature is also available by selecting File | Send.

Save - Click to save the mail message.
This feature is also available by selecting File | Save.

Cut - Click to cut highlighted text in the message field.
This feature is also available by selecting Edit | Cut.
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Checking Names and Addresses

Clicking the Check Names button resolves the recipient’s name to the address book by looking 
for contacts configured as either First Name-Last Name or Last Name-First Name (including 
middle initial, if applicable). The following rules apply:

Note: Novell GroupWise users need to use a wildcard character, *, when resolving an 
incomplete name.

• When address book has multiple cases where a name being resolved can be both a 
First Name or Last Name (e.g., James), the Check Names dialog box prompts the 
user to select the appropriate recipient.

• When you type an entire recipient name as <First Name Middle Initial Last Name>, 
you must use the correct punctuation for the middle initial (e.g., Betty A. Jones) for 
the name to be resolved to the address book.

• When you type a recipient name as <Last Name First Name Middle Initial>, you must 
use the correct punctuation; a comma must follow the Last Name. When a Middle 
Initial is included, you must follow it with a period (e.g., Jones, Betty A.).

Copy - Click to copy highlighted text in the message field to the clipboard.
This feature is also available by selecting Edit | Copy.

Paste - Click to paste text in the message field that was copied to the clipboard.
This feature is also available by selecting Edit | Paste.

Check Names - Click to verify names and email addresses entered in the To field 
from your Address Book.
This feature is also available by selecting Tools | Check Names.

Address Book - Click to open the Address Book and add email addresses to the 
Message Recipients text boxes by selecting the Name, then clicking the To, Cc, or 
Bcc buttons. To remove names, double-click on the name in the Message Recipients 
list and it will return to its original location.
This feature is also available by selecting Tools | Address Book.

Note: If you are using a large Novell GroupWise address book (more than 15,000 
entries), all recipient names may not be available in the Select Names dialog box.

Spell Check - Click to spell check text entered in the message field.
This feature is also available by selecting Tools | Spell Check.

Note: Spell check is only supported for workstations with Microsoft Word installed.

Button Description
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Viewing Unity Pop Files and Links
The Unity Client must be installed on workstations in order to view Unity Pop files and links. 
The installed instance of the Unity Client must be running in Service Mode to view Unity Pop 
files and Unity Pop links. If Unity Pop links or Unity Pop files are to be viewed, you will need the 
Unity Pop Automation Service Mode feature enabled. Contact your system administrator for 
more information. 

Note: For more information on Email Templates, contact your system administrator.

Depending on your configuration, email messages that you create by selecting Send To | Mail 
Recipient (as Link) may contain either Unity Pop files or Unity Pop URI links. 

Unity Pop files are XML files that are references to content in OnBase. When a Unity Pop file is 
opened, the Unity Client is launched in order to display the content of the Unity Pop file. 

Unity Pop URI links are links to content within OnBase. When a Unity Pop link is clicked, the 
Unity Client is launched in order to display the content of the Unity Pop link. 

With both Unity Pop files and Unity Pop links, multiple documents may be sent at once. When a 
link or file to multiple documents is clicked, a hit list containing all linked documents is opened. 

Folders can also be sent by both Unity Pop methods. When a link or a file to a folder is clicked, 
the folder is opened in the File Cabinet layout.

E-Forms and Unity Forms may also be sent as Unity Pop files and Unity Pop links. When the file 
or link is opened, the form creation page is opened. For more information on sending and 
receiving Unity Pop files and Unity Pop links containing E-Forms and Unity Forms, see the E-
Forms module reference guide and the Unity Forms module reference guide.

If you are already logged on to the Unity Client when you click on a Unity Pop file or link, the 
content is opened in the existing instance of the Unity Client. If you are not logged on to the 
Unity Client, you are required to do so before viewing the Unity Pop content. After logging in, the 
Unity Client is launched in the system tray and the content is displayed.

Because you are required to log on to OnBase in order to view Unity Pop files and link, if you do 
not have rights to view the content in OnBase, you will not be able to view the content via Unity 
Pop.

Note: A Concurrent Client license is consumed while viewing Unity Pop files and links.

Note: If multiple Unity Pop files were sent to you with Lotus Notes, a ZIP file containing the 
Unity Pop files is attached to the email message. To view the Unity Pop files, open the ZIP file 
using a ZIP utility.
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Using Envelopes
Envelopes provide a way to bundle documents together for easy access, or to easily email the 
group of documents at one time.

Envelopes are similar to folders from a document retrieval perspective. However, there are 
some key differences:

• Only the user that created an envelope can see its contents.
• Folders are based on Folder Types configured by your system administrator.
• Some Folder Types are designed to automatically pull documents in based upon 

Keyword value and Document Type. Documents residing in envelopes require no 
common characteristics.

• Some Folder Types do not allow users to manually add documents to them, whereas 
envelopes do.

• A system administrator must configure the file cabinet in order for a user to be able 
to create folders.

• Not all Folder Types are user-creatable. This is determined by your system 
administrator. If you have proper privileges, you can create envelopes.

• Some documents automatically create the folder structure as they are imported into 
OnBase.

• You cannot search for envelopes based upon Keyword Value.

Envelope
You can place any documents you want into an envelope, regardless of whether they have 
anything in common. When an envelope is opened, it displays a list of documents that have 
been placed in it.

Envelopes provide you with a way to group documents together for easy access. Only the 
envelope’s creator can view that envelope. Envelopes are an alternate way to retrieve 
documents; the documents remain accessible through standard document retrieval methods.

• Because the entry in an envelope is actually a pointer to the document stored in its 
Document Type Group, removing a document from an envelope will not delete the 
document from OnBase.

• Adding documents to envelopes does not duplicate the document in OnBase.
• There is no limit to the amount or type of documents that can be placed in one 

envelope.
• You can add a document to more than one envelope.
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Creating and Deleting Envelopes
This topic describes how to create and delete envelopes.

Note: You must have appropriate privileges to use and delete envelopes. The only envelopes 
available to you upon login are the envelopes you created.

Creating a New Envelope
To create a new envelope:

1. On the Home tab, click Envelopes:

2. The Envelopes layout is displayed:

3. Perform one of the following:
• Right-click in the Envelopes pane, and select Create Envelope.
• On the Envelopes tab, click Create Envelope:
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4. The following dialog box is displayed:

5. Type the name of the new envelope in the text field.

Note: Envelope names must be unique and cannot be left blank.

6. Click OK.
7. The new envelope is created and displayed in the Envelopes pane.

Deleting an Envelope
To delete an envelope:

1. On the Home tab, click Envelopes:

2. The Envelopes layout is displayed:

3. From the Envelopes pane, select one or more envelopes to delete.
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4. Perform one of the following:
• Right-click on the selected envelopes in the Envelopes pane, and select Delete 

Envelope(s).
• On the Envelopes tab, click Delete Envelope(s):

5. The selected envelopes are deleted and removed from the Envelopes pane.

Note: Deleting an envelope does not remove its documents from OnBase. They will still be 
available through other document retrieval methods.

Sharing an Envelope
If you have sufficient privileges, you can share envelopes with other OnBase users.

When sharing envelopes, note the following:
• Document Type user permissions are respected when sharing an envelope. For 

example, if you share an envelope with a user who does not have permission to 
Document Types in the envelope, the envelope will appear empty to that user. If the 
envelope contains both documents that the user does and does not have rights to, 
the Document Types the user can view are still displayed.

• In addition to Document Type permissions, users in the Unity Client must be 
privileged to retrieve and view documents in order to view documents in a shared 
envelope.

To share an envelope:

1. On the Home tab, click Envelopes:
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2. The Envelopes layout is displayed:

3. From the Envelopes pane, select the envelope to share.
4. Perform one of the following:

• Right-click in the selected envelope, and select Share Envelope.
• On the Envelopes tab, click Share Envelope:
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5. The following dialog box is displayed:

6. From the Available Users list, select the users with whom to share the envelope, and 
click Add.
To share the envelope with all available users, click Add All.
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7. To grant envelope permissions to one or more users, select users from the Selected 
Users list, and grant any of the following permissions:

8. Click OK.

Adding or Removing Documents from Envelopes
This topic describes adding documents to envelopes and removing documents from 
envelopes.

Adding Documents to Envelopes
You can add an open document to an envelope, or one or more documents to an envelope from 
a Document Search Results list.

To add documents to an envelope:

1. Perform one of the following:
• Right-click and select Send To | Envelope.
• On the Document tab, click Send To and select Envelope.

Permission Description

Full Control Allows the selected user to do the following:
• Share the envelope.
• Add documents to the envelope.
• Remove documents from the envelope.
• Delete the envelope.

Note: When you delete an envelope that is shared with other users, the 
envelope is only deleted from your view. Other users will still be able to see 
the envelope.

View Envelope Allows the selected user to view the envelope.

Add to Envelope Allows the selected user to add documents to the envelope.

Remove from 
Envelope

Allows the selected user to remove documents from the envelope.
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2. The Select Envelope pane is displayed:

3. Select the envelope to which the documents are to be added, and click Add.
4. The documents are added to the envelope, and the pane is closed.

Removing Documents from Envelopes
To remove documents from an envelope:

1. On the Home tab, click Envelopes:

2. The Envelopes layout is displayed:

3. Select an envelope. The envelope’s documents are displayed in the Documents pane. 
Envelope contents are displayed in the same format as a Document Search Results list. 
For more information, see Document Search Results List on page 74.

4. Select one or more documents to be removed.

Tip: You can select one document by clicking it, or select multiple documents by using 
standard Shift + Click and Ctrl + Click techniques. 

5. Right-click and select Remove From Envelope to remove the document(s).
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Opening Existing Envelopes
To open an existing envelope:

1. On the Home tab, click Envelopes:

2. The Envelopes layout is displayed:

3. From the Envelopes pane, select an envelope.
4. The envelope’s documents are displayed in the Documents pane. Envelope contents 

display in the same format as a Document Search Results list. For more information, 
see Document Search Results List on page 74.

Note: To refresh an envelope’s contents, double-click the name of the envelope in the 
Envelopes pane.
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Importing Documents
You can use the Unity Client to import documents to OnBase.

When importing documents in the Unity Client, consider the following:
• If importing a Microsoft Excel document, remove the Shared Workbook setting from 

the document in Excel before importing.
• The Unity Client Document Viewer does not support viewing XML documents 

imported as Microsoft Office file types. Before importing these documents, contact 
your system administrator.

• Email messages and their attachments are imported into OnBase as separate 
documents. To import an email message as one document with its attachments 
embedded, first save the email message as an .EML or .MSG file.

• As .dotm and .dotx files are Microsoft Word Templates, modified versions are 
automatically saved to OnBase as new documents. If this is not the intended 
behavior, the files should be saved as .docx or .doc files before importing them into 
OnBase.

• When importing a .dotx file, the file is opened externally and must remain open until 
the import process is completed.

• Importing AFP files is not supported in the Unity Client. For more information, see the 
AFP Input Filter module reference guide.

Note: Some Document Types are configured to require Keyword Values to be entered in order 
to create and/or retrieve documents. Required Keyword Values are displayed in red for these 
operations, which may include the following: Document Retrieval, Import, and Add/Modify 
Keywords.

Note: Unless otherwise noted, OnBase does not support the import of files larger than 2 GB.

To begin the Import process:

1. On the Home tab, click Import.

2. Select one of the following input methods:

Import Description

Browse imports the document from a drive accessible from your workstation.
Refer to the below section on Importing Documents by Browsing for 
additional information.
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You can also drag and drop a file into the Preview pane. For more information, see Importing 
Documents by Dragging and Dropping on page 287.

Importing Documents by Browsing
Browse imports the document from a drive accessible from your workstation.

To import documents by browsing for them:

1. In the Create ribbon group on the Home tab, click Import:

2. The Import layout is opened. In the Import ribbon group, click Browse:

3. The standard Windows Open File dialog box is displayed.
4. Locate the document(s) to import.
5. Select the desired document(s).
6. Click Open.

7. To preview, edit, and index the new imported document(s), see Completing the Import 
Process on page 288.

Acquire scans in the document using a scanner, or imports the document 
image from a scanner, digital camera, or other supported digital storage 
device.
Refer to the below section on Importing Documents by Acquiring for 
additional information.

Drive allows you to access documents stored in your Google Drive account 
and to import them to OnBase.
Refer to the below section on Importing Documents from Google Drive for 
additional information.

Import Description
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Importing Documents by Acquiring

Acquire scans in the document using a scanner, or imports the document image from a 
scanner, digital camera, or other supported digital storage device. To import documents using 
the Acquire option:

1. In the Create ribbon group on the Home tab, click Import:

2. The Import layout is opened. In the Import ribbon group, click Acquire:

Note: If more than one device is connected to your workstation, you are prompted to select an 
imaging device.

If you select a scanner:

1. The device’s scanning interface is displayed.
2. Select the desired scan settings, such as image resolution and page size.

Tip: Depending on your scanning interface, you can receive help by clicking the Help button, or 
clicking the Windows Help button in the upper-right corner and then clicking the setting.

3. Click Scan.
4. Continue to the steps outlined in the Completing the Import Process section to preview, 

edit, and index the newly imported document(s).

Note: Black and white images are stored as Group 4 compressed TIFF images in OnBase. Color 
and grayscale images are stored as JPEG images.

If you select a camera:

1. The Windows Image Acquisition (WIA) Get Pictures interface is displayed.

Note: If the camera is not detected, ensure that the Windows Imaging Service is enabled and 
started. For information on the Windows Imaging Service, consult the Windows help files.

2. Select the images to import.
3. Click Get Pictures.
4. Continue to the steps outlined in the Completing the Import Process section to preview, 

edit, and index the newly imported document(s).
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Importing Documents from Google Drive

Documents created and stored in Google Drive, if a download or export link is available, may be 
imported into OnBase.

Note: Your workstation must be configured to use Google Services. Contact your system 
administrator for additional information.

Note: Google Forms cannot be viewed within OnBase.

Some documents created in Google Drive cannot be imported into OnBase in their native file formats. 
The files are converted into their Microsoft file equivalents before import. The table below outlines the 
file conversion for each Google document type:

Caution: Due to the file conversion process, formatting differences may occur. Similar formatting 
differences can be seen when you download Google documents to your desktop.

To upload documents from Google Drive:

1. In the Create ribbon group on the Home tab, click Import:

2. The Import layout is opened. In the Import ribbon group, click Drive:

Google Application File Converted File Format

Document .docx

Spreadsheet .xlsx

Presentation .pptx

Drawing .png
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3. The Select File dialog is opened. If you have not already logged into your Google account, you 
will be prompted to do so. Click Log in to Google:

Note: If a Google account is already logged in and you would like to switch users, you can click the 
profile icon and select Log out from Google to log the Google account out of OnBase. You will also 
need to log out of Google from your web browser to log out fully. 

4. If you clicked Log in to Google, a Google login page is opened. Enter the Email and Password 
associated with your Google account, then click Sign in.

5. If it is your first time accessing Google Drive through OnBase, you may be asked to confirm 
that the application has permission to view and manage your Google account information. 
Click Accept. 

Note: If Cancel is clicked, permission to the application will be denied. You must close and re-open 
the Google Drive upload dialog to accept the permissions.
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6. After you have signed in to your Google account and accepted the checkout permissions, the 
Select File dialog is populated with a list of documents contained within your Google Drive:

7. Select a document for import by left-clicking the document name:
8. Click OK. The document is featured in the Import layout. 
9. Continue to the steps outlined in the Completing the Import Process section to preview, 

edit, and index the newly imported document(s).

Importing Documents from Third-Party Google Applications
Files created by third-party Google applications may not properly import into OnBase. This is because 
third-party applications do not always provide download or export links and cannot be converted into a 
compatible file format. An error message will be shown if a file created by a third-party Google 
application is unable to be imported into OnBase:

The remote server returned an error: (401) Unauthorized.

As with any document imported from Google Drive, files from third-party applications may be subject 
to formatting errors upon import.
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Importing Documents by Dragging and Dropping

You can import a document, including Microsoft Outlook emails or email attachments, by 
dragging and dropping it onto the Import or Preview panes:

When you drag and drop documents, you can only queue one document for import at a time, 
unless you are licensed for EDM Services.

Note: Files dragged and dropped in this manner will be brought into the Import dialog in the 
order in which they were selected in Windows Explorer. This order is influenced by which file 
you click and hold to drag the group of files. For example, if files 1, 2, 3, 4, and 5 were selected 
in Windows Explorer and you clicked on file 3 to drag them into the Import dialog, the files 
would be organized in the Import dialog as follows: 3, 4, 5, 1, 2.

Note: If you are in the process of importing a document and attempt to drag-and-drop import a 
document with a different file extension, you are prompted that you have not imported your 
original document. Click Yes to remove the original document and import the new document. 
Click No to retain the original document and continue importing it.

Note: When you drag and drop documents, the source program must be the same account type 
as the Unity Client. For example, if the Unity Client is running in administrator mode (accessed 
by right-clicking the executable file and selecting Run as administrator), Microsoft Outlook 
must be running in administrator mode to drag and drop emails or email attachments.

To preview, edit, and index the new imported document(s), see Completing the Import Process 
on page 288.
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Completing the Import Process

When you upload multiple image documents with the same file extension (i.e., .tif images), you 
are prompted to combine these image documents into one document. Click Yes to create and 
import a single multi-page document. Click No to import each document separately using the 
Queued files for import pane.
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When you upload multiple documents with different file extensions, the Queued files for import 
pane displays the names of these documents:

1. The document, or a hyperlink to the document, is displayed in the Preview pane if the 
File Type is compatible with the Preview pane:
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Note: When an OLE document is displayed in the Preview pane, the document can be edited. 
Modifications are saved when the document is uploaded. Modifications are not saved if you 
cancel the upload. Any changes you make in the Preview pane are not saved to the original 
document.

Note: Preview eligibility is dependent on File Type. Preview of other File Types is handled by 
Internet Explorer and installed applications.

If you are importing an image file, a thumbnail viewer is displayed. The following actions 
are available:

Pages Description

Move Up moves the selected page up one position.

Move Down moves the selected page down one position.
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2. From the Document Type Group drop-down list, select the Document Type Group to be 
assigned to the document by OnBase. After selecting a Document Type Group, OnBase 
automatically filters the available Document Types in the Document Type drop-down 
list.

Note: When <All> is selected, Document Types from all Document Type Groups are available 
for selection from the Document Type drop-down list.

3. From the Document Type drop-down list, select the Document Type to be assigned to 
the document by OnBase. After selecting a Document Type, OnBase automatically 
displays fields for Keyword Types that are used to index documents of that type.

Note: If you select a different Document Type during upload, entered Keyword Values are 
cleared. Default values for common Keyword Types are either updated or cleared when 
selecting a different Document Type, depending on whether the selected Document Type has 
default values for those Keyword Types.

Remove removes the selected page.

Remove All removes all pages.

Transforms Description

Rotate Left rotates the document 90 degrees counterclockwise.

Rotate Right rotates the document 90 degrees clockwise.

Pages Description
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4. If OnBase can associate the file extension with a file type (format), that file type is 
automatically selected from the File Type drop-down list. For example, if you import a 
file whose extension is .tif, OnBase will select Image File Format.
If OnBase has not selected the file type, select the appropriate type from the File Type 
drop-down list.

Caution: Contact your system administrator before selecting the Image Rendered PDF file 
type, as selecting this file format without the proper system specifications can cause 
unexpected behavior.

5. Select a Document Date.
6. Type Keyword Values in the Keywords pane, or verify that any Keyword Values in the 

Keywords pane are accurate.
Depending on your system’s configuration, some Keyword Values may be provided by 
default. Other Keyword Types may be configured as read-only, preventing you from 
indexing the document with a value for that Keyword Type. If the Keyword Type name is 
displayed in red, a Keyword Value is required.

Note: Red Keyword text warnings are not available in Unity Briefcase.

You can use the Tab key to move to the next Keyword Value field.

Note: If the primary Keyword you enter is associated with multiple AutoFill Keyword Sets, the 
Select Keyset dialog box will appear when the Tab key is pressed. In the Select Keyset dialog 
box, you can select an available AutoFill Keyword Set to populate the Keywords pane. For more 
information about AutoFill Keyword Sets, please refer to the AutoFill Keyword Sets 
documentation.

Note: When uploading documents of two different Document Types which contain a common 
keyword, if the common keyword has a default value on the Document Type, the default value is 
cleared for the second Document Type. Only keywords modified by the user will be 
remembered.

You can clear Keyword Values by clicking the Clear Keywords button:

Note: Depending on the module, the Keyword Values may be read-only.

7. Expand the Options pane. Depending on your system’s configuration, one or more of the 
following check boxes may be available:
• Open Document After Import - Select to open the document after it is uploaded.

Note: If you are uploading a text rendition of an image document and you select Open 
Document After Import, the image rendition of the document will be displayed in the Document 
Viewer. This is because the image rendition is the original rendition of the document.
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• Delete Files After Import - Select to delete the document from its original location 
after it is uploaded.

• Hide Scanner Settings - Select to hide the scanner settings dialog when ad-hoc 
scanning. You will not be prompted to select a device, unless more than one device is 
connected to your workstation.

8. Click Import to import the image, or click Cancel to cancel the import.
After clicking Import, an indicator displays import progress. When the import is 
complete, a message is displayed near the system tray stating:
Your file has been imported successfully.

If you are using drag-and-drop upload to import multiple documents, repeat steps 1 
through 8 to import remaining documents.
If more information is needed to complete the import, a message displays the 
appropriate instructions.
You may be presented with additional options if you are importing a rendition or revision 
of a document. If you are prompted to import another image, click Yes to import another 
image, or click No to close the WIA interface.

Note: Importing a revision of a document that is of a different file type than the original 
document is not supported in Unity Briefcase.

If you are licensed for EDM Services and are uploading an image document to a 
revisable image document type, you can append the new image document as a page of 
the revisable document. For more information, see the EDM Services documentation.

Note: Before importing the document, OnBase checks its file size against the maximum size 
allowed for imports. If the document is too large, you will be notified that the import failed.

Note: If you receive an Import Failed message, contact your system administrator.
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Multi-Page TIFF Images

If you are using a Windows 7 operating system or later, you can import multi-page TIFF images 
in any compression format.

Note: When attempting to import a multi-page TIFF image with Group IV Fax compression, the 
thumbnails displayed in the Preview window may behave erratically. This is an indication that 
the multi-page TIFF image cannot be imported into OnBase. As a workaround, click Cancel to 
cancel image import. Separate the multi-page TIFF into multiple single-page files using an 
imaging application, or convert the multi-page TIFF to a different file format (e.g., PDF). Repeat 
the above steps to successfully import the file(s) into OnBase.

Appending Pages to an Existing Document

Depending on your configuration, during the import process, you can append a file to an 
existing document in the same Document Type with the same File Type and Keyword Values. 
For Document Types with a default file format of Image File Format, when you import a 
document that contains the same indexing information as another document already residing 
in OnBase, the append pages dialog box is displayed. From this dialog box, you can either 
append the document to an existing document, or you can save the document as a new 
document in OnBase.

Note: Depending on your configuration, the append pages dialog box may also be displayed 
when you attempt to import a document containing the same indexing information as another 
document, and the document type is configured to be revisable. For information about saving a 
document as a revision of an existing document, see the EDM Services documentation.
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To append the document to an existing document:

1. Import a document containing the same indexing information as an existing document 
already residing in OnBase. The append pages dialog box is displayed:

2. Select the existing document from the list of documents.
OnBase 18
©2018 Hyland Software, Inc.

295



Unity Client
Usage
3. The selected document is displayed:

4. The existing document’s Keyword Values are displayed in the Keywords pane.
5. Click one of the following buttons:

Button Description

Append Page(s) Appends the document to the existing document in OnBase.
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Save as New Document Saves the document as a new document in OnBase.

Cancel Cancels the import process. No new pages or documents are 
added.

Button Description
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Printing
This section describes how to print documents using the OnBase Unity Client.

Printing Documents
Print is available from the Document tab ribbon if you have the appropriate user rights.

Note: When printing PDF documents with a paper size other than 8.5 x 11 inches, use the print 
option on the Adobe toolbar.

1.To print a document, perform one of the following actions:
• From a Document Search Results list, select one or more documents, right-click and 

select Print.
• From an open document, click Print on the Document tab.
• From an open image or text document, right-click and select Print.
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2. The Print pane is displayed:

Note: Depending on your configuration, printing an Electronic Form (E-Form) or HTML 
document from the Document Viewer will print the document using Internet Explorer instead of 
OnBase.
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3. In Copies, type or select the number of copies you want to print.

Note: When printing several copies of a multi-page document to XPS or PDF Creator, some 
print jobs may combine.

4. Select one of the available printers from the Print To... drop-down select list.

Note: Click the Printer Properties hyperlink to configure options specific to the selected 
printer. See the documentation for your printer for more information on these options. This 
hyperlink is not available when printing to a print queue. 

5. Select a print format from the Print Format drop-down list. Print formats determine the 
appearance of the selected documents. When you select a print format, its settings are 
used as defaults for subsequently printed documents of the same Document Type. If a 
batch is selected, or your system administrator has not associated a print format with 
the Document Type, the settings is <Default>. To override the print format defaults, 
change the settings in the Print pane.
When printing multiple items with varying document types, select <Use Doc Type 
Default> from the Print Format drop-down list. This selection will allow each document 
to print using the print format configured for each Document Type.

Caution: If using the <Use Doc Type Default> setting, do not use the Printer Properties option. 
A conflict between assigned options may occur and result in unexpected output. If you have 
used the Printer Properties option and have also changed a standard setting (such as 
Orientation) that may conflict with the Document Type default print settings, the <Use Doc 
Type Default> setting overrides any options set in the Printer Properties dialog.

Note: The <Use Doc Type Default> setting is not available for Document Types that have 
Default Print Format set to <None>.

Note: You cannot apply a print format when printing PDF or OLE documents.

6. Select from the following Settings drop-down lists:
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Setting Description

Print Range Print All Pages: Prints all pages of the document(s).
Print Custom Range: Prints a range of pages from the image or text 
document. Type a range of pages in the Pages field. If you type a complex 
range into this field, the pages will be printed in the appropriate order. For 
example, you could enter 5, 1-3, 9. In this case, page 5 of the document would 
be printed first, followed by pages 1, 2, 3, and 9.

Note: When printing multiple documents, the Print Custom Range setting is 
only available if the first document selected supports printing a range of pages. 
It is not available when the first document selected does not support printing a 
range of pages, or when printing documents that do not support page range 
selection.

Note: Printing complex custom ranges is not supported when printing to a 
network printer.

Print Current Page: Prints the current page of the document. 

Note: The Print Current Page setting is not available when printing a document 
from a document Search Results list. 

Note: The Print Current Page setting is not available when printing HTML 
documents, XML documents, E-Forms, Unity Forms, multiple documents, or 
when printing documents that do not support page range selection.

Note: This setting is not supported when printing PDF documents.

Orientation Portrait Orientation: Prints the top of the page on the shortest side of the 
paper.
Landscape Orientation: Prints the top of the page on the longest side of the 
paper.
Auto Orientation: Prints the page according to its dimensions. For example, if 
the height of the page is greater than the width, Portrait Orientation will be 
used. If the width of the page is greater than the height, Landscape 
Orientation will be used.

Note: This setting is not supported when printing PDF or OLE documents.

Note: This setting is not respected when printing XML documents. XML 
documents are printed using the default orientation setting of the printer.
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Print Overlay No Overlay: Prints the document without the associated overlay.
Print Overlay: Prints the document with the associated overlay. The overlay 
that is printed may be different than the overlay that is displayed, depending on 
the configuration of the Document Type.
Fax Compatible Overlay: Select this option if you are printing to a fax 
machine. OnBase arranges the overlay image in a way that faxing software can 
properly interpret. The overlay that is faxed may be different than the overlay 
that is displayed or printed, depending on the configuration of the Document 
Type.

Note: This setting is not supported when printing PDF or OLE documents.

Color Options Grayscale: Prints the document in black and white.
Color: Prints the document in color, if a color printer is available.

Note: Depending on your installed print drivers, these options may not be 
respected with certain printers.

Note Options Note Icon/Annotation on Document: Prints the note icon/annotation 
(graphical representation of a note) on the document.

Note: This setting is not supported when printing PDF or OLE documents.

Note Text on Document: Prints the note text on the document. This setting is 
not respected by Overlapped Text annotations.

Note: This setting is not supported when printing PDF or OLE documents.

Note Text After Document: Prints the text of the document notes in the 
specified page range on a separate page.

Note: Depending on your system’s configuration, some note icons or text may 
not be printed no matter what Notes Options you have selected. See your 
system administrator if you have questions.

Print Revision These options are only available if your database is licensed for EDM Services. 
For more information, see the EDM Services module reference guide.

Image Scaling Best Fit Scaling: Prints image to fit, with scaling as necessary.
One to One Scaling: Prints image actual size/scale (1:1 in terms of inches).

Note: This setting is not supported when printing PDF or OLE documents.

Setting Description
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7. Click Print.

Note: When printing multiple documents, the documents are printed in the order in which you 
selected them.

File Format not Supported for Printing
If you see the following error message upon trying to print one or more documents from a 
Document Search Results list, the File Format is not supported for printing, or the page range is 
not valid. See your system administrator for additional information regarding file formats.

The following documents were not printed:

Note: Printing .MSG and .EML file type documents from the Document Search Results list is 
not supported. These documents must be opened in and printed from their native application.

Job Settings Single Job: If multiple documents are highlighted, Single Job instructs the 
system to combine the selected documents into a single Windows print job, 
rather than printing each separately. 
Continuous Flow: If multiple documents are selected and are formatted for a 
multi-image layout on the page, the Continuous Flow option instructs the 
system to continue filling the page with images from the next document, filling 
the existing multi-page format before proceeding to the next page.
Example of Continuous Flow: If you select three two-page documents for 
printing and choose a print format configured to print two rows and two 
columns, your output would be three pages, each of which is a single 
document. If you select Continuous Flow, your output would be two pages, the 
first page having two documents and the second page having the third 
document.

Set As Default When selected, this option will use the selected settings as the default print 
settings. The settings will remain selected by default on the workstation for all 
document types until this option is deselected. If a setting is changed or Set as 
Default is deselected, the settings will remain selected until the user changes 
them, prints, or closes the Print pane.

Note: This setting is not respected by the selections made for the following 
settings: Print To... when a print queue is selected, Print Format, Print 
Overlay, and Print Range.

Setting Description
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Reports

Creating List Reports

Note: To create list reports, a user must have the Create List Report privilege.

Note: List reports cannot be generated from Full Text Search result lists.

List reports are text documents that can contain the date the report was created; the time the 
report was created; the user who created the report; the configured Auto-Names of documents 
selected within a Document Search Results list, a batch queue, or a Workflow life cycle; the 
total number of documents; and the total time spend processing the report. These reports are 
stored in the SYS List Contents Report Document Type.

An example of a list report is shown below.

The header at the top of the report displays who created the report and when. Below the header 
is the report summary (if one was entered when the report was created), followed by the Auto-
Name strings of the reported documents. The end of the report lists the total number of 
documents in the report and the total processing time.
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Document Search Results Lists and Batch Queues
To create a List Content Report for document(s) in a Documents Search Results list or a batch 
queue:

1. Right-click on selected document(s) and select Create List Report.
2. Choose options in the List Report Options dialog box.

Option Description

All Items This option generates information about all documents in the list.

Note: Although the Document Search Results list is limited to 
display 65,535 documents, the report will contain information for 
all documents that meet search criteria, even if the number of 
documents is greater than 65,535.

Selected Items This option generates information about the selected item(s) only.

Generated Page Headers This option generates the following header on the first line of every 
page of the report: LSTRPT055PAGE: page #

Generate Summary Info This option generates the Total Documents and Total 
Processing Time at the end of the report.

Report Summary This option allows you to add up to 80 characters of text to the 
report.
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3. Click OK. The List Contents Report will display containing a report on the selected 
criteria. The header of the report contains the Date, Time and the User Name of the 
creator of the report. When you create a List Contents Report from a Document Search 
Results list, it also contains a Search Results Title that identifies the Document Type or 
Document Type Group used to create the list.
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Introduction
This chapter details information necessary to perform administrative activities in the OnBase 
Unity Client.

The following areas are covered in this chapter:
• Managing Locks on page 308
• User Administration on page 311
• User Option Policy Administration on page 322
• Personal Page Tile Group Administration on page 346
• Troubleshooting Layout on page 358
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Managing Locks
OnBase allows you to manage document, Disk Group, or process locks using the Manage Locks 
dialog box:

To open the Manage Locks dialog box, click the Unity Client File menu. Then, select 
Administration | Manage Locks.

The Manage Locks dialog box contains the Locks and Checkouts tabs.

Each row on the Locks tab contains the following information:

Column Description

User Displays the name of the user that placed the lock.

Note: Depending on your system configuration, the real name of the user may be 
displayed.

Date Locked Displays the date and time that the lock was created.

Type Displays one of the following types of locks:
• Document - A document lock. 
• Disk Group - A Disk Group lock. 
• Process - A process lock. 
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To remove a lock, select a row and click Remove Selected. To refresh the list, click Refresh.

Note: Depending on your configuration, you may or may not be able to see and manage the 
locks associated with other users.

For information on the Checkouts tabs, see the EDM Services documentation.

Document Locks
When working in OnBase, you may see a message saying that the document you want to view 
or retrieve has a "lock" on it. There are several types of these locks, including:

• Locks caused by the system not closing properly in a previous session.
• Locks caused when trying to modify a document or its Keyword Values if the 

document is currently in use by another user or by you from a previous session. 
See Keyword Locking on page 310 for more information.

If OnBase closes unexpectedly while a document is being modified, the next time OnBase is 
launched, the following dialog box will prompt you to view or remove any currently open locks 
assigned to you:

Clicking Yes will open the Manage Locks dialog box. Clicking No will close the dialog box and 
continue to open OnBase. The Manage Locks dialog can be accessed at a later time.

Details Displays additional information about the lock.
• For document locks, the document’s Auto-Name string is displayed.
• For Disk Group locks, the name of the Disk Group is displayed.
• For process, the type of process is displayed.

Column Description
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Any user can view a “locked” document, but only the first user can modify it. When the first user 
is finished viewing or modifying a document, the document is “unlocked” automatically.

Caution: Removing locks when a document is currently being accessed by a user may cause 
document changes to be lost. Locks should only be removed if the user’s session is closed and 
the lock remains.

Note: Image documents are locked if opened by a user with the Save Rotation User Group 
privilege. 

Keyword Locking
To preserve data integrity, OnBase protects against situations where multiple users can change 
a document’s Keyword Values at the same time. A document is rendered as read-only for 
additional users viewing the document if:

• The initial user accesses a document’s Keyword Values from the Add/Modify 
Keywords pane.

• The initial user accesses a document’s Keyword Values from the Re-Index pane.
• The initial user opens the document in any viewer.

When a user accesses a document’s Keyword Values from the Add/Modify Keywords or Re-
Index panes, OnBase locks the values so that only the user who accessed them first can modify 
them. If any other users attempt to access the document’s Keyword Values, the Keyword 
Values will be read-only, and the users will be unable to modify them. When the first user closes 
the document, the lock is released, and other users can modify the document’s Keyword 
Values.

Documents are also locked when opened. For example, Keyword Values are locked when a user 
opens an E-Form. Because Keyword Values can be edited on the E-Form itself, the lock is 
created when a user opens the E-Form.

Disk Group Locks
A Disk Group lock can occur in OnBase when modifying Disk Group configuration in the OnBase 
Configuration module.

Process Locks
A process lock occurs if a process is configured for printing, indexing, committing, purging, 
platter management, re-indexing, caching, or document management. The process lock is 
removed when the process is finished.
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If OnBase closes unexpectedly while a Workflow process is occurring, the next time OnBase is 
launched, the following dialog box will prompt you to view or remove any abandoned Workflow 
process locks assigned to you:

Clicking Yes will open the Manage Locks dialog box. Clicking No will close the dialog box and 
continue to open OnBase. The Manage Locks dialog can be accessed at a later time.

If the completed process did not remove a lock, you can manually remove it using the Manage 
Locks dialog box.

Before removing the lock, ensure the user is not using the process.

User Administration
Users with administrative rights can perform user administration from the Users layout. For 
rights required to access this context, see the following topic, Required Administrative Rights 
on page 311.

Required Administrative Rights
To open the Users layout, you must have one of the following:

• User Account Admin configuration right
• User Update Admin configuration right
• Password Admin configuration right

Each of these rights provides access to different options in the Users layout, as shown in the 
following table:

User Account Admin User Update Admin Password Admin

Lock Account
Unlock Account
Reset Password
Security Keywords
Delete User
Create User

Lock Account
Unlock Account
Reset Password
Security Keywords

Unlock Account
Reset Password
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Additionally, the Usergroup security configuration right is required to enable the User Groups 
button in the Users layout.

For more information about these rights, see the OnBase Configuration help.

User Administration Overview
If you have rights to user administration activities, then you can access the Users layout. 

To access the Users layout, click the Unity Client’s Application button. Then, select 
Administration | User Administration.

The Users layout is displayed:

The Users layout includes the following:

The Users layout includes the Users tab. The buttons that are available on this tab depend on 
your user rights. For more information on this tab, see Users Tab on page 313.

Column Description

ID The number assigned to the OnBase user.

Name The OnBase user name.

Real Name The OnBase user’s real name.

Email The OnBase user’s email address.

Last Logon The date when the user last logged in to OnBase.

Institution The user’s institution.

Note: This column is only available when using an institutional database.

Disabled Shows whether the user is disabled. Yes indicates that the user is disabled. No 
indicates that the user is not disabled.
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Users Tab

The Users tab allows you to manage OnBase users.

Actions Description

Refresh Users refreshes the list of users in the Users layout.

Create User allows you to create and configure a new user.
See Creating Users on page 314 for more information.

Edit User allows you to add or modify the user’s Real Name or Email Address.

Note: You can also double-click a user to modify the user’s Real Name or Email 
Address.

See Editing Users on page 316 for more information.

Reset Password allows you to reset the password for the selected user.
See Resetting User Passwords on page 316 for more information.

Lock Account allows you to lock a user account.
See Locking and Unlocking Users on page 317 for more information.

Unlock Account allows you to unlock a user that was locked.
See Locking and Unlocking Users on page 317 for more information.
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Creating Users
As a user administrator, you can create a new OnBase user at any time, provided you can 
supply the user name and password to log the new user in. You can provide additional 
information about the user at the time of creation, or at any time thereafter.

1. Ensure you are in the Users layout.
2. Click Create User.

Delete User allows you to delete a user.
See Deleting Users on page 318 for more information.

Security Description

User Groups allows you to configure the User Group assignment for the selected 
user.
See Changing User Group Assignments on page 318 for more information.

Security Keywords allows you to configure Security Keywords for the selected 
user.
See Assigning Security Keywords to Users on page 320 for more information.

Actions Description
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3. The following dialog box is displayed:

4. In the User Name field, type the user name that the new user will log on to OnBase with.
5. In the Real Name field, type the real name of the new user (or any other text string you 

want to use for identification).
6. (Optional) In the Email Address field, type the user’s email address.
7. In the Password field, type the password for the user name.
8. Type the same password in the Verify Password field.
9. If you are using an institutional database, select an institution from the Institution drop-

down list.
10. Click OK. The user is created.

The new user will automatically be selected in the Users list.

Note: If OnBase is unable to create the new user, it will display a dialog box with an error 
message explaining the reason for failure (e.g., the User Password does not satisfy the 
password requirements of your OnBase solution). You can resolve the problem by editing the 
field and then clicking OK again.
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Editing Users
Users can be edited by a user administrator. To change a user’s Real Name or Email Address:

1. Click the Edit User button.

Note: You can also double-click a user to modify the user’s Real Name or Email Address.

2. Modify the user’s Real Name and/or Email Address in the Edit User dialog box.

3. Click OK to save your changes and to close the Edit User dialog box. Click Cancel to 
close the Edit User dialog box without saving your changes.

Resetting User Passwords
You can change, or reset, the login password for a user at any time.

1. Ensure you are in the Users layout.
2. Click Reset Password.
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3. The following dialog box is displayed:

4. Type a new password in the New Password field.
5. Type the same password in the Verify Password field.
6. Select Require Password Change on Next Login to require a password change the next 

time the user logs in.
7. Click OK.
8. The user's password is changed. A confirmation message is displayed near the bottom 

of the screen.
 

Locking and Unlocking Users
When a user account is locked, the account cannot be accessed. In other words, no one can 
use that account to log in to the system. User accounts may be locked automatically by the 
system for a variety of reasons; a common reason is that the user repeatedly attempts to log in 
with the wrong password.

You can lock or unlock the account of any user for whom you have administrative 
responsibilities.

To lock a user account:

1. Ensure you are in the Users layout.
2. Select a user.
3. Click Lock Account.
4. The system locks the selected account.

To unlock a user account:

1. Ensure you are in the Users layout.
2. Select a user.
3. Click Unlock Account.
4. The system unlocks the selected account.
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Deleting Users
You can delete existing users from the OnBase at any time. Once deleted, a user can no longer 
log on to OnBase.

To delete a user:

1. Ensure you are in the Users layout.
2. Select a user.
3. Click Delete User.
4. You are prompted to confirm that you want to delete the selected user. Click Yes to 

delete the user. Click No to retain the user.
5. OnBase deletes the user and displays a confirmation message near the bottom of the 

screen.

Changing User Group Assignments
User Groups are configured by the system administrator and users are typically assigned to 
User Groups in the Configuration module. With the appropriate rights, you can also assign 
users to User Groups.

1. Ensure you are in the Users layout.
2. Select a user.
3. Click User Groups.
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4. The following screen is displayed:

The Available User Groups list displays the User Group(s) to which the user does not 
belong. The Selected User Groups list displays the User Group(s) to which the user 
belongs.

5. To add a user to a group:
• Double-click the group name in the Available User Groups list; or
• Select the group name in the Available User Groups list and click Add Selected 

Items.

• Click Add All Items to add all user groups to the Selected User Groups list.
 

6. To remove a user from a group:
• Double-click the group name in the Selected User Groups list
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• Select the group name in the Selected User Groups list and click Remove Selected 
Items.

• Click Remove All Items to remove all user groups from the Selected User Groups 
list.

7. When you are finished changing User Group assignments, click OK. The system makes 
the specified changes, and displays a confirmation message near the bottom of the 
screen.

Assigning Security Keywords to Users
Normally, the ability to retrieve documents is determined by the Document Types that a user's 
user group is granted retrieval rights to. In other words, a user can retrieve all documents 
whose Document Types can be retrieved by any user group that the user belongs to.

You can use Security Keywords to define specific limitations on an individual's document 
retrieval rights. Security Keywords restrict retrieval by Keywords. For example, an employee 
could be restricted to retrieving documents from the Human Resources department. 
Furthermore, that same clerk could be prevented from retrieving documents related to the 
Accounting department.

When you assign a Security Keyword, you must specify whether the document Keyword Value is 
to be Equal or Not Equal to the Security Keyword Value.

• Equal means that the user can retrieve only documents with the specified Keyword 
Value.

• Not Equal means that the user can retrieve all documents except those with the 
specified Keyword Value.

Note: Security Keywords do not enable a user to retrieve documents that the user does not 
have user rights to retrieve. For example, if the user does not have retrieval rights to Human 
Resources documents, then that user cannot retrieve those documents no matter what Security 
Keywords are assigned.

Your system administrator determines which Keyword Types can be used for Security 
Keywords, and may also establish other validation rules.

Once you have created Security Keywords for a user, you can add new ones or delete existing 
ones at any time.

To assign Security Keywords:

1. Ensure you are in the Users layout.
2. Select a user.
3. Click Security Keywords.
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4. The following window is displayed:

5. From the Keyword Types drop-down list, select the Keyword Type to be used for 
security.

6. In Condition, select one of the following:
• Equal enables the user to retrieve documents whose Keywords match the specified 

value.
• Not Equal prevents the user from retrieving documents whose Keywords match the 

specified value.
7. In Keyword Value, select one of the following:

• Static Value - Select to enter an unchanging value for this Security Keyword.
• Username - Select to configure this Security Keyword to restrict documents for each 

user based on that user’s personal user name. Username is only available if the 
selected Keyword Type is alphanumeric.

8. If you selected Static Value, type the Keyword Value in the Keyword Value field.

Note: The Keyword Value is limited to the allowable values for the Keyword Type previously 
configured in the Keyword Type Settings dialog box.

If you selected Username, the Keyword Value field is automatically populated with << 
USERNAME >>.

9. Click Add. OnBase displays the added value in the Security Keywords list.
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10. For each additional Security Keyword to be assigned to the current user, repeat steps 5-
9.
The following example illustrates what OnBase displays after several Security Keywords 
have been added for a user:

To delete a Security Keyword, click the X to the left of the Security Keyword.
11. When you finish assigning Security Keywords to this user, click OK. The system saves 

the Security Keyword assignments and displays a confirmation message near the 
bottom of the screen.
The Security Keywords will be in effect the next time the user logs into the system.

User Option Policy Administration

Note: The User Management product right and the Usergroup Security configuration right are 
needed to view the User Option Policy Administration layout. To assign a User Option Policy to 
a User Group, the User Group Configuration right is needed. For additional information, see the 
System Administration module reference guide.
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User Option Policies allow an Administrator to set and enforce User Options for designated 
User Groups. The User Options that can be set include the User Options accessed by clicking 
User Options in the File menu, the users’ Home Layout, and the Thumbnail Settings found in 
the Document Separation layout. User Option settings are applicable only in the Unity Client.

Note: For more information on User Options, see User Options on page 46. For more 
information on Document Separation, see Separating Image and PDF Documents on page 181.

User Options can be enforced, which means that they cannot be changed by users. Or, they 
may be non-enforced, which means that they can be changed by users.

If a user has already adjusted a User Option for themselves, the User Option Policy overrides 
that setting.

Changes made to a User Option Policy take effect upon user login.

Note: If an Administrator is part of a User Group that has a User Option enforced by a User 
Option Policy, the User Option in question will not be enforced for the Administrator when 
working within the User Option Policy layout. This is to ensure that an Administrator who 
configures User Option Policies and is also part of a User Option Policy is not locked out of the 
modification of User Option Policies.

Example of a User Option Policy: A company makes use of the Notes feature within OnBase. 
Important information concerning hiring decisions is often conveyed within notes placed on 
resume documents. It is crucial that all members of the HR User Group view all notes placed on 
documents or they may miss information concerning a potential employee. So, to ensure that 
all members of the HR User Group are shown notes immediately upon opening a document, the 
Hide Notes User Option can be enforced to be set as false for the HR User Group. Users within 
this User Group will be unable to select the option to hide notes themselves in the User Options 
dialog since it is enforced by the policy.
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The User Option Policy Administration layout is accessed by clicking Administration | User 
Option Policy Administration in the File Menu.

In the above diagram, the area labeled A is the ribbon menu. The area labeled B is the list of 
configured User Option Policies, which are organized alphabetically. The area labeled C is the 
User Option Policy Summary, which displays the General Settings, configured User Options, 
and assigned User Groups for the selected User Option Policy.

Adding a User Option Policy
To create a new User Option Policy:

1. In the File menu, click Administration | User Option Policy Administration:

2. The User Option Policy Administration layout is opened:
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3. In the New ribbon menu group, click Create Policy:

4. The General Settings dialog is opened:

Enter a Name for the policy in the Name field. The name must be unique from existing 
User Option Policy names.
Enter a Description for the policy, if desired.

5. Click Continue.
OnBase 18
©2018 Hyland Software, Inc.

325



Unity Client
Client Administration
6. The User Options dialog is displayed:

Select a User Options category from the Categories drop-down select list. Options 
include:
• General Options 
• Document Import 
• Retrieval Date Options 
• Document 
• Revision Control 
• Workflow 
• Printing 
• WorkView 
• Document Separation 
• Signatures 
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• Imaging
• Plan Review Viewer

Note: For more information on these categories, refer to User Options on page 46.

7. After a category has been selected, the available settings for each category will be 
listed below the Category drop-down:

These settings can be reordered by clicking the Name or Configure column headings.
Click the Configure button next to the setting you would like to configure:
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8. The Edit User Option [Setting Name] dialog is displayed:

Configure the setting as necessary.
If Enforce User Option is selected, that User Option setting will not be changeable by 
users. If Enforce User Option is not selected, user will be able to adjust that setting.
Enter a Description, if desired.

9. Configure additional User Options as necessary. Complete steps 6-8 as needed for each 
option.
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10. When you are finished configuring User Options, click Continue. The Assign User 
Groups to Policy dialog is displayed:

11. Move a User Group from the Available User Groups column to the Assigned User 
Groups column to assign a User Group to the policy. User Groups can be moved from 
one column to another by double-clicking them or by using the arrow control buttons.
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12. When you are finished assigning User Groups to the policy, click Continue. The Set 
Priority dialog is displayed:

The name of the policy is featured in bold above the list of existing policies. Click and 
drag the new policy to a spot in the priority order list. The placement of the policy 
determines which user option takes precedence when applied to a user. This feature 
helps determine which User Option Policy is applied when a user is assigned to more 
than one User Option Policy with conflicting options configured.
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13.  Once the new policy has been placed in the list, you can reorder the policies using the 
Up and Down arrows on the left:

In the above example, HR New Employees takes precedence before HR Policies. HR 
Policies takes precedence above Guest Users.

14. Click Finish when you are done adjusting the policy.
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15. The new User Option Policies is added to the User Options Policies list:

Viewing the Resultant Set of User Options
After User Group Policies have been created, you can review the settings for each User Group 
by viewing the Resultant Set. The Resultant Set dialog allows you to view which options are 
configured for each User Group. To view the Resultant Set:

1. In the File menu, click Administration | User Option Policy Administration:

2. The User Option Policy Administration layout is opened. Click the View Resultant Set 
button in the Resultant Set ribbon group:
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3. The Resultant Set dialog is displayed:

When no User Groups are selected, the settings displayed are the default User Options 
and their values.
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4. From the User Groups column, select the User Group(s) for which you would like to see 
the Resultant Set:
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5. When the required User Groups have been selected, click Refresh. The Resultant Set 
column will display the User Options selected and the values for each User Group:

Values with a green checkmark next to them have been set in a User Option Policy.
Values with a lock icon next to them have been set as Enforced in a User Option Policy.

6. Hover over a green checkmark to see which User Option Policy set the value:

7. When you are finished viewing the Resultant Set, close the Resultant Set dialog.
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Changing a User Option Policy
User Option Policies can be updated after their creation. Certain aspects of changing the User 
Option Policy require different methods of editing. This section covers:

• Changing the Name and Description of a User Option Policy on page 336
• Changing the Configured User Options of a User Option Policy on page 338
• Changing the Assigned User Group of a User Option Policy on page 342
• Changing the Priority of a User Option Policy on page 343

Changing the Name and Description of a User Option Policy
To change the name or description of a User Option Policy:

1. In the File menu, click Administration | User Option Policy Administration:

2. The User Option Policy Administration layout is displayed.
In the User Options Policies list, select the User Option Policy you would like to change 
the name and/or description of:
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3. In the User Option Policy Summary area of the layout, click Edit in the General Settings 
section:

Or, you may click the General Settings button in the Edit ribbon group:
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4. The General Settings edit dialog is displayed:

Change the Name and Description as needed.
5. Click Finish to apply your changes and to close the General Settings dialog.

Changing the Configured User Options of a User Option Policy
To change, add, or remove the User Option settings of a previously configured User Option 
Policy:

1. In the File menu, click Administration | User Option Policy Administration:
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2. The User Option Policy Administration layout is opened.
In the User Options Policies list, select the User Option Policy you would like to change 
the configured User Options of:

3. In the User Option Policy Summary area of the layout, click Edit in the User Options 
section:

Or, you may click the User Options button in the Edit ribbon group:
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4. The User Options edit dialog is displayed:

Select a User Options category from the Categories drop-down select list.
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5. After a category has been selected, all of the available settings for each category will be 
listed below the Category drop-down select list:

If the option displays a check mark in the Configure column, settings for that option 
have been previously configured. 
Click Configure to edit the settings for any option. 
Click the red X next to the Configure button on previously configured options to remove 
the option configuration from the policy. 

6. Click Finish to apply your changes and to close the General Settings dialog.
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Changing the Assigned User Group of a User Option Policy
To change the assigned User Group of a User Option Policy:

1. In the File menu, click Administration | User Option Policy Administration:

2. The User Option Policy Administration layout is displayed.
In the User Options Policies list, select the User Option Policy you would like to change 
the assigned User Group for:

3. In the User Option Policy Summary area of the layout, click Edit in the User Groups 
section: 

Or, you may click the User Groups button in the Edit ribbon group:
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4. The Assign User Groups To Policy edit dialog is displayed:

Move a User Group from the Available User Groups column to the Assigned User 
Groups column to assign a User Group to the policy. User Groups can be moved from 
one column to another by double-clicking them or by using the arrow control buttons.

5. Click Finish to apply your changes and to close the Assign User Groups To Policy 
dialog.

Changing the Priority of a User Option Policy
To change the priority of a User Option Policy:

1. In the File menu, click Administration | User Option Policy Administration:
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2. The User Option Policy Administration layout is displayed.
In the User Options Policies list, select the User Option Policy you would like to change 
the priority of:

3. Click the Priority button in the Edit ribbon group:
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4. The Set Priority edit dialog is displayed:

Re-order the User Option Policies as needed.
5. Click Finish to apply your changes and to close the Set Priority dialog.
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Deleting a User Option Policy
To delete a User Option Policy:

1. Select an existing User Option Policy from the User Option Policies list:

2. In the Delete ribbon group, click User Option Policy:

3. You are asked: Are you sure you want to delete the selected User Option Policy? Click 
Yes to delete the policy and to remove it from the User Option Policy Administration 
layout.

Personal Page Tile Group Administration

Note: The Templates for Personal Pages privilege and Usergroup Security configuration right 
are needed to create and configure templates for Personal Pages and to share them with other 
User Groups. The Personal Page Configuration privilege is needed to add and edit tiles on the 
Personal Page. For additional information, see the System Administration Module Reference 
Guide.

Users with Administrative rights can distribute required and recommended tiles to specified 
User Groups. Tiles intended for distribution are contained within Tile Groups. These Tile Groups 
can be viewed and updated from your Personal Page. The following sections cover creating 
and editing Tile Groups, adding tiles to Tile Groups, and designating User Groups to each Tile 
Group.
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Creating a Tile Group
To create a named Tile Group to distribute to users:

1. In the File menu, click Administration | Tile Group Administration.
2. The Tile Group Administration layout is opened. Click Add New in the Tile Group 

Administration ribbon menu:

3. The Create Tile Group dialog is displayed:

Enter the desired Tile Group name into the name field.

Note: Tile Group names cannot exceed 255 characters and must be unique.

4. Click OK to create the new Tile Group and to close the Create Tile Group dialog box.

Renaming a Tile Group
Tile Groups created in the Unity Client can be renamed at a later time. To rename a Tile Group:

1. In the File menu, click Administration | Tile Group Administration.
2. The Tile Group Administration layout is opened. Select an existing Tile Group from the 

Tile Groups list:
.
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3. In the ribbon menu, click Edit Tile Group Name:
 

4. The Rename Tile Group dialog box opens. Change the value in the name field:

Note: Tile Group names cannot exceed 255 characters and must be unique.

5. Click OK. The Tile Groups list will refresh and display the new name.

Deleting a Tile Group
Tile Groups created in Tile Group Administration can be deleted. Deleted Tile Groups will be 
removed from all Personal Pages associated with the Tile Group. To delete a Tile Group:

1. In the File menu, click Administration | Tile Group Administration.
2. The Tile Group Administration layout is opened. Select an existing Tile Group from the 

Tile Groups list:

3. In the ribbon menu, click Delete: 
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4. When asked, “Are you sure you want to delete the tile group ’[Tile Group Name]’ and all 
associated tiles?” click Yes:

5. The Tile Group is removed from the Tile Groups list.

Assigning a Tile Group to a User Group
In order for Tile Groups to be pushed out to users, a User Group must be associated with the 
Tile Group. To assign a User Group:

1. In the File menu, click Administration | Tile Group Administration.
2. The Tile Group Administration layout is opened. Select an existing Tile Group from the 

Tile Groups list:

3. In the ribbon menu, click Edit User Groups:
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4. In the Assign User Groups dialog box, assign the appropriate User Group(s) and move 
them from the Available User Groups column to the Assigned User Groups column:

 User Groups in the Assigned User Groups column will be presented with the Tile Group 
on their Personal Page.

5. Select Required if you would like the Tile Group to be read-only for the User Group:

 Users will not be able to delete or change the contents of the Tile Group if this is 
selected. If you do not select Required, users will be able to delete and edit the Tiles 
contained within the Tile Group.

Note: If a user is part of two User Groups and the Tile Group is assigned as Required for one of 
the User Groups, and not Required for the other, the Tile Group will be presented as not 
Required to the user. These tiles will be shown in the My Tiles section of their Personal Page.

6. Click OK to save your changes and to close the Assign User Groups dialog.
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Adding Tiles to Tile Groups
Many items within OnBase that can be used on the Personal Page can also be added to a Tile 
Group. The following can be added to a Tile Group:

• OnBase Layouts
• Documents
• Folders
• Custom Queries
• Custom Query Results
• Document Knowledge Transfer Reading Groups
• Document Tracking folders and folder lists
• E-Forms/Unity Forms
• Full Text Search (Full-Text Indexing Server for Autonomy IDOL)
• Workflow document queues 
• Workflow Combined Inboxes
• Internal Mailbox (with a list of unread messages)
• Individual Document Templates
• WorkView Applications
• Import Tiles with specified Document Types
• Dashboards and Dashboard items

Note: Non-document Workflow queues cannot be added to Tile Groups.

A tile can belong to more than one Tile Group. Tiles will be added automatically to users’ 
Personal Pages.

Note: Tiles added to non-required Tile Groups are displayed in the My Tiles group on a user’s 
Personal Page. Only required Tile Groups are automatically displayed.

If you attempt to add an item to a Tile Group before any Tile Groups have been created, you will 
be prompted to create a new Tile Group. Refer to Creating a Tile Group on page 347.

The sections below cover adding documents, folders, and individual items, folders, layouts, and 
Custom Query results to Tile Groups.

Adding Documents, Folders, and Individual Items to Tile 
Groups
Generally, individual items can be added to Tile Groups by right-clicking the item you wish to 
add and selecting the Send To | Tile Groups option or, if the item is open, by clicking the Send 
To button in the ribbon menu and clicking Tile Groups. After you have selected this option, you 
will be prompted to select the appropriate Tile Group(s) in the Tile Group selection list.
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Adding a Layout to Tile Groups
To add a Layout to Tile Groups:

1. With the layout you wish to add to the Tile Group displayed, navigate to the Home tab 
and click the bottom part of the Personal Page button located in the Favorites group.

2. Click Add this layout to Tile Groups:

 

3. The Add To Tile Groups dialog is displayed:

Select the appropriate Tile Group(s).
4. Click OK to add the layout to the Tile Group(s) and to close the Add to Tile Groups 

dialog.

Adding Custom Query Results to Tile Groups
To add a Custom Query results tile to Tile Groups:

1. Click the drop-down button on the Custom Query tab:
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2. Click Add to Tile Groups:

3. The Description dialog is displayed. Enter a description for the Custom Query:

4. Click OK when a description has been entered.
5. The Add To Tile Groups dialog is displayed:

Select the appropriate Tile Group(s).
6. Click OK to add the Custom Query results to the Tile Group(s) and to close the Add to 

Tile Groups dialog.
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Adding Import Tiles with Specified Document Types to Tile 
Groups
To add an Import layout tile with a Document Type to Tile Groups:

1. In the Create ribbon group, click the Import button.

2. The Import layout is displayed. Select a Document Type in the Import pane.

3. After a Document Type has been selected, navigate to the Home tab.
4. From the Favorite ribbon group, click the bottom portion of the Personal Page button.

5. Select Add this layout to Tile Groups.
6. The Add To Tile Groups dialog is displayed:

Select the appropriate Tile Group(s).
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7. Click OK to add the Import tile to the Tile Group(s) and to close the Add to Tile Groups 
dialog.

8. The tile is added to the Tile Group(s). The name of the tile reflects the Document Type 
specified.

Note: To add an Import tile without a specified Document Type, add the layout to your Personal 
Page before selecting a Document Type.

Managing and Configuring Tiles in Tile Groups
Tiles that have been added to a Tile Group can be configured and managed to suit your needs. 
To configure a tile:

1. Click the Configure button on the tile you want to configure:

2. The General Options dialog box is displayed. The following configurable options are 
available:

When you are finished configuring the tile, click Save to save your changes. Click 
Cancel to cancel.

The following sections describe additional options that can be configured for some tiles in Tile 
Groups:

• Custom Query Results Tiles on page 356

Option Tab Option Description

General Title Modify the title that is displayed on the tile.

Description Modify the description that is displayed on the tile.

Color Modify the color of the tile displayed on the Personal 
Page.
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Custom Query Results Tiles
The following additional items can be configured on the Custom Query Results tile 
configuration screen:

Removing Tiles from a Tile Group
Tiles previously added to a Tile Group can be removed. Tiles will be removed from user’s 
Personal Pages when the users next navigate to their Personal Page. The tile will be deleted as 
long as it is not an altered suggested tile. Altered suggested tiles cannot be deleted by an 
administrator - only required and unaltered suggested tiles may be deleted. 

To remove a tile from a Tile Group:

1. In the File menu, click Administration | Tile Group Administration.
2. The Tile Group Administration layout is opened. Select an existing Tile Group from the 

Tile Groups list:
.

3. Right-click on the tile you want to delete from the Tile Group.

Option Tab Description

Custom Query This screen allows you to modify the form field values that are used when 
returning the Custom Query result displayed on the tile. You can add, modify, 
or remove search terms.

Note: You can include additional instances of a Keyword Type, or use 
Wildcard or Boolean operators to narrow the search.

When you are finished modifying form field values, click Search to run the 
Custom Query and validate the results. Click OK to confirm the results and 
return to the Tile Group Administration layout.
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4. Select Delete Tile from the right-click menu:

5. When asked if you are sure you would like to remove this tile, click Yes:

 Click No to cancel and keep the tile in the Tile Group.
6. The tile is removed from the Tile Group.
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Troubleshooting Layout

Note: The Troubleshooting layout is intended for use by your first line of support or users 
trained to interpret various troubleshooting messages.

The Troubleshooting layout is accessible from within the File menu. To access this layout, 
click the Application icon and select Troubleshooting:

This layout shows Troubleshooting Messages, Connection Information, Message Sources, 
Rendering Information, Performance Counters, Client Side Locks, Memory Usage, and SQLCE 
Information. You can also create Bug Reports from this layout.

Troubleshooting Messages
The main pane within the Troubleshooting layout is the Troubleshooting Messages pane. This 
pane displays the Timestamp, Type, and Message for each entry.

To export the contents of the Troubleshooting Messages pane, click Save to File.

Exporting the messages to file is useful when communicating with support. The resulting file, 
which is a Log file (.log), is saved to your workstation for later use.

To clear the contents of the pane, click Clear Log.

Note: The Troubleshooting Messages log is limited to 20 MB.

Creating Bug Reports
Bug Reports can be created from the Troubleshooting layout. Bug Reports generate zipped 
files that include documents containing relevant Messages, Exceptions, Logging Service 
information, the Timestamp of the creation time and date of the Bug Report, and, if selected, a 
screenshot. The file can be provided to a system administrator or solution provider when 
registering your issue.

Note: Bug Reports are not a substitute for a formal reporting mechanism within your 
organization.
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To create a Bug Report:

1. Right-click within the Troubleshooting Messages pane and select Create Bug Report.
2. The Create Bug Report dialog is opened.
3. Enter your name and email into the Name and Email fields.
4. Select Include Screenshot if you would like to add a screenshot of the active layout to 

your report.
5. In the field at the bottom of the dialog, include a detailed description of the bug you 

encountered.
6. Click Save To Desktop. The Bug Report file will be found on your workstation Desktop. 

Send this file to your OnBase system administrator.

Using the Request Profile Diagram
The Request Profile Diagram layout is used for monitoring latency in Service Requests. 
Requests that fail, timeout, or return an exception are visible in this layout.

Note: In order to see Service Request timing results, the Application Server must have service-
profile diagnostics enabled.

To access the Request Profile Diagram layout, click the Application icon and select 
Troubleshooting | Request Profile Diagram:

Press Record to begin profiling actions performed:

A live graph of requests made to the server is available in this view.

The information collected in this layout can be saved as an .URP file by clicking Save. These 
saved files can be opened again at a later time by clicking Open and selecting the previously 
saved .URP file.

Note: Saved .URP files can only be opened in the same version of OnBase in which they were 
created.

Note: Only data can be exported to file. The graph itself cannot be saved.
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Tracer Requests, which can be sent by clicking Send Tracer, may help diagnose environmental 
issues.

The information displayed in the Request Profile Diagram can be cleared by clicking Clear.
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Custom Query Configuration
The following sections describe Custom Query configuration settings that can be used with the 
Unity Client. For further information on Custom Query configuration, see the System 
Administration documentation.

Grouping Columns

Custom Queries that have been configured with display columns can be configured to 
automatically group results by a display column.

Note: Custom Written SQL Custom Queries cannot be configured for column grouping.

To configure Custom Query column grouping:

1. Select a Custom Query in the OnBase Configuration module’s Custom Query dialog box.
2. Click Group Columns. The Query Results Group Columns dialog box is displayed:

3. Double-click a column in the Available Columns list, or select it and click Add. The 
selected column is displayed in the Selected Columns list.

4. Repeat the previous step to add additional columns.
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5. Order the columns in the Selected Columns list by selecting them and using the Move 
Up and Move Down buttons.

6. Click Save.

Filtering Columns
Custom Queries that have been configured with display columns can be configured to allow a 
user to filter the Custom Query results set by criteria in various display columns.

Note: Custom Written SQL Custom Queries cannot be configured for column filtering.

To configure Custom Query column filtering:

1. Select a Custom Query in the OnBase Configuration module’s Custom Query dialog box.
2. Click Filter Columns.
3. The Query Results Filter Columns dialog box is displayed:

4. Double-click a column in the Available Columns list, or select it and click Add.
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5. The Filter Type Configuration dialog box is displayed:

6. Select one of the following Filter Types:

7. Click Save.
8. The selected column is displayed in the Selected Columns list.
9. Repeat steps 4 and 8 to add additional columns.

Filter Type Description

Instance This filter is displayed as a list of values with the number of instances of that 
value.

Tip: Use an instance filter for any data which has a narrow range of discrete 
values, such as a Keyword Data Set.

Note: Instance filters are only available for alphanumeric Keyword Type Data 
Types, as well as the Document Name, Author, Document Type, Workflow 
Queue, Note Contents, and Note Type columns.

Text This filter is displayed as a text box.

Note: Text filters are available for all Keyword Type Data Types and columns.

Pinch This filter is displayed as a slider, with two thumbs beneath a sparkline.

Tip: Use a pinch filter for values with a moderate to large range, or when the 
user is unsure of specific range boundaries. Pinch filters should not be used for 
high precision or a small range of values.

Note: Pinch filters are only available for non-alphanumeric Keyword Type Data 
Types, as well as the Document Date, Date Stored, Document Handle, Author ID, 
Arrival Time, and Note Count columns.
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10. Order the filters in the Selected Columns list by selecting them and using the Move Up 
and Move Down buttons.

Note: The order in which filters appear in the Selected Columns list is the order in which they 
will appear in the Unity Client’s Custom Queries pane.

11. Click Save.

Document Retrieval
The following sections describe additional Document Retrieval configuration settings that can 
be used with the Unity Client.

Document Retrieval Threshold
The appSettings node in the Application Server’s Web.config file contains the following 
settings which can be used to adjust the number of document results returned when retrieving 
a document, conducting a Custom Query, or opening a Workflow queue.

DocumentQueryWarningThreshold
This Unity Client setting controls the threshold of document results at which a warning is 
displayed to a user. For example, if this value is set to 500, a warning will be displayed to the 
user when their document retrieval search or custom query will return 500 or more results.

DocumentQueryLimit
This Unity Client setting controls the maximum number of document results which are returned 
when retrieving documents or conducting a Custom Query. The maximum value allowed is 
10000.The Workflow queue inbox returns the results respecting the setting; however, a warning 
is displayed to the user.

Note: Folders and cross-references do not respect this threshold limit.
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Configuring Google Services
To use Google Drive when importing and checking out documents and/or to use Gmail as your 
external mail client, you must first configure the functionality. The following sections outline 
how to enable and configure Google Services.

Note: To use Google Services, a Google account with access to Gmail and Google Drive is 
required.

Note: If Google Services is configured, documents will, by default, be displayed in the Google 
viewer.

Creating a Google API Project in the Google Developers 
Console

The following must be completed in the Google Developers Console (https://
console.developers.google.com/project) before configuration can occur:

• Create a new Project
• Acquire a Project ID
• Enable the Drive API and the Google+ API
• Create a Client ID with the following settings: Installed Application, with Other listed 

as the Installed Application Type
• Acquire a Client Secret
• Customize a Consent Screen

For additional information on completing these requirements, refer to Google’s documentation.
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Enabling Google Services
To use Google Services in the Unity Client, an integration must be created from within the 
Configuration module.

To enable Google functionality:

1. In the Configuration module, navigate to Utils | Web Integration Settings. The Web 
Integration Settings dialog box is displayed.
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2. Click Create to configure a new integration. A dialog box is displayed, containing 
settings for the integration.

3. Select Unity Client (Mail Sending, Check In/Out, Import) from the Integration Type 
drop-down select list.

4. Select Google from the Service Type options. The Client ID and Client Secret fields are 
made available, and the Authentication Type is set to OAuth.

5. In the Client ID field, enter the Client ID created in the Google Developers Console.
6. In the Client Secret field, enter the Client Secret acquired from the Google Developers 

Console.
7. Click Save to create the integration.

Configuring Gmail
To configure Gmail as the external mail client for the Unity Client, the Unity Client configuration 
file (obunity.exe.config) must be edited. Refer to appSettings on page 372 for information on 
how to configure this option.
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Microsoft Office Web Application Server Integration

The OnBase Web Application Open Platform Interface (WOPI) Server integrates with the 
Microsoft Office Online Server and provides users with integrated access to OpenDocument 
and Microsoft Office documents within OnBase using the WOPI viewer. 

The WOPI Server is a communication layer between the separately installed and configured 
Microsoft Office Online Server and the OnBase Application Server. It seamlessly displays Word, 
Excel, and PowerPoint documents to end users within the familiar OnBase client interfaces.

For information about WOPI Server installation and configuration, see the System 
Administration module reference guide.

The Unity Client Configuration File
The Unity Client configuration file (obunity.exe.config) is an XML file used to configure the 
Unity Client and control its behavior and feature sets. The file contains plain text and resides in 
the same directory as the Unity Client executable (obunity.exe). To change features, edit the 
appropriate value, and save and close the file.

Note: When using Unicode characters in the Unity Client Configuration File (such as in 
DataSource names), ensure you are saving the file with Unicode encoding (e.g. UTF-8).

AD FS Configuration
For information on how to configure the Unity Client for AD FS, see the Authentication module 
reference guide.

Hyland.Canvas.Client
The ServiceMode attribute is available in the Hyland.Canvas.Client element in the Unity Client 
configuration file.

This element controls whether the Unity Client runs in Service Mode or Interactive Mode.

When enabled is set to true, the Unity Client runs in Service Mode. This means that:
• Closing the Unity Client with the X in the top right corner minimizes it to the system 

tray, where it continues to run. The embedded document viewer is closed and you are 
prompted to save any changes.

• The Log Out button is not available from the Unity Client File menu. The ability to log 
out of OnBase is available by right-clicking the Unity Client system tray icon.

• When allowExit is true, the Exit OnBase option is available from the system tray. 
When allowExit is false, the Exit OnBase option is not available from the system tray.
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• When autoLaunch is true, the Unity Client will launch in Service Mode when Windows 
starts.
When autoLaunch is false, the Unity Client will not launch in Service Mode when 
Windows starts.

• The sendSessionID attribute is treated as false for Pop-Based Application Enabler 
contexts that use this attribute.

• The following features are available:

When enabled is set to true and the -deferredlogin command line switch is applied:
• After the Unity Client starts, users are not prompted to log on. The Unity Client is 

minimized to the Windows system tray. Double-clicking the shortcut a second time 
will open the Client login.

Feature Name Description

Unity Client When enabled is set to true, the Launch Unity Client option is 
available from the system tray. Double-clicking the system tray icon 
will launch the Unity Client.
When enabled is set to false, the Launch Unity Client option is not 
available from the system tray. Double-clicking the system tray icon 
will launch the Application Enabler toolbar if the ApplicationEnabler 
feature is enabled.

Application Enabler When enabled is set to true, the Application Enabler module can be 
used.
When enabled is set to false, the Application Enabler module cannot 
be used.

Unity Client Automation 
API

When enabled is set to true, the Unity Client Automation API, which is 
used by third-party applications to automate the Unity Client, can be 
used.
When enabled is set to false, the Unity Client Automation API cannot 
be used.

Virtual Print Driver When enabled is set to true, the Virtual Print Driver module can be 
used.
When enabled is set to false, the Virtual Print Driver module cannot 
be used.

Unity Pop Whether Unity Pop is enabled.
When enabled is set to true, Unity Pop is enabled.
When enabled is set to false, Unity Pop is not enabled.

Note: To specify what type of Unity Pop item is sent (Unity Pop link 
or Unity Pop file), refer to the emailLinkAs setting in appSettings on 
page 372.
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• Users are required to log on to the Unity Client when performing the first Unity Client 
context with Application Enabler. Triggering subsequent contexts does not require 
users to log on to the Unity Client.

• Users are not required to log on to the Unity Client when performing OnBase Client, 
Web Client, and Pop-Based Application Enabler contexts.
For more information about the -deferredlogin command line switch, refer to the 
Application Enabler module reference guide.

When enabled is set to false, the Unity Client runs in Interactive Mode. This means that:
• The Unity Client cannot be minimized to a system tray icon.
• If Application Enabler is not licensed, any context event scraping is in Demo Mode.

Trusted Certificates
In order to help increase the security of the system, the AllowAllSSLCertificates setting is set 
to False by default. This ensures that if the certificate used for an HTTPS connection cannot be 
verified, then the connection is refused and users cannot log on to the Unity Client. To help 
maintain a higher level of security, it is recommended that the AllowAllSSLCertificates setting 
is set to False.

ServiceLocations
Service Locations are pre-configured items that contain web service connection information. 
They can be added and modified in the Unity Client configuration file.

Note: Within the Unity Client, Unicode characters are only supported in data source names and 
FriendlyName contexts if the Unity Client configuration file is saved with Unicode encoding.

Setting Name Description

ServicePath The URL to the Service.asmx page of the Application Server.
For example, http://[Application Server]/appserver/service.asmx.

Note: The Service Path URL must end in .asmx. The Unity Client 
cannot be configured to use remoting as the transport protocol. 

DataSource The data source name (configured at the Application Server) to 
connect to.
For example, OnBase.

FriendlyName The "friendly name" of the service location. This name is displayed in 
the Unity Client’s title bar.
For example, OnBase.

UseNTAuthentication When set to true, the Unity Client is configured to use Active Directory 
or LDAP Authentication.
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To configure multiple Service Locations for your OnBase solution, add an additional Service 
Location prior to the </ServiceLocations> tag in the Unity Client configuration file. For example, 
<add ServicePath="http://[name of server]/appserver/Service.asmx" DataSource="OnBase" 
FriendlyName="OnBase" UseNTAuthentication="false" DefaultDomain="" UseADFS="false" 
IdpUrl="" IdpSilent="false"/>.

Note: The Unity Client will automatically log in if there is only one entry in the ServiceLocations 
element in the Unity Client configuration file, the UseNTAuthentication attribute is set to true, 
and the Core Services option in the Directory Service Authentication dialog box in the OnBase 
Configuration module is not selected. For more information about the UseNTAuthentication 
attribute and the Core Services option, see the Authentication module reference guide. 

DefaultDomain The name of the domain to use by default.
For example, mydomain.com.

Note: The value of DefaultDomain is not case sensitive.

Note: If no value is specified for DefaultDomain, the current 
domain of the user logging in is used as the default domain.

UseADFS When set to true, the Unity Client is configured to use ADFS 
Authentication. 
Additional steps must be taken to configure ADFS Authentication in 
the Unity Client. For more information, see the Authentication 
module reference guide.

Note: If UseADFS is set to true, UseNTAuthentication must be set 
to false.

IdpUrl The URL to the IDP server to be used for authentication.

IdpSilent A true or false value indicating if the user should be prompted with a 
web browser showing the IDP Path.

Setting Name Description
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appSettings
The following settings are available in the appSettings section of the Unity Client configuration 
file:

Setting Name Description

mailclient The email client that will be used to email documents from the Unity 
Client.
When set to outlook, Microsoft Outlook will be used.
When set to lotus, Lotus Notes will be used.
When set to gmail, Google Gmail will be used.
When set to groupwise, Novell GroupWise will be used.

Note: When sending messages with Novell GroupWise, Plain Text is 
the only format available.

Note: When Microsoft Outlook and Novell GroupWise are installed 
on the same machine, using GroupWise as the Default Mail Client for 
the Unity Client may result in unexpected behavior and is not 
supported.
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emailLinkAs Whether Send To | Mail Recipient (as Link) is enabled, and how 
links to documents will be sent. Possible settings are: disabled, 
docpop, upop-file, and upop.
When set to disabled, Send To | Mail Recipient (as Link) is not 
available.
When set to docpop, DocPop links will be sent via Send To | Mail 
Recipient (as Link).

Note: To send DocPop links, the Create Integration Hyperlink 
privilege is needed. 

When set to upop-file, Unity Pop files will be sent via Send To | Mail 
Recipient (as link).

Note: To view Unity Pop files, the Unity Client must be running in 
Service mode. Within the ServiceMode element, enabled must be 
set to true. Unity Pop must also be enabled within the ServiceMode 
section of the Unity Client configuration file.

When set to upop, Unity Pop URI links will be sent via Send To | Mail 
Recipient (as link).

Note: To view Unity Pop URI links, the Unity Client must be running in 
Service mode. Within the ServiceMode element, enabled must be 
set to true. Unity Pop must be also enabled within the ServiceMode 
section of the Unity Client configuration file.

Note: To send Unity Pop links, the Create Integration Hyperlink 
privilege is needed. 

docpopurl The DocPop link used when emailing DocPop links from the Unity 
Client.
Replace [servername]/[virtualdirectory] with the web server name 
and virtual directory.

MaxConcurrentAutoVue
Controls

This value specifies the maximum number of concurrent instances 
allowed for AutoVue controls. The default value is 3. This setting 
only applies to modules which utilize AutoVue controls.

Note: Increasing this value may decrease the performance of your 
system.

Setting Name Description
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Hyland.Canvas
The following settings are available in the Hyland.Canvas section of the Unity Client 
configuration file.

DisplayLanguage

The interface is displayed in the Windows default operating system language.
To display the interface in a language different from the default operating system language, type the 
language code, such as de-DE for German or fr-FR for French. For more information on language 
codes, see http://msdn.microsoft.com/en-us/library/ms533052(VS.85).aspx.

Note: This setting is commented out by default. This means that this setting cannot be used until 
you remove the <!-- preceding <DisplayLanguage> and the --> following </DisplayLanguage>.

Note: Personal Page tile names are displayed in the language that the Unity Client interface was in 
at the time the tile was created. The OnBase database collation must support the writing script of 
tile names.

PlanReviewEngineeringV
iewer

This setting is used with the Electronic Plan Review module.

Caution: This setting should not be modified unless you have been 
directed to do so by your solution provider.

Note: An Electronic Plan Review license is required to use Electronic 
Plan Review in the Unity Client, for more information, see the 
Electronic Plan Review Module Reference Guide or help file.

scanlog This setting enables scan logging when set to true. The default value 
is false.

Note: The scanlog setting is only respected when the 
enableModernScanning setting is set to true. For more 
information, see the Document Imaging module reference guide.

The log file can be opened from the %LOCALAPPDATA%\Hyland 
Software, Inc\Hyland.Canvas.Controls\scanlog directory for up to 
three days after closing the Unity Client after scanning. Log files 
older than three days will be deleted automatically.

Setting Name Description
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When the <DisplayLanguage> tag is active, the language specified will display as the default 
language for the interface, regardless of the workstation’s Windows language settings. This also 
applies to ClickOnce deployments.
The language specified during the creation of the ClickOnce deployment in the ClickOnce installer 
will be forced on all deployments of the application.
To override the display language which was configured initially, you can modify the configuration 
file for each individual user’s workstation. The configuration file is located in the application 
directory inside of the ClickOnce application cache (e.g., C:\Users\[user 
name]\AppData\Local\Apps).

Note: Each time you update or create a new ClickOnce deployment instance, these settings must be 
manually reconfigured.

Culture

The interface displays dates, time, currency, and numeric values using the default Windows locale 
settings configured in Regional and Language Options.
To override the default Windows locale in the interface, set the Culture to an ISO code such as de-
CH for German (Switzerland).

Note: This setting is commented out by default. This means that this setting cannot be used until 
you remove the <!-- preceding <Culture> and the --> following </Culture>.

Note: The <DisplayLanguage> and <Culture> settings are not required to match, except when 
<DisplayLanguage> is configured as Arabic (Saudi Arabia). When <DisplayLanguage> is 
configured as ar-SA, <Culture> must also be configured as ar-SA. However, when <Culture> is 
configured as ar-SA, the <DisplayLanguage> is not required to be ar-SA.

Application
The IsPersistentLogonEnabled attribute controls persistent logon. It can be configured 
manually, or through the Enable Persistent Logon check box in a Unity Client ClickOnce 
deployment.

When set to true, users can use persistent logon. The Remember me on this computer check 
box is displayed in the log on dialog box. When this check box is selected, the Unity Client 
stores the user’s credentials and uses them to automatically log on to OnBase during future 
sessions. Credentials are stored until the user manually logs off of OnBase using the File 
menu’s Log Out button.

Note: If multiple Service Locations are configured, the Remember me on this computer check 
box will not be displayed even if the IsPersistentLogonEnabled attribute is set to true. This 
check box will only be displayed when one Service Location is configured for use with the Unity 
Client.
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When set to false, persistent logon is not available.

Note: Credentials are not remembered when upgrading a Unity Client installation.

DefaultHomeLayout
The web sites and RSS or Atom feeds displayed in the Unity Client’s Home layout.

Web sites are included in the <Websites> node, and are defined in the following format:

<Website Name="[name of web site]" Url="[web site URL]"/>

Note: The Name attribute is optional. The Url attribute is required. When the Name attribute is 
not specified, the URL is used as the web site’s name.

RSS or Atom feeds are included in the <Feeds> node, and are defined in the following format:

<Feed Url="[RSS or Atom feed URL/>

When configuring the DefaultHomeLayout setting, ensure that you aware of the following:
• Users are still able to configure web sites and RSS or Atom feeds through the Unity 

Client interface.
• If you completely remove the DefaultHomeLayout setting from the Unity Client 

configuration file, the default OnBase web sites and feed are used.
• If you modify the DefaultHomeLayout setting after using the Unity Client, you are 

required to delete the IsolatedStorage on the workstation before modifications are 
displayed in the Unity Client interface.

UserGroupTimeoutMode
The UserGroupTimeoutMode attribute controls how OnBase determines if a user is active.

If set to Request, timeout is detected through lack of requests to the Application Server.

If set to Windows, timeout is detected through lack of user interaction with any application 
within a Windows session.

Note: This attribute is set to Request by default.

Note: This setting is only checked when User Group Timeout is configured. For more 
information, refer to the System Administration documentation.
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Hyland.Canvas.Automation.Services
The following setting is available in the Hyland.Canvas.Automation.Services section of the 
Unity Client configuration file:

Application Enabler

For Application Enabler to function, settings in the Unity Client’s configuration file must be 
configured. These settings can be configured manually. Some can also be configured during 
the Unity Client’s ClickOnce installation process.

Setting Name Description

VPDMailslot When enabled is set to true, the Virtual Print Driver can be used with 
the Unity Client.
When deleteAfterUpload is set to true, the Delete Files After 
Import option is automatically selected in the Import pane. When set 
to false, the Delete Files After Import option is not selected.
Users are able to select or clear the Delete Files After Import option 
regardless of this setting’s configuration.

Note: For more information on using the Unity Client with the Virtual 
Print Driver, see the Virtual Print Driver documentation.
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The following attributes in the <ApplicationEnabler> tag are related to the Application Enabler 
module.

Attribute Corresponding 
ClickOnce Option

Description

EnableHandlingUnityClientEvents Unity Features - 
Application 
Enabler

When set to true, the Unity 
Client can receive scrape 
events from Application 
Enabler.
When set to false, the Unity 
Client cannot receive scrape 
events from Application 
Enabler.

Note: You must manually 
add this attribute to the 
<ApplicationEnabler> tag. 
When this attribute is not 
present, it is treated as true.
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DefaultConfigFile Default 
Configuration 
File

To automatically load a 
saved configuration when 
the Unity Client is opened, 
specify the full path to the 
file. The path to the 
configuration file can be a 
local path, UNC path, URL 
(HTTP or HTTPS), or a URN.
When a default 
configuration is specified, 
the configured screen is 
enabled on startup. To start 
Application Enabler, click 
AppEnabler.

Note: When a URL is 
specified for a file, the file is 
downloaded to a temporary 
directory from its specified 
location and the temporary 
file is opened. Any time the 
configuration file on the 
server is modified, you must 
restart IIS or reset the cache 
of the OnBase Application 
Server for changes to take 
effect.

Note: To specify a custom 
temporary directory, create 
environment variable 
ONBASETEMP in the 
Windows Environment 
Variables configuration 
window, and enter the 
desired path in the Variable 
value field.

Attribute Corresponding 
ClickOnce Option

Description
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UsePersistentWindowForRetrieval When set to true, the 
Application Enabler - 
Retrieve Documents context 
uses the same window each 
time it is triggered. The 
window’s size and position 
are also retained.
When set to false, the 
Application Enabler - 
Retrieve Documents context 
uses a new window each 
time it is triggered. The 
window’s size and position 
are not retained.

UsePersistentWindowForCustomQuery When set to true, the 
Application Enabler - Run 
Custom Query context uses 
the same window each time 
it is triggered. The window’s 
size and position are also 
retained.
When set to false, the 
Application Enabler - Run 
Custom Query context uses 
a new window each time it 
is triggered. The window’s 
size and position are not 
retained.

UsePersistentWindowForEformCreation When set to true, the 
Application Enabler - Create 
New E-Form context uses 
the same window each time 
it is triggered. The window’s 
size and position are also 
retained.
When set to false, the 
Application Enabler - Create 
New E-Form context uses a 
new window each time it is 
triggered. The window’s size 
and position are not 
retained.

Attribute Corresponding 
ClickOnce Option

Description
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UsePersistentWindowForFolderRetrieval When set to true, the 
Application Enabler - 
Retrieve Folders context 
uses the same window each 
time it is triggered. The 
window’s size and position 
are also retained.
When set to false, the 
Application Enabler - 
Retrieve Folders context 
uses a new window each 
time it is triggered. The 
window’s size and position 
are not retained.

UsePersistentWindowForWorkflowRetrieval When set to true, the 
Application Enabler - 
Retrieve in Workflow 
context uses the same 
window each time it is 
triggered. The window’s size 
and position are also 
retained.
When set to false, the 
Application Enabler - 
Retrieve in Workflow 
context uses a new window 
each time it is triggered. The 
window’s size and position 
are not retained.

Note: In order for this 
attribute to work correctly 
with Workflow Retrieval, you 
must enable Allow multiple 
instances of the Workflow 
layout in the Unity Client’s 
Workflow User Options.

Attribute Corresponding 
ClickOnce Option

Description
OnBase 18
©2018 Hyland Software, Inc.

381



Unity Client
Configuration
Note: Persistent windows are shared among all contexts. For example, the Application Enabler 
- Retrieve Documents and Application Enabler - Run Custom Query contexts are configured to 
use the same Unity Client window each time they are triggered. If you trigger the Application 
Enabler - Retrieve Documents context and then trigger the Application Enabler - Run Custom 
Query context, the Application Enabler - Run Custom Query context will use the same window 
that the Application Enabler - Retrieve Documents context previously used.

Caution: Using the Reset Cache option in OnBase Configuration or the Reset Server Cache 
option in OnBase Studio may have a negative impact on system performance. Requests to the 
Application Server will be forced to wait until the cache is rebuilt before they can be processed. 
Depending on the size of the OnBase system, as well as the current server load, the 
performance impact of resetting the cache may be severe.

To avoid performance issues, only reset the cache of the Application Server during off-peak 
hours. For more information about the Reset Cache option in OnBase Configuration, see the 
System Administration documentation. For more information about the Reset Server Cache 
option in OnBase Studio, see the Studio documentation.

HTTPS Automation
HTTPS Automation allows Application Enabler to expose an HTTPS endpoint to allow third-
party applications to perform Application Enabler context events.

If HTTPS Automation is selected during installation, the location of the HTTPS certificate to be 
used must be specified in the obunity.exe.config file.

To specify the location of the HTTPS certificate:

1. Open the obunity.exe.config file.
2. In the Hyland.Canvas.Automation.Services node, locate <HttpsAutomation 

enabled="false" port="15425" certificateLocation="" />.
3. Set enabled to "true".
4. Change the port setting, if required.
5. Set certificateLocation to the file path of the HTTPS certificate.
6. Save and close obunity.exe.config.

Workflow

The Unity Client configuration file’s enableWorkflowDebugTrace setting controls whether the 
Debug Options ribbon group is displayed on the Developer tab. When set to true, the Debug 
Options ribbon group is displayed. When set to false, the Debug Options ribbon group is not 
displayed.
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Configuring Unity Pop
Unity Pop is used to send links or shortcuts to content within OnBase to another user via 
external mail. There are two types of Unity Pops: Unity Pop files and Unity Pop links.

Unity Pop files are XML files that reference content in OnBase. Unity Pop files are the legacy 
method of creating Unity Pops.

Unity Pop links are URI links to content in OnBase. Unity Pop links are the recommended 
method of sending Unity Pops. Unity Pop links do not require a physical file and, therefore, do 
not take up disk space as a Unity Pop file would. Additionally, links can be easily shared by 
copying and pasting them into websites, documents, etc. 

Caution: Do not switch to Unity Pop links if existing Unity Pop files are still in use by your 
organization.

To those sending and receiving Unity Pop files and links, the differences between the two types 
of Unity Pops will not be apparent. Both methods are sent through the Send To | Mail Recipient 
(As Link) menu option and, when opened, the Unity Client is launched to display the content in 
the appropriate layout.

Note: A Concurrent Client license is consumed while viewing Unity Pop files and links.

The configuration of Unity Pop files and Unity Pop links differ. The sections below outline the 
configuration of each Unity Pop method.

Configuring Unity Pop Links
 To configure Unity Pop links:

• Ensure that the user(s) have the Create Integration Hyperlink privilege. This can be 
set in the Configuration module. For more information on this privilege, refer to the 
System Administration Module Reference Guide

• Enable Service Mode. In the Unity Client configuration file (obunity.exe.config), find 
the Hyland.Canvas.Client section. There, you will find the ServiceMode element. 
Ensure that the element reads: ServiceMode enabled="true"

• Enable Unity Pop. Within the ServiceMode element of the Unity Client configuration 
file, find the Unity Pop feature. Ensure that the setting reads: <Feature name="Unity 
Pop" enabled="true"/>
For more information on enabling Service Mode refer to Hyland.Canvas.Client on 
page 1.

• Set the emailLinkAs setting to "upop." Within the appSettings section of the Unity 
Client configuration file, find the emailLinkAs setting. Ensure that the setting reads: 
<add key="emailLinkAs" value="upop"/>
For more information on the emailLinkAs setting, refer to appSettings on page 372.
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Configuring Unity Pop Files
Unity Pop files are the legacy method of creating Unity Pops. If you used Unity Pop in a version 
of OnBase prior to OnBase 14, you used Unity Pop files. The old method of configuring Unity 
Pop files (setting the emailLinkAs setting to "upop" in the Unity Client configuration file) is now 
part of the method to configure Unity Pop links, so care should be taken to ensure you are 
configuring the desired method of Unity Pop.

To configure Unity Pop files:
• Enable Service Mode. In the Unity Client configuration file (obunity.exe.config), find 

the Hyland.Canvas.Client section. There, you will find the ServiceMode element. 
Ensure that the element reads: ServiceMode enabled="true"

• Enable Unity Pop. Within the ServiceMode element of the Unity Client configuration 
file, find the Unity Pop feature. Ensure that the setting reads: <Feature name="Unity 
Pop" enabled="true"/>
For more information on enabling Service Mode refer to Hyland.Canvas.Client on 
page 1.

• Set the emailLinkAs setting to "upop-file." Within the appSettings section of the 
Unity Client configuration file, find the emailLinkAs setting. Ensure that the setting 
reads: <add key="emailLinkAs" value="upop-file"/>
For more information on the emailLinkAs setting, refer to appSettings on page 372.
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Unity Client Supported Operating Systems

• Windows Server 2008 R2 SP1 or later service pack
• Windows 7 SP1 or later service pack
• Windows 8.1
• Windows Server 2012 R2
• Windows 10 (1607 Anniversary Update, 1703 Creators Update, or 1709 Fall Creators 

Update)
• Windows Server 2016

Note: As of OnBase 16, the Windows Vista, Windows 8, Windows Server 2008, and Windows 
Server 2012 operating systems are no longer supported. If you are using any of these operating 
systems, you should not upgrade to OnBase 18 until you have upgraded to a Windows 
operating system supported by OnBase. For a complete list of operating systems that are no 
longer supported, see the Technical Requirements Overview for New Installations and 
Upgrades document.

Unity Client Hardware Requirements

Component Minimum Recommended

CPU 1.6 GHz dual-core 2.4 GHz dual-core

Memory (RAM) 2 GB 4 GB

Free Hard Disk Space (for 
installing and running the 
Unity Client)

650 MB

Screen Resolution 1024 x 768 (1280 x 800)

Note: Using a lower 
resolution may result in a 
loss of functionality.

1280 x 1024 (1440 x 900 
widescreen)
Base 18
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Note: The OnBase System Assessment Tool can be used to ensure that your workstation 
meets the minimum system requirements for the 18 OnBase Unity Client. For more information 
on this tool, see System Assessment Tool on page 465.

HTTPS Automation Requirements
If you are installing Application Enabler and you want to expose an HTTPS endpoint to allow 
third-party applications to perform Application Enabler context events, additional requirements 
must be met.

The following requirements must be configured prior to enabling HTTPS Automation:
• A domain that will resolve to localhost.
• An HTTPS binding public/private key pair for the domain, in .PFX format, that must 

be trusted by all client workstations.
• The password for the private key must be OnBase.
• The key pair must be stored somewhere accessible to all clients using HTTPS 

Automation (for example, distributed to every workstation or stored in a network 
share accessible via UNC).

If you need a URL and certificate to use with an HTTPS binding, contact your first line of 
support.

Microsoft .NET Framework Requirements

OnBase requires Microsoft .NET Framework 4.6 or later. The .NET Framework can be obtained 
from the Microsoft Download Center at http://www.microsoft.com/downloads.

The version of the .NET Framework required by the module being installed must be installed on 
both the deployment and client machines before installation.

Graphics Card 128 MB 256 MB with hardware 
acceleration support

Email Platform Lotus Notes 8.5.x
IBM Notes 9.0.x
Microsoft Outlook 2010, 
2013, or 2016
Novell GroupWise 2012 or 
2014

Media Player Windows Media Player 10

Component Minimum Recommended
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Microsoft Visual C++ Requirements

The Web Server and both the 32-bit and 64-bit versions of the Application Server require the 
Microsoft Visual C++ Redistributable Packages listed below. If not already present on your 
server, these packages are installed when the setup.exe installer is used to install the OnBase 
Web or Application Servers.

Note: If the Web Server and Application Server are not installed on the same computer as the 
module(s) with which they are connecting, you must ensure that the following packages are 
also installed on the modules’ workstations.

The 32-bit Application Server requires the following:
• Microsoft Visual C++ 2010 Redistributable Package (x86)
• Microsoft Visual C++ 2015 Redistributable Package (x86)

The Web Server and the 64-bit Application Server require the following:
• Microsoft Visual C++ 2010 Redistributable Package (x86)
• Microsoft Visual C++ 2010 Redistributable Package (x64)
• Microsoft Visual C++ 2015 Redistributable Package (x64)

If you are using the Application Server in conjunction with the Unity Client, you must also 
ensure that the following are installed on the Unity Client’s workstation:

• Microsoft Visual C++ 2005 Redistributable Package (x86)
• Microsoft Visual C++ 2010 Redistributable Package (x86)
• Microsoft Visual C++ 2013 Redistributable Package (x86)
• Microsoft Visual C++ 2015 Redistributable Package (x86)

Databases Supported
The following sections list the databases supported in OnBase 18.

Microsoft SQL Server

The following versions of Microsoft SQL Server™ are supported:
• Microsoft SQL Server 2008 (RTM, SP1, SP2, SP3, or SP4)
• Microsoft SQL Server 2008 R2 (RTM, SP1, SP2, or SP3)
• Microsoft SQL Server 2012 (RTM, SP1, SP2, SP3, or SP4)
• Microsoft SQL Server 2014 (RTM, SP1, or SP2)
• Microsoft SQL Server 2016 (RTM or SP1)
• Microsoft SQL Server 2017 (for Windows or Linux)
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When using Microsoft SQL Server databases, also note the following:
• Microsoft SQL Server 2008 and Microsoft SQL Server 2008 R2 are being deprecated 

for eventual removal from the OnBase product suite. SQL Server 2008 and 2008 R2 
are supported in OnBase 18; however, they will not be available in OnBase 19 and 
subsequent versions of OnBase. If you are currently using either Microsoft SQL 
Server 2008 or Microsoft SQL Server 2008 R2, Hyland Software recommends using 
Microsoft SQL Server 2012 or later to fulfill your needs.

• In April 2016, Microsoft discontinued technical support for Microsoft SQL Server 
2005. As of release 17, Hyland Software no longer supports SQL Server 2005.

• If you are using an ODBC data source to connect to the database, you must ensure 
that your SQL Server database client software version matches or exceeds the 
database server version. For example, if your database server is SQL Server 2012, 
verify that the database client is SQL Server 2012 (or later). Running a previous client 
version, such as SQL Server 2008, will result in system instability and memory issues. 
For instructions on determining your server and client versions, see Database Client / 
Server Version Compatibility.

Oracle

The following versions of Oracle® are supported:
• Oracle 11g (R2)
• Oracle 12c (R1 or R2)

Note: All Oracle 11g and 12c drivers can be used.

Note: If you are using an Oracle database, it is strongly recommended that you have a certified 
Oracle Database Administrator on staff.

SAP SQL Anywhere

Support for SAP SQL Anywhere™ databases is being deprecated for eventual removal from the 
OnBase product suite. Beginning in OnBase 18, new customers are required to use a supported 
version of a Microsoft SQL Server or Oracle database. However, the following versions of SAP 
SQL Anywhere are still supported for existing customers:

• SAP SQL Anywhere 16
• SAP SQL Anywhere 17

Beginning in OnBase 19, SAP SQL Anywhere databases will no longer be supported.

Note: On December 31, 2016, SAP retired engineering support for SQL Anywhere versions 12.x 
and lower. As of OnBase 17, Hyland Software no longer supports SQL Anywhere versions 12.x 
and lower.
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Database/File Servers

Server requirements are site-specific. Database/file servers should be dedicated purpose 
servers; that is, these servers should not be used as a domain controller, email server, print 
server, or proxy server. Network and disk I/O hardware should be optimized for performance 
and redundancy. Multiple network interface cards on servers are often required to minimize 
network bottlenecks.

Hyland Software - Microsoft Service Pack Statement
The developers of OnBase are dedicated to ensuring the monthly cumulative updates released 
by Microsoft® are compatible with OnBase. On the second Tuesday of each month, the Quality 
Assurance Department of Hyland Software evaluates the cumulative fixes released and labeled 
as Critical or Important by Microsoft. The details of the update provided by Microsoft are 
reviewed for interaction with OnBase and installed when appropriate for testing its 
compatibility with OnBase. If you have questions regarding a specific Microsoft cumulative 
update and its compatibility with OnBase, please contact your support provider.

Third-Party Software Compatibility
OnBase is used in conjunction with a variety of third-party software products. The specific 
versions of third-party software that are supported are documented in the requirements 
sections of this manual, which reflect the versions that were required at the time this manual 
was published.

For up-to-date information, visit the following site: https://www.onbase.com/community/
technical_communities/third_party_software_updates/default.aspx.

About Virtual Environments
Hyland Software develops, tests, and supports the OnBase suite of products on specific 
Operating Systems, not specific hardware configurations. When OnBase is operated in a virtual 
environment (such as Citrix, VMware, Hyper-V, or Windows Remote Desktop) there may be 
limitations or subtle differences imposed by the environment. The customer and the virtual 
environment vendor are responsible for any interactions or issues that arise at the Hardware or 
Operating System layer as a result of their use of a virtual environment.

When it appears that a performance-related issue in OnBase is either caused by (or is unique 
to) the virtual environment, organizations may be asked to validate that the issue occurs in a 
non-virtual environment. Hyland Software will make this request if there is reason to believe 
that the virtual environment is a contributing factor to the issue.
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Each OnBase site is unique. Hyland Software depends on the customers who deploy OnBase in 
virtual environments to do so only after careful design and adequate planning (that takes into 
account the workloads of your organization), and in accordance with recommendations 
provided by the virtual environment’s vendor. As with any implementation, Hyland Software 
strongly recommends that any customer deploying the OnBase solution in a virtual 
environment thoroughly test the solution before putting it into production.

For information about using OnBase in a Citrix and Microsoft Windows Remote Desktop 
environment, please see the Citrix and Microsoft Windows Remote Desktop Environment 
Deployment Guide, available on the Hyland Community (https://www.onbase.com/
community).

64-Bit Support Statement
The OnBase suite of products is tested on 64-bit systems and is capable of being deployed on 
64-bit systems using the Windows 32-bit on Windows 64-bit Emulator (WOW64) layer. However, 
OnBase modules that integrate with third-party applications may not be able to be used with 
the 64-bit versions of these applications. For these modules, only the 32-bit versions of these 
third-party applications are currently supported by the OnBase integrations. Consult the 
module-specific requirements section in each module reference guide for complete 
requirements details.

Supported database versions that are deployed on a 64-bit database server are also supported. 
For more information, contact your solution provider.

Windows User Account Control Statement
Hyland Software is dedicated to ensuring that OnBase is compatible with Windows User 
Account Control (UAC). UAC is a feature of Windows operating systems that was introduced 
with Windows Vista. It limits the ability of standard users to make global system changes to a 
workstation and prevents malicious software from making unauthorized changes to protected 
areas.

For details on UAC, refer to your Microsoft support information or see http://
technet.microsoft.com/en-us/library/cc709691(WS.10).aspx.

You may encounter UAC in OnBase when:
• Installing or uninstalling OnBase, OnBase modules, or OnBase ActiveX controls.
• Copying, moving, or saving files to the Program Files directory, Windows directory, or 

another protected location.
• Modifying system-wide settings, such as the registry.
• Re-indexing a document or opening a scanned batch using published Internet 

Explorer from a Remote Desktop Server.

If Windows UAC is enabled, the above operations may prompt for administrator privileges or 
credentials, even if an administrator is currently logged on.
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Modifying Configuration Files
When UAC is enabled, administrators may be unable to modify Web.config or other *.config 
files. To address this issue, the administrator should open a text editor (such as Notepad) by 
right-clicking it and selecting Run as administrator. The administrator can then open the 
*.config file from within the text editor. Because the text editor is running with administrator 
privileges, the configuration file can be modified and saved using that application.

Licensing
See Licensing on page 1 for licensing requirements.

Note: A Unity Client Server license is required for each server instance in your OnBase solution.

Digital Input Device Compatibility
Digital input devices, such as scanners and digital cameras, can use the Windows Image 
Acquisition (WIA) driver model. Depending on the module being used, devices that use TWAIN, 
Kofax, or ISIS can also be used.

To use Windows Image Acquisition (WIA) digital input devices to acquire images, the WIA 
Windows service must be configured with an Automatic or Manual Startup Type. For more 
information on WIA, including a complete list of devices compatible with WIA, see http://
www.microsoft.com.

For more information on the TWAIN standard for image acquisition devices, see http://
www.twain.org.

Third-Party Software Requirements
Microsoft Office 2010 or greater is required to work with Microsoft Office documents in the 
Unity Client. Ensure that the latest Office service pack is installed.

Microsoft Outlook 2010 or greater, Lotus Notes 8.5.x, IBM Notes 9.0.x, or Novell GroupWise 
2012 or 2014 is required to email documents in the Unity Client.

Upgrade Considerations

The following upgrade considerations have been compiled by OnBase subject matter experts. 
These upgrade considerations are general and applicable to most OnBase solutions and 
network environments and should be considered each time an upgrade is performed.

Carefully consider the impact of making any changes, including those listed below, prior to 
implementing them in a production environment.
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For additional general information about upgrading OnBase, refer to the Upgrade Guidelines 
reference manual, and visit the Hyland Community at: 
https://www.onbase.com/community.

General User Interface Redesign

As of OnBase 17, the Unity Client and Web Client have a new user interface design. The design 
changes do not affect functionality, but end users may find the new interface unfamiliar. If you 
are upgrading from OnBase 16 or earlier to OnBase 17 or later, review the changes to the user 
interface with end users, and ensure that any custom end-user documentation is updated 
accordingly.

Server Machine Considerations
The following should be considered with regard to server machines:

• Ensure that the Unity Client version and build match the Application Server version 
and build.

End-User Workstation Considerations
The following should be considered with regard to end-user workstations:

• Ensure that the proper compatible third party applications are installed (e.g., Adobe 
Acrobat, Microsoft Office).

• Ensure that the directory where the Unity Client is installed is added to the virus 
scanner white list. 

• Make note of any settings in the Unity Client configuration file that have been 
modified from their default values.

• Ensure that the Application Server URL is correct in the ServicePath field of the 
Unity Client configuration file and can be accessed from a web browser. Verify the 
user does not receive certificate errors and is not prompted for authentication 
credentials.

ClickOnce Deployment Considerations
The following should be considered with regard to ClickOnce deployments:

• Ensure that the environment in which the Unity Client will be deployed is not a 
Terminal Services environment.

• Ensure that the workstation environment can allow ClickOnce deployments to be 
installed.

• Ensure that any upgrades are made to existing deployments.
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General Deployment Considerations
In addition to the previous considerations, the following should be considered with regard to 

general deployments:
• Use of VBScript is not supported for HTML documents, E-Forms, or any document 

formats that rely on Internet Explorer for rendering. This is because VBScript is 
deprecated in Internet Explorer. Any functionality that depends on VBScripts should 
be updated to use JavaScript. For more information, see Microsoft's documentation 
on Disabling VBScript execution in Internet Explorer.

Installation Overview

Note: Before installing the OnBase Unity Client, ensure you have a functioning OnBase 
Application Server. Ensure that the build of the OnBase Application Server matches the build of 
the OnBase Unity Client.

The Unity Client can be installed:
• Using the Hyland Unity Client Installer. For more information, see Installation Using 

the MSI Installer on page 396.
• Using a ClickOnce Deployment. For more information, see ClickOnce Deployment on 

page 412.
• Manually. For more information, see Manual Installation on page 455.

Standard (EXE or MSI) Installers — There are two methods for running OnBase installers: 
Interactive and silent. An interactive installation requires user interaction with dialog boxes 
during the installation process. A silent installation does not require user interaction during the 
installation process.

OnBase installers may consist of both an executable file (.exe) and a Windows Installer 
Package file (.msi). When performing an interactive installation, and both an executable file 
and MSI are available, use the executable file to ensure a complete installation. The executable 
validates that all prerequisites are met before proceeding with the installation. If any missing 
prerequisites are identified, the installer alerts the user. Most missing prerequisites can be 
installed directly from the installer before continuing the installation process. 

Note: The Microsoft .NET Framework prerequisite must always be installed separately before 
running either the EXE or MSI installer. 

When performing a silent installation, and both an executable file and MSI are available, use the 
MSI. Since the MSI package does not validate prerequisites, you must ensure that Windows 
Installer 3.0 or greater is installed on each workstation and that all other prerequisites are met 
before running the MSI. If any prerequisites are not met, a silent installation from the MSI will 
fail without alerting the user.

For more information about configuring a silent installation, see http://msdn.microsoft.com/
en-us/library/aa367988.aspx.
OnBase 18
©2018 Hyland Software, Inc.

393



Unity Client
Installation
ClickOnce Installers — Some OnBase modules are installed for deployment using ClickOnce. 
ClickOnce is a Microsoft technology that installs a deployment package to a central server. 
This package can then be accessed by users to install the application on their local 
workstations. The application is installed entirely under the user’s profile, ensuring that it 
cannot interfere with other applications installed on the workstation.

ClickOnce deployments also have the following advantages:
• Previously installed versions of the module can be easily and automatically updated 

to the latest version with little or no user interaction, as long as the deployment 
server and deployment instance name are not changed.

• The module is installed on a per-user basis and does not require administrator 
privileges for local installation.

• There can be multiple instances of the module deployed, allowing for different 
versions of the module to be installed on a per-user basis, to match the version 
requirements of the workstation it is being installed to.

For more information on Microsoft’s ClickOnce technology see
http://msdn.microsoft.com/en-us/library/142dbbz4(VS.80).aspx.

Note: ClickOnce-deployed applications are not supported by Microsoft within a Remote 
Desktop environment.

OnBase modules that are deployed using ClickOnce should either take advantage of the 
ClickOnce deployment method as an alternative to a Remote Desktop deployment, or the 
module should be installed using a standard installer and deployed using the Remote Desktop 
methodology.

Note: Not all OnBase modules that support ClickOnce have a standard installer available. 
Contact your first line of support if you are unsure how to install and deploy a specific module.

User Account Control (UAC) — If Windows User Account Control (UAC) is enabled, the installer 
must be run with elevated administrator privileges, even if an administrator is currently logged 
on. This can be accomplished by right clicking on the installer executable and selecting Run as 
Administrator from the right-click menu. MSI files cannot be run using the Run as 
Administrator option. Instead, you must launch the MSI package using the command line. For 
more information on installing files through the command line, refer to your Microsoft support 
information or see http://technet.microsoft.com/en-us/library/cc759262(WS.10).aspx.
Silent Installation Using setup.exe — If you are running setup.exe silently from the command 
line you must use the /q switch and the /CompleteCommandArgs switch, followed by the 
required command-line arguments.

The q switch specifies quiet mode and is required to suppress the GUI. The 
CompleteCommandArgs switch must be followed by the command-line parameters required to 
configure and install the desired components.
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The complete string of command-line parameters must be included in double quotes after the 
CompleteCommandArgs switch. If a parameter in the string also requires double quotes, those 
quotes must be escaped using \. For example: setup.exe /q /CompleteCommandArgs 
"INSTALL_PROPERTY=\"my value\" INSTALL_PROPERTY_2=\"my value 2\"".

Note: You should check the return value of the setup.exe process. A return value of 0 (zero) 
indicates success. Any other value returned may indicate that an error was encountered and 
the installation failed.

Installer Prerequisites
The installer must be run on operating systems that support the Windows® Installer 3.0+ 
architecture.

The installer setup executable (setup.exe) detects most of the prerequisites for the module 
that are also required for installation and installs them, if necessary. If the installer fails to run, 
install all of the requirements for the module separately before relaunching the installer. 
Module requirements can be found in the installation chapters of the corresponding module 
reference guides.

Note: If installation is being performed using the installer MSI file, the requirements for the 
module must be installed before launching the installer.

Installer User Permissions
You must be logged on to the installation machine with administrator privileges in order to run 
the installer.

If installing under Windows operating systems with UAC enabled, the installer must be run with 
elevated administrator privileges, even if the user currently logged in is an administrator.

Installer .NET Framework Requirements
The installer must be run on a machine that meets the .NET Framework requirements of the 
module being installed. Module requirements can be found in the installation chapters of the 
corresponding module reference guides.

OnBase requires Microsoft .NET Framework 4.6 or later. The .NET Framework can be obtained 
from the Microsoft Download Center at http://www.microsoft.com/downloads.
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Installation Using the MSI Installer

Running the Installer
Launch the Hyland Unity Client installer by executing setup.exe. This executable is usually 
located in the \install\Unity Client\ folder of your source installation files.

Note: If the installer is being copied from the source location to be run from a different 
location, the entire Unity Client folder and its contents must be copied to the new location.

1. The Hyland Unity Client installation welcome dialog is displayed.

2. Click Next. The Destination Folder dialog box is displayed.
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3. Enter the top-level installation directory in the field provided, or click Change to browse 
to it.

Note: This location does not affect components not installed under the top-level directory. If 
the installer provides for the installation of multiple components, the specific installation 
locations of each component can be changed later in the installation process.

If Change is clicked the Change destination folder dialog box is displayed.

Enter a Folder name in the field provided or select it from the Look in drop-down select 
list, then click OK.
If the Destination Folder is not changed, the default location is used.
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4. Click Next. The Custom Setup dialog is displayed.

The following features can be installed using the Hyland Unity Client installer:

* Because this component can only run when the Unity Client is in Service Mode, choosing to install 
this component automatically configures the Unity Client to run in Service Mode.

Component Description

Unity Client Installs the Unity Client.
The Unity Client is a next-generation document 
management system that offers the familiar look-and-feel 
of Microsoft® Office® 2013.

Datalogics Installs Datalogics.

Application Enabler* Installs the Application Enabler module.
Application Enabler provides a way to seamlessly integrate 
an organization’s core line-of-business applications with 
OnBase.

Client Automation API* Installs the Unity Client Automation API, which is used by 
third-party applications to automate the Unity Client.

Virtual Print Driver Listener* Installs the Virtual Print Driver listener.

Unity Pop Automation* Installs Unity Pop.
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5. Click the drop-down select list beside the name of a component to display the 
installation options:

6. Select This feature will be installed on local hard drive for each component you want 
to install.
To install all components, select Entire feature will be installed on local hard drive 
from the drop-down select list beside the top-level component.

7. To determine the amount of space available for installation of the selected 
components, click Disk Usage. The Disk Space Requirements dialog is displayed, with 
information on the space required for the selected components and the space available 
on the drives accessible by the installation machine.

Option Description

Will be installed on local hard drive Installs the selected feature and does not install any 
dependent, optional functionality. To view optional 
functionality, click the + icon next to the feature to 
expand the sub feature list.

Entire feature will be installed on 
local hard drive

Installs the selected feature and any dependent 
functionality. To view the dependent functionality, click 
the + icon next to the feature to expand the sub feature 
list.

Entire feature will be unavailable Select this option to remove a feature from the list of 
features to install.
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8. To change the installation location of a component, select it and click Browse. The 
Change destination folder dialog is displayed.

Enter a Folder name in the field provided or select it from the Look in drop-down select 
list. If the destination folder is not changed, components are installed to the default 
locations listed in the following table.

9. Click Next. The Service Location dialog is displayed.
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10. In the Display Name field, enter a user-friendly name for the service location.
11. In the Service Path field, enter the full URL to the Service.asmx page on the OnBase 

Application Server. For example, https://MachineName/AppServer/Service.asmx.

Note: Ensure that the Service Path reflects the configuration of the OnBase Application Server 
in regard to HTTPS bindings. If the Application Server is not configured to use HTTPS, setting 
the Service Path to HTTPS in this installer does not configure an HTTPS binding on the OnBase 
Application Server.

12. In the Data Source field, enter the data source name this component will use to connect 
to OnBase.

13. Select Yes from the Use NT / LDAP Authentication drop-down select list if your system 
uses Active Directory or LDAP Authentication, otherwise select No.

Note: In order to use Active Directory or LDAP authentication, the database against which the 
installed component runs must be separately configured for Active Directory or LDAP 
authentication. This installer configures the installed components to match the authentication 
scheme of the database but does not configure Active Directory or LDAP.
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14. Click Next. The Additional Settings dialog is displayed.

In the Default Mail Client drop-down select list, select the default email client that users 
will use to send external mail from within the Unity Client.
If you chose to install Unity Pop Automation, the Additional Settings dialog includes 
Unity Pop options.
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In the Unity Pop option drop-down select list, select the Pop integration option that will 
be used for document retrieval and viewing.

Option Description

DocPop Link Select this option to use DocPop. The DocPop URL field will become available. 
For more information, see the DocPop module reference guide.

Unity Pop File Select this option to use Unity Pop Files. For more information, see Viewing 
Unity Pop Files and Links on page 270 and Configuring Unity Pop on page 383.

Unity Pop Link Select this option to use Unity Pop Links. For more information, see Viewing 
Unity Pop Files and Links on page 270 and Configuring Unity Pop on page 383.

Caution: Do not select Unity Pop Link if existing Unity Pop files are still in use 
by your organization.
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15. Click Next. If you chose to install Application Enabler Client, the Application Enabler 
Options dialog is displayed.

f. In the Default Configuration File field, enter the full URL or UNC path to the default 
configuration file that Application Enabler should use (for example, 
\\FileServer\Apps\ApplicationEnabler\DefaultFile.xml), or click Change to navigate 
to the file to use. Leave this field empty to not configure a default file.

g. Select Enable HTTP Automation to expose an HTTP endpoint to allow third-party 
applications to perform Application Enabler context events.

h. If Enable HTTP Automation is selected, type the port number for the HTTP endpoint 
in the Port field. The default value is 15412.

i. Select Enable HTTPS Automation to expose an HTTPS endpoint to allow third-party 
applications to perform Application Enabler context events.

Note: HTTPS Automation requires additional configuration after installation.

j. If Enable HTTPS Automation is selected, type the port number for the HTTPS 
endpoint in the Port field. The default value is 15425.
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16. Click Next. If you chose to install any of the Service Mode components, the Service 
Mode Options dialog is displayed.

Select Prevent Client from launching on system startup to prevent the Client from 
automatically launching when the system starts.
OnBase 18
©2018 Hyland Software, Inc.

405



Unity Client
Installation
17. Click Next. The Ready to install dialog is displayed.

18. Select Create Desktop shortcut(s) when applicable to create shortcuts to the installed 
components in the Windows Start | All Programs | Hyland menu, on the Windows 
desktop, or in both locations, when applicable.

19. Click Install to continue with the installation, or click Cancel to cancel the installation.
20. When the installation is complete, click Finish. 

Tip: In order to ensure that the required system settings take effect, it is a best practice to 
restart the installing machine once the installer has finished.

Note: Some functionality must be configured directly in the configuration file. See Post-
Installation on page 412.
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Change, Repair, or Remove an Installation
After initial installation, the setup program can be used to change, repair, or remove 
components from a previous installation. After launching setup.exe or the *.msi installation 
package, and clicking Next at the welcome dialog, the Change, repair, or remove installation 
dialog box is displayed.

Select the option for the actions you wish to perform:

Running the Installer from the Command Line
You can control the installation of components from the command line by passing its feature 
name to the installer using the ADDLOCAL property. The values of the configuration options 
available in the graphical installation wizard are passed to the installer using the property 
names associated with the installer options.

This section describes the feature names and properties associated with this installer.

Note: Feature and Property names are case sensitive.

Option Description

Change Add or remove components using the Custom Setup dialog.

Note: This option is not available if the installer has no independently 
selectable features.

The steps for adding selected components are the same as those under the 
Component Selection section of the installation instructions, if applicable to 
the installer.

Note: Change does not allow you to alter configuration options originally set 
during a previous installation of components contained in the installer.

Repair Repair errors in the most recent installation of the component, such as 
missing and corrupt files, shortcuts, and registry entries.

Note: This option is not available from all installers. Repair does not include 
errors made in the configuration options set by the user during installation. 
For specific troubleshooting information regarding an installed component, 
see the module reference guide for that component.

Remove Removes all previously installed components.
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Feature Names
To install the components contained in this installer, the value of the ADDLOCAL property must 
use the following Feature Names:

* Because this component can only run when the Unity Client is in Service Mode, choosing to install 
this component automatically configures the Unity Client to run in Service Mode.

The ADDLOCAL property is added to the installation command line, as shown here:

msiexec /i "Hyland Unity Client.msi" ADDLOCAL=Unity_Client,ApplicationEnabler

Properties
When controlling the installation of components from the command line you must also 
configure the settings for each component you are installing by using the properties listed in 
the following table. If a property is not included, the default value is configured for that 
property.

Component Feature Name

Unity Client Unity_Client

Datalogics UnityClient_Datalogics

Application Enabler* ApplicationEnabler

Client Automation API* UnityClientAutomation

Virtual Print Driver Listener* VirtualPrintDriverListener

Unity Pop Automation* UpopAutomation

Property Description

AE_DEFAULTFILE The full URL or UNC path to the default 
configuration file that Application Enabler should 
use. Leave this property empty to not configure a 
default file. By default, this property is empty.
For example: 
AE_DEFAULTFILE="\\FileServer\Apps\Applic
ationEnabler\DefaultFile.xml"

CREATE_DESKTOP_SHORTCUTS Set to 1 to add desktop shortcuts for the 
installed component, or leave empty to not add 
the shortcuts. By default, this property is empty.
For example: 
CREATE_DESKTOP_SHORTCUTS="1" or 
CREATE_DESKTOP_SHORTCUTS=""
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CREATE_MENU_SHORTCUTS Set to 1 to add program menu shortcuts for the 
installed component, or leave empty to not add 
the shortcuts. By default, this property is set to 
1.
For example: CREATE_MENU_SHORTCUTS="1" 
or CREATE_MENU_SHORTCUTS=""

SERVICE_LOCATION_DATA_SOURCE The ODBC connection for the data source 
installed components will use to connect to 
OnBase. By default, this property is set to 
{DataSource}.
For example: 
SERVICE_LOCATION_DATA_SOURCE="ODBC 
source name"

SERVICE_LOCATION_DISPLAY_NAME A user-friendly name for the service location. By 
default, this property is set to New Service 
Location.
For example: 
SERVICE_LOCATION_DISPLAY_NAME="My 
Service Location"

SERVICE_LOCATION_NT_AUTH Set to true if your system uses Active Directory 
or LDAP authentication, or set to false if it does 
not. By default, the 
SERVICE_LOCATION_NT_AUTH property is set 
to false.

Note: In order to use Active Directory or LDAP 
authentication, the database against which the 
installed component runs must also be 
configured for Active Directory or LDAP 
authentication. The installer configures the 
installed component to match the authentication 
scheme of the database.

For example: 
SERVICE_LOCATION_NT_AUTH="true" or 
SERVICE_LOCATION_NT_AUTH="false"

SERVICE_LOCATION_SERVICE_PATH The full URL to the Service.asmx page on the 
OnBase application server. By default, this 
property is set to https://{WebSite}/
{Directory}/Service.asmx. 
For example: 
SERVICE_LOCATION_SERVICE_PATH="http://
MachineName/AppServer/Service.asmx"

Property Description
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UNITYCLIENT_AE_HTTPAUTOMATION Set to 1 to enable HTTP Automation for 
Application Enabler, or leave empty to not enable 
HTTP Automation for Application Enabler. By 
default, this property is empty.
For example: 
UNITYCLIENT_AE_HTTPAUTOMATION="1" or 
UNITYCLIENT_AE_HTTPAUTOMATION=""

UNITYCLIENT_AE_HTTPSAUTOMATION Set to 1 to enable HTTPS Automation for 
Application Enabler, or leave empty to not enable 
HTTPS Automation for Application Enabler. By 
default, this property is empty.
For example: 
UNITYCLIENT_AE_HTTPSAUTOMATION="1" 
or UNITYCLIENT_AE_HTTPSAUTOMATION=""

Note: If HTTPS Automation is selected during 
installation, the location of the HTTPS 
certificate to be used must be specified in the 
obunity.exe.config file. For more information, 
see Post-Installation on page 412.

UNITYCLIENT_AE_HTTPS_PORT The secure port number Application Enabler will 
use if HTTPS Automation is enabled. By default, 
this property is set to 15425.

Note: Valid values are any integer 1 to 65535.

UNITYCLIENT_AE_PORT The port number Application Enabler will use if 
HTTP Automation is enabled. By default, this 
property is set to 15412.

Note: Valid values are any integer 1 to 65535.

Property Description
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Properties are added to the installation command line, as shown here:

msiexec /i "Hyland Unity Client.msi" ADDLOCAL=Unity_Client 
SERVICE_LOCATION_DATA_SOURCE="My ODBC" 
SERVICE_LOCATION_SERVICE_PATH="http://MyMachineName/AppServer/Service.asmx"

UNITYCLIENT_DEFAULT_MAIL_CLIENT The default mail client for Unity Client. By 
default, this property is set to outlook.

Note: Valid values are outlook, lotus, 
groupwise, and gmail.

Note: When Microsoft Outlook and Novell 
GroupWise are installed on the same machine, 
using GroupWise as the Default Mail Client for 
the Unity Client may result in unexpected 
behavior and is not supported.

For example: 
UNITYCLIENT_DEFAULT_MAIL_CLIENT="outl
ook" or 
UNITYCLIENT_DEFAULT_MAIL_CLIENT="lotu
s"

UNITYCLIENT_DOCPOP_URL The URL that will be used when sending DocPop 
links. By default, this property is set to http://
[server]/[virtual directory]/docpop/
docpop.aspx?docid={0}&clienttype=html.
For more information on DocPop links, see the 
DocPop module reference guide.

UNITYCLIENT_POP_OPTION The Unity Pop option to set. Set to disabled, 
upop (Unity Pop Link), upop-file (Unity Pop File), 
or weblink (DocPop Link). By default, this 
property is set to upop.
For example: 
UNITYCLIENT_POP_OPTION="disabled" or 
UNITYCLIENT_POP_OPTION="upop"

UNITYCLIENT_SERVICEMODE_DISABLEAUT
ORUN

Set to 1 to prevent Unity Client from launching on 
system startup, or leave blank to allow Unity 
Client to launch on system startup. By default, 
this property is empty.
For example: 
UNITYCLIENT_SERVICEMODE_DISABLEAUTO
RUN="1" or 
UNITYCLIENT_SERVICEMODE_DISABLEAUTO
RUN=""

Property Description
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Post-Installation
Some functionality must be configured directly in the configuration file. For general information 
about making changes to the obunity.exe.config file, see The Unity Client Configuration File on 
page 368.

AD FS Configuration
For information on how to configure the Unity Client for AD FS, see the Authentication module 
reference guide.

HTTPS Automation
For information on HTTPS Automation requirements, see HTTPS Automation Requirements on 
page 386.

If HTTPS Automation is selected during installation, the location of the HTTPS certificate to be 
used must be specified in the obunity.exe.config file.

To specify the location of the HTTPS certificate:

1. Open the obunity.exe.config file.
2. In the Hyland.Canvas.Automation.Services node, locate <HttpsAutomation 

enabled="false" port="15425" certificateLocation="" />.
3. Set enabled to "true".
4. Change the port setting, if required.
5. Set certificateLocation to the file path of the HTTPS certificate.
6. Save and close obunity.exe.config.

Installation Using ClickOnce

ClickOnce Deployment

To install a ClickOnce deployment of the Unity Client:

1. Launch the installer using setup.exe. This file is typically located in the In the 
\ClickOnce\Unity Client folder of your source installation files. The Welcome... dialog 
box is displayed.

2. Click Next. The Ready to install... dialog box is displayed.
3. Click Install. The deployment setup is installed.
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4. Click Launch or Finish, depending on the module being installed. The Welcome to the 
Deployment Creation Wizard dialog is displayed.

Select Advanced Mode to enable the ability to update certain aspects of the installation 
where the default values are populated by the installer. Not selecting this option 
automatically uses the default values populated by the installer.

Caution: Any necessary changes to the files in the deployment folder or the contents of the 
deployment folder, such as custom changes to the *.config file for the module, must be made 
before clicking Next at the Deployment Signing dialog box. If you are in Advanced Mode, you 
still have the option to edit files in the deployment folder at the File Edit Notification dialog box 
that is displayed after the Deployment Signing dialog box.

Note: If your servers are configured to use an HTTPS binding, or you are going to enable Active 
Directory or LDAP Authentication, you should enable Advanced Mode in order to be able to 
configure these options in your deployment.
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5. Click Next. The Instance Settings dialog box is displayed.

Note: If the Package Selection dialog box is displayed, select the package to deploy then click 
Next to reach the Instance Settings dialog box.

6. Select the name of the application instance from the drop-down select list under the 
Instance Name section. To create a new instance name:
a. Click the Add button to the right of the drop-down select list. The Create New 

Instance dialog box is displayed.

Note: If you create a new instance name for an existing deployment, the package must be 
redeployed to client machines under the new instance name.
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b. Enter a name for the new instance in the field provided. The name entered is used to 
distinguish this deployment from other deployments, so it must be unique.

Note: The instance name cannot contain any of the following characters: [ ] < > , ; : + = " / \ | ? 
* # '

c. Click OK.
7. The Deployment Version Number fields can be used to manually set a new version 

number for this deployment. This number is used by client machines to determine if the 
application installed needs to be updated.
The Deployment Version Number is incremented automatically by the deployment 
wizard. The initial Deployment Version Number is 1.0.0.0, and there is no need to 
change this number.

Note: The Deployment Version Number is not available unless Advanced Mode is selected on 
the Welcome to the Deployment Creation Wizard dialog. To enable the Deployment Version 
Number, click Back and select Advanced Mode on the Welcome to the Deployment Creation 
Wizard dialog.

8. Select the Require clients to upgrade to version check box to force client machines to 
upgrade to the current instance. This option is selected by default.

9. Click Next. The Deployment Location dialog box is displayed.
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10. Click Change beside the Deployment Folder field to select a different folder. The 
Deployment Folder can be a local path or network location and is the folder to which the 
application files are copied on the deployment server.

Note: If you are updating an existing deployment, you cannot change the Deployment Folder. If 
you create a new instance with a different Deployment Folder, the old deployment is not 
updated and the package must be redeployed to client machines with the new Deployment 
Folder location. 

Caution: Files in the Deployment Folder selected are overwritten.

11. Click Next. The How do you want to deploy...? dialog is displayed.

12. Click the Web Server icon to deploy the application to client workstations via a URL 
(e.g., https://web-server/Application/DeployedApp.application).

Note: If IIS is not installed, you cannot select Web Server and must deploy the application via a 
UNC path.

Click the From a Shared Folder icon to deploy the application to client workstations via 
a UNC path (e.g., \\machine-name\Application\DeployedApp.application).

Note: The From a Shared Folder option is not available if deploying to a network location (e.g., 
\\MyServer\MyShare).

Select Skip this step to configure the deployment folder manually as a shared folder or 
a virtual directory.
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13. Click Next.
• For Web Server installations, go to the Web Server Installation Steps.
• For From a Shared Folder installations, go to the From a Shared Folder Installation 

Steps.
• If Skip this step is selected, go to the Manually Created Share Steps.

Web Server Installation Steps
If you are installing the deployment package to a Web server, the Web server must be added to 
the Local intranet zone in Microsoft Internet Explorer. Zones are configured in Internet Explorer 
by selecting the Security tab of the Internet Options (available from the Tools menu). You 
must also Enable the following Security settings:

• Automatic prompting for file downloads
• File download
• Font download

Tip: For complete details on adding and configuring sites in the Local Intranet Zone, see the 
Microsoft Internet Explorer help files.

After selecting Web Server at the How do you want to deploy...? dialog box, the Configure 
Virtual Directory dialog is displayed:
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1. Select the Web Site to create the virtual directory under from the drop-down select list.

Note: The application generated by the deployment wizard uses the security settings from the 
Default Web Site in IIS.

2. Select a Protocol from the drop-down select list. This allows you to configure the 
installed application to use the https protocol if an HTTPS binding is available.

3. Enter the Host Name of the Web Site selected, or accept the default host name 
presented. In some cases, such as with an HTTPS binding, the default value may need 
to be changed to match the host name in the certificate.
To specify a port to use for this connection, include the port number in the host name: 
<host name>:<port> (e.g., DEV-007832:82).

4. Enter a name for the Virtual Directory in the field provided. This is the name of the 
virtual directory created under the Web server selected.

Note: If a virtual directory with the same name already exists, the existing virtual directory is 
configured to point to the Deployment Folder configured. The following special characters 
cannot be used in the Virtual Directory name: \ ? ; : @ & = + $ , | " < > *.

5. Click Next. The Package Extraction dialog is displayed, which displays the progress of 
the installation.
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6. Click Next when the extraction has completed. The General Settings dialog is 
displayed.

Note: The General Settings dialog is not displayed for all modules, depending on the type of 
application being deployed. For example, desktop shortcuts cannot be created for the 
Microsoft Office add-ins so the General Settings dialog is not displayed.

Select Create Desktop Shortcuts to create a shortcut to the deployed application on the 
client machine when the application is first installed on the client machine.

Note: This option is only available for new deployments.

7. Click Next.

Note: You do not need to complete the steps under From a Shared Folder Installation Steps or 
Manually Created Share Steps. Proceed to the section after the Manually Created Share Steps 
section.
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From a Shared Folder Installation Steps
If you selected From a Shared Folder at the How do you want to deploy...? dialog, the 
Configure Folder Share dialog is displayed:

Note: Read access on the shared folder is required for users to be able to install and upgrade 
the deployed application. Shared folder permissions must be set outside of this installation for 
deployments installed to a UNC location.

1. Enter a Share Name in the field provided. This is the name that the Deployment Folder 
will be shared as to users.

Note: The Share Name must be unique. You cannot enter the name of an existing share.

2. Enter the External Name of the server hosting the Deployment Folder configured, or 
accept the default value presented. This is the name users will use to access the server. 
The default value is the machine name of the machine containing the shared folder.

Note: The External Name field is only available if Advanced Mode is selected on the Welcome 
to the Deployment Creation Wizard dialog.
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3. Click Next. The Folder Share Permissions dialog is displayed if you are installing the 
deployment to a local drive (e.g., C:):

This dialog allows you to add or remove the users and groups that have read access to 
the Deployment Folder. By default, the local Everyone group is given read access.

Note: Read access is required for users to be able to install and upgrade the deployed 
application.
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4. Click Add to add additional users or groups, or select a user or group to remove and 
click Remove to remove it. If the users and groups presented are acceptable, proceed to 
the next step.
If you click Add, the Select Users and Groups dialog is displayed:

Select the Domain or Workspace to find users and groups under from the drop-down 
select list, then enter a User Group or Name to search for in the field provided, and click 
Search. Leave the User or Group Name field empty to locate all available accounts.
Select the user or group to add from the Search Results, then click OK. Repeat as 
necessary to configure your Folder Share Permissions.
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5. Click Next. The Package Extraction dialog is displayed, which displays the progress of 
the installation.
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6. Click Next when the extraction has completed. The General Settings dialog is 
displayed.

Note: The General Settings dialog is not displayed for all modules, depending on the type of 
application being deployed. For example, desktop shortcuts cannot be created for the 
Microsoft Office add-ins so the General Settings dialog is not displayed.

Select Create Desktop Shortcuts to create a shortcut to the deployed application on the 
client machine when the application is first installed on the client machine.

Note: This option is only available for new deployments.

7. Click Next.

Note: You do not need to complete the steps under Manually Created Share Steps. Proceed to 
the section after the Manually Created Share Steps section.

Manually Created Share Steps
If you selected Skip this step at the How do you want to deploy...? dialog, you must manually 
create the share that the deployment will be installed to.
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If you are installing the deployment package to a Web server, the Web server must be added to 
the Local intranet zone in Microsoft Internet Explorer. Zones are configured in Internet Explorer 
by selecting the Security tab of the Internet Options (available from the Tools menu). You 
must also Enable the following Security settings: 

• Automatic prompting for file downloads
• File download
• Font download

Tip: For complete details on adding and configuring sites in the Local Intranet Zone, see the 
Microsoft Internet Explorer help files.

If you are installing the deployment package to a network share, Read access on the shared 
folder is required for users to be able to install and upgrade the deployed application. Shared 
folder permissions must be set outside of this installation.

If you selected Skip this step at the How do you want to deploy...? dialog, the Web Deployment 
URL dialog is displayed:

1. Select Configure Web URL to have the installer create the link to the deployment that 
will be sent out to client machines for client installations of the deployed application. 
This link is available to be copied at the end of the installation, if one is configured.

Tip: Do not select this option if the deployment Web site has not been configured for external 
access.
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2. In the field, enter the base URL of your deployment without the application name (for 
example, https://web-server/virtual-directory). The application name is automatically 
appended to the URL at the end of the installation.

3. Click Next. The Package Extraction dialog is displayed, which displays the progress of 
the installation.
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4. Click Next when the extraction has completed. The General Settings dialog is 
displayed.

Note: The General Settings dialog is not displayed for all modules, depending on the type of 
application being deployed. For example, desktop shortcuts cannot be created for the 
Microsoft Office add-ins so the General Settings dialog is not displayed.

Select Create Desktop Shortcuts to create a shortcut to the deployed application on the 
client machine when the application is first installed on the client machine.

Note: This option is only available for new deployments.

5. Click Next.
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Unity Features
After clicking Next on the General Settings dialog, the Unity Features dialog is displayed.

1. Select from the following features to install:

Component Description

Unity Client Installs the Unity Client.
The Unity Client is a next-generation document 
management system that offers the familiar look-and-feel 
of Microsoft® Office® 2013.

Application Enabler* Installs the Application Enabler module.
Application Enabler provides a way to seamlessly integrate 
an organization’s core line-of-business applications with 
OnBase.

Unity Client Automation API* Installs the Unity Client Automation API, which is used by 
third-party applications to automate the Unity Client.

Virtual Print Driver* Installs the Virtual Print Driver listener.

Unity Pop Automation* Installs Unity Pop.
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* Because this component can only run when the Unity Client is in Service Mode, choosing to install 
this component automatically configures the Unity Client to run in Service Mode.

2. Click Next.

Service Location and Deployment Configuration
After clicking Next, the Service Location dialog is displayed.

1. Click Add.
2. Enter in the Display Name field the name of the service location.
3. Enter in the Service Path field the full URL to the OnBase application or Web server 

service (for example, https://machinename/AppServer/Service.asmx or https://
machinename/AppNet/Service.asmx).

Note: URLs that use the HTTPS binding must be correctly configured on the server for secure 
connections.

4. In the Data Source field, enter the data source name for the appropriate data source.
5. Select Use NT / LDAP Authentication if your system uses Active Directory or LDAP 

Authentication.

Note: In order to use Active Directory or LDAP authentication, the database against which Unity 
Client runs must also be configured for Active Directory or LDAP authentication. The installer 
configures Unity Client to match the authentication scheme of the database.
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6. Select Use ADFS if your system uses AD FS (Active Directory Federation Services) 
authentication.

Note: Use ADFS is not the same Active Directory authentication scheme as Use NT/LDAP 
Authentication. The Use ADFS option is not available for all modules. If this option is not 
displayed, the module you are installing either does not support AD FS or must be manually 
configured for AD FS authentication. You cannot enable both Use ADFS and Use NT/LDAP 
Authentication. For more information about configuring OnBase to use AD FS, see the 
Authentication module reference guide.

Selecting Use ADFS causes the remainder of the deployment to be run in Advanced 
Mode, even if Advanced Mode was not selected initially, because the configuration file 
for the module must be updated before signing and finalizing the deployment.

Note: Depending on the module being updated or added, you may be required to complete 
information in additional dialogs specific to the module. See the main installation steps above 
for information on any additional dialogs or steps that must be completed before signing the 
deployment.

For information on how to use the obunity.exe.config file to configure Unity Client for 
ADFS, see the Authentication module reference guide.

7. Click Next. The Additional Settings dialog is displayed.

8. On the General tab, in the Default Mail Client drop-down select box, select the default 
mail client that users will use to send external mail from within the Unity Client.
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9. Select the Enable HTTPS Web Requests if you are installing Application Enabler and 
you want to expose an HTTPS endpoint to allow third-party applications to perform 
Application Enabler context events.
Type the port number for the HTTPS endpoint in the Port field. The default value is 
15425.

Tip: For more information on HTTPS Automation requirements, see HTTPS Automation 
Requirements on page 386.

Note: If HTTPS Automation is selected during installation, the location of the HTTPS certificate 
must be specified in the obunity.exe.config file before signing the deployment.

10. Select the Enable Persistent Logon check box if users should be able to use persistent 
logon. When selected, the Remember me on this computer check box is displayed in the 
log on dialog box. When this check box is selected, the Unity Client stores the user’s 
credentials and uses them to automatically log on to OnBase during future sessions. 
Credentials are stored until the user manually logs off. This feature is only available 
with OnBase authentication.

11. Select the Enable Email Link As check box if the Send To | Mail Recipient (as Link) 
option should be available to users:

 Select Upop URI if Unity Pop hyperlink URI files will be sent via Send To | Mail Recipient 
(as Link). Select Upop Shortcut File if Unity Pop shortcut files will be attached via Send 
To | Mail Recipient (as Link). Select DocPop URL if DocPop hyperlink URLs will be sent 
via Send To | Mail Recipient (as Link).

Note: The Create Integration Hyperlink privilege is required to send Upop URI links.
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12. Click Next. The Default Configuration File dialog is displayed.

13. You can select a default configuration file. If you don’t want to specify a file, select 
None.
 If you want to specify a configuration file and include it with the deployment, select the 
Include Configuration File with Deployment option. Specify the path to the 
configuration file in the Configuration Path field. 
If you want to specify a configuration file but not include it in the deployment, select the 
External Path to Configuration File option. Specify the path to the configuration file in 
the External Path field. The path specified must be accessible to users.
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14. Click Next. The Application Enabler Options dialog is displayed.

15. On the General tab, select Enable HTTP Automation to expose an HTTP endpoint to 
allow third party applications to perform Application Enabler context events.
Type the port number for the HTTP endpoint in the Port field. The default value is 
15412.
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16. Click the Pop Configuration tab.

17. The Pop Configuration tab allows you to configure URLs for DeficiencyPop, Patient 
Window, and FolderPop. 
Specify the appropriate URL in the field for each feature as needed.
• For DeficiencyPop, enter the URL for the Medical Records Login.aspx page. If 

DeficiencyPop should share sessions with Application Enabler and not require a login 
every time a related context is triggered, select the Enable session sharing check 
box. In order for this to function properly, users must log into Application Enabler 
using a service location which is pointing to a Medical Records Management server. 
For checksum validation to occur, EnablePopChecksum must be set to true in the 
Medical Records Management server’s web.config file. For more information on the 
EnablePopChecksum setting, see the Medical Pop Integrations documentation. If 
Include external deficiencies is selected, the external attribute is set to true. For 
more information on these settings, see the Application Enabler module reference 
guide.

• For Patient Window, enter the URL for Patient Window Login.aspx page. If Patient 
Window should share sessions with Application Enabler and not require a login every 
time a related context is triggered, select the Enable session sharing check box. For 
checksum validation to occur, EnableChecksum must be set to true in the Patient 
Window’s web.config file. For more information on the EnableChecksum setting, see 
the Medical Pop Integrations documentation. If View patient banner is selected for 
Patient Window, the showBanner attribute is set to true. For more information on this 
setting, see the Application Enabler module reference guide.
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• For FolderPop, enter the URL to the FolderPop.aspx page. Select the Open FolderPop 
Results in Separate Windows option if you want FolderPop links to be opened in 
separate windows. Select the Send the session ID to web server option if you want 
the AE - FolderPop context to reuse the active session that Application Enabler has 
instead of consuming a new session. If the option is not selected, users will have to 
log into each FolderPop instance that is launched after logging into Application 
Enabler.

Note: The Application Enabler - Retrieve Documents and Application Enabler - Retrieve 
Folders contexts still require users to log in through a standard Application Server and cannot 
use a Medical Records Management server.

18. Click Next. The Deployment Signing dialog box is displayed.

Note: Do not sign the deployment until you have made any required changes to the 
obunity.exe.config file. See Before Signing the Deployment on page 435.

Before Signing the Deployment

Caution: Any necessary changes to the files in the deployment folder or the contents of the 
deployment folder, such as custom changes to the *.config file for the module, must be made 
before clicking Next at the Deployment Signing dialog box.

If you are in Advanced Mode, you still have the option to edit files in the deployment folder at 
the File Edit Notification dialog box that is displayed after the Deployment Signing dialog box. 

If you are not in advanced mode, you must access the files directly by navigating to the 
deployment location.

For general information about making changes to the obunity.exe.config file, see The Unity 
Client Configuration File on page 368.

AD FS Configuration
For information on how to configure the Unity Client for AD FS, see the Authentication module 
reference guide.

HTTPS Automation

If HTTPS Automation is selected during installation, the location of the HTTPS certificate to be 
used must be specified in the obunity.exe.config file.

To specify the location of the HTTPS certificate:

1. Open the obunity.exe.config file.
2. In the Hyland.Canvas.Automation.Services node, locate <HttpsAutomation 

enabled="false" port="15425" certificateLocation="" />.
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3. Set enabled to "true".
4. Change the port setting, if required.
5. Set certificateLocation to the file path of the HTTPS certificate.
6. Save and close obunity.exe.config.

Deployment Signing

Caution: Any necessary changes to the files in the deployment folder or the contents of the 
deployment folder, such as custom changes to the *.config file for the module, must be made 
before clicking Next at the Deployment Signing dialog box.

If you are in Advanced Mode, you still have the option to edit files in the deployment folder at 
the File Edit Notification dialog box that is displayed after the Deployment Signing dialog box. 

If you are not in advanced mode, you must access the files directly by navigating to the 
deployment location before signing the deployment.
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The Deployment Signing dialog box is displayed.

1. Select the appropriate signing method.
When Sign from Test Certificate is selected, a test certificate with the Common Name 
localhost is used. This test certificate is packaged with all ClickOnce installers. For 
security purposes, it is strongly recommended that this certificate remain un-trusted. 
This does not mean the certificate cannot be used, simply that when users attempt to 
launch the ClickOnce link, they are prompted with a message stating that the publisher 
could not be verified.
When Sign from Certificate User Store is selected, certificates from the current user 
store are listed under this option. If there are any certificates in the current user store, 
they can be used for signing here. Only certificates purposed for code signing are valid.
When Sign from File is selected, the deployment is signed using the PFX file entered in 
the corresponding field. Only certificates purposed for code signing are valid.

Caution: Any necessary changes to the files in the deployment folder or the contents of the 
deployment folder, such as custom changes to the *.config file for the module, must be made 
before clicking Next at the Deployment Signing dialog box. If you are not in advanced mode, 
you must access the files directly by navigating to the deployment location before clicking Next 
and signing the deployment.
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2. Click Next. If you are in Advanced Mode, the File Edit Notification dialog box is 
displayed.

From this dialog box you can open the deployment folder by clicking Open Deployment 
Folder. At this time, any necessary changes to the files in the folder or the contents of 
the folder must be made, such as custom changes to the *.config file for the module.

3. Click OK. Upon clicking OK, the folder is signed and cannot be modified without 
updating the deployment instance. The application is deployed and the Summary dialog 
is displayed upon completion.
Clicking the link provided under Success launches the application. This is the same as 
the full path that external users must use to install and launch the application. 
Click Copy Link To Clipboard to copy this link to the clipboard. 

4. Click Finish.

Upon completing these steps, you have installed the Deployment Wizard and installed an 
instance. You can add additional instances and access the Deployment Wizard by selecting 
Start | All Programs | Hyland | Deployment | Deployment Wizard. You can also update existing 
instances in the same way. See the Updating or Adding a Deployment Instance section for more 
information.
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Updating or Adding a Deployment Instance
When a change is necessary for a deployment instance, it can be updated or a new instance 
can be created. To update an existing instance or create a new instance:

1. Select Start | All Programs | Hyland | Deployment | Deployment Wizard. The Welcome 
to the Deployment Wizard Creation Wizard dialog is displayed.

Select Advanced Mode to enable the ability to update certain aspects of the update 
where the default values are populated by the installer. Not selecting this option 
automatically uses the default values populated by the installer.

2. Click Next. The Package Selection dialog is displayed.
3. Select the deployed module for which you are updating the instance.
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4. Click Next. The Instance Settings dialog is displayed.

5. Select the name of the application instance from the drop-down select list under the 
Instance Name section. To create a new instance name:
a. Click the Add button to the right of the drop-down select list. The Create New 

Instance dialog box is displayed.

Note: If you create a new instance name for an existing deployment, the package must be 
redeployed to client machines under the new instance name.

b. Enter a name for the new instance in the field provided. The name entered is used to 
distinguish this deployment from other deployments, so it must be unique.

Note: The instance name cannot contain any of the following characters: [ ] < > , ; : + = " / \ | ? 
* # '

c. Click OK.
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6. The Deployment Version Number fields can be used to manually set a new version 
number for this deployment. This number is used by client machines to determine if the 
application installed needs to be updated.
The Deployment Version Number is incremented automatically by the deployment 
wizard. There is no need to change this number.

Note: The Deployment Version Number is not available unless Advanced Mode is selected on 
the Welcome to the Deployment Creation Wizard dialog. To enable the Deployment Version 
Number, click Back and select Advanced Mode on the Welcome to the Deployment Creation 
Wizard dialog.

7. Select the Require clients to upgrade to version check box to force client machines to 
upgrade to the current instance. This option is selected by default.

8. Click Next. The How do you want to deploy Unity Client? dialog is displayed.

9. Click the Web Server icon to deploy the application to client workstations via a URL 
(e.g., https://web-server/Application/DeployedApp.application).
Click the From a Shared Folder icon to deploy the application to client workstations via 
a UNC path (e.g., \\machine-name\Application\DeployedApp.application).

Note: If you are upgrading an existing instance, you can only select to deploy it in the same 
method as it was deployed originally. For new instances, if IIS is not installed, you cannot select 
Web Server and must deploy the application via a UNC path.
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10. Click Next.
For Web Server installations, go to the Web Server Add or Update Steps.
For From a Shared Folder installations, go to the From a Shared Folder Installation 
Steps.

Web Server Add or Update Steps
If you are adding a deployment package to a Web server, the Web server must be added to the 
Local intranet zone in Microsoft Internet Explorer. Zones are configured in Internet Explorer by 
selecting the Security tab of the Internet Options (available from the Tools menu). You must 
also Enable the following Security settings:

• Automatic prompting for file downloads
• File download
• Font download

Tip: For complete details on adding and configuring sites in the Local Intranet Zone, see the 
Microsoft Internet Explorer help files.

If you are adding or updating a Web Server deployment, the Configure Virtual Directory dialog 
is displayed:
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1. The default Deployment Folder path is displayed. Click Change to select a different 
folder.

Note: If you are updating an existing deployment, you cannot change the Deployment Folder. If 
you create a new instance with a different Deployment Folder, the old deployment is not 
updated and the package must be redeployed to client machines under the new Deployment 
Folder location.

The Deployment Folder is the folder to which the application files are copied. This 
folder is configured as a virtual directory, to be mounted by the selected web server.

Caution: Files in the Deployment Folder selected are overwritten.

2. Select the Web Site to create the virtual directory under from the drop-down select list.

Note: If you are updating an existing instance, you cannot change the Web Site.

3. Enter a name for the Virtual Directory in the field provided. This is the name of the 
virtual directory created under the web server selected.

Note: If a virtual directory with the same name already exists, the existing virtual directory is 
configured to point to the Deployment Folder selected. If you are updating an existing instance, 
you cannot change the Virtual Directory.

4. Select a Protocol from the drop-down select list. This allows you to configure the 
installed application to use the https protocol if an HTTPS binding is available.

Note: If you are updating an existing instance, you cannot change the Protocol.

5. Enter the Host Name of the Web Site selected, or accept the default host name 
presented. In some cases, such as with HTTPS bindings, the default value may need to 
be changed to match the host name in the certificate.

Note: If you are updating an existing instance, you cannot change the Host Name.
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6. Click Next. The Package Extraction dialog is displayed, which displays the progress of 
the installation.

7. Click Next when the extraction has completed. The General Settings dialog is displayed, 
but the Create Desktop Shortcuts option is only available for new deployments.

Note: The General Settings dialog is not displayed for all modules, depending on the type of 
application being deployed. For example, desktop shortcuts cannot be created for the 
Microsoft Office add-ins so the General Settings dialog is not displayed.

8. Click Next. Go to the Service Location and Deployment Configuration steps to complete 
the installation.
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From a Shared Folder Add or Update Steps
If you are adding or updating a From a Shared Folder deployment, the Configure Folder Share 
dialog is displayed:

1. The default Deployment Folder path is displayed. The Deployment Folder is the folder 
to which the application files are copied. Click Change to select a different folder.

Note: If you are updating an existing deployment, you cannot change the Deployment Folder. If 
you create a new instance with a different Deployment Folder, the old deployment is not 
updated and the package must be redeployed to client machines under the new Deployment 
Folder location.

Caution: Files in the Deployment Folder selected are overwritten.

2. Enter a Share Name in the field provided. This is the name that the Deployment Folder 
will be shared as to users.

Note: The Share Name must be unique. You cannot enter the name of an existing share. If you 
are updating an existing instance, you cannot change the Share Name.
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3. Enter the External Name of the server hosting the Deployment Folder selected, or 
accept the default value presented. This is the name users will use to access the server. 
The default value is the machine name of the machine containing the shared folder.

Note: The External Name field is only available if Advanced Mode is selected on the Welcome 
to the Deployment Creation Wizard dialog. If you are updating an existing instance, you cannot 
change the External Name.

4. Click Next. The Folder Share Permissions dialog is displayed:

This dialog allows you to add or remove the users and groups that have read access to 
the Deployment Folder. By default, the local Everyone group is given read access.

Note: Read access is required for users to be able to install and upgrade the deployed 
application.
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5. Click Add to add additional users or groups, or select a user or group to remove and 
click Remove to remove it. If the users and groups presented are acceptable, proceed to 
the next step.
If you click Add, the Select Users and Groups dialog is displayed:

Select the Domain or Workspace to find users and groups under from the drop-down 
select list, then enter a User Group or Name to search for in the field provided, and click 
Search. Leave the User or Group Name field empty to locate all available accounts.
Select the user or group to add from the Search Results, then click OK. Repeat as 
necessary to configure your Folder Share Permissions.
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6. Click Next after configuring your Folder Share Permissions. The Package Extraction 
dialog is displayed, which displays the progress of the installation.

7. Click Next when the extraction has completed. The General Settings dialog is displayed, 
but the Create Desktop Shortcuts option is only available for new deployments.

Note: The General Settings dialog is not displayed for all modules, depending on the type of 
application being deployed. For example, desktop shortcuts cannot be created for the 
Microsoft Office add-ins so the General Settings dialog is not displayed.

8. Click Next. Go to the Service Location and Deployment Configuration steps to complete 
the installation.
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Service Location and Deployment Configuration
After clicking Next on the Package Extraction or General Settings dialogs, the Service 
Location dialog is displayed.

1. Select an existing Service Location or click Add to create a new service location.
2. Update or enter in the Display Name field the name of the service location for the 

instance. 
3. Update or enter in the Service Path field the full URL to the OnBase application server 

service. For example, https://machinename/AppServer/Service.asmx.
4. Update or enter in the Data Source field the data source name for the appropriate data 

source.
5. Select Use NT / LDAP Authentication if your system uses Active Directory or LDAP 

Authentication.

Note: In order to use Active Directory or LDAP authentication, the database against which Unity 
Client runs must also be configured for Active Directory or LDAP authentication. The installer 
configures Unity Client to match the authentication scheme of the database.
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6. Select Use ADFS if your system uses AD FS (Active Directory Federation Services) 
authentication.
Selecting Use ADFS causes the remainder of the deployment to be run in Advanced 
Mode, even if Advanced Mode was not selected initially, because the configuration file 
for the module must be updated before signing and finalizing the deployment.

Note: Use ADFS is not the same Active Directory authentication scheme as Use NT/LDAP 
Authentication. The Use ADFS option is not available for all modules. If this option is not 
displayed, the module you are installing either does not support AD FS or must be manually 
configured for AD FS authentication. You cannot enable both Use ADFS and Use NT/LDAP 
Authentication. For details on configuring OnBase to use AD FS, see the Authentication 
module reference guide.

7. Click Next to proceed to the Deployment Signing dialog box. 

Note: Depending on the module being updated or added, you may be required to complete 
information in additional dialogs specific to the module. See the main installation steps above 
for information on any additional dialogs or steps that must be completed before signing the 
deployment.
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8. At the Deployment Signing dialog, select the appropriate signing method.

When Sign from Test Certificate is selected, a test certificate with the Common Name 
localhost is used. This test certificate is packaged with all ClickOnce installers. For 
security purposes, it is strongly recommended that this certificate remain un-trusted. 
This does not mean the certificate cannot be used, simply that when users attempt to 
launch the ClickOnce link, they are prompted with a message stating that the publisher 
could not be verified.
When Sign from Certificate User Store is selected, certificates from the current user 
store are listed under this option. If there are any certificates in the current user store, 
they can be used for signing here. Only certificates purposed for code signing are valid.
When Sign from File is selected, the deployment is signed using the PFX file entered in 
the corresponding field. Only certificates purposed for code signing are valid.

Caution: Any necessary changes to the files in the deployment folder or the contents of the 
deployment folder, such as custom changes to the *.config file for the module, must be made 
before clicking Next at the Deployment Signing dialog box. If you are not in advanced mode, 
you must access the files directly by navigating to the deployment location before clicking Next 
and signing the deployment.
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9. Click Next. If you are in Advanced Mode, the File Edit Notification dialog box is 
displayed.

From this dialog box you can open the deployment folder by clicking Open Deployment 
Folder. At this time, any necessary changes to the files in the folder or the contents of 
the folder should be made. Upon clicking OK, the folder is signed and cannot be 
modified without updating the deployment instance. Clicking Cancel returns you to the 
signing screen.

10. Click OK. The application is deployed and the Summary dialog is displayed upon 
completion.
Clicking the link provided under Success launches the application. This is the same as 
the full path that external users must use to install and launch the application. 
Click Copy Link To Clipboard to copy this link to the clipboard. 

11. Click Finish.

Automatically Launching a Deployed Application at 
System Startup

In order to launch a deployed application automatically at startup, Service Mode must be 
enabled. Unity Client is configured to start in Service Mode by default.

If the application has been redeployed, the application upgrade will automatically be 
downloaded at startup.

Removing a Deployed Application
Deployed applications are installed to both client workstations and the deployment server. This 
section describes how to remove a deployed application instance from both the client 
workstations and deployment server, or completely removing the deployed application and all 
installed instances.
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Removing a Deployed Application Instance from Client 
Workstations
To remove a deployed application instance from a client workstation:

1. Access the Windows Control Panel by selecting Start | Control Panel on the Windows 
desktop.

2. Double click Add or Remove Programs. The Add or Remove Programs dialog is 
displayed.

3. Locate the installed application in the list of programs (e.g., Hyland Unity Client 
[Instance Name]).

4. Select the program and click Change/Remove. The deployed application Maintenance 
dialog is displayed.

5. Select Remove the application from this computer.
6. Click OK.

The installed application is removed from the workstation.

Note: Removing the application instance from client workstations does not remove the 
application instance from the deployment server. Users can re-install a removed application 
instance by following the original link to the instance. To completely remove a deployed 
application instance, see Removing a Deployed Application Instance from the Deployment 
Server or Completely Removing a Deployed Application below.

Removing a Deployed Application Instance from the 
Deployment Server
If a deployed application instance is removed from all client workstations, it can be re-installed 
by users who follow the link to the deployed application instance, unless the instance is also 
removed from the deployment server.

To remove an instance of a deployed application in order to reset the version and/or re-use an 
instance name:

1. Access the Windows Registry (enter regedit in the Windows Start | Run dialog). The 
Registry Editor dialog is displayed.

Caution: Modify the registry at your own risk. Incorrectly editing the Windows registry can 
cause serious problems that may require you to reinstall your operating system. Be sure to 
back up the registry before making any changes to it. For more registry information, see the 
following Microsoft articles: http://support.microsoft.com/kb/256986 and http://
technet.microsoft.com/en-us/library/cc725612.aspx

2. Expand the following registry key: 
HKEY_LOCAL_MACHINE\SOFTWARE\Hyland\Deployment
Under 64-bit systems this key may be located at: 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Hyland\Deployment
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3. Expand the subkey that corresponds to the deployed application you want to remove the 
instance from (for example, ApplicationEnabler or ReportServices).

4. Right click the subkey that corresponds to the instance name you want to remove.
5. Select Delete.
6. Click Yes at the confirmation prompt. The deleted instance is no longer available in the 

Deployment Wizard.
7. Locate the files for the instance to remove on the deployment server. 

The location of the files depends on the location selected during installation. In a 
default, 32-bit installation, the files are located at C:\Program 
Files\Hyland\[ApplicationName]\[InstanceName]\ (for example, C:\Program 
Files\Hyland\ApplicationEnabler\MyAppEnablerInstance\).

8. Delete all of the files and folders contained in the instance folder, or delete the entire 
instance folder. The application is no longer available for installation.

Caution: Take care to delete only the folder for the instance you are removing. Deleting the 
application folder will remove all instances of the deployed application.

Note: If the instance files are not removed from the deployment server, the application 
instance can still be installed by users who follow the link to the deployed application.

9. Follow the steps above to remove the installed instance from all client workstations 
(see, Removing a Deployed Application Instance from Client Workstations).

Note: Until the instance is removed from client workstations, the application instance can still 
be used by client workstations, even if it is removed from the deployment server.

Completely Removing a Deployed Application
To completely remove a deployed application:

1. Follow the steps above to remove all instances of the deployed application from the 
deployment server (see, Removing a Deployed Application Instance from the 
Deployment Server).

2. Access the Windows Control Panel by selecting Start | Control Panel on the Windows 
desktop.

3. Double click Add or Remove Programs. The Add or Remove Programs dialog is 
displayed.

4. Locate the installed application in the list of programs (e.g., Hyland Unity Client or 
Hyland Unity Client Deployment).

5. Select the application and click Change/Remove. The application and deployment 
package is removed.

Note: Removing the last deployed application from the deployment server also removes the 
Deployment Wizard from the deployment server.
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6. Follow the steps above to remove all instances of the deployed application from all 
client workstations (see, Removing a Deployed Application Instance from Client 
Workstations).

Note: Until all instances of the application are removed from client workstations, the 
application can still be used by client workstations, even if it is removed from the deployment 
server.

Manual Installation
To install the OnBase Unity Client manually:

1. Copy the ..\apps\Unity Client folder from your OnBase Core Services build.
2. Paste this folder to a location on the workstation where you are installing the Unity 

Client.
3. Navigate to the location where you pasted the Unity Client folder.
4. Open obunity.exe.config.
5. Configure the following settings in the <ServiceLocations> section:

Note: Within the Unity Client, Unicode characters are only supported in data source names and 
FriendlyName contexts if the Unity Client configuration file is saved with Unicode encoding.

Setting Name Description

ServicePath The URL to the Service.asmx page of the Application Server.
For example, http://[Application Server]/appserver/service.asmx.

DataSource The data source name (configured at the Application Server) to connect 
to.
For example, OnBase.

FriendlyName The "friendly name" of the service location. This name is displayed in 
the Unity Client’s title bar.
For example, OnBase.

UseNTAuthentication When set to true, the Unity Client is configured to use Active Directory 
or LDAP Authentication.

DefaultDomain The name of the domain to use by default.
For example, mydomain.com.
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6. Configure additional settings if necessary. See The Unity Client Configuration File on 
page 368 for more information.

7. Save and close obunity.exe.config.

Running Multiple Instances of the Unity Client
You can run multiple instances of the Unity Client when, for example, you want to test out a 
different Unity Client configuration. You can run multiple instances of the Unity Client only 
when they are installed to different locations on the workstation. You cannot run multiple 
instances of the same Unity Client installation.

Note: When running multiple instances of the Unity Client, only a single instance can run in 
Service Mode, across all Unity Client deployments.

Backup/Recovery

Window Settings
Unity Client window position settings are saved for each user in the window.settings file.

The default location of the window.settings file for Windows 7, Windows 8.1, and Windows 10 
is C:\Users\[user]\AppData\Local\Hyland Software, Inc\Hyland.Canvas\window.settings.

Frequently Asked Questions
1. Which OnBase setting determines the time allotment for a user working within the 

Unity Client?
The Enable Timeout setting, in the OnBase Configuration module, determines the time 
allotment for users working within the Unity Client and many modules that access 
OnBase through the Unity Client, such as Application Enabler.

UseADFS When set to true, the Unity Client is configured to use ADFS 
Authentication. 
Additional steps must be taken to configure ADFS Authentication in the 
Unity Client. For more information, see the Authentication module 
reference guide.

Note: If UseADFS is set to true, UseNTAuthentication must be set to 
false.

Setting Name Description
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Troubleshooting

Note: A poor network connection may result in general errors and performance issues in the 
Unity Client. When troubleshooting, begin by ensuring that your network connection is stable 
and of the highest quality.

Cannot Start Application
When attempting to install a module to a client machine using a ClickOnce deployment, the 
Cannot Start Application dialog may be displayed with the message: Application validation did 
not succeed. Unable to continue.

This error occurs when a deployment file for the application is modified after the deployment 
was created. To resolve this error, you must create a new deployment of the application using 
the Deployment Wizard. See the Updating or Adding a Deployment Instance section of this 
module reference guide for details. 

Note: When updating an existing deployment, make sure you select the appropriate module, as 
well as the Instance Name that corresponds to the instance that generated the error.

Display
When working in a dual monitor environment and the right monitor is the primary monitor, the 
Unity Client displays the title bar partially off screen.

Resolution: Use the left monitor as the primary monitor. After opening the Unity Client, drag it 
to your left monitor. The next time you launch the Unity Client, it will be displayed in the left 
monitor.

External Email

The Body of Notifications is Blank
If the Use Native Mail Dialog option is not selected, meaning the OnBase Mail Message dialog 
box is used, and HTML is the default format for messages, the body of notifications may not be 
populated correctly. It is a best practice to set the default format to Plain Text or Rich Text to 
ensure that notification messages from OnBase are populated correctly.
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Exception Has Been Thrown by the Target of an Invocation
When attempting to send an external email in the Unity Client using Microsoft Outlook, the 
following message is displayed: Exception has been thrown by the target of an invocation. 
Clicking Show Details displays the following: System.Reflection.TargetInvocationException: 
Exception has been thrown by the target of an invocation. ---> 
Hyland.Canvas.Controls.MissingPrerequisiteException: Microsoft Office and the Microsoft 
Office Primary Interop Assemblies must be installed to use this feature. Please install the 
required prerequisites and try again.

Resolution: The .NET Programmability Support feature was not installed with Microsoft 
Outlook. Use the Windows Control Panel to modify your Outlook installation to include .NET 
Programmability Support.

One or More of the Selected Documents Could Not Be Sent
When attempting to send an external email in the Unity Client using Microsoft Outlook, the 
following message is displayed: One or more of the selected documents could not be sent. 
Clicking Show Details displays the following: The attachment size exceeds the allowable limit 
[OnBase document’s Auto-Name string].

Resolution: This issue occurs because the size of the OnBase documents attached to the 
external email message exceed the mail system's attachment size limitation. When sending 
multiple documents, those documents with a cumulative size less than the mail system's 
attachment size limitation will be attached to the email message. Documents whose size will 
cause the email message to exceed the mail system's attachment size limitation will not be 
attached.

Unity Pop File Is Not Valid for the System
When attempting to open a Unity Pop file attached to an email message, a message is 
displayed stating that the Unity Pop file is not valid for the system.

Resolution: This issue occurs because the Unity Pop file is being launched against a different 
database than it was sourced from. For example, a Unity Pop file was created in database 1. A 
user logged on to database 2 will not be able to open this file. Because Unity Pop files do not 
include database information, if users will be accessing multiple OnBase databases with one 
Unity Client, consider using DocPop instead of Unity Pop.

You Do Not Have Privileges to View This Document
When attempting to open a Unity Pop file, the following message is displayed: You do not have 
privileges to view this document. An object reference not set to an instance of an object 
message is logged in the Diagnostics Console.

Resolution: The document no longer exists in OnBase.

Open or Save an EML Document
No prompt to open or save an EML document is presented.
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Resolution: Ensure a mail client is correctly installed. Without the mail client, the EML file type 
is not recognized.

Page Could Not Be Displayed
When you attempt to send documents as external email attachments, a This page cannot be 
displayed error is returned rather than the email draft being opened. This behavior is often 
sporadic, and affects systems using Internet Explorer as the default web browser.

Resolution: Add the secure URI being passed to the web browser to Internet Explorer’s list of 
Trusted Sites. 

Logging On
Microsoft SQL Server Compact Edition (CE)

When using a machine that previously had Microsoft SQL Server Compact Edition (CE) 
installed, you are unable to log on to the Unity Client.

Resolution: Remove the legacy registry entries for Microsoft SQL Server CE.

Caution: Modify the registry at your own risk. Incorrectly editing the Windows registry can 
cause serious problems that may require you to reinstall your operating system. Be sure to 
back up the registry before making any changes to it. For more registry information, see the 
following Microsoft articles: http://support.microsoft.com/kb/256986 and http://
technet.microsoft.com/en-us/library/cc725612.aspx

These registry entries are located at HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft 
SQL Server Compact Edition\v3.5 (32-bit operating systems) or 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Microsoft SQL Server 
Compact Edition\v3.5 (64-bit operating systems).

Initialization Error
An Initialization Error WMI (Windows Management Instrumentation) corruption error message 
is displayed when attempting to log on to the Unity Client.

Resolution: Navigate to the ..system32\wbem\ folder on the workstation and delete the 
Repository directory. Restart the Windows Management Instrumentation Windows Service as, 
and well as any dependent Windows Services.

Scanning

When issues arise during scanning in the Unity Client, the LowTwainMode setting can be used 
in troubleshooting.
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When enabled, this setting allows the following scanner settings to be saved at the local 
workstation level: Duplex, auto feed, color format, brightness, contrast, paper size, orientation, 
rotation, threshold, xres, and yres. Other settings are retained only for the duration of the scan 
session.

When LowTwainMode is disabled, the Unity Client attempts to configure all scanner settings at 
once.

To enable LowTwainMode, add the following to the appSettings section of the Unity Client 
configuration file:

<add key="lowTwainMode" value="true" /> 

To disable this setting, change the lowTwainMode key’s value to false.

Note: Once LowTwainMode is enabled, it will only take effect on newly created scan formats. 
Existing scan formats must be recreated to exhibit the LowTwainMode behavior.

Working with Documents

Created in a Newer Version of Word
When a Microsoft Word 2007 document (.docx) is opened in the Unity Client on a machine with 
Microsoft Office 2003 and an older version of the Office Compatibility Pack, the following 
conversion warning message is displayed: Because this file was created in a newer version of 
Word, it has been converted to a format that you can work with. This conversion warning 
message may be displayed behind the Unity Client window, making it difficult to detect.

Resolution: Update the Office Compatibility Pack to a version that provides the ability to 
suppress this message. For more information, see http://support.microsoft.com/kb/936695.

There Was an Error Opening This File
When uploading or opening a document, the following message is displayed: There was an 
error opening this file.

Resolution: Ensure that the document is in the Document Type’s default file format.

Excel Ribbon Is Reset to the Home Tab
When multiple Microsoft Excel documents are open in the Unity Client, the Excel ribbon is reset 
to the Home tab each time you switch between documents.

Resolution: This is a known issue when working with multiple Microsoft Excel documents 
simultaneously in the Unity Client.
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Opening a Modal Dialog Box
When multiple Microsoft Word or Excel documents are open in the Unity Client, opening a 
modal dialog box (e.g., Word’s Font dialog box) in one document does not allow you to perform 
work on the other document. Closing the modal dialog box allows you to perform work on the 
other document.

Resolution: This is a known issue when working with multiple Microsoft Word or Excel 
documents simultaneously in the Unity Client.

Unable to Use Microsoft Excel Outside of the Unity Client
Viewing a Microsoft Excel document in the Unity Client takes focus away from the Microsoft 
Excel application. When an Excel document is open in the Unity Client, you are unable to use 
Microsoft Excel outside of the Unity Client.

Resolution: This is a known issue when working with Excel documents in the Unity Client. When 
an Excel document is open in the Unity Client, you are unable to use Microsoft Excel outside of 
the Unity Client until the Excel document in the Unity Client is closed.

Attempt to Access Invalid Address
When a cell in the Microsoft Excel application is being edited, opening a Microsoft Excel 
document in the Unity Client displays the following message: Attempt to access invalid 
address.

Resolution: Click Ignore and close the Microsoft Excel document in the Unity Client. In the 
Microsoft Excel application, navigate to a different cell. In the Unity Client, reopen the Microsoft 
Excel document.

Exception Has Been Thrown by the Target of an Invocation
When attempting to view a document in the Unity Client, the following error is displayed: 
Exception has been thrown by the target of an invocation.

Resolution: Ensure the Unity Client is the same version and build as the Application Server. The 
Unity Client version and build is displayed in the login screen’s Build Version field. You can also 
view the version and build by right-clicking the Unity Client executable file and selecting 
Properties. The version and build is displayed in the Product version field on the Details tab.

If this error is encountered when attempting to view a Microsoft Office document in the Unity 
Client, ensure that either Microsoft Office is installed on the workstation, or the WOPI Server is 
installed and configured to integrate with a valid Microsoft Office Online Server.

Characters Appear Cut Off in Text Documents
Text documents viewed in the Unity Client may display a different number of characters per line 
than those viewed in the OnBase Client.
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Resolution: This inconsistency occurs because text documents are rendered as images in the 
Unity Client. In the OnBase Client, text documents are rendered as text. In the Unity Client, the 
number of characters displayed per line is controlled by the Characters per line setting for the 
Document Type. For example, if the Characters per line setting is 132, only characters 1-132 
are displayed for text documents in the Unity Client. The Characters per line setting is 
accessed by clicking View/Print from the Document Types dialog box in the Configuration 
module.

Unity Client Becomes Unresponsive When Scrolling
When Microsoft Excel documents are open in the Unity Client, hovering over a document that is 
not in focus and attempting to scroll causes the Unity Client to become unresponsive.

Resolution: In Windows 10, the ability to scroll inactive windows when hovering over them was 
introduced, and this feature is not compatible with Microsoft Excel. To avoid encountering this 
issue, disable the Scroll inactive windows when I hover over them Windows setting.

Notes, Redactions, Burned Markups, and Deficiencies on 
Documents with Overlays

Notes, redactions, burned markups, and deficiencies on documents that have an overlay 
applied may encounter unexpected behavior. The position of notes, redactions, burned 
markups, and deficiencies may shift when the document is rendered.

The position shift may occur in the following instances:
• Text documents that contain overlays with an offset configured
• Text documents accessed using modules that render text documents as an image 

for display
• Image documents with overlays that do not have the same DPI or dimensions as the 

document

Caution: If a redaction, burned markup, or deficiency appears in a shifted position, do not save 
or sign the document until the shift has been corrected. Saving or signing the document will 
permanently place the redaction, burned markup, or deficiency in the shifted position. The 
position shift of notes that do not permanently alter the document can be corrected at any 
time.

When setting up overlays for documents that may also include notes, redactions, burned 
markups, or deficiencies:

• Ensure the dimensions of the overlay match the dimensions of the document.
• Do not use offsets with overlays if the document may also contain notes, redactions, 

burned markups, or deficiencies.
• For text documents, use 96 DPI for overlays.
• For image documents, ensure the DPI of the overlay matches the DPI of the 

document.
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A position shift can be corrected through the following methods:
• For text documents, recreate the overlay to match the dimensions of the document 

instead of using an offset. For example, add empty space to the margin of the 
overlay instead of using an offset to account for this space.

• For text documents, it is considered a best practice to set the DPI of the overlay to 96 
DPI. Some OnBase modules render text documents as an image for display, and in 
most cases, the image is rendered at 96 DPI.

• For image documents, recreate the overlay to match the DPI and dimensions of the 
document.

If the issue still occurs, contact your first line of support.

Contacting Support
When contacting your solution provider, please provide the following information:

• The OnBase module where the issue was encountered.
• The OnBase version and build (Example: 18.0.0.10).
• The type and version of the connected database, such as Microsoft SQL Server 2014 

or Oracle 12c, and any Service Packs that have been installed.
• The operating system that the workstation is running on, such as Windows 10 or 

Windows Server 2012 R2, and any Service Packs that have been installed. Check the 
supported operating systems for this module to ensure that the operating system is 
supported.

• The name and version of any application related to the issue.
• The version of Internet Explorer, and any Service Packs that have been installed, if 

applicable.
• A complete description of the problem, including actions leading up to the issue.
• Screenshots of any error messages.

Supplied with the above information, your solution provider can better assist you in correcting 
the issue.
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SYSTEM ASSESSMENT TOOL
The System Assessment Tool helps to ensure that workstations meet the minimum system 
requirements for the OnBase Client, Unity Client, and Web and Application Servers. It is an 
optional tool that can be used when deploying or upgrading workstations to the current version 
of OnBase.

Using the System Assessment Tool

To run the System Assessment Tool:

1. Navigate to the SAT folder of your OnBase Client or OnBase Core Services build.
2. Double-click System Assessment Tool.exe.
3. The System Assessment Results page is opened in a web browser.
4. Results are returned in two sections:

• Client Report - This section checks the workstation’s components against the 
OnBase Client and Unity Client minimum requirements. It contains the following 
results:

Component Description

Operating System The operating system installed on the workstation.

CPU The speed of the workstation’s CPU.

RAM The amount of RAM on the workstation.

Free Hard Disk Space The amount of free hard disk space on the workstation.

Video Memory The amount of video memory on the workstation.

.NET Framework Whether or not the required Microsoft .NET Framework 
is installed on the workstation.

Internet Browser The Internet browser installed on the workstation.

Visual C++ Redistributable Whether or not the required Microsoft Visual C++ 
Redistributable Package is installed on the workstation.
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• Server Report - This section checks the workstation’s components against the 
OnBase Web/Application Server minimum requirements. It contains the following 
results:

5. One of the following statuses is displayed next to each component:

Note: The description for each PASS component indicates whether the component meets the 
minimum requirement or the recommended requirement.

Component Description

Operating System The operating system installed on the workstation.

CPU The speed of the workstation’s CPU.

RAM The amount of RAM on the workstation.

Free Hard Disk Space The amount of free hard disk space on the workstation.

.NET Framework Whether or not the required Microsoft .NET Framework 
is installed on the workstation.

Internet Browser The Internet browser installed on the workstation.

Visual C++ Redistributable Whether or not the required Microsoft Visual C++ 
Redistributable Package is installed on the workstation.

Status Description

PASS This component meets or exceeds the minimum requirement.

FAIL This component does not meet the minimum requirement.
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BEST PRACTICES
The following best practice recommendations have been assembled by a team of OnBase 
subject matter experts. They represent the accumulation of years of experience installing and 
configuring OnBase solutions.

The following recommendations are general in nature, and are applicable to most OnBase 
solutions and network environments. Depending on your solution design and your 
organization’s needs, not all of the best practice recommendations listed below may apply to, 
or be recommended for, your OnBase solution.

Carefully consider the impact of making any changes, including those listed below, to your 
OnBase solution prior to implementing them in a production environment.

DocPop and Unity Pop

Note: This section applies to working with OnBase through the Unity Client and Web Client.

DocPop and Upop serve similar purposes, but they are not interchangeable. There are 
situations where one Pop integration should be used over the other.

Upop assumes that users have the Unity Client installed, are operating the Unity Client in 
Service Mode, and have user accounts in OnBase. Upop may be recommended for a Unity Client 
installation or where Upop provides additional benefits over DocPop.

• Use DocPop if the Unity Client will not be installed on users’ workstations. DocPop 
requires no OnBase software on the user’s workstation, whereas Upop requires the 
Unity Client. 

• Use DocPop if Macintosh users require access to OnBase. Upop cannot run on a 
Macintosh operating system. In environments where only some users have the Unity 
Client installed, use DocPop to ensure all users can view documents.

• Use DocPop for unauthenticated integrations or where OnBase documents are 
available to the public. For example, Upop should not be used to provide public 
access to documents from a county Web site, because most public users would not 
have the Unity Client installed on their workstations.

• Use Upop if users send external email messages from the Unity Client only to other 
users who have the Unity Client installed on their workstations. Use DocPop if 
messages are sent to users who may or may not have the Unity Client installed.

Network Connectivity
The Unity Client is a “connected” client. A poor network connection may result in errors or 
performance issues.
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Document Retrieval

Dates
It is considered a best practice to select a document date or range of document dates from the 
Dates panel when retrieving documents. Selecting a document date or range of document 
dates expedites document retrieval.

Drop-Down Lists
When a Keyword Type is configured with a drop-down list, it is considered a best practice to 
type any known characters in the Keyword Value field before clicking the drop-down list icon. 
OnBase automatically appends a wildcard to the end of the string of known characters, and 
filters the available values from the drop-down list accordingly.

Wildcards
Wildcard searches impose extensive database load, and can negatively impact other users. 
Wildcard searches often generate a Document Search Results list that is much larger than 
necessary, and is not useful.

To ensure high database performance and execute queries more efficiently, the following are 
considered best practices for using wildcards when searching:

• Only use leading wildcards in searches when attempting to retrieve documents with 
complex or misspelled Keyword Values.

• Provide as many known characters as possible before using a wildcard, preferably 
four or more.

Importing

Text Documents
To ensure correct functionality for all text documents, it is considered a best practice to 
remove all Tab characters from text documents before importing them into OnBase. Tab 
characters that are not removed are converted to spaces when imported into OnBase.
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Multi-Instance Keyword Type Groups
When duplicating a Multi-Instance Keyword Type Group, it is considered a best practice to 
index all Keyword Values in the Multi-Instance Keyword Type Group, even if only one Keyword 
Value is different between the original Multi-Instance Keyword Type Group and the duplicate 
Multi-Instance Keyword Type Group.
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QUICK REFERENCE GUIDE
The following Quick Reference Guides are designed to serve as resources you can quickly 
reference for the available keyboard shortcuts and general usage of the Unity Client.
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Keyboard Shortcuts  Quick Reference Guide
Note: For each shortcut, press all keys at the same time.

Global
Alt When on the Home tab, shows shortcut 

keys for the ribbon tabs and File menu.
Note: The functionality of shortcuts using
Alt may vary depending upon the active
window, tab, or pane.

F1 Accesses the help files.
Alt + Space Opens the system menu for minimizing, 

maximizing, and restoring the program.
Alt + F4 Closes the program.

Main Window
Ctrl + M Opens the Home layout.
Ctrl + Q Opens the Custom Queries layout.
Ctrl + R Opens the Document Retrieval layout.
Ctrl + E Opens the Forms layout.
Ctrl + N Opens the current layout in a new 

window.
F8 Opens the Import layout.

Data Lists
Ctrl Hold to select multiple items in a list.
Ctrl + A Selects all items in a list.
Ctrl + Shift + End Selects all items below the selected item 

in a list, including the selected item.
Ctrl + Shift + 
Home

Selects all items above the selected 
item in a list, including the selected item.

Keywords
F3 Changes the operator for the selected 

Keyword Type.
F4 Changes the connector for the selected 

Keyword Type.
F5 Shows the drop-down select list for the 

selected Keyword Type.
F6 Adds another value for a Keyword Type.
Ctrl + O Collapse or expand any Multi-Instance 

Keyword Type Group.

Re-Indexing
Esc Closes the Re-Index pane.

Import Layout
Ctrl + O Opens the Browse dialog.
Ctrl + S Uploads the document.
Esc Cancels the upload and clears the Import 

pane.
Ctrl + Shift Up Moves the page open in the Import 

Preview pane up.
Ctrl + Shift 
Down

Moves the page open in the Import 
Preview pane down.

Delete Removes the currently selected page in 
the Import Preview pane.
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Ctrl + Delete Removes all pages.
Ctrl + Left Rotates the page counter clockwise.
Ctrl + Right Rotates the page clockwise.

Document Viewer
Ctrl + H Opens the Document History dialog.
Ctrl + P Opens the Print pane.
Ctrl + K Opens the Add/Modify Keywords pane.
Ctrl + W Opens the Cross-References pane.
Ctrl + U Toggles the thumbnail display.
Ctrl + O Toggles text overlay when working with 

image documents.
Ctrl + Mouse 
Wheel Up or Ctrl 
and +

Zooms in on the document.
Note: Ctrl + is not usable when working
within a text document. Use the Ctrl Mouse
Wheel Up shortcut to zoom in on text
documents.

Ctrl + Mouse 
Wheel Down or 
Ctrl and -

Zooms out on the document. 
Note: Ctrl - is not usable when working
within a text document. Use the Ctrl Mouse
Wheel Down shortcut to zoom out on text
documents.

Ctrl + Page Up 
or F11

Displays the previous page in a multi-
page document.

Ctrl + Page 
Down or F12

Displays the next page in a multi-page 
document.

Ctrl + Home Displays the first page in a multi-page 
document.

Ctrl + End Displays the last page in a multi-page 
document.

Ctrl + Shift + 
Page Up

Displays the previous document in the 
Document Search Results list.

Ctrl + Shift + 
Page Down

Displays the next document in the 
Document Search Results list.

Ctrl + G Opens the Go to Page dialog box.
Ctrl + Right 
Arrow

Rotates the currently selected pages 90 
degrees clockwise.

Ctrl + Left Arrow Rotates the currently selected pages 90 
degrees counterclockwise.

Crtl + Down 
Arrow

Rotates the currently selected pages 
180 degrees.

Document Separation
Delete Deletes selected pages.
Esc Exits the Document Separation layout 

without saving changes.
Ctrl + S Saves selected documents.
Ctrl + H Flips selected pages horizontally.
Ctrl + . Rotates selected pages right.
Ctrl + , Rotates selected pages left.

Import Layout
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Ctrl + J Joins selected pages.
Note: This operation is only used in Page
Display Mode.

Alt and + Copies the selected document.
Ctrl and + Copies selected pages in new 

document.
Ctrl and Shift 
and +

Copies selected pages in place.

Ctrl + C Copies individual pages to the clipboard.
Ctrl + X Cuts individual pages.
Ctrl + V Pastes individual pages.
Shift + Click Selects all pages between two selected 

pages. Shift must be held while clicking.
Ctrl + Click Selects or deselects a page without 

deselecting other pages or documents.
Ctrl + Drag Copies the page being dragged and 

dropped instead of moving the page to 
the new insertion point.
Note: This operation is only used in
Document Display Mode.

Ctrl + Shift Selects multiple page ranges in multiple 
documents. These buttons must be held 
while clicking.
Note: This operation is only used in
Document Display Mode.

Ctrl + Delete Enters Delete Mode.
Alt + Home Scrolls to the first selected page of a 

document, if not already in view.
Up Arrow / Page 
Up

Scrolls up in the Separation Workspace.
Note: This operation is only used in
Document Display Mode.

Down Arrow / 
Page Down

Scrolls down in the Separation 
Workspace.
Note: This operation is only used in
Document Display Mode.

Ctrl + Mouse 
Wheel Up

Zooms in on the page open in Detailed 
View.

Ctrl + Mouse 
Wheel Down

Zooms out on the page open in Detailed 
View.

Ctrl + Left Arrow Rotates the page open in Detailed View 
90 degrees counterclockwise.

Ctrl + Right 
Arrow

Rotates the page open in Detailed View 
90 degrees clockwise.

Document Separation
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Access the End-User Help Files
The Unity Client includes help files for end-users. These can be 
referenced at any time in the Unity Client either by pressing the 
F1 button on your keyboard, or by clicking the Help button:

The help files are opened in a separate window. 

Set Your Home Page
The Home button takes you to your configured Home Page.

To set a layout to be your Home Page, navigate to the desired 
layout and select Make this layout my Home Page from the 
Home button drop-down menu.

To reset your Home Page to the default, select Reset Home 
Page from the Home button drop-down menu.

Add Favorites
You can add the currently displayed layout to your list of 
favorites by performing the following steps:
1. Click the Favorites button:

2. Click Add this layout to my favorites.
The favorite can be accessed by clicking the Favorites 
button again and selecting the favorite from the list.

Use the Personal Page
Many OnBase items and layouts can be added to your Personal 
Page as tiles. Tiles serve as easy access points to the files, 
items, and interfaces of your choice.

The Personal Page can be opened by clicking the Personal Page 
ribbon button:
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To add an item or layout to the Personal Page, right-click the 
object and select Add To Personal Page. If the right-click option 
is unavailable, the Personal Page option may be included under 
the Send To functions or, as is the case with Custom Query 
results, as a special menu option to Add to Personal Page. 

When adding an entire layout to your Personal Page, select 
Personal Page | Add this layout to my Personal Page from the 
ribbon menu.

Document Retrieval
You can retrieve documents in the Unity Client based on the 
document’s keyword values, the text contained within the 
document, or the note information contained on a document. 
The following example describes how to retrieve documents 
based on their keyword values.
To access Document Retrieval:
1. In the Documents ribbon group on the Home tab, click 

Retrieval.

2. In the Document Retrieval pane, select a Document Type 
Group.
Select a Document Type.

Note: The information contained in the panel may dynamically
change based on the Document Type Group or Document Type
you selected.
3. If desired, you can specify a date range to only return 

documents that were created or imported between a 
certain range of dates.

4. A list of keyword fields displays below the date range.

Enter values for the keywords that are displayed. You can 
enter as much or as little information you know.
Note: Some searches require you to enter at least one keyword
value. Search requirements are determined by your system
administrator.
5. When you have entered all search criteria, click the Find 

button at the bottom of the panel.

Use the Personal Page (Continued)
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The Search Results are displayed in a list on the right side 
of the screen.

6. Double-click a document from the list to open it. 

Import Documents
To import documents in the Unity Client:
1. In the Create ribbon group on the Home tab, click Import.

The Import layout is displayed.
2. Select the document you want to import by doing one of 

the following actions:
• Browse to the file location of the document you are 

importing by clicking the Browse button,
• Scan a document, or import a document image from 

another supported digital storage device such as a 
scanner or camera, by clicking the Acquire button,

• If configured, select a document stored or created in 
Google Drive by clicking the Drive button, or 

• Drag and drop the file you want to import into the white 
space next to the Import pane.

3. Select a Document Type Group for the document.
Select a Document Type for the document.

4. Enter all of the necessary keyword values in each field.
5. When you are finished entering the necessary keyword 

values, click the Import button to import the document into 
OnBase:

Document Separation
Image and PDF documents can be manipulated in the 
Document Separation layout. Documents and their individual 
pages can undergo multiple editing processes in this layout 
such as splitting, joining, rotation, and copying. Documents can 
be deleted or created within Document Separation. Pages can 
be dragged to different documents, or to an empty area to 
create a new document.

Document Retrieval (Continued)
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To send one or more documents to Document Separation, 
select Split from the Re-Index pane, the Edit Pages button in the 
Image tab of an open document, the Send To | Document 
Separation option from the ribbon or right-click menu, or drag 
and drop the document(s) into an existing Document 
Separation window.
To switch between Document Display Mode and Page Display 
Mode, toggle the Group by Documents button:

 

D

Keep important pages separate while reorganizing and editing 
documents by dragging them to the Page Holder.
Double-click a page to open it in Detailed View, which allows for 
full-scale viewing, rotation, and flipping.
Click Join to join two or more documents through the Merge 
Documents, Join Pages, or Append After Page options.

Click Split to separate a document through the Split or Break 
into Documents options.

The thumbnails within Document Separation can be adjusted by 
accessing the Thumbnail Settings from the ribbon menu.

Envelopes
Envelopes are collections of documents that you can compile 
and share with other OnBase users. Any document can be put 
into an envelope, regardless of content or Document Type.
Envelopes can be created and viewed by clicking the Envelopes 
ribbon button on the Home tab.

Select an envelope to view its contents.
If you would like to share an envelope with other users, select 
the desired envelope and click Share Envelope.

Selected Users are the users sharing the envelope with you. 
Users can have Full Control over the envelope, can be permitted 
to Add to Envelope and/or Remove from Envelope, or can just be 
allowed to view the envelope contents. Adjust user permissions 
as needed.

Document Separation (Continued)
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User Options
System functionality and appearance can be customized in the 
User Options. The User Options dialog is accessed through the 
User Options button in the File Menu.

General Unity Client behavior and display features, Document 
display options, Document Import options, Printing options, 
Retrieval Date options, and Service Mode options can be set 
here.
Note: The Service Mode tab is only available when the Unity
Client is running in Service Mode.
Note: Some User Options may be enforced by an administrator-
designated User Option Policy.
To apply User Options: 
1. Select the desired options in each tab. Selection controls 

for options vary (check boxes, text fields in which you can 
insert a number or date range, etc.). 

2. After you have selected the appropriate options, click Save 
to save your changes and to close the User Options 
dialog.

Generate CSV Files
Document Search Results lists can be exported as .csv files. 
CSV files can contain metadata pertinent to the documents 
included. Keywords, DocPop URLs, and Document Dates are 
examples of information fields that can be included in your CSV 
output.
Note: CSV files cannot be generated from Full Text Search
result lists. 
To generate a CSV file:
1. Right-click within a Document Search Results list and 

select Generate CSV File. The Generate CSV File window 
is displayed.

2. Configure your file as desired.The document Range and 
resulting Columns within the CSV file can be adjusted 
here.

3. In the Save to File field, enter the name and location that 
will be used to save the CSV file. You can select Browse to 
navigate to the correct location.

4. Click Launch Associated Application if you would like to 
view the CSV file after you click Generate. The file will be 
opened by your default CSV application.

5. Click Generate. The CSV file has been created at the 
specified location.
Or click Cancel to cancel the process and return to the 
search results list.
OnBase 18
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Send Mail
Internal mail messages can be sent to other OnBase users. 
Documents and folders can be sent within the Unity Client to 
other users. If you need to send documents to non-OnBase 
users, external mail messages can contain documents as 
attachments, or can include documents, folders, Custom Query 
Results, E-Forms, and Unity Form Creation pages as Unity Pop 
Links or Unity Pop Files. Recipients of Unity Pop Links and Files 
must be OnBase users.
Send To | Internal User

Selecting this option will allow you to send the selected or 
open document or folder to another OnBase user. A new mail 
message dialog is displayed and recipients, attachments, 
and message body text can be edited as needed.

Received internal mail messages can be checked by clicking 
the Mailbox button in the ribbon menu.
Send to | Mail Recipient

Selecting one of the two Mail Recipient options will allow you 
to send the selected or open item to a user outside of 
OnBase.
Note: A functional, supported email client is required to send
OnBase items externally.

Selecting Send to | Mail Recipient (as Attachment) will attach 
the document(s) to a new message dialog in your configured 
external email client.

Selecting Send to | Mail Recipient (as Link) opens a blank 
email message containing a link to the item(s) or XML file 
that references the content in OnBase, depending on your 
configuration.

Document List Organization
Document lists can be organized to better suit your needs. Lists 
can be organized through grouping, sorting, column reordering 
and stacking, and filtering through operators and drop-down 
lists.
Grouping

Drag a column heading to the space above a data list to 
group the list by that column.
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Sorting

Lists can be sorted by column values. Click on a column 
heading to sort the list in descending order. Click the column 
heading again to sort in ascending order.

Reordering and Stacking Columns

Click and drag a column to the area between two columns to 
move it to that location:

Click and drag a column onto the header of a different 
column to stack the columns:

Document List Organization (Continued)
OnBase 18
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Filtering

The Custom Queries, Document History, Document Retrieval, 
Mailbox, and Users layouts support filtering. Operators, drop-
down lists, and custom filters are available methods of list 
filtering.

Click the operator button in the desired column to view 
available operators:

Click the drop-down list arrow to view available drop-down 
list options:

Note: Operator and drop-down list options vary by column.

Select Custom from a drop-down list to open the Custom 
Filter Selection dialog box. You can create your own data list 
filter using conditions and operators.

Document List Organization (Continued)
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